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Command Shortcuts—Listed Alphabetically 
If no keyboard shortcut is available, menu selections are given. Also: <select > indicates that you must make a selection). 

Append to 
the Clipboard 

Append to a file 

Assign a password 

Automatic 
page number 

Backups 

Backward search 

Binding width 

Block protection 

Bold 

Case conversion 

Alignment character 

Cancel a command 

Command-4 3 

<select > Command-A 1 

<select > Command-A 2 

Choose Save As from 

File menu 

Command-?2 2 

Choose WP Defaults 2 

from File Menu 

Command-B 

Command-2 1 

<select > Command-2 6 

Command-Shift-B 

Command--. 

<select > Choose Case 

Convert from Edit menu 

‘Shorea «Se 
108 

56 

238 

127 

244 

125 

139 

59 

Center Command-Shift-C 
or Command-4 1 

Center page 
top to bottom 

Chain macro 

Command-?2 1 

Command-M 3 

125 

Change font, size 

Change H-zone 

Change units 
of measurement 

Character style 

Check spelling 
of document 

Check spelling 
of page 

Check spelling 
of selection 

Close a window 

Codes, show 

Colors 

Columns on/off 

Column options 

Conditional EOP 

Change dictionaries Command-E 6 

Command-5 

Command-R 

Choose WP Defaults 5 
from File menu 

Command-5 

Command-Shift-W 
or Command-E 1 

Command-E 2 

<select >Command-E 3 

Command-K 

Command-7 

Choose Screen 4 
from Special menu 

Command-Shift-K 
or Command-1 1 

Command-1.2 

Command-?2 5 

405 

85 

112 

449 

88 

400 

400 

400 

236 

60 

450 

144 

149 

138 

_Display justification 

Convert a file 

Copy 

Copy or cut a 
column 

Copy a file or 
folder 

Create new folder 

Create an endnote 

Create a footnote 

Cut 

Cycle windows 

Date 

Date function « 

Date (merge code) 

Date/time format 

Define index 

Define lists 

Define macro 

Define TofC 

Delete character 

Delete EOL 

Delete EOP 

Delete a file 

or folder 

Delete right 

Delete word 

Delay in a macro 

Display disk space 

Endnote (create) 

Endnote (edit) 

End of field 

[Shorcut __—_—*(i Se 
Choose Save 
As from File menu 

<select > Command-C 

Command-6 5 Command-C 
or Command-X 

Command-L <select > 
Command-4 

Command-L Command-8 

Command-9 5 

Command-9 1 

<select > Command-X 

Command-W 

Command-D 

Command-Shift-D 

Command-8 D 

Command-D 3 

Choose Define Lists 7 
from Special menu 

Choose Define Lists 1-5 
from Special menu 

Command-Shift-M 
or Command-M 1 

Choose Define Lists 6 
from Special menu 

Delete 

Command-1 (numeric 
keypad) 

Command-3 (numeric 
keypad) 

Command-L <select > 
Command-6 

. (numeric keypad) 

Command-Delete or Enter 
Delete 

Command-M 4 

Command-L 

Command-Shift-J 

Command-9 5 

Command-9 6 

Command-Shift-R. 



‘Command 

End of record 

‘Enter Key 

‘Enter key mapping 

Execute macro 

Execute merge 

‘File/folder info 

File management 

Flush right 

Fonts (change) 

Footers 

Footnote (create) 

Footnote (edit) 

Footnote number 

Footnote options 

Forward search 

Full windows 

to top of page 

Hand feeding 

ss indent 

Hard page break 

Hard (non- 
oreaking) space 

Headers 

Hyphenation 

H-zone 

Jelp 

Command-Shift-E 

Enter, 7, or 5 (numeric 
keypad) 

Command-? 

Command-Shift-X 

Choose Merge from 
Special menu 

Command-L <select > 
Command-7 

Command-L 

Command-Shift-F 

Command-5 

Command-Shift-H 

Command-9 1 

Command-9 2 

Command-9 3 

Command-9 4 

Command-F 

Command-Shift-Z 

Command-Shift-G 

Command-G 

Command-G 4 

Command-G character 

Command-G ft 

Command-P 

Command-Shift-T Shift-Tab 

Command-Return 

Enter space bar 

‘Command-Shift-H 

Command-4 4 

Command-R 
<move shaded portion > 

Command-? 

Indent 

Input in a macro 

Insert literal 

(ASCII) 

Invoke macro 
in a merge 

Index (mark for) 

Italics 

Justification 

Kerning 

Leading 

Left/right indent 

Letterspacing 

Line height 

Line spacing 

List (mark for) 

List files (file 
management) 

Look in a file 
or folder 

Look up a word 
(Speller) 

Lowercase 

conversion 

Macros 

Macro merge code 

Margins 

Margin release 

Mark for index 

Mark for list 

Mark for TofC 

Merge 

Merge codes 

Merge from 
keyboard code 

Command-Shift-T 

Command-M 5 

Command-I 

Command-8 G 

<select > Command-] 3 

Command-Shift-I 

Command-R <select icon > 

Command-4 6 

Command-4 5 

Command-S$hift-L 

Command-4 6 

Command-4 5 

Command-4 5 

<select > Command-] 1 

Command-L 

Command-L <select > 
Command-3 

Command-E 5 

<select > Choose Case 
Conversion 2 from Edit menu 

Command-M 

Command-8 G 

Command-R 

Shift-Tab or Command-4 7 

<select > Command-J 3 

<select > Command-J 1 

<select > Command-J 2 

Choose Merge from Special 
menu 

Command-8 

Command-8 C 

(continued on inside back cover) 
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XXL 

— Introduction 

I’ve tried to write this book so that it will be the only one you’ll 

have to buy. You’ll learn a lot of things that aren’t in the WordPerfect 
documentation, and, if you’re a WordPerfect IBM user, you’ll find 

tips about how the program works differently on the Mac. 
Mastering WordPerfect on the Macintosh isn’t just a tutorial in the pro- 

gram’s fundamentals, or just a reference book, or a “‘tips and traps”’ 
book: it’s all three. First, it gives you a short set of exercises that you 
can use to get accustomed to some of the basic ways the program 

works. It’s then organized by the tasks you normally do, so that you 
can use it as a reference to quickly look up a feature long after you’ ve 
learned it. In addition, Mastering WordPerfect on the Macintosh is full of 
tips and shortcuts that can help you get around many obstacles you 
may encounter while using the program. And, because the Macin- 

tosh is so easy to use, the book doesn’t stop where most ‘“‘mastering”’ 
books stop; it takes you through the most sophisticated things you 
can do with WordPerfect, such as setting up conditional macros, 

performing complex merge printing, and executing macros 
from merges. 

WordPerfect for the Macintosh probably isn’t your first word pro- 
cessing program. You may have been using WordPerfect on an IBM 
PC and want to take advantage of the Mac’s superior graphics capa- 
bilities or to transfer documents between the IBM and the Macin- 
tosh. You may have been using MacWrite or some other basic word 
processing program and now want to move up to a more sophisti- 
cated word processor. Or you may want to do desktop publishing on 
your Macintosh without having to invest in a separate desktop pub- 
lishing program like PageMaker. All of these are excellent reasons for 
using WordPerfect on the Macintosh. 

With little practice, you can use WordPerfect’s menu system and 
select commands, and you can click on buttons in dialog boxes by 
using the mouse. You can also use keyboard shortcuts. These key- 
board shortcuts can save you time as you type, because you don’t 
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have to take your hand off the keyboard and reach for the mouse. 

There are some situations, of course, in which the mouse is much 

better suited for the task—such as selecting which words to cut, or 

selecting the exact point where you want to put a tab—but issuing a 

series of commands through several submenus isn’t one of them. 
However, it’s simply a matter of personal preference: you can use the 

mouse in some situations and the keyboard shortcuts in others— 

whatever suits you. 
It’s assumed that you know how to use a Macintosh computer and 

are reasonably familiar with its operation. You should be comfortable 
with pull-down menus, windows, and using the mouse to click and to 
drag. You should also understand the basic techniques for opening 

and closing documents. If you’re new to the Macintosh or need a 

quick review, see your Macintosh owner’s guide. 
If you’re an experienced Macintosh user, you may find that Word- 

Perfect uses the Macintosh interface in some unique ways. For 

example, Mac WordPerfect, like its IBM counterpart, uses invisible 
codes that control formatting. Normally these codes don’t appear on 
the screen, but you can view them in a special Codes window. Using 
a word processor with embedded codes may take a little getting used 

to, but they give you almost total control over what you can do with 
your word processor. You can search for these codes, for example, 

and replace them with other codes, thus reformatting your docu- 
ment. You can see exactly how much space is between words and 
characters. And, because you can write macros in WordPerfect, you 
can have the program ‘‘automatically”’ carry out complex sequences 
of instructions that involve manipulating format codes. For example, 

you can have WordPerfect search for all the main headings in a docu- 
ment, change them to boldface and all caps, format a contents page, 
generate a table of contents, and print it with the document—all by 

recording one macro that you can use over and over again with other 
documents. 

Using This Book 
Not everybody will want to use this book in the same way. If you’re 

new to WordPerfect, you’ll probably want to begin with Chapter 1. 
It contains a tutorial that gets you quickly familiar with WordPer- 
fect’s basic operations. Even if you’re already experienced with 
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WordPerfect, you’ll probably want to review this chapter. After you 

complete the tutorial, you’ll know how to enter and edit text, change 
fonts, set up different formats, paste graphics, insert the date in your 
document, use the Speller to check the document you’ve created, 
save the document, and print it. 

After this basic tutorial, you can use the book as a reference aid. 
You'll find descriptions of all the procedures required to carry out 
tasks, and you’ll find many examples that you can practice with if 
you like. 

Here’s a brief look at how the rest of the book is organized. 
Chapter 2 presents WordPerfect’s editing techniques. It expands 

on some of the basic skills presented in the tutorial and demonstrates 
more advanced techniques, such as working with multiple docu- 

ments, using search and replace, and converting uppercase to lower- 
case and vice versa. It also discusses many procedures you use with 

longer documents, such as using strikeout and redline to indicate 
deleted and changed text in documents that are reviewed by others. 

Chapter 3 covers character, line, and paragraph formatting. 
You’ll see how to create hanging paragraphs, set special kinds of tabs, 
change line spacing, use automatic hyphenation, control justifica- 

tion, change fonts and character styles, and insert special characters 
in your documents. 

Chapter 4 presents page formatting techniques, such as inserting 
headers and footers, using different page numbering systems, and 
controlling how pages break. 

Chapter 5, which covers desktop publishing, shows you how to 
work with text formatted in parallel and newspaper columns and how 
to insert graphics into documents. If you’re publishing newsletters or 
making presentations with WordPerfect, you’ll want to review this 
chapter thoroughly. 

Chapter 6 discusses printing your documents both with the Apple 
ImageWriters and the LaserWriters. It also examines fonts—screen 
fonts, printer fonts, and downloadable fonts. 

Chapter 7 discusses managing your files. If you’re an experienced 
Mac user (that is, if you’ve used a Macintosh for about 15 minutes or 
so), you already know how to copy files, create folders, and so forth. 
However, WordPerfect has many built-in options that let you carry 
out these tasks without a trip to the Finder. You may want to review 
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this chapter to see if there are any additional tips and shortcuts you 

can use in your work. 

In Chapter 8, you’ll see how to record macros in WordPerfect. 

Writing macros to accomplish your routine tasks is a wonderful time- 

saver. You simply carry out all the commands required to accomplish 
a task, and WordPerfect records what you do and plays it back when- 
ever you use the macro. Using macros saves you from having to 
remember complex sequences of commands and responses, and car- 

ries out operations faster than you-can with the keyboard or mouse. If 
you haven’t used macros before, you’ll be delighted by how simple 
and easy they are to create in WordPerfect. If you’ve used macros in 

another word processing program, you’ll be delighted that they’re 
finally here in WordPerfect on the Macintosh. This chapter has more 
than 50 useful macros, ranging from simple ones to relatively com- 
plex macro systems that automate processes for you. If you don’t 
want to record all these macros yourself, you can order a disk con- 
taining them. See the last page of the book for details. 

Merge printing is one of the most powerful things you can do with 
a word processor, and you’ll learn how to use it in Chapter 9. It 
appears after the macros chapter so that you can see some of the more 

advanced things you can do by combining merges with macros. You 

can set up a system for assembling documents from master files, for 

example, and use boilerplate (standard text) to create documents 
without much typing at all. 

Chapters 10 through 12 discuss specialized features of the pro- 

gram: outlining, working with footnotes and endnotes, and creating 
tables of contents, lists, and indexes. You may never need to create an 

index, an outline, or a table of contents; if so, you can skip these 
chapters. 

Chapter 13, although it’s short, is one of my favorites. I’m fasci- 
nated by the way the Speller works, and I’m amazed at how versatile 
itis. You’ll see how to create custom dictionaries of your own and get 
into the inner workings of the Speller and Thesaurus. 

In Chapter 14, you can explore some worlds beyond WordPerfect. 
You’ll see how to use an on-line information facility like Compu- 
Serve, which you can use to access the WordPerfect Support Group 
with your questions and read answers from fellow WordPerfect users 
all over the country. This chapter also discusses how you can connect 
your Mac to IBM PCs and transfer your WordPerfect files from 
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machine to machine. If you have a large number of IBM WordPer- 
fect files, this chapter will be of great interest to you. It will also dis- 
cuss a few pointers you should keep in mind if you’re using 
WordPerfect on a network. 

In the appendixes to this book, you’ll find a list of WordPerfect’s 
formatting codes (Appendix A) and a chart of the functions assigned 

to specific keys (Appendix B). Appendix C reviews many of the 

different ways you can customize WordPerfect to suit the way you 
work, including setting screen color on a color monitor. 

In addition, printed on the inside covers of the book is a quick ref- 
erence guide so that you can look up how to accomplish a task with- 
out having to skim through the book. 

Throughout the book, you’ll find margin notes that will give you 
tips (the checkmark), general notes (the pointing finger), and a few 
warnings (the bull’s eye). Use of the Command key (gg) is indicated 
by the word Command instead of the cloverleaf symbol. In most 
cases, you are given two alternate ways to accomplish a task— 
either by using the mouse or with the keyboard shortcuts. 

The Fast Tracks 

The Fast Track section at the beginning of each chapter summa- 
rizes the chapter’s contents, lists the steps or keystrokes needed to 
complete specific tasks, and points you to the page where you can 
find a tutorial presentation or more detailed explanation. In some 
cases, the Fast Track entry will be all you need to get going. In other 
cases, you can use the Fast Track to pick out the points you are inter- 
ested in and then go directly to the information you need. Also note 
that Fast Tracks cover the Chapters’ primary topics; they do not 
cover every option, exception, or caveat discussed in the text. 

Keep in Touch 
WordPerfect Corporation provides a toll-free number you can call 

for user assistance if you need it. It’s available from 7 A.M. to6 P.M. 
Mountain Time. The number is: 

(800) 321-5906 
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You’ll also want to get any upgrades to your program as they become 

available. The address to use when obtaining an upgrade by mail is: 

WordPerfect Corporation 
Update Department 

329 N. State Street 
Orem, UT 84507 

You can call (800) 321-4566 if you prefer to use your credit card to 
order an upgrade, or to find out. when new releases of the program 
will be available. 

In addition, I’d be happy to hear any ideas or suggestions you may 
have for future editions of the book. I’m on CompuServe (user 
72000,1176), and at the address given on the last page of the book 
with the disk offer. 

A Final Word 

WordPerfect on the Macintosh is a sophisticated and powerful 
word processor that’s now available through the Macintosh’s easy- 
to-use user interface. It may look deceptively simple, but don’t be 
disappointed if you don’t master every one of its features in a single 
sitting. Learn the features you need to use in your work now; learn 
the others as the need arises. Do start writing macros for your routine 
tasks as soon as you feel comfortable with the program’s basics; you’ll 
be delighted with how much more effectively you can work. 



7 — Getting Started 



Fast Track 

To choose commands from menus by using the mouse, 8 

click on the menu’s name and hold the mouse button down; 

then drag with the mouse. Release the mouse button when the 

command you want is highlighted. 

To select text, 11 

double-click or shift-click with the mouse, or choose Select from 

the Edit menu (Command-6). 

To choose commands by using the keyboard, 12 

press the Command key and the command’s keyboard shortcut 

character. For commands on submenus, press the Command 

and Shift keys plus the keyboard shortcut character. For 

example, Command-B searches backward and Command- 

Shift-B turns on boldface. 

More detailed coverage 16 
of the following commands can be found in later chapters. 

To open a new window, 17 

choose New from the File menu (or press Command-N). 

To select different fonts, font sizes, and styles, 18 
choose them from the Font menu (or press Command-5). You 
can also select styles by clicking the boxes on the Status line. 

To view WordPerfect’s hidden codes, 24 
choose Show Codes from the Edit menu. 

To save the document you’re working on, . , 25 
choose Save from the File menu (or press Command-S). 



To delete the word the insertion point is in, 

press Command-Delete. 

To undelete one of the last three deletions, 

choose Undelete from the Edit menu (or press Command-U). 

To undo the last thing you’ve done, 

choose Undo from the Edit menu (or press Command-U). 

To change tabs, margins, and justification, 

choose Show Ruler from the Format menu (or press 
Command-R). 

To search and replace text, 

move to the beginning of the document and choose Replace from 

the Search menu (or press Command-H). 

To center text, 

choose Line from the Format menu; then choose Center (or 

press Command-Shift-C). 

To spell-check your document, 
choose Spell from the Special menu; then choose Check Docu- 

ment (or press Command-Shift-W). 

To print a document, 

choose Print from the File menu (or press Command-P). 
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32 

36 
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39 



CHAPTER 7 

WORDPERFECT ON THE MACINTOSH GIVES YOU A 
sophisticated word processor available through the easy-to-learn 
Macintosh interface. You’ve probably heard the program described 
as ‘‘feature laden,”’ and it’s true. Here are only a few of WordPer- 
fect’s features: 

e Ability to create your own keyboard commands to customize 

the program 

e Automatic reformatting 

e Automatic timed backups 

¢ Uppercase/lowercase conversion 

¢ Date and time insertion 

¢ Double-layout page preview 

¢ Footnotes and endnotes 

¢ Full file management within the program 

¢ Full windows with no menu bar, if you choose 

¢ Graphics 

¢ Headers and footers 

¢ Hyphenation 

¢ Indexing 

¢ Kerning 

¢ Keyboard shortcuts 

° Letterspacing | 

¢ Macros 

¢ Merge printing 



¢ Outlining 

¢ PostScript commands 

¢ Redlining and strikeout 

e Spelling checker and Thesaurus 

e Subscripting and superscripting 

e Text columns 

e ‘Transfer files to another program 

¢ Undelete and Undo commands 

e Virtual memory—you can create documents much larger 
than the amount of RAM you have 

e Word count 

In addition, if you’ve been using WordPerfect on an IBM PC, XT, 

or AT; you’ll find that your documents are usable on the Macintosh, 
and you can save your Macintosh documents in IBM format as well. 
If you’ ve been working with WordPerfect on a VAX, an Apple II, or 

a Data General computer, those documents can easily be converted 

to WordPerfect Macintosh format. 

SCS tting Up 
Before you start using WordPerfect, there are a few things you 

should know about how the program is designed to interact with you. 

Taking the time to go over these now may save you some unneces- 

sary trouble later. 

What Equipment Should You Have? 

WordPerfect for the Macintosh is designed to run on the Macintosh 

512KE, the Macintosh Plus, the Macintosh SE, and the Macintosh II, 

although you may find it slow on the 512KE and the Plus without a hard 
disk. It should also work with any new Macintoshes that Apple releases. 

To get the most from the program, you’ll need a hard disk, and you’ll 
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want a keyboard with a numeric keypad. And, of course, you'll need 

double-density 800K disks. 

WordPerfect works with whatever printers you have installed in your 

System folder. 

Which Keyboards Work with WordPerfect? 

All the Macintosh keyboards work with WordPerfect, but depending 
on which Macintosh you’re using, you’ll probably have a different key- 
board. The keyboard for the SE and the Mac II has a numeric keypad, 
arrow keys, a Control key, and an Escape key, which are all functional in 
WordPerfect. In addition, there’s the Apple Extended Keyboard, which 

has 15 function keys across the top, all of which you can use with Word- 
Perfect. This keyboard works with either the SE or the II. 

The keyboard for the Macintosh Plus has arrow keys and a 
numeric keypad, but it doesn’t have an Escape or Control key. How- 

ever, you can get by without either one of those. 
If you’re using the original Macintosh keyboard, however, you 

won’t have any arrow keys, numeric keypad, Escape, or Control 
keys. You can use the following key combinations as arrow keys: 

KEY COMBINATION ARROW-KEY EQUIVALENT 

Command-] cg 

Command-[ — 

Command- = t 

Command-’ y 

You can use the numeric keypad instead of the mouse for many 
keyboard shortcuts. WordPerfect Corporation provides a set of 
‘‘keycals’’—keycap decals—that you can stick on your key caps to 
remind you of the functions of the numeric keys. However, if you’ve 
misplaced your keycals or if they’ve become worn or have dropped 
off from use, you can use the template in Appendix B to create 
another set. 

If you’re using the Apple Extended Keyboard with the function 
keys, you’ll want to copy the larger template in Appendix B and fix it 
on the keyboard above the function keys to remind you of their 
optional use. 



To copy a disk, just 
@™m drag its icon over 

the icon of a blank disk. 
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What Should You 

Know Before You Start? 

You should already know how to use a Macintosh computer and 

be reasonably familiar with its operations. We’ll review some of the 
basics later in this chapter, but in general, you should be comfortable 
with pull-down menus, windows, and using the mouse to click and to 
drag. You should also understand the basic technique for opening 
and closing documents. If you’re new to the Macintosh or need a 
quick review, see your Macintosh owner’s guide. 

WordPerfect probably isn’t your first word processor—you’ve 

most likely used MacWrite or another basic word processor before. 

You should at least be aware of such basics as what word wrap is, that 
text is reformatted as it’s inserted, and so forth. 

How Do You Get Help? 

You can get on-line help while you’re using WordPerfect. First, 

select WP Help from the Apple menu; then choose the topic you 
need help with. Click Help to get information about that topic. In 
fact, you can execute the command you are looking up by clicking on 

the Execute button. You can then click Topics to see other topics or 
click Quit to close the Help dialog box. 

Where Should You Begin? 
Getting WordPerfect running on your Macintosh is simple. First, 

make backup copies of the WordPerfect disks. If you’re using two disk 
drives, you’ll need four blank disks, initialized two-sided. Copy the 
three disks that came with WordPerfect—-the System disk, the Word- 

Perfect disk, and the Speller/Thesaurus disk. You’ll use the fourth disk 

as a data disk. 
If you have a hard disk (highly recommended), you’ll need only 

two initialized disks for backup floppies, one for WordPerfect and the 

other for the Speller/Thesaurus, because you already have a system 
file on your hard disk, which you’ll also use as your data disk. You’ll 
copy WordPerfect and the Speller/Thesaurus disk into your Word- 

Perfect folder on the hard disk. 

WILLIAM F. MAAG LIBRARY 

YOLINCSTOWN STATE UNIVERSITY 
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When using a hard disk, create a new folder named WordPerfect 

or WP. Then open the WordPerfect disk and Speller/Thesaurus disk 

icons, press Command-A to select everything, and drag the high- 

lighted icons into the WordPerfect folder. 

WordPerfect needs System version 4.1 or a later version. If you’re 

using a hard disk, check to see which version you have. (Select the 
System icon in the System folder; then choose Get Info from the 
Apple menu.) If your system is an earlier version than 4.1, replace it 

with the new system that came. with WordPerfect—but don’t put 
both versions of the System on the hard disk, or you may cause prob- 

lems. If you need to replace the System file on your hard disk, start 
your Macintosh using a startup disk in the floppy drive so that your 
System file won’t be in use. You can then copy the new System file 
into your System folder; then restart from the hard disk. 

How Is WordPerfect Different? 

WordPerfect uses the Macintosh graphic interface with its system 

of pull-down menus, dialog boxes, windowing, and the mouse, and 

also adds a few elements that give you more control over how you 

work. First, you’ll find that in addition to pull-down menus, you'll 

see pop-out menus (also called submenus) that appear to the right of a 
menu when more options are available. If a pop-out menu is present, 

you'll see a solid, right-pointing arrowhead. If making a menu selection 
brings up a dialog box, you’ll see an ellipsis (...). In Figure 1.1, for 
example, all the menu selections lead to additional submenus except the 
Thesaurus and Merge options, which bring up a dialog box. 

Second, WordPerfect, like all word processors, uses hidden format 

codes to format your document. Unlike other Macintosh word pro- 
cessors, WordPerfect lets you view and manipulate these codes. If 
you’re used to working with other Macintosh word processors, you 
may have a little difficulty in getting used to these codes until you see 
how much control they give you over your document. 

To view the normally hidden codes in WordPerfect, choose Show 
Codes from the Edit menu. A special Codes window opens at the bot- 
tom of your screen, as illustrated in Figure 1.2. 

= te = wy oe - Oe, 
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Figure 1.1: Arrowheads indicate the presence of additional submenus; ellipses 
indicate that dialog boxes will appear if you choose that item. 
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Chapter 1 
Getting Started 

Before you can start using WordPerfect, there are a few 
things you should know about how the program is designed to 
interact with you. Taking the time to go over these now may save 
you some unnecessary trouble later. 

What Equipment Should You Have? 

WordPerfect for the Macintosh is designed to run on the 
Macintosh 512KE, the Macintosh Plus, The Macintosh SE, and the 
Macintosh II. It should also work with any new Macintoshes a 

Getfont Courier Hs) 
Chapter 1 
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Figure 1.2: To view the hidden format codes WordPerfect uses, you open a 
special Codes window. 
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Third, WordPerfect adds an Undelete command to the Macin- | 

tosh’s Undo command. Not only can you (in most cases) undo what 

you just did, but you can also restore up to the last three deletions. In 

addition, you can also cancel many processes and back out of dialog 

boxes by pressing Command.-. (period). 

Several other WordPerfect features may be slightly different from 

what you’re used to if you’ve used other word processors, either on 

the Macintosh or on a PC: 

e The Retrieve command places the contents of the file you’re 
retrieving into the document you’re working on, at the inser- 

tion point. Use the Open command to open a new document. 

e There is a cursor (the insertion point) as well as a pointer. 
The pointer resembles an I-beam when it’s in a document. It 

changes to an arrow when it’s in a menu. Scrolling the docu- 

ment doesn’t move the position of the insertion point. 

¢ The Macintosh keyboard has both an Enter key and a 

Return key. The Enter key works like the Home key on the 

PC, and the Return key is the same as the 4 key on the PC. 

e There are three different Save commands: Save, Save As, 

and Save Copy As. The Save command saves the document 
you’re working on. If you haven’t saved it before, you’ll be 
asked to give it aname. If you’ve saved the document before, 
the Save command replaces the previously saved version 

without prompting you. The Save As command lets you save 

a document under a new name; it replaces the document on 

the screen with the version you are saving (the name in the 
title bar changes) so that you can work on the version you just 
saved. The Save Copy As command saves the document 

under a new name but doesn’t replace the document that’s 
on the screen, so you can continue to work with the original 
version. 

There are other differences and innovations, but they’ll be covered in 
the course of the book. In general, WordPerfect works as you would 
expect it to: z 

e Word wrap takes place automatically. Press Return only to 
begin a new paragraph. 
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e Format changes take place only after the point where you 
make them. 

e The Return key moves the insertion point and also inserts 
blank lines. 

e Pages are reformatted and paginated automatically as you 
write. 

¢ What you see on the screen is what you get when you print. A 
Print Preview feature allows you to see headers and footers, 

footnotes, and top and bottom margins. 

WordPerfect Basics 

In the next few sections we’ll take a look at the basic ways you work 
with WordPerfect. If you’re an experienced word processor, you can 

Just skim these sections and go to the tutorial at the end of this chap- 

ter, or start with Chapter 2, which presents WordPerfect’s basic text 
entry and editing techniques in more detail. Everything that’s cov- 
ered in the tutorial will be discussed elsewhere in the book as well, but 

the tutorial gives you an easy place to get a quick overview. 

The WordPerfect Window 

WordPerfect’s editing screen (Figure 1.3) gives you a full screen in 
which to work. We’ll look at each of its components: the menus, dia- 

log boxes, title bar, status line, scroll bars, and insertion point. 

Selecting from Menus 
The menu bar across the top contains the main menu. When you 

click on any of these names, a pull-down menu appears, listing the 

choices you can make from that menu. A solid, right-pointing arrow- 
head indicates that a submenu is associated with that item. You can 
choose from the submenu in two ways: 

e Drag down to the command you want and then drag to the 
right and down on the submenu: Release the mouse button 
when the command you want is highlighted. 
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Figure 1.3: The WordPerfect window lets you size the window and scroll the 
document. 
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e Drag to the command you want on the first menu and then 

release the mouse button, which makes the submenu appear 
on the screen by itself. 

You'll probably find that the second method is easier to use. 
‘To remove a submenu from the screen without selecting anything 

from it, click anywhere on the screen outside the menu. 

Another way to choose from a menu is to use the keyboard short- 
cuts. Ifthere’s a keyboard shortcut for a command, you'll see it listed 
on the menu. For example, in Figure 1.4 you can see that the key- 
board shortcut for Paste is Command-V. You can press the Com- 
mand key and the V key at the same time to execute the Paste 

cor You can also map command without having to use the mouse to choose from the menu. 
features that don’t O b rec hoariceh 

haveikevboard shortcuts n some submenus, keyboard shortcuts are represented by a 
to an Enter key sequence, Command-Shift combination, so you’ll have to press the Command 
or you can create Enter key, the Shift key, and the letter or number key associated with that 
key keyboard shortcuts : ee command. Other submenu selections are numbered. For example, 
work. Appendix C will choosing Spell (whose shortcut is Command-E) from the Special 
tell you how. menu brings up a submenu with six choices, the second of which is 
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Figure 1.4: Keyboard shortcuts are listed on the menus next to any commands 
that have built-in shortcuts. 

Check Page. You can press Command-E and type 2 instead of choos- 
ing Spell from the Special menu and then choosing Check Page from 

the submenu. You’ll be reminded of these shortcuts throughout this 
book, because they can save you time as you type. 

Using Dialog Boxes 

If a menu selection leads to a dialog box, you’ll see an ellipsis (...) 
after it. Choosing that item brings up a dialog box like the one in Fig- 
ure 1.5. Dialog boxes allow you to click buttons such as OK or Can- 
cel, and they often contain text boxes where you type in additional 
information. To move from one text box to the next in a dialog box, 
press the Tab key. 

There are also keyboard shortcuts to use in dialog boxes. You can 
cause a button to be clicked by pressing the Command key while you 

type the first letter of the button’s name. For example, instead of 
clicking Cancel in the dialog box in Figure 1.5, you could type 

Command-C. 
In addition, you can press Return instead of clicking on any but- 

ton that’s outlined with a double rule, like the OK in Figure 1.5. 
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Figure 1.5: Dialog boxes allow you to enter additional information that the 
program needs. 

To back out of a dialog box without making any changes, you can 
press Command-., or type Command-C or click Cancel (if there’s a 
Cancel button). 

The Title Bar 

The line beneath the main menu is the title bar. It contains the 
name of the document you’ re working on if it’s already been saved. If 
you haven’t saved it, ‘‘Untitled’’ appears in the title bar. It also con- 
tains the number of the documents you’re working on—you can 
have as many documents open as memory allows. They’re num- 
bered in the order you open them. When you close one, the rest 
aren’t automatically renumbered, so you can keep track of your 
documents. 

‘To cycle among the windows you’ve opened, choose Cycle Win- 
dows from the Windows menu (or press Command-W, the keyboard 
shortcut). Chapter 2 has more information on working with several 
documents in different windows. 

. 



Getting Started I5 nee ae eee eye 

The Status Line 

The status line at the bottom of the window indicates the page and 
line number of the insertion point and also contains boxes marked P, 
B, U, I, O, and S. By clicking on these boxes, you can change the 

character style to Plain, Bold, Underline, Italic, Outline, and 

Shadow, respectively. 
If you want to see the position of the insertion point in terms of its 

vertical and horizontal coordinates on the page, you can choose 
Show Position from the Special menu’s Screen submenu. These 
positions will appear in the right corner of the status line. You can 

choose inches, centimeters, or points by choosing WP Defaults from 
the File menu and then choosing Measurement. 

You may see other messages on the status line as you work. For 

example, if WordPerfect can’t find a word it’s searching for, you’ll 
see ‘“‘Not Found”’. 

Using Scroll Bars 

The vertical scroll bar on the right of the window lets you scroll up 
and down through your document without moving the insertion 

point. To scroll down line by line, click in the downward-pointing 
arrow and keep the mouse button down. To scroll up line by line, use 
the upward-pointing arrow. You can also use the scroll elevator to 
move through a document without moving the insertion point. First, 
drag the square box in the vertical scroll elevator and then release the 
mouse. You'll see the Pg indicator on the status line change so that 
you know what page you’re looking at. 

Clicking in the gray area of the scroll elevator also moves you 
through the document quickly without moving the insertion point. 
When you click in the gray area above the scroll box, you move up 
one window at a time; clicking below the box moves you down one 

window at a time. 
You can also scroll horizontally to see areas that are off the screen; 

use the scroll bar at the bottom of the window next to the status line. 
WordPerfect’s ruler line will extend to the right as long as you scroll 
horizontally so that you can see where you are on an extra-wide page. 
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You can change the 
Mi rate at which the 

insertion point blinks by 
choosing Control Panel 
from the Apple menu. 
This menu choice also 
controls the rate at which 
the menu blinks, the 

double-click speed for the 
mouse, the key-repeat 
rate, and the noise the 

beep makes. 

The Insertion Point 

The insertion point (called the cursor in the WordPerfect docu- 

mentation) is represented on the screen by a blinking line. It repre- 

sents where the text you type will appear. You can move the insertion 

point in the window by clicking with the mouse. The new insertion 

point appears where the pointer was. 
Normally, WordPerfect is in Insert mode, which means that the 

text you type will be inserted at the insertion point. To switch to 

Typeover mode so that what you type replaces text on the screen, 

choose Typeover from the Edit menu (or, on a numeric keypad, press 
the 0 key). You’ll see the word Typeover on the status line when 
Typeover is on. 

The Pointer 

The pointer, unlike the insertion point, moves as you move the 

mouse. Inside the WordPerfect window, the pointer appears as an 
I-beam. When you move it into the menu bar, it looks like an arrow. 

Now that you’ve had a brief introduction to the basics of WordPer- 

fect, you can work through a short tutorial that will quickly familiarize 
you with how to use the program. In this tutorial, you’ll learn enough 

about WordPerfect’s basic commands to get you started writing letters, 
memos, and short reports. After you’re comfortable with the program’s 
basics, you can explore the additional techniques that are discussed in 
the rest of the book. You’ll find marginal notes directing you to chapters 
that have more information about each topic. 

Introducing WordPerfect 
on the Macintosh: A Tutorial 

Before you begin, you should make sure that you’ve set up your 
files so that WordPerfect will know which default folder to make your 
work folder for saving your documents. It will also need to know 
where to put the temporary files it automatically creates as it oper- 
ates, where you keep the Speller and Thesaurus dictionaries, and 
where you want to store your macro files. If you haven’t set up your 
default folders, see Chapter 7. 
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: 

: har pe The keyboard shortcuts shown in the tutorial can be used on all Mac- 
Board hoticnts-that intosh keyboards. You don’t need a numeric keypad or arrow keys. 

you can use with a After you complete this exercise, which consists of writing and for- 
numeric keypad. matting a one-page letter, you’ll have seen how to: 

e Input and edit text 

¢ Create a simple logo 

¢ Use different character styles and font sizes 

e Center text and headings 

e Insert today’s date 

¢ Go immediately to a character 

e Select text in different ways 

: e Cut and paste text 

¢ Undelete what you just deleted 

¢ Undo what you just did 

Although you'll e Cancel a selection 
format text as you 

enter it in these exercises e View and delete hidden format codes 
so that you can see how 
the commands work, you e Save and open documents 

may find it faster in your 
Gib Werits type the-text ¢ Use the ruler line for tabs and decimal tabs 

pee ocmnent ¢ Convert lowercase words to uppercase 
without any special for- 

matting and then format e Search for one word and change it to another 
it after you’ve input it. 
After you’ re familiar with e Insert special characters 
WordPerfect, use which- : ; : 
ever method suits your e Write a macro that closes a letter with your personal signa- 
style of writing. ture block 

e Run the Speller to check what you just wrote 

e Preview and Print the document you Just created 

To begin the tutorial, open a new document. Select New from the 
File menu or press Command-N. 
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cr There’s more on 
fonts and styles in 

Chapter 3. 

Creating a Logo 

One nice thing about the Macintosh is that you can design your 

own letterhead. First, you’ll create a logo for the letterhead. 

To keep things simple, it’s assumed that you’re using the default 

font, which is Geneva. If you’ve changed to another font, you must 

already know how to change fonts, so change back to Geneva for this 

tutorial. 

i Enter the following at the beginning of the new document. 
Press Return twice after Noah’s Ark to add a blank line. 

Noah’s Ark 

4550 West Calgary 
San Diego, CA 94126 

You'll use a larger type for the company name, but before you 
change it, you need to select it. 

. Click just to the left of the Nin Noah’s; then press the Shift key 
and click again at the end of the line. 

The words Noah’s Ark are now highlighted, and the words Select On 
appear on the status line. Shift-clicking is a quick way to select a 
few letters or words or even several lines of type. You could also 
click and drag the mouse to select the words, but shift-clicking is 
more accurate than dragging because the point where you click 
the second time is exactly the end of the selection. 

. To change Noah’s Ark to a different and larger font so that it 
will contrast with the rest of the text, choose Chicago from the 
Font menu. 

. To switch to 18-point type, choose 18 from the Font menu. 

The best sizes for the font you’re currently using appear in out- 
line form on the Font menu. 

. To center the words Noah’s Ark between the margins, choose 
Line from the Format menu; then choose Center. 

If you’d rather use a keyboard shortcut, press Command-Shift-C to 
center the text. 
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6. To change the style to Shadow, click on the S in the small box 
on the status line. Then click anywhere that’s not highlighted 
in the document to turn off the highlighting and get a better 
look at the effect you’ve created. 

WordPerfect offers you several different ways for doing most 
things. In this case, you could also choose Style from the Font menu 
and then choose the style you wanted, or you could press Command- 
Shift-S to use the keyboard shortcut to switch to Shadow. 

You can add other styles to the style that’s shown. For example, 
you can click on the O box in the status line (or press Command- 
Shift-O, or choose Outline from the menu) to create an outline effect, 
and you’d have outlined shadowed text. Experiment until you find 

the effect you like; then turn off Select. Click on P (for Plain) to 
remove all the extra character styles and start over again if your logo 
gets too hard to read. ; 

7. Move the insertion point to the beginning of the second 
address line. Shift-click or drag to highlight the next two lines 
of the address; then press Command-Shift-C to center them 
under Noah’s Ark. 

For those of you with arrow keys, which is probably most of you, 
there’s another way of selecting. If you turn on Select by choos- 
ing Select from the Edit menu and then choosing Select On (or 
pressing Command-Shift-N, the keyboard shortcut), you can 
extend the selection by using the arrow keys. You’ll see Select On 

highlighted on the status line when you’ve turned on Select this 
way. In this case, turning on Select and pressing the ¥ key twice 
would select the two lines. To turn off Select, press Command-. 

(period). 

After you’ve selected the two lines, you can then select different fonts, 
sizes, and styles for them. The logo we’ve created in Figure 1.6 is 18- 
point Chicago Outline, and the address block is plain 12-point Chicago. 

8. When your logo resembles the one in the figure, turn off Select 
by pressing Command-. (period). 

You can then enter the rest of the letter in plain text. 
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ber How WordPerfect 
displays lines of text 

on your screen depends 
on which printer you are 

using. The illustrations in 
this book were done with 
a LaserWriter. If you are 
using an ImageWriter, 
and you want the display 
to be the same as the 
figures in this book, 
choose Print Options 
from the File menu; then 

choose Page Setup. Click 
Tall Adjusted and OK. 

Py Whenever you see 
numbered options 

on a submenu, you can 

use them as keyboard 
shortcuts. For example, 

to insert today’s date, you 
could press Command-D 
(the shortcut for Date) 
and then type 1. 

r 

& File Edit Search Format Font Special Windows 

Doc 7: Untitled 

Noal’s rts 
4550 West Calgary 

San Diego, CA 92126 

January 15, 1988 

Mr. Robert Larkin 

1 4411 Hillsdale Blvd. 

Indianapolis, IN 46250 

Dear Mr. Larkin: 

Thank you for your recent request about our pet doors. We carry 

several different models and sizes suitable for both apartment and 

residential use. ; 

For large and medium dogs, we have three basic models: 

Figure 1.6: You can create logos and letterheads for your letters without using 
special stationery. 

Entering Today’s Date 

WordPerfect can automatically enter the date that’s in your com- 
puter’s system clock so that you don’t have to look it up or type it out. 
To enter today’s date: 

1. Press Return twice to insert a blank line. 

2. Choose Date from the Special menu; then choose option 1, 
Insert Text. 

‘Today’s date appears in your document. If the date that appears 
isn’t correct, use the Control Panel or the Alarm Clock on the Apple 
menu to change it. 

Entering and Editing Text 

Go ahead and enter the rest of the text shown in Figure 1.6. Don’t 
worry about making typographical errors, because you’re going to 
run the Speller later to correct the document. 
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WordPerfect’s tabs 

are preset every five 
spaces. See the section 
“Working with Tabs”’ 
later in this chapter for 
more on tabs. 

The Thesaurus can 
help you when you 

need to choose a “‘just- 
right” word. See Chapter 
13; 

To replace selected 
text, just start typ- 

ing. You don’t have to 
delete it first. 

If you’re using a numeric keypad, you may inadvertently press the 
zero key while you’re typing. This turns on Typeover. You’ll see the 
word Typeover on the status line when Typeover is on. WordPerfect is 
preset to use Insert mode, in which characters are inserted among the 
characters already on the screen instead of replacing them. If you turn 

on ‘Typeover by mistake, turn it off by pressing 0 on the keypad again. 

1. Press Return twice to insert an extra blank line between the 

date and the recipient’s address block. 

2. Then enter the text that’s shown. Press Return twice for each 

blank line. When you get to each paragraph, press the Tab key 
for the indent. 

After you’ve entered the text, look at the first paragraph. Perhaps 

“‘request’’ is not the word you want. Let’s replace it with a 
different word. 

3. Move the insertion point to request (you can use the mouse or 
the arrow keys) and double-click on it to select it. 

Double-clicking selects the word the insertion point is on. It’s the 
fastest way to select a word. You can also double-click on one 

word and then extend the selection to include other words by 
shift-clicking. Experiment and see: with request selected, shift- 
click anywhere before it and after it to change the length of what 

you ve selected. Then double-click on request so that it’s the only 
thing selected. 

4. Type the word inquiry. 

You don’t have to delete a word to replace it with another word. As 

long as it’s selected, just start typing the other word. ‘This is true for 
anything that’s selected: typing something else replaces the selec- 
tion. Using this method can save time, because you don’t have to 
use the Delete key, and it automatically turns off Select. 

Now, where else do you need to change a word? Perhaps szzes isn’t 
the right word. Here’s a shortcut to get you there quickly: 

5. Press Command-G and type z; then press Return. 

The Goto command can take you to the next occurrence of any 
character you type. (It can also take you to any page number you 
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specify.) Because there aren’t any zs between the word inquiry, 

where your insertion point is, and the word sizes, using Goto z 

takes you right to the word szzes. 

6. Double-click on sizes, then choose Cut from the Edit menu to 

delete it. (Command-X is the keyboard shortcut.) 

The word sizes and the space following it disappear from your 

document. WordPerfect automatically deletes this space so that 

the rest of the words will be spaced accurately. 

You have two different ways to get that word back. You could 
immediately paste it back in or you could Undelete what you just 
deleted. First, try pasting it back. 

7. Choose Paste from the Edit menu (or press Command-V). 

The word sizes reappears, correctly spaced in the line of text. 

Whatever you cut is saved in the Clipboard, so if you haven’t cut 
anything else, your last cut is still there and can be pasted back in. 

But what if you want to restore a word you deleted a little while ago 
and you’ve cut something else in between? WordPerfect remembers 
the last three deletions you made and lets you restore them. To see 
how this works, take the following steps. 

8. Select sizes again. This time, press Delete when it’s high- 
lighted. 

Eee ty 9. Type styles. Then try a shortcut: without selecting the word, 
Bet Cominaadt Delete: but with the insertion point at the end of it, just press 

For other techniques that Command-Delete. 
delete text quickly, see : : caegsihe 
Chapter Ve y (Command-Delete deletes the word the insertion point is in.) 

10. Then type designs, press the space bar once, select designs, and 

cut it (Command-X). 

You now have three deletions in WordPerfect’s delete buffer— 

sizes, styles, and designs—and you’ve deleted them in three 
different ways. 

11. Choose Undelete from the Edit menu (or press its keyboard 
shortcut, Command-U). 



WordPerfect can 
restore your last 

three deletions. It can 
also Undo the last thing 
you did. 
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You'll see a dialog box like the one in Figure 1.7. The last thing 

you deleted—designs—has been returned to the screen and high- 
lighted. Click Previous to see the previous deletion or click Next 
to see the next one. Go ahead and cycle through all three. When 

sizes is again highlighted, click Restore to put it back in the 
document. 

Even if you’ve deleted a large amount of text, WordPerfect will 

remember it and undelete the last three deletions for you. 
In addition to undeleting, you can undo the last thing you’ ve done 

(most of the time) by using the Undo command on the Edit menu. 
Command-Z is its keyboard shortcut. 

12. Type a few characters for Undo to work on. It doesn’t matter 
what or where you type. Then choose Undo or press 
Command-Z. 

Whatever you typed disappears. Undo undoes the last editing or 
formatting change you made, but it won’t undo some actions, 
like replacements. 

. 
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Doc 1: exercise letter stage 1 

Noali’s rt 
4550 West Calgary 

San Diego, CA 92126 

January 16, 1988 

Mr. Robert Larkin 

4411 Hillsdale Blvd. 

Indianapolis, IN 46250 

Dear Mr. Larkin: 

Thank you for your recent request about our pet doors. We carry 

several different models and bERpir suitable for both apartment and 

residentia & 

nea 
lei 

Figure 1.7: The Undelete dialog box lets you restore the last three deletions. 
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Viewing Format Codes 

You’ve been making style changes without being aware of what is 

going on behind the scenes. When you add a style to characters or issue 

other format orders to the program, such as pressing Return or Tab, 

WordPerfect inserts format codes around the text you’ve typed. You can 

view those codes and manipulate them: 

1. Choose Show Codes from the Edit menu. 

A special Codes window opens at the bottom of your screen 

showing lines of text above and below the insertion point, as in 
Figure 1.8. The gray box indicates the insertion point. You can 
see the [HRt] and [Tab] codes that indicate where you pressed 
Return to insert a hard return or pressed Tab for a paragraph 
indent. 

You can’t change anything directly in the Codes window; instead, as 
you edit your document, the changes are reflected in the Codes win- 
dow. For example, suppose you wanted to emphasize the word both. 

2. Select the word both by double-clicking; then change it to 
italic. 

Edit Search Format Font Special Windows 

Doc ?: Untitled 

Dear Mr. Larkin: 

Thank you for your recent inquiry about our pet doors. We carry 

several different models and sizes suitable for both apartment and 

residential use. 

For large and medium dogs, we have three basic models: 

@2)T hank oyouofor Oyour Orecent oi Nquiryoaboutoour opet Odoors.o OWe Ocarry sat) 

several Odifferent Omodels Oand Osizes of uitable Ofor both OapartFoft-)ment oand see) 
residen[Soft-Jtial Ouse. (HRY) 

(8) For Slarge oando medi um dogs , Owed have othreed basic © models: [Set Font:Chicago 

Figure 1.8: The Codes window reveals the hidden format codes WordPerfect 
uses. 
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You’ll see two new codes in the Codes window: [Select] indicates 
that Select is on, and two [Ital] codes surround the word both. The 
first code turns on the effect, and the second turns it off. 

3. To turn off Select, press Command-. (period), or click any- The Cancel com- 

mand (Command-. : 
Ea ofS i a ee ) where in the document. 

also press Command-. to 
back out of dialog boxes 
without making any 

changes, as well as to 
cancel many processes, 

like printing. 

You'll see [Select] disappear from the Codes window. 

To delete the italic style, you can delete either of the codes. 

| 4. Since the insertion point (the black box) is to the right of the 
last code, just press Delete to delete the italic style. 

If you delete a code while you’re deleting text with the Codes 
window closed, you’ll get a message asking whether you want to 

delete that format. Click OK to delete it. Pressing Return (or 
clicking Cancel) leaves the code in place, although the characters 
disappear from your screen. 

: 
: 

5. Choose Show Codes again (or press Command-7) to close the 
Codes window. 

Saving Your Letter 

You’ve done quite a bit of work here, so save the letter before you 
continue. 

1. Choose Save from the File menu, or press Command-S. hr For more informa- 
tion about manipu- 

lating your files, see 
Chapter 7. 

To open a document 
Sem and start WordPer- 

| fect at the same time, just 
| double-click on the docu- 

' ment’s icon on the 

Desktop. 

Since you haven’t saved this document before, you’ll be asked to 
give it a name. Name it anything you like. You can use spaces 
between words and any symbols other than the colon (:). For 
example, you might want to name it Larkin letter, or describe it 
with today’s date. You can use up to 63 characters, including 
spaces, but only 20 can be displayed in most lists. 

2. Type a name for your letter and click Save (or press Return). 

. If you decide that you want to quit at this point, select Quit 
from the File menu (or press Command-Q). 

If you quit, you’ll need to open the letter you saved when you 
start WordPerfect again. Choose Open from the File menu, 

locate the name of the letter, and double-click on it to open it. The 
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= Just so you’ll know 
what’s going on on 

the ruler line, the heavier 

right- and left-pointing 
arrowheads are your right 
and left margin settings. 
The tab flags with pre- 
ceding periods are tabs 
with dot leaders. Other 
icons control hyphen- 
ation, the position of the 
page number, and so 
forth, but you don’t need 
them in these exercises. 
They’ re discussed in 
Chapter 3. 

letter will open in a window of its own. If you choose Retrieve 

instead of Open, the letter will appear in the window you’re 

working in. This is very useful for combining documents, but it’s 

not what you want in this case. 

Working with Tabs 

Up to now you’ve used WordPerfect’s default ruler settings, but 
it’s easy to change them. A normally hidden ruler line controls tab 
settings, margins, and justification. To see the ruler, choose Show 

Ruler from the Format menu (or press Command-R). You can work 
with the ruler displayed on the screen if you like. To remove it, 
choose Show Ruler again (or press Command-R again). It’s tempt- 
ing to use the close box to close the ruler window, but that closes your 
document instead. Just remember that Show Ruler is a toggle: it acts 

as either Show Ruler or Hide Ruler. 
Next, you’ll want to display the ruler line so that you can set tabs. 

Move to the end of the last line in the letter and press Return twice to 
add a line of space. Then: 

1. Choose Show Ruler from the Format menu (Command-R). 

A ruler like the one in Figure 1.9 appears. The ruler line always 
appears at the top of your screen, but it takes effect only after the 
insertion point. 

The various icons on the ruler line determine the types of tabs 
being used. The left-pointing flag is the default left-aligned tab, the 
right-pointing flag is for right-aligned tabs, and the two upward- 
pointing flags are center tabs. The flag with the dot under it centers 
text on the decimal point. 

The next text you’re going to type is a list of models and prices. 
You could use the default tab settings, but you’d have to press Tab 
repeatedly to move more than five spaces, and the decimal points in 
your numbers wouldn’t align. It’s simpler to delete the extra tab 
stops and set only the ones you need to use. 

2. Click on the left-aligned tab (the first tab icon). 

When a tab is selected, its box is outlined and the pointer turns 
into the icon of the tab. You can then use this new tab pointer to 
delete tab settings or enter new tab settings. 
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ar Chapter 3 has more 
details on setting the 

_ various kinds of tabs and 
centering text. 

" ¢€ File Edit Search Format Font Special Windows 

Doc 1: exercise letter 

Mr. Robert Larkin 

4411 Hillsdale Blvd. 

Indianapolis, IN 46250 

Dear Mr. Larkin: 

Thank you for your recent request about our pet doors. We carry 

several different models and sizes suitable for both apartment and 

residential use. 

For large and medium dogs, we have three basic models: 

Figure 1.9: The ruler controls tabs, margins, justification, and the hyphen- 
ation zone. 

3. Click on all the tab settings on the ruler below the midline 
from 1 to 5 to delete them. 

4, Then click on the decimal tab icon, the upward-pointing 
arrow with the period. Click on 3 and 5 on the ruler line to set 

decimal tabs at the 3-inch and 5-inch marks. 

Your ruler should look like the one in Figure 1.10. 

5. Type the table shown in Figure 1.10. Press Tab after typing 
each description. 

The insertion point will move to the decimal tab. The numbers 
you type will be aligned on the decimal point, and your text will 
be aligned at the left margin. 

6. To enter the headings above each column, as shown in Figure 
1.11, go back to the beginning of the blank line above the 
table. Press Return to add another blank line. Then press Tab 
and the space bar until the insertion point is centered over the 
first column, just to the left of the decimal point. 

Notice that because you’ re above the point where you set the dec- 
imal tabs on the special ruler line, the ruler line is again the 
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Indianapolis, IN 46250 

Dear Mr. Larkin: 

Thank you for your recent request about our pet doors. We carry 

several different models and sizes suitable for both apartment and 

residential use. 
For large and small dogs, we have three basic models: 

Large Small 

In-a-Door $89.90 $79.90 
Door Panel 115.00 99.95 
Breezeway 55.99 49.99 

Figure 1.10: Setting special tabs lets you quickly create a simple table like this 
one. 

" & File Edit Search Format Font Special Window 

Doc 1: fig 1.11 
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Mr. Robert Larkin 

4411 Hillsdale Blvd. 

Indianapolis, IN 46250 

Dear Mr. Larkin: 

Thank you for your recent request about our pet doors. We carry 
several different models and sizes suitable for both apartment and 
residential use. 

For large and small dogs, we have three basic models: 

In-a-Door $89.90 
Door Panel 

Breezeway 

Figure 1.11: Use the Center command to center headings over columns. 
‘ Ze 

default line. That’s fine for what you’re going to do next, which is 
to center text headings. To do this, you have to use the Center 
command instead of setting tabs. 
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7. Choose Line from the Format menu; then choose Center. 

You can also press Shift-Command-C for the keyboard shortcut. 

8. Type the word Large. 

Because you’ve used the Center command, your heading is cen- 
tered over the column. 

9. Press Tab; then press the space bar until the insertion point is 
centered over the second column. 

10. Choose Center again and type the word Small. Then press 
Return to add a blank line of space. 

Both headings are centered over the columns, as Figure 1.11 
shows. 

If you had used the Center command with the insertion point at 
the left margin, text would be centered on the page, between the right 

and left margins, as happened when you created the logo. 
Now, because you’re through with the table, you need to adjust 

the ruler line for regular indents. 

11. Move to the end of the table and press Return twice to add a 
blank line. Then click on the left-aligned tab icon (the first 
one) and the 1.5-inch mark to set a tab half an inch from the 
left margin. 

12. Choose Hide Ruler from the Format menu (or press 
Command-R) to hide the ruler. 

Moving Text 

Now you need some more text to work on to see what else Word- 
Perfect can do, so enter the last two paragraphs of the letter, as shown 

in Figure 1.12. Be sure to misspell received as recieved so that even if 
you’re an excellent typist, you’ll have at least one mistake to correct 

with the Speller. 

To italicize the word not as you type, click on the I (for Italic) on the 

status line, type not and then click on P (for Plain). 

Now that you’ve got some larger portions of text on the screen, 

you can experiment with how to copy, cut, and move sentences and 

paragraphs. WordPerfect lets you select sentences, paragraphs, 
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Large Small 

In-a-Door $89.90 $79.90 

Door Panel 115.00 99.95 

Breezeway 39:99 49.99 

The In-a-Door and Breezeway modeis are designed to be installed 

within an existing exterior door. The Door Panel model is used only with 

sliding glass doors. If you aren't installing your pet door in a sliding glass 

door, do 7@i order this model. 

We ship your order the same day it’s recieved, via ups unless you 

request otherwise. Please add $2.50 shipping and handling charges to each 

order over $19.95. 

Figure 1.12: Entering the last two paragraphs will give you practice in moving 
text and using the Speller. 

entire pages, or even the entire document with a couple of key- 
strokes. The advantage of selecting text this way instead of shift- 
clicking is that the correct format codes associated with the text are 
also selected, so you can move and copy a paragraph, for example, 
and it will stay formatted as a paragraph. 

To see how this works, you can move a paragraph in your letter. 

1. With the insertion point anywhere in the paragraph beginning 
with ‘“‘The In-a-Door”’, choose Select from the Edit menu; 

then choose option 3, Paragraph. You can also type 
Command-6 3 if you prefer to use the keyboard. 

The entire paragraph is highlighted, including its format codes— 
the tab indent at the beginning and the hard return that ends it, 
which you can see by opening the Codes window. You can now 
copy it, cut it, or move it by cutting and pasting. 

2. Press Command-X to cut the paragraph (or choose Cut from 
the Edit menu). 

The paragraph disappears from the screen, and the spacing is 
adjusted automatically. 
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bar Chapter 2 has more 
information about 

case conversion and insert- 
ing special characters. 

3. Move the insertion point to the end of the letter— after the 
period in $19.95. Then press Return. 

4. Press Command-V (or choose Paste from the Edit menu) to 
paste the paragraph in its new location. 

The paragraph appears just as it was earlier, but in the new loca- 
tion. It’s also still on the Clipboard and in the Undelete buffer, so 

you can undelete it or move the insertion point to any other place 
in the text and paste that paragraph again. 

Other Editing Commands 

Now that the letter is finished, you can add some final touches to it. 

Converting to Upper- and Lowercase 

First, move the insertion point to the word ups so that you can capi- 

talize it. 

1. Double-click on ups; then choose Case Convert from the Edit 
menu. 

2. Select To Upper. 

The letters UPS are converted to uppercase. This feature is especially 
handy if you’re changing headings to all capital letters. 

Inserting a Special Character 

Suppose ‘“‘In-a-Door”’ is a trademark. You can enter that special 
symbol easily. 

1. Position the insertion point after the r in In-a-Door. 

2. Choose Insert Literal from the Edit menu (or press Command-I). 

You’ll see a special Select Character dialog box, like the one in 
Figure 1.13. These are all the special characters associated with 

the Geneva font, which you’re using. Clicking on any character 
inserts that character into your text. If you don’t have a Control 
key on your keyboard, using Insert Literal lets you insert control 

characters. 
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Figure 1.13: You can insert special characters that aren’t represented on your 
keyboard by using the Insert Literal command. 

3. Click on the TM symbol (it’s at coordinates A,A). 

The trademark symbol appears in your text at the insertion 

point. 

Searching and Replacing 

You can replace a word or phrase with another very easily in Word- 
Perfect. You can even search and replace using format codes. This 
allows you to do some very sophisticated things with macros, but for 
now we’ll look at the simplest case: replacing one word with another. 

Suppose you suddenly realized that you had quoted prices in your 
letter for large and medium doors instead of large and small doors. 
You could locate all the places where small occurs in the letter and 
change it to medium: 

a On a numeric key- 
§ pad, the 7 and 5 setae : 

ive Wworll'as Eniter key 1. Move to the beginning of the document. Pressing Enter three 
ee times and then pressing t will take you there quickly. 

If you want to search through an entire document, you’ll want to 
move to its beginning. Otherwise, the search takes place only 
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from the insertion point to the end (if you’re doing a forward 
search). 

2. Choose Replace from the Search menu (or press Command- H). 

You'll see a dialog box like the one in Figure 1.14. 

3. Type small in the Search box; then press Tab. 

Pressing ‘Tab takes you to the next area of an open dialog box. 
Don’t press Return, or WordPerfect will think you want to delete 
all occurrences of the word small. 

4, In the Replace box, type medium. 

If you enter the replacement word in lowercase, WordPerfect 
matches the capitalization it finds in your document, so small in the 
text stays lowercase, and Small in the headings is capitalized. 

If you’ve done any other searches, you may have changed the 

search settings. In the Type box, make sure Partial Word Search is 
checked. That should be the only setting checked. Chapter 2 has 
more information about the other choices. 

&@ fe Edit Search Format Font Special Winadouss 

Doc 1: exercise letter stage 1 

Search: [small Bold » KY] 
: 

Replace: medium| 5 

Type 
L] Case Sensitive © Partial Word Search 

J With Confirm © Complete Word Search 

Dear Mr. Larkin: 

Thank you for your recent request about our pet doors. We carry 

several different models and sizes suitable for both apartment and 

residential use. 

For large and small dogs, we have three basic models: 

Figure 1,14: The Replace dialog box allows you to sees both what to search 
for and how to replace it. 
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5. Press Return (or click Find) to automatically replace medium 

with small wherever it occurs. 

The middle part of your document should now look like the one in 
Figure 1.15. Save it at this point before you go on. 

Recording a Macro 

Now that you’ ve finished with the body of the letter, you can add a 
standard closing to it. Instead of having to type Szncerely, press Return 

to add space, and type your name and title every time you close a let- 

ter, you can record a macro that will do it for you when you press 

three keys simultaneously. This can save you a lot of time when 
you’re working. 

First, move the cursor to the end of the letter, just after the last per- 

iod. Pressing Enter three times and then pressing ¥ takes you directly 
to the end of a document. 

You want this macro to work with all the letters you write, so you can 

set it up to automatically put the right amount of space above the close. 

1. Select Macro from the Special menu (or press Command- M). 

‘@ File Edit Search Format Font Special Windows 

Doc 1: exercise letter stage 1 

Thank you for your recent request about our pet doors. We carry 

several different models and sizes suitable for both apartment and 

residential use. 

For large and medium dogs, we have three basic models: 

Large Medium 

In-a-Door™ $89.90 $79.90 

Door Panel 115.00 99.95 

Breezeway 95.99 49.99 

We ship your order the same day it’s recieved, via UPS unless you 
request otherwise. Please add $2.50 shipping and handling charges to each 
order over $19.95. 

The In-a-Door and Breezeway models are designed to be installed 
within an existing exterior door. The Door Panel model is used on] 
TE ONO 

Figure 1.15: After you’ve successfully searched and replaced, your document 
should resemble this one. 
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2. Choose Define Macro. 

Command-Shift-M is the keyboard shortcut for defining a macro. 

You'll see the dialog box shown in Figure 1.16. Since you’ll use 

this macro often, assign it to a Command-Option combination 
instead of giving it a name. 

3. Click in the Single Key: Command-Option box and type c (for 
closing). Then click Save (or press Return). 

From now on everything you do will be recorded in the macro. 
You'll see the message ‘‘Macro Def’’ on the status line, telling 

you that you are defining a macro. If you make a mistake, don’t 

worry; just correct it and the macro will record the correction. If 

you want to turn off macro definition and start again, choose 
Define Macro again, or press Command-Shift-M. 

4, Press Return twice to add two blank lines. 

5. To make the signature block flush right, choose Line from the 
Format menu; then choose Flush Right (or press Command- 
Shift-F). Type Sincerely, . 

& File Edit Search Format Font Special Windows 

Doc 1: exercise letter stage 

order over $19.95. 
The |n=a= i installed 

d only with within an 
sliding glq [Sa macros | iho Sse sliding glass 

door, do 7 8 -Optian« Ky] home stuff 

{hive 

Cancel | 

iy paren 

Cy aipha cut 

Save Macro As: 

#-Option-C 

Single Key: s-Option- |C 

Figure 1.16: This dialog box allows you to name macros or assign them to a 
key combination. 
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cr You’ll find more 

about macros in 

Chapter 8. 

bar Chapter 4 discusses 

formatting pages in 
more detail. 

. Press Return three times to allow space for your signature. 

. Choose Flush Right again, type your name, and press Return. 

. Choose Flush Right again and type your title. 

. Choose Define Macro (or press Command-Shift-M) to turn off 

macro definition. 

OC ON DD 

Now, whenever you press Command-Option-C, your personal 

signature block will be created.‘Try it now. 

10. Delete the signature block you just created in the letter, includ- 
ing the spaces. Then press Command- Option-C. 

You’ ve taken the first step toward creating a library of macros that 

can automate many of your routine tasks. 

Centering the Page 

Now that you’ve finished the letter, you can center it on the page 
for a professional-looking print job. 

1. Move to the beginning of the letter, before any format codes. 

The code that centers the page has to come before any other 
codes. Pressing Enter three times and then pressing t moves the 
cursor directly there. 

2. Choose Page from the Format menu; then choose Page Layout. 

3. Click the Center Page Top to Bottom box; then click OK. 

Now, when you print your letter, it will be centered on the page. To 
see how it will look, you can preview it before you print. 

Previewing Your Letter 

WordPerfect’s Print Preview feature lets you see your document 
exactly as it will look when printed. To preview the letter: 

1. Choose Print Options from the File menu; then choose Print 
Preview. (Command-Shift-P is the shortcut.) 
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It’s always wise to 
Ml save a document 

just before you spell- 
check it, and it’s essential 

to save it afterward, 

because WordPerfect 

doesn’t save the spell- 
checked version with the 

, corrections until you tell 
| it to. 

You’ll see a screen like the one in Figure 1.17. The insertion point 
has changed to a magnifying glass. 

2. Click on any part of the letter to see its actual size. 
You can’t edit the letter, but you can examine it in this Print Pre- 
view window. 

3. Click again to see the reduced version of the letter. 

When you’re through previewing the letter, click on the close box. 

Spell-Checking Your Letter 

Before you print your letter, you can have WordPerfect spell-check 
it for any typos or spelling mistakes you may have made. Since 

you re probably just starting out with WordPerfect, your spelling dic- 
tionary won’t have any proper names like Hillsdale or Larkin in it, 
but you can add them to the dictionary as you go along. 

To spell-check your document, choose Spell from the Special 
menu; then choose Check Document (or press Command-Shift-W). 

& File Edit Search Format Font Special Windows 
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The Print Preview window lets you see exactly how your docu- 
ment will look when you print it. 
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ber Chapter 13 contains 
more information 

about the Speller, includ- 
ing how you can look up 
words and create custom 

dictionaries. 

If you’ re not using a hard disk, you’ ll need to insert the Speller disk in 

the external drive. If you haven’t told WordPerfect where you’re 

keeping the Speller’s dictionaries (as described in Chapter 7), you 

may be asked to click on the folder that holds the dictionaries. 
You’ll see a special Speller window at the bottom of your screen. 

The Speller will stop at any word that isn’t in its dictionaries and give 
you the message ‘‘Word not found.”’ If it can suggest a word or sev- 

eral words to correct a typographical error you may have made, 

you'll see a list of alternatives under Typo Suggestions. It may also 
present a list of phonetic alternatives—words that sound like the pat- 
tern you typed. If one of its suggestions is the word you want, just 
double-click on it to insert it in your document. (You can also click on 
the word and then click Replace, but that takes a little longer. ) 

If you don’t see the word you want, just type the correct word or 

edit the word in the Word: box. When it’s right, press Return to put 

it in the document. Once you’ve replaced a word with its correct 
spelling, the Speller uses that spelling to correct any other errors that 
have the same pattern in your document. For example, if you habitu- 
ally type htat instead of that, once you correct Atat, WordPerfect will 

remember the pattern and correct all the other Aéats in the document. 

Click Skip to skip the word and continue spell-checking the docu- 
ment. If the word appears again in the document, the Speller will 
query you on it. You can also use Command key shortcuts in the 
Speller, or in any of the other dialog boxes in the program. Pressing 
the Command key and then the first letter of the command chooses 

the command. Here, pressing Command-S chooses Skip. 
Click Ignore (or press Command-J) to tell the Speller to ignore the 

word both now and whenever it occurs again in the document. 

Click Add (or press Command-A) to add the word to your user 
dictionary so that you won’t be queried on it again. 

The words the Speller will query you on in this letter depend on 
what’s been added to its dictionaries. If you or someone else has used 
the Speller before, some proper nouns may have already been added 
to the user dictionary. That’s why you deliberately typed recieved 
incorrectly—so that there would be one error the Speller would 
definitely catch, as illustrated in Figure 1.18. 

Here the Speller is offering received (the correct spelling) and relieved as 
suggested alternatives. Double-click on received to put it in your letter. 



For more on print- 
ing, see Chapter 6. 
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Doc 2: exercise letter stage 1 
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We ship your order the same day it's [fgetrn), via UPS unless you 
request otherwise. Please add $2.50 shipping and handling charges to each 
order over $19.95. 

Pg1 Ln 24 Select On 

Typo Suggestions: 
received relieved 

Phonetic Suggestions: 
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Phonetic] (skip Once] (Ignore }{ Add |{ Exit | 

Figure 1.18: When the Speller locates a pattern that’s not in its dictionaries, it 
presents as many suggested alternatives as it can find. 

When the Speller finishes checking a document, it gives you a 
word count. Click on Exit to quit the Speller. Then save your cor- 
rected document. 

Printing the Document 

To print your document, make sure you’ve used the Chooser on 

the Apple menu to select the printer you want to use. Then select 
Print from the File menu. You’ll see a Print dialog box containing the 
selections that are possible with the printer you’re using. Click All if 
it’s not already selected; then press Return to begin printing. The 
finished letter, printed on a LaserWriter, is shown in Figure 1.19. 

Looking Forward 

You’ve now not only mastered the basics of using WordPerfect to 
enter, edit, and format text, record simple macros, use the Speller, 
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Noah's @rk 

4550 West Calgary 

San Diego, CA 92126 

January 21, 1988 

Mr. Robert Larkin 

4411 Hillsdale Blvd. 

Indianapolis, IN 46250 

Dear Mr. Larkin: 

Thank you for your recent request about our pet doors. We carry 

several different models and sizes suitable for both apartment and 

residential use. 

For large and medium dogs, we have three basic models: 

Large Medium 

In-a-Door™ $89.90 $79.90 

Door Panel 115.00 99.95 

Breezeway 55.99 49.99 

We ship your order the same day it's recieved, via UPS unless you 

request otherwise. Please add $2.50 shipping and handling charges to each 

order over $19.95. 

The In-a-Door and Breezeway models are designed to be installed 

within an existing exterior door. The Door Panel model is used only with 

sliding glass doors. If you aren't installing your pet door in a sliding glass 

door, do not order this model. 

Sincerely, 

Your Name 

Your Title 

Figure 1.19: Your printed letter will resemble this one, which was printed on a 
LaserWriter. 

and preview and print a document, but you’ve also learned a few 
tricks that can increase your efficiency. With what you already know 
you’re ready to create documents on your own. 

To find out more about keyboard shortcuts and editing tech- 
niques, go on to Chapter 2. If you’re mainly interested in formatting, 
Chapter 3 is the place to start. 
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Fast Track 

To assign a keyboard shortcut 46 

to a feature that doesn’t have one, choose WP Help from the 

Apple menu (or press Command-?). 

To move one character at a time, 47 

press the > and < keys. 

To move one word right or left, 50 

press Command-< (Word Left) or Command-~> (Word 
Right). } 

To move to the beginning of the line, 50 

press the Enter key and then the < key. To move to the end of 

the line, press Enter and then the > key. (If the end of the line is 

beyond the edge of the window, you have to press Enter twice.) 

To go to the beginning or end of a document, 51 
press Enter Enter t or Enter Enter J. 

To move forward or backward by screens, 52 

press the + or — keys on the numeric keypad. 

To move to top or bottom of the screen, 52 
press Enter t or Enter J. 

To move to the previous or next page, 52 
press the 9 (Page Up) or the 3 (Page Down) on the numeric 
keypad. 



To move to the top of the page 

you’re on, press Command-G (Goto) and then press the * key. 

To move to the bottom of the page, use Goto-V. 

To go to a specific page, 

use the Goto command (Command-G). 

To turn on Select, 

press Command-Shift-N. To turn off Select, press Command- 

., choose Select Off, type Command-Shift-N again, or click 

anywhere in the document that’s not highlighted. 

To delete the character to the left of the insertion point, 

press Delete. 

To delete the character to the right of the insertion point, 
press the . (decimal point) on the numeric keypad. 

To delete the word the insertion point is on, 

press Command-Delete. 

To search forward, 

choose Forward from the Search menu (or press Command-F). 

To replace text or codes 
with other text or codes, choose Replace from the Search menu 

(or press Command-H). 

To use redlining and strikeout, 
choose Style from the Font menu (or press Command-Y). 

52 

oe 

54 

56 

56 

56 

62 

65 

75 



CHAPTER O 

ber If you’re an experi- 
enced word pro- 

cessor, you may be able 
to skip the exercises in 
this chapter and find out 
all you need by reading 
the text, the tables, and 

the tips. 

THIS CHAPTER EXPANDS ON THE BASIC SKILLS YOU 
learned in Chapter 1. You’ll find all the basic text editing techniques 
repeated here as well as many more keyboard shortcuts and 

advanced skills. 
Take a moment now to create an actual WordPerfect document so 

that you can get some practice using these techniques. Open a new 
window and type these two paragraphs: 

On the Macintosh, WordPerfect has the user interface that 

you’re already accustomed to, so there are no basic commands 

to relearn, just techniques for using some of its sophisticated 

features. And because the documents you create can be 
converted to and from IBM format, you can transfer them back 

and forth between different types of computers. 

You'll soon discover that WordPerfect has almost every feature 

you can think of, from merge-printing to indexing to 

spell-checking. Since the program is practically a desktop 
publishing program, you'll be able to do everything you want a 
word processor to do and more. 

Save the document as sample document. 

Keyboard Shortcuts 
In the tutorial in Chapter 1, you became aware that most com- 

mands in WordPerfect have keyboard shortcuts as well as menu 
options. For example, you can cut text either by selecting Cut from 
the Edit menu or by pressing Command-X. With your practice doc- 
ument on the screen, try using a few of these keyboard shortcuts: 

1. Double-click on the word Macintosh to select it. 

2. Press Command-X (Cut) to cut it. 



har These Command- 

Shift shortcuts are 

located on submenus, not 

on the main menu. 
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3. Press Command-V (Paste) to paste it back. 

Other commands use Command-Shift combinations as keyboard 
shortcuts, so that when you press the Command key, the Shift key, 
and another key, the function takes place. For example, you can turn 
Select on by pressing Command-Shift-N. 
Commands that have keyboard shortcuts will be mentioned 

throughout the book to keep you aware of them. If you prefer to use 
the mouse, you can select from menus, of course. Table 2.1 briefly 
summarizes the Command- and Command-Shift key combinations 
that are built into the program as keyboard shortcuts. 

Table 2.1: Keyboard Shortcuts for Commands 

Letter Key 

Select all 

Backward search 

Copy 

Date 

Spell 

Forward search 

Goto 

A 

B 

Cc 

D 

E 

F 

G 

H Replace 

Insert literal — 

Mark text 

Close window 

List files 

Macros 

New document 

Open 

Print 

Quit NOPD Ue IO) Ae Et pete 

With Command-Key With Commana-Shift 

Bold 

Center 

Date function 

End of merge record 

Flush right 

Generate (lists, etc.) 

Headers 

Italics 

Display justification 

Columns on 

Left/right indent 

Define macro 

Select on/off 

Outline (style) 

Print preview 

Stop merge 
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Table 2.1: Keyboard Shortcuts for Commands (continued) 

Letter Key With Command-Key With Command-Shift 

Show ruler End of merge field 

Save Shadow 

Thesaurus Indent 

Undelete x Underline 

Paste Overstrike 

Windows Check document (Speller) 

Cut Execute macro 

Style Outline on/off 

R 

S 

a 

U 

W 

WwW 

xX 

YG 

Z Undo Full window 

In addition to these shortcuts, pressing the Command key plus the 
first letter of any button in a dialog box selects that option. For 
example, you can press Command-O instead of selecting OK. You 
can press Return to select any button that has a double outline. 

If there’s a program feature you use frequently that doesn’t have a 
keyboard shortcut, you can assign it an Enter key sequence, as 
described in Appendix C. 

—______..._ Using the Mouse 

In some situations, it’s faster and more convenient to use the 

mouse than a keyboard shortcut. Table 2.2 lists some alternate ways 
you can carry out operations by using the mouse. 

Table 2.2: Convenient Mouse Functions 

Function Mouse Action 

To select An ihsertion point Point and click 

A character Drag over it 
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Table 2.2: Convenient Mouse Functions (continued) 

Function Mouse Action 

To select A word double-click on it 

Several words Drag over them 

A line Click in margin; then shift-click at 

end of line 

Drag over it or use the shift-click 

method 

A paragraph 

A text box Double-click inside it 

To change To plain Click on P in status line 

or add 

styles To bold Click on B in status line 

To underline Click on U in status line 

Click on I in status line To italic 

Click on O in status line To outline 

To shadow Click on S in status line 

Click in page number area of status 

line 

To a specific page 

Forward or backward Click in grey area of scroll bar or 

through the document _drag in scroll bar (for longer 

distances) 

Forward or backward Click the up or down scroll arrow 

through the docu- 

ment, line by line 

Moving Through Your Documents 

The most basic skills to master are those that help you move 
around your documents quickly. With your sample document, you 

can practice a few of these. 

1. Press the > key to move the insertion point to the right. 

On the numeric keypad, the 6 also acts as a > key. 
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Many of these 
keyboard shortcuts 

require you to have a 
numeric keypad. 

— 

I-| Instead of pressing 
mf Command-G (for 

Goto), move the pointer 
to the bottom-left corner 
of the window. When the 
word “‘GO”’ appears, 
click the mouse. You’ll 
get the Goto dialog box. 

2. Press the < key to move the insertion point to the left. 

On the numeric keypad, the 4 acts as a < key. 

3. Press the ) key to move down line by line. Then move back to 

where you were by using the f key. 

The 8 on the keypad acts as a t key, and the 2 acts as a ¥ key. 

4, Press the Esc key; then press the > key. 

The insertion point moves eight spaces to the right. Pressing Esc 
tells WordPerfect to repeat a command the number of times 
shown in the dialog box. The program is preset for eight times, 
but you can change the number by just typing a new one. 

5. To move down two lines, press Esc, type 2, and press the key. 

In addition to these basic ways of moving through documents, 
WordPerfect has quite a few keyboard shortcuts you can use to get to 
places in your documents quickly. They’re summarized in Table 2.3 

and discussed in the following sections. 

Moving Short Distances 

There are several keyboard shortcuts for moving the insertion 

point short distances. Of course, you can always click with the mouse 

to move the insertion point, but these keyboard shortcuts let you keep 
your hands on the keyboard. 

Moving to a Specific Character 

The > and < keys move the insertion point one character at a 
time. On the numeric keypad, the 4 is also a <, and the 6 isa >. 

As you saw in the tutorial in Chapter 1, if you type a character 
instead of a page number in the Goto dialog box, the insertion point 
moves directly to the next occurrence of that character. 

‘Try this in your sample document: 

1. With the insertion point to the right of the word Macintosh, 
choose Goto from the Search menu. 

2. Type u. 

The insertion point moves directly to the u in user. 
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Table 2.3: Moving the Insertion Point with the Keyboard 

Key Command Action 

Moves right or left one character 

Command-~>, Moves right or left one word 

Command-<— 

Enter-< or -Home Moves to the beginning of the line 

Enter-> or -End Moves to the end of the line 

ty Moves up or down one line 

Enter-t Moves to the beginning of the first line at the top 

of the screen 

Enter-+ Moves to the beginning of the last line at the 

bottom of the screen 

Page Down Moves to the beginning of the next page 

Moves to the beginning of the previous page Page Up 

+ (on keypad) Moves one screen forward 

— (on keypad) Moves one screen backward 

Goto t Moves to top of page 

Goto 4 Moves to bottom of page 

Goto >, <— Moves from column to column 

Goto page number Moves to that page 

Moves to that character Goto character 

Enter Enter ft Moves to the top of the document 

Moves to the end of the document Enter Enter 4 

Moves to the beginning (end) of the line before 

(after) any codes 
Enter Enter Enter < (~) 

Enter Enter Enter f (4) Moves to the beginning (end) of the document 

before (after) any codes 
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3. To return to where you were, choose Goto again. This time, 

click Previous. 

The insertion point moves back to the previous position. 

Moving One Word Right or Left 

Pressing Command-< (Word Left) and Command-~ (Word 
Right) moves the insertion point one word to the right or left. If the 

insertion point isn’t at the beginning of the word when you press 

Command-<, it first moves to the beginning of the word. After that, 
when you press Command-«, the insertion point moves one word to 

the left. 
Try this in your sample document: 

1. With the insertion point still at the end of the word Macintosh 
in your sample document, press Command-> 

The insertion point moves to the beginning of the next word, 

WordPerfect, skipping over the punctuation. 

2. Press Command-< to move back to the beginning of the word 
Macintosh. 

The Command-~> and Command-< shortcuts always move to 
the beginning of a word. You can also move several words to the 
right or left at a time. 

3. To move five words to the right, press Esc, type 5, and press 
Command-> 

4. To move two words to the left, press Esc, type 2, and press 
Command-< 

Moving to the Beginning or End of a Line 

Pressing the Enter key and then pressing the < key moves the 
insertion point to the left edge of text in the window. Pressing Enter 
and then the > key moves it to the right edge of text in the window. If 
your lines extend beyond the window, press Enter twice before you 
press the arrow key. 

‘Try this in your sample document: 

1. With the insertion point anywhere in a line, press Enter; then 
press the < key. 



On a numeric key- 
MS pad, the 1 key acts 

as an End key, so pressing 
Enter and then pressing 1 
also takes you to the end 
of the line. 

On a numeric key- 
m™ pad, you can use the 

7 key (Home) or the 5 
key instead of Enter. If 
you’ve used WordPerfect 
on other computers, this 
sequence may be easier 
for your fingers to 
remember. 
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The insertion point moves to the beginning of the line. 

2. Press Enter; then press the > key to move to the end of the 
line. 

Pressing Enter three times and then pressing the < key moves the 
insertion point to the beginning of a line, before any codes. Pressing 
Enter three times and pressing the > key moves the insertion point to 
the end of a line, after any codes. 

Moving to the Beginning or End of a Document 

Pressing Enter twice and then pressing the f key takes you to the 

beginning of the document. Pressing Enter twice and then pressing 
the ¥ key takes you to the end. 

Try this in your sample document: 

1. Move the insertion point to the last line in the document by 
clicking with the mouse. 

2. Press Enter twice; then press the f key. 

The insertion point moves to the beginning of the document, just 
before the O in On. 

3. Press Enter twice; then press the ¥ key. 

The insertion point moves to the end of the document. 

Pressing Enter three times and then pressing the t key moves the 

insertion point to the beginning of the document, before any codes. 
Pressing Enter three times and then pressing the 4 key moves the 

insertion point to the end of the document, after any codes. 

Long-Distance Moving 

In addition to the short-distance shortcuts, there are quite a few 

ways you can move through longer documents without using the 
mouse. They’re listed in Table 2.3 and described briefly here. After 

you’ve become accustomed to WordPerfect and have created some 

longer documents, you can refer to this table and practice long- 

distance moving. 
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agi For a quick way to 
edit a sentence and 

then return to your origi- 
nal position, press Page 
Up (9 on the keypad) or 

Page Down (3 on the 
keypad); then use the 
arrow keys to move to the 
sentence you want to 
change. After you’ve 
finished editing it, choose 
Previous from the Goto 
dialog box. You’ll be 
returned to your original 

position, because Word- 
Perfect remembers where 
you are when you press 
Page Up, Page Down, 
Screen Up and 
Down (+ and —- on the 
keypad), Search 
(Command-F and 
Command-B) and 
Replace (Command-H), 
or any of the Enter key 
movement commands. It 
doesn’t remember your 
location when you use the 
arrow keys by them- 
selves, Command-< 

(Word Left), or 
Command-> (Word 
Right). 

Moving by Screens 

Pressing Enter and then the t key takes you to the first line at the top 

of the screen. Pressing Enter and then the ¥ key takes you to the last line 

at the bottom of the screen. 
Try this in your sample document: 

1. With the insertion point on the word discover in the second 

paragraph, press Enter; then press the ft key. 

2. To move to the last line on the screen, press Enter; then press 
the ) key. 

Moving by Pages 

On a numeric keypad, the 9 is the Page Up key and the 3 is the Page 
Down key. Pressing Page Up takes you to the beginning of the previous 
page; pressing Page Down takes you to the beginning of the next page. 

To move to the top of the page you’re on, press Command-G 
(Goto) and then press the t key. To move to the bottom of the page, 

use Goto, then ¥. 

Moving to a Specific Page 

In a document that’s several pages long, the fastest way to go to a 

specific page is to use the Goto command (Command-G). You’ll see 
a dialog box like the one in Figure 2.1. Enter the page number you 
want to go to and press Return. Clicking Previous takes you to the 
last place you moved the insertion point. 

Moving without Moving the Insertion Point 

You can also use the scroll bar to move through a document with- 
out moving the insertion point. Drag the square box in the vertical 

scroll bar and then release the mouse. You’ll see the Pg indicator on 
the status line change so that you know what page you’re looking at. 

Clicking in the gray area of the scroll bar also moves you through 
the document quickly without moving the insertion point. 

Clicking on one of the arrows in the scroll bar scrolls the document 
one line at a time. You can press the mouse button and hold it down 
to repeatedly scroll one line at a time. 
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If you’ ve lost the 

insertion point in a 
long document, press 
Command-G (Goto) and 
click Previous. If that 
doesn’t take you back to 
where you were, just 
press Return. 

@ Fe Ed Search Fort pecial Winadwouss 

Figure 2.1: The Goto command will take you directly to a specific page. 

Selecting Text 
Selecting is a task you do all the time, so as you may imagine, there 

are also many shortcuts for selecting text in WordPerfect. They’re 
summarized in Table 2.4 and described in the following sections. 

Practicing some of these techniques in your sample document will 
help you get familiar with them. 

Table 2.4: Shortcuts for Selecting Text 

Command Action 

With select off | Double-click Selects the word the insertion point 

is in. 

Turns on Select but does not 

anchor it. To make a selection, hold 

down Shift and click with the 

mouse at the endpoint of your 

Shift-click 

selection. 
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Table 2.4: Shortcuts for Selecting Text (continued) 

Command Action 

Shift-<-, Shift-> Turns on Select and selects the 

character next to the insertion 

point. You can extend the selection 

by keeping the Shift key down and 

using the arrow keys. 

Shift-t, Shift-4 Turns on Select and selects by lines. 
You can extend the selection by 

keeping the Shift key down and 

using the arrow keys. 

Command-Shift-N Turns on Select and anchors the 

insertion point. Select On is high- 

lighted on the status line. You can 

extend the selection by using the 

arrow keys or the Command-<— 

and -~> keys to select one word at a 

time. The f and 4 keys extend the 
selection by lines. Command-Shift- 

N or Command-. turns off Select. 

With Select on —_ Enter-<— Selects to the beginning of the line 

(but not before codes). 

Enter-> Selects to the end of the line (but 

not after codes). 

Selects to the insertion point’s same 

position in the next line. 

Selects to the insertion point’s same 

position in the previous line. 

Select Command-6 2 Selects the sentence the insertion 

submenu point is in. 
sequences 

Command-6 3 Selects the paragraph the insertion 

point is in. 

Command-6 4 Selects the page the insertion point 

‘ is in. 

Command-6 5 Selects the column the insertion 

point is in. 

Command-Shift-A Selects the engine document. 



er To WordPerfect, a 

i sentence is any text 

_ that ends in a period, 
question mark, or excla- 
mation point. A para- 
graph is text that ends 
with a hard return, anda 

page is text that ends with 
a soft or hard page break. 
A column is the text 

| that’s been defined with 
+ the Columns feature, not 

text that you’ve set in 

columns by using tabs. 

tr 4 

| If you’re carrying 
28 out more than one 

' Operation on the same 

| block of text, use the 

| Geto command to rese- 

- lect it efficiently. Click 
) Previous in the Goto 

dialog box to reselect the 
text that was just selected. 

i © If you’re used to 
\ WordPerfect on the 
| IBM, you know that 
} when you’ve selected a 
| block and press a letter 
| key, the cursor moves to. 
| that letter. In WordPer- 
! fect on the Macintosh, 

) pressing a letter key when 
| you’ve selected a block of 
| text deletes the selected 
| text and replaces it with 
) the letter, Use Undo 
| (Cemmand-Z) to get the 
) text back. 
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In addition to allowing you to select text with the mouse by double- 
clicking, dragging, or shift-clicking, the program has several com- 
mands that automatically select certain text elements for you, 
including their format codes. If you choose Select from the Edit 
menu, you'll see that you can then choose a sentence, paragraph, 
page, column, or all of your document to be selected. 

To see how this works with your sample document, put the inser- 

tion point next to the O in On. If you’ve been following the exercises, 
it should be there already. Then: 

1. Choose Select from the Edit menu. 

2. Choose Sentence. 

The entire sentence, including the spaces following it, is selected. 

3. Choose Select again; then choose Paragraph. 

The highlighting extends to the entire paragraph. 

4, This time, press Command-Shift-A. 

The entire document is selected. Pressing Command-Shift-A is a 

keyboard shortcut for selecting Select and then choosing All. 

5. Press Command-. (Cancel) to turn off Select. 

To select large sections of text line by line quickly, press the mouse 

button and drag. You can also press the Shift key and hold it down 

while holding down the ¥ or t key. Your document will scroll from the 
insertion point, selecting text line by line. You can also shift-click and 

use the scroll bar to select large blocks of text. When you’ve high- 
lighted a selection, you can delete it, cut it, copy it, or perform other 

functions on it, like saving it or spell-checking it. 

There’s also a special Select On command on this menu that works 

a little differently from selecting with the mouse. When you turn on 

Select with this command (or by pressing Command-Shift-N, its key- 

board shortcut), the words Select On are highlighted on the status 

line, and you can then extend the selection by using any of the arrow 

keys and cursor-movement key sequences. This method is handy 

when you’re writing macros, because it lets you rapidly extend a 

selection to include format codes as well as text. You’ll use it in 

Chapter 8. 
Once you’ve selected text, you can simply begin typing to replace it. 

You can also carry out most other operations on it, like formatting it, 
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If you come across a 

hidden format code 
while deleting, you’ll get 
a dialog box asking 
whether you want to 

delete the code. Click OK 
to delete it, or press 
Return to skip over it. 

When WordPerfect 
deletes a word, it 

doesn’t delete symbols. If 
you delete a hyphenated 
word like spell-checking, 
you'll have to delete both 
parts as separate words. 
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copying it, printing it, saving it as a separate document, replacing it with 

the contents of the Clipboard, appending it to the Clipboard, spell- 

checking it, and so forth. 
To turn off Select, press Command-., choose Select Off, type 

Command-Shift-N again (if that’s how you turned on Select), or 

click anywhere in the document that’s not highlighted. 

Deleting Text 

There are also many keyboard shortcuts for deleting text. They’re 
summarized in Table 2.5. 

To get familiar with these techniques, you can practice some of 
them in your sample document. 

Deleting by Characters 

Pressing Delete or Backspace deletes the character to the left of the 
insertion point. The period on the numeric keypad deletes the char- 
acter to the right of the insertion point. 

Ley: ih: 

1. With the insertion point on the m in merge, press Delete. 

The m disappears. 

2. Press the period on the numeric keypad. 

The e disappears. 

3. Press Esc, type 3, and press the period on the keypad. 

Three characters—the rge—disappear. You can repeat deletion 
commands by using the Esc key. 

4. Choose Undo from the Edit menu (or press Command-Z) to 
get the word back. 

Deleting by Words 

Command- Delete deieics the word the insertion point is on. If it 
isn’t on a word, it deletes the word to the right. Enter-Delete does the 
same thing. 

. 

2 
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Table 2.5: Shortcuts for Deleting Text 

Command Action 

Delete (or Backspace) Deletes the character to the left of the insertion 

point 

Deletes the character to the right of the insertion 

point 

.(on numeric keypad) 

Command-Delete Deletes the word the insertion point is in, or, if it 

isn’t in a word, deletes the word to the right of 

the insertion point 

Deletes from the insertion point’s position to the 

end of the line 

Command-End 

Shift-<- Command-<- Deletes the word to the left of the insertion 

Delete point* 

Deletes from the insertion point’s position to the 

end of the page 

Command-PgDn Return 

Command-6 2 Delete Deletes the sentence the insertion point is in 

Command-6 3 Delete Deletes the paragraph the insertion point is in 

Command-6 4 Delete Deletes the page the insertion point is in 

Command-6 5 Delete Deletes the column the insertion point is in 

(when Columns are on) 

Deletes the entire document Command-Shift-A Delete 

* Ifthe insertion point is in the middle of a word, it first moves to the begin- 

ning of the word when you press Command-<. You'll need to press 

Command-< again to highlight the next word to the left. 

Try it in your document: 

1. With the insertion point on the word printing, press 
Command-Delete. 

The word printing disappears. 

2. Press Command-Delete again. 

WordPerfect deletes the word to the right of the insertion point, 
in this case the word ¢o. 
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Comments (Pare 
Down) on the 
numeric keypad deletes 
everything to the end of 
the page. You'll also need 

to click OK in the dialog 
box that appears, so it 
isn’t strictly a keyboard 
shortcut. 

You can use the 

period key on the 
numeric keypad to delete 
selected text. In this case, 

it works just like the 
Delete key. 

har If there’s not 
enough room in 

memory or on disk to 
accommodate the latest 
deletion, you may get a 

message asking you 
whether you want to 
delete the text without 
having a backup that can 
be restored with Unde- 
lete. 
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Deleting to the End of the Line 

Command-End (1 on the numeric keypad) deletes from the inser- 
tion point’s position to the end of the line. Try it and see: 

1. Press Command-End. 

The rest of the line is deleted, and text from the next line moves up. 

Deleting Selections 

You can use the options on the Select submenu to quickly delete 

the current sentence, paragraph, page, column (when Columns are 

on), or even the whole document. The keyboard shortcuts are listed 
in Table 2.5. 

For practice, delete some text from your sample document. 

Remember, you can either choose from the Edit menu with the 
mouse or use keyboard shortcuts. 

1. With the insertion point anywhere in the document, choose 
Select, then All (or press Shift-Command-A). Then press 
Delete. 

The entire document is highlighted; when you press Delete, it’s 
deleted. 

Now you’ve got nothing left. But, as you saw in the tutorial in 
Chapter 1, you have several ways of getting it back. 

Undeleting Deleted Text 

You can’t use Command-V (Paste) to get back what you deleted 
with any Delete key combination. To restore what you’ve just 
deleted, use Command-Z to Undo your last action or Command-U 
to Undelete. Under most circumstances, Command-U will bring it 
back. The program stores the last three deletions, erasing the oldest 
deletion each time you make a new one. 
When you press Command-U to retrieve text you’ve deleted, you’ll 

see a dialog box like the one in Figure 2.2. Clicking Restore restores the 
highlighted text, which is the last item you deleted. Clicking Previous 
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pa 

“ You could as easily 
just paste the cut 

text, which is on the 

Clipboard, but the Clip- 
board holds only the last 
deletion. Use the Unde- 
lete command when you 
want to restore any of the 
last three deletions or 
cuts. 

displays the next to the last item you deleted, and clicking Next cycles 

you forward through the three deletions. 

Try it with your deleted document: 

1. Press Command U (or choose Undelete from the Edit menu). 

You'll see the last text you deleted. Clicking Previous displays 
text you deleted earlier. 

2. Click Restore to restore your sample document. 

e tie Edit Search Format Fort ‘Special 

Doc 1: Untitled 

Doc 2: Speller ch 

WordPerfect's Speller and Thesaurus can be of 

iPindows 

great help to you as you write. The Speller especially 

is a joy to use, because it's so fast and almost always 

suggests the right word, which you can then click to 

select. I never bother to a ee as I type in WordPer- 

fect because I know that the Speer will do it faster 

and more accurately than I can. I can't say that about 

any other word processor's spell checker, including 

WordPerfect's IBM version. 

While the Speller can correct your document, the 

Undelete: { Restore Previous } Next } (cancer | 

Figure 2.2: WordPerfect keeps track of the last three deletions. 

Converting Characters 
to Upper- or Lowercase 

In addition to moving the cursor, selecting text, and deleting text, 
WordPerfect also has other shortcuts for carrying out tasks you per- 
form often as you edit documents. For example, you can change 

uppercase characters to lowercase characters and vice versa. 

The Case Convert command on the Edit menu changes text you’ve 

selected to uppercase or lowercase characters. For example, in your 

sample document, change the word WordPerfect to WORDPERFECT: 
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bar There’s a macro in 
Chapter 8 that will 

show you how to keep the 
first letter of a word capi- 
talized when you convert 
the word to lowercase. 

= Sometimes what 
you see on the 

editing screen can be 
misleading because it 
doesn’t accurately reflect 
the true position of the 
insertion point in relation 
to the codes. A general 
rule to follow is this: 
Believe what you see in 

the Codes window, not 

what you see on the main 
screen. 
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1. Select WordPerfect by double-clicking on it. 

2. Choose Case Convert from the Edit menu; then click To Upper. 

WordPerfect becomes WORDPERFECT. 

3. To change it back, choose Case Convert; then choose To Lower. 

WORDPERFECT becomes wordperfect. 

4, Click outside the selected text to turn off Select. 

If you’re converting a sentence whose first word is capitalized, 
WordPerfect will keep the first letter in the sentence capitalized if you 
include the punctuation from the end of the previous sentence in the 

selection. 

Working with the Codes Window 
One other technique that’s basic to editing in WordPerfect is work- 

ing with the Codes window open, as shown in Figure 2.3. It’s often 
important to view the hidden formatting codes WordPerfect uses, 
especially if something seems to be going wrong in your document 
and you can’t figure out what the trouble is. Nine times out of ten, 
it’s either a format code that’s in the wrong location or an incorrect 
format code. 

As you saw in the tutorial in Chapter 1, when you choose Show 
Codes from the Edit menu (or press Command-7, which is a toggle 
that opens and closes the Codes window), the program displays the 
normally hidden format codes it’s using to format your text. It takes a 
little practice to get used to moving the insertion point in the upper 
window while tracking it accurately in the lower window, but you’ll 

find that as you use the mouse and cursor-movement keys, the inser- 
tion point (represented by a gray box in the Codes window) moves 
around and among the codes. It’s tempting to try to change codes 
directly in the Codes window, but you can’t. You have to make your 
changes in the document itself. 

While you have the Codes window open, you can use any of the 
program commands, keyboard shortcuts, and cursor-movement key 
sequences. In short, you can work just as you normally do. You’ll get 
some practice in working with format codes in the exercises in 
Chapter 3. 
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@ File Edit Search Format Font Special Windows 

Doc 1: Untitled 
Sometimes what you see on the screen can be misleading because it 
doesn't accurately reflect the true position of the cursor in 
relation to the codes. 

Watch out for Center codes 

H A general rule to follow is: believe what you see in the Codes 
q¥ window, not what you see on the main screen. It may look like the 
insertion point is exactly next to a word when in reality there 
may be several hidden codes between the insertion point and the 
word, as the figure illustrates. 

relationoto othe ocodes. (#R3) 

[Center>f[/z2 Bold Watch out for oCenter ocodes Center 

i Adgeneral Orule Oto Ofollow Ois: believe Owhat you Osee Oin Othe OCodes (SRY) 

window , Onot Owhat Oyoudsee on othe Omaindscreen. Olt OmaySlook like othe (Ski) 

Figure 2.3: WordPerfect’s Codes window reveals the normally hidden format 
codes the program is using. 

—_____._ Searching and Replacing Text 
Not only can you search for and replace characters, words, or 

phrases in WordPerfect, but you can also search for and replace for- 
matting codes and style changes. And because searches can be made 
part of macros, you can set up macros that will repeat until some- 
thing can’t be found any more—which lets you set up conditional 
macros that work like logical programs, as you’ll see in Chapter 8. 

What kinds of things can you do by searching and replacing? Here 

are a few: 

e You can search your document for an error and correct it 
wherever it has occurred. For example, if someone’s address 
has changed, you can correct it wherever it is in your 

document. 

e You can speed up typing complicated words and phrases by 
substituting a symbol for them as you type and then later 

replacing that symbol with the word or phrase. For example, 

you can use a symbol such as @ to stand for up to 59 charac- 

ters and spaces. As long as you typed it correctly the first 
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time, you’il be sure there are no typographical errors in the 

final result, no matter how many times the word or phrase 

appears in your document. 

e Ifyou send out form letters only occasionally, you can abbre- 

viate the recipient’s name and address or specific phrases 

wherever they occur and then simply replace them rather 

than having to set up a mail-merge system. 

e You can search for a heading or a particular word in a section 
of text you want to work on. Using the Search feature this 
way lets you go directly to a certain area of the document 
without having to scroll or guess at the page number of the 
section you want. 

e You can search for format codes and change them to other 
codes, thus effectively reformatting your document with only 
a few keystrokes. For example, you can change all your bold 
text to italic or locate all occurrences of underlining and 

delete them (replace them with nothing). By combining 
search and replace operations with macros, you can search 

for a code, delete it, and replace it with another code. 

First we’ll look at searching and then at searching and replacing. 

Searching for Text and Codes 

To search for an occurrence of a particular character, word, 
phrase, format code, or a combination of words and format codes, 

follow these steps: 

1. Choose Forward from the Search menu (or press Command-F). 

‘To search backward from the insertion point, press Command-B 
(or choose Backward). In either case, you’ll see the dialog box 
illustrated in Figure 2.4; the highlighted arrow will indicate the 
direction you chose. If you decide to search in the other direction, 
Just click on its arrow; there’s no need to use a different com- 
mand. In the example shown in Figure 2.4, the program will 
locate all occurrences of the word WordPerfect when it has been 
indented and boldfaced. 

en — ee 
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If you’re searching 
for a hyphenated 

word, you'll need to insert 
the [Req-] symbol (indica- 
ting a required hyphen)in 
the Search box. Otherwise 
the program won’t be able 
to locate the word. If 
you’re searching for a 
phrase with a long dash— 
like this one—insert two 
[Req-] symbols. 

If you’re searching 
for an acronym 

that’s also a common 
pattern in words—such as 
ING or OUS—choose 
Complete Word Search to 
restrict the search. Other- 
wise WordPerfect will 

_ locate each occurrence of 
the pattern of letters 

- within words. 
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© Partial Word Search 

© Complete Word Search [2] peer se Searen 

(_] Case Sensitive [+] Forward Search 

Bottom lar, 

suggests the right word, which you can then click to 

select. I never bother to correct typos as I type in 

WordPerfect because I know that the Speller will do it 

faster and more accurately than I can. I can't say that 

about any other word processor's spell checker, 

a BONG 

Figure 2.4: You can search for almost any combination of text and format 
codes. 

2. Type whatever you want to find. 

You can enter up to 59 characters, including spaces. To search for 

format codes, scroll the box on the right of the dialog box. When 
you see the code you want to search for, click on it. Then click 
Insert to put it in the Search box. You can combine format codes 
with characters to further restrict searches. For example, you can 
search for the word marketing when it occurs in bold—as in head- 
ings, for example, but not in text. 

. Click on any of the Type buttons to restrict the search. 

WordPerfect is preset for Partial Word searches, which means 
that it will locate the characters you typed even if they are part of 

other words. If you typed other, for example, it will locate other, 
mother, another, others, and so forth. To have it locate a whole word 

by itself, click Complete Word Search. It’s also preset so that if 

you type a word or phrase in lowercase, the program will locate 
the word regardless of whether it’s in lowercase or uppercase. If 
you type in uppercase, WordPerfect will find the word only when 
it’s in uppercase. To locate the word WordPerfect (but not wordper- 
fect, Wordperfect, or WORDPERFECT), click Case Sensitive. 
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4. Press Return (or click Find) to begin the search. 

WordPerfect will locate the next occurrence of whatever you 

typed and highlight it, as illustrated in Figure 2.5. (It doesn’t 

search headers and footers, though.) Here it’s found WordPerfect 

in boldface after an indent. Select will be on, and the insertion 

point will be at the end of the pattern you were searching for. ‘To 

replace whatever was found, you can begin typing immediately 

without having to first delete the selection. To type new text from 

that point on without replacing what’s there, click anywhere in 
the document to turn off Select. 

If WordPerfect can’t find what you typed, you’ll get a “‘Not Found”’ | 

message on the status line. : 

You can try searching in your sample document. Although it hap- ) 
pens to be a short document and you can see it all on the screen, 

searching can greatly speed up locating text in a long document. 
First, move to the beginning of the document. Pressing Enter 

twice and then pressing the f key will take you there. 

1. Choose Forward from the Search menu (or press Command-F). 

¢ é File Edit Search Format Font Special Windows | 
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faster and more accurately than I can. I can't say that 

about any other word processor's spell checker, ! 

including WordPerfect's IBM version. 

and Its Thesaurus 

While the Speller can correct your document, the 

Thesaurus can suggest words to you as you write. If 

you're looking for just the right word to use, or if 

you think you've overused a word and want to see other 

words that have similar meanings. use WordPerfect's 

[rot ints eee ols] 

Figure 2.5: When WordPerfect locates what you’ re looking for, Select is auto- 
matically turned on. 



To return to where 

you were before you 
began a search, press 
Command-G (Goto) and 
click Previous. 

bar You can search 
while the Codes 

window is open. If you’re 
trying to locate a code 
whose effects are not 
readily apparent, such as 
[Tab Set] codes, search 
with the Codes window 
open. This can also help 
you locate codes to delete 
them or to change them 
to other codes. 

har In a long document, 
don’t start a search 

with the wildcard symbol 
as the first character in 
the pattern. It will take 
WordPerfect longer to 
locate all possible 
matches. Restrict the 
search to one section of 

_ the alphabet if you can. 
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2. Type do in the Search For box; then press Return. 

WordPerfect locates the do in document. If you wanted to find only 

the separate word do, you’d need to click Complete Word Search. 

3. Press Command-F again. This time, click Complete Word 
Search and press Return. 

WordPerfect locates the word do. 

WordPerfect remembers what you searched for last and keeps it in 

the Search box. If you want to search for something else, simply type 
in a new search pattern; you don’t have to delete the old one first. 

There are some clever uses for the Search feature that aren’t men- 
tioned in the documentation but that can work to your advantage. For 
example, you can search for the beginning or end of a long paragraph 
you’re working on without having to scroll it if it’s not all displayed on 
the screen. Just search backward for the next [HRt] code to go to the 
beginning of the paragraph, or search forward for the next [HRt] to go 

to the end of the paragraph. In Chapter 8 you’ll find several macros that 

use the Search feature in some of these useful ways. 

Using Wildcards in Searches 

If you insert the wildcard symbol as part of your search pattern, 
WordPerfect will match any character that occurs at that position in 
the pattern. For example, if you enter no and then insert the wildcard 
character, WordPerfect will locate now, not, nor, non, and so forth. (It 

will also find words that contain now, not, nor, and so forth, like another, 

nowadays, notable, enormous, denoted... unless you click Complete Word 

Search.) You can’t use the wildcard character to represent a space, 
but you can use it more than once in any pattern. For example, enter- 

ing conc and two wildcards plus ve will locate all the occurrences of con- 
ceive, even if you’re pretty sure you also misspelled it as concieve. 

The wildcard symbol is in the box of symbols and codes at the right 
of the dialog box; you’ll need to scroll to see it. 

Replacing Text 

You can replace both text and its format codes with other text and 
format codes. The process is not much more complicated than search 
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All character style 

changes require two 
codes, one to turn on the 

effect and the other to 
turn it off. Be sure to 
include the ending code 
in the replacement pat- 
tern, if one is required. 
Otherwise, WordPerfect 

will turn on that effect in 
the rest of the document. 
If the second [Ital] code 
in Figure 2.6 weren’t 
there, for example, every- 
thing from the word 
WordPerfect to the end of 
the document would be in 
italics. 

alone. To search and replace at the same time: 

1. Choose Replace from the Search menu (or press Command-H). 

You’ll see the Replace dialog box, as shown in Figure 2.6. In this 
figure WordPerfect is being told to search for all occurrences of 
the word WordPerfect in boldface and replace it with WordPerfect 

in italics. 

Type what you want to search for. 

If you’re searching for a code, select it from the box on the right; 
then click Insert to insert it in the Search box. 

Press. Tab to move to the Replace box; then type what will 
replace what you’re searching for. 

To delete what you’re searching for, don’t enter anything in the 
Replace box. 

Press Return (or click OK) to start the search-and-replace 
operation. 

You’ll get a warning message if you’ve left the Replace box 
blank; click OK if you really want to delete all occurrences of 
what you’re searching for. 

@ fie Edit Search Format Feat Special Windouss =z 

_ Doc 1: Speller ch 
= 

Search: |(BoldWordPerfect 

Replace: |e WordPerfect Ze] 

Type 

LJ Case Sensitive 

(J With Confirm 

© Partial Word Search 
© Complete Word Search 

1s a joy to use, because it's so fast and almost always 

suggests the right word, which you can then click to 

select. I never bother to correct typos as I type in 

WordPerfect because I know that the Speller will do it 

faster and more accurately than I can. I can't say that 

other word processor's spell checker, 
Pg 1 Ln 1 

Figure 2.6: You can also search and replace at the same time. 



If you want to locate 
a word and replace 

it so it always begins with 
a capital letter, no matter 
how it’s been entered in 

the document, be sure to 

enter it in lowercase in 

the Search box and with a 

capital letter in the 
Replace box. For 
example, enter finder in 
the Search box and 
Finder in the Replace 
box to locate and correct 
any occurrences of finder 
or FINDER and change 
them to Finder. 

You can restrict a 
Mi search and replace 

to be only in the block of 
text you’ve selected, not 
in the whole document. 
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For example, in your practice document, you can search for IBM 
and change it to VAX: 

1. Choose Replace from the Search menu (or press Command-H). 

2. Enter IBM as the Search pattern and VAX as the Replace pat- 
tern. (Press Tab to move to the Replace box.) 

3. Click Find. 

WordPerfect is preset to search and replace without prompting you 
for a confirmation each time it locates what it’s searching for. If you 

want to be prompted, click With Confirm before you press Return to 
start the operation. 

If you replace without confirming each case, you may discover 

what is often referred to as “‘unexpected results” in your document. 
For example, if you replace man with person, you’ll get words like 

unpersonageable and personagement (replacing unmanageable and man- 

agement). If this happens, Undo (Command-Z) won’t help; it 
doesn’t undo a search and replace. To repair your document, go to 
the beginning and do another search and replace, switching the pat- 
terns (searching for person and replacing with man)—and this time 
click With Confirm so that you can check each one. 

Like searches, replace operations are preset for partial word 

searches that are not case sensitive. To tell the program to match 

exactly what you’ve typed, click Complete word search and Case 
sensitive. Otherwise, WordPerfect will match the capitalization of the 

first letter of the words it finds. If it’s searching for saturday delivery and 
has been told to replace it with monday schedule, it will replace both Sat- 
urday Delivery and Saturday delwery with Monday schedule. This feature 
allows it to correctly replace words and phrases that begin a sentence 
as well as occur within text. 

WordPerfect lets you search backward as well as forward, but you 
can replace only from the insertion point forward. You can’t use 
wildcards as part of a replacement pattern. 

Using Codes in Search and Replace 

A very handy way to use the Search and Replace features is to 
search: for format codes and delete them or change them to other 
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codes. When you work with a program that uses invisible codes, it’s 

very easy to accidentally copy codes you don’t want when you copy a 

selection. It’s also easy to overlook codes that control settings 

throughout a document, such as tab and margin settings and line 

spacing changes. And some codes, like [Align] (which is used for 
flush right and tab align) can actually make text disappear from your 
screen. It’s nice to be able to find these codes quickly so that you can 
determine what is going on if something strange seems to be happen- 

ing to the format of your document. 
You can’t use all of WordPerfect’s format codes as replacements. 

The ones you can’t use are marked with an asterisk in Table 2.6, 
which also lists all the codes you can search for. You can get around 

this limitation by writing a macro that searches for a code, deletes it, 

and then inserts another code. You’ll see how in Chapter 8. 
Suppose, for example, that you wanted to locate each occurrence 

of the phrase ipso facto in your document and italicize it, so that you 
wouldn’t have to italicize it each time you typed it. 

1. Choose Replace from the Search menu (or you can press 
Command-H). 

2. In the Search box, enter ipso facto and press Tab. 

The insertion point moves to the Replace box. 

3. Scroll the codes box on the right until you see the [Ital] codes. 

4. Click the first [Ital] code; then click Insert to put it in the 
Replace box. 

5. Type ipso facto; then click the second [Ital] code and Insert to 
put it in the Replace box. 

When you click Find (or press Return), all occurrences of ipso 
facto in your document will be italicized. If you want the pro- 
gram to prompt you at each location of ipso facto, click With 
Confirm before you click Find. 

Another good use for searching and replacing codes is to remove 
codes from your document. For example, you may have changed 
margin settings several times in a document, or you may have com- 
bined several documents with different margin settings into one. You 



[L#, C#, R# Pos] 

[Align][Align] 

[Align Char] 

[Protect] 

[Bold][Bold]* 

[Bottom Mar] 

[Cncl-]* 

[Center Pg]* 

[Center][Center] 

[Column][Column]* 

[Col Def] 

[Cond EOP] 

[Date] 

[< Def] 

[Font] 

[Font Size:] 

(Hdr/Ftr:] 

[HPg]* 
([HRt]* 

[Hyph][Hyph]* 

[HZone Set] 

[> Indent] 

[> Indent <] 

[Index:] 

[Ital] [Ital] * 

Table 2.6: Format Codes You Can Search For 

Page number position 

Flush right 

Tab align 

Block protection on/off 

Bold on/off 

Bottom margin 

Cancel hyphenation 

Center page top to bottom 

Center text 

Column on/off 

Column definition 

Conditional end of page 

Date 

End of index, list, table of contents 

Font 

Font size 

Header or footer 

Hard page break 

Hard return 

Hyphenation on/off 

Set H-zone 

Indent 

Left/right indent 

Index entry 

Italics on/off 

* Indicates codes that can also be used as part of a replacement pattern 
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[Justify: type] 

[Kern:] 
[< Mar Rel] 

[Line #] 

[Margin Set:] 

[Mark:][Mark:] 

[Def Mark] 

[Mark: TofC][Mark:TofC] 

[Note] 

[Note#]* 

[Note # Set] 

[Note Opt] 

[Outhn}[OutIn]* 

[Overstk] * 

[Pg # Pos] 

[Pg #] 

[1 #] 

[{ # Def] 

[Picture] 

[PostScript] 

[Redline][Redline]* 

[Req-]* 

[Shad][Shad] * 

[Soft-]* 

[SPg] 

Table 2.6: Format Codes You Can Search For (continued) 

Justify (type = type of justification) 

Kerning 

Margin release 

Line number 

Margin set 

Mark text on/off 

Defintion of index, list, table of contents 

Mark for table of contents 

Note 

Note number 

Set note number 

Note options 

Outline style on/off 

Overstrike 

Page number position 

Page number 

Paragraph number 

Paragraph number definition 

Graphic image 

PostScript command 

Redline on/off 

Required hyphen 

Shadow on/off 

Soft hyphen 

Soft page 

* Indicates codes that can also be used as part of a replacement pattern 



[Spacing Set] 

[Strkout][Strkout] * 

[SubScript][SubScript] * 

[SuprScript][SuprScript] * 

[Suppress] 

[Tab] * 

[Tab Set] 

[TopMar] 

[Undrln][Undrin]* 

[Undln Style] 

[W/O][W/O]* 

[wild card] 

[ € OF ere be 
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Table 2.6: Format Codes You Can Search For (continued) 

Spacing set 

Strikeout on/off 

Subscript on/off 

Superscript on/off 

Suppress for current page 

Tab 

Tab set 

Top margin 

Underline on/off 

Underline style 

Widow/orphan protection on/off 

Wildcard 

Merge codes 

* Indicates codes that can also be used as part of a replacement pattern 
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can search for all [Margin Set] codes and remove them: 

1. With the insertion point at the beginning of the document, 
choose Replace from the Search menu (Command-H). 

2. Scroll the codes box on the right until you see the [Margin Set] 
code; then click it and click Insert to put it in the Search box. 

3. Instead of entering anything in the Replace box, just press 
Return (or click Find). 

You’ll get a warning that all occurrences of the search pattern will 
be deleted, but that’s what you want. 

4. Press Return. 
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If you have the 
Codes window 

open, you can just click in 
the lower-right corner to 
size the window. 
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All the [Margin Set] codes in your document will be deleted, and 

you can set new margins at the beginning that will be in effect 

throughout the document. 
You can also use this technique to delete any extra headers or footers 

that may be in your document, remove any additional top margin set- 

tings, delete style changes such as underlining or boldface, remove night 

justification in sections of the document that may have been right- 
justified originally, and so forth. In short, you can “clean up” any docu- 
ment by taking out extraneous codes and simply replacing them with 

the ones you want to use. 

Working with Multiple Documents 

With WordPerfect, you can have as many different documents 

open in separate windows as your computer’s memory allows. 

Because the program uses virtual memory, in which disk space as 
well as RAM is used as memory, this can be quite a few documents 

indeed (I’ve had as many as 19 open). It’s very useful to be able to see 

the contents of other documents while you’re working. For example, 
you may want to look at last week’s report while you’re writing this 

week’s, or compare one version of a document with another. If 
you’ re creating an index, you can keep a list of topics in a second win- 

dow, or you can keep an outline available in a separate window to 

refer to as you write. Another excellent use is for copying and pasting 
boilerplate-—standard text that you use over and over. You can open 

a document that contains all the standard clauses in a contract, for 

example, and simply paste them into the contract you’re writing. 
You'll also find having several windows open is helpful for alpha- 

betizing lists, as illustrated in Figure 2.7. The list was originally typed 
in random order; each item was cut and pasted into the appropriate 
window, and as a last step, the items in each window were 
alphabetized. 

To make a full-screen window smaller, click the size box in the 
lower-right corner and drag it inward. To make it larger, drag it out- 
ward. Clicking in the zoom box in the upper-right corner of the win- 
dow toggles the window between its last two sizes. Table 2.7 lists the 
techniques you use to manipulate windows with the mouse. 

You can activate each document you’ ve opened by choosing Cycle 



You can make the 
menu bar at the top 

of the screen invisible if 
you really want full- 
screen windows. When 

you move the mouse into 

the menu bar, the menu 

will reappear. If you use 
keyboard shortcuts all the 
time, you may want to 
hide the menu bar. 
Choose Screen from the 
Special menu; then 
choose Full Window (or 
press Command-Shift-Z). 
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Figure 2.7: Having several windows open allows you to quickly cut and paste 
among them, in this case to alphabetize a long list. 

windows (Command-W) from the Windows menu. The Windows 
menu also lists all the documents you’ve opened, and an alternate 
way of activating a document’s window is by clicking on its name in 
that list. Of course, if a portion of a window is visible on the screen, 
clicking on it activates the window. 

Table 2.7: Manipulating Windows with the Mouse 

Window Change Mouse Action 

Change a window’s size Position the pointer on the size box in the 

lower-right corner; then drag 

Make a window full-screen size Click on the zoom box in the upper-right 

corner 

Move a window Drag it by its title bar 

Make a window active Click in it 

Close a window Click in the close box in the upper-left 

corner 
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The Insert Literal 
command can also 

be used to insert Control 
characters if you don’t 
have a Control key on 
your keyboard. For 
example, entering a 
Control-B into a docu- 
ment tells WordPerfect to 
automatically insert the 
number of the current 
page. (Using * -B for 
page numbering is dis- 
cussed in more detail in 
Chapter 4.) 
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The Windows menu also allows you to see the contents of the Clip- 

board. The last text that you cut or copied in WordPerfect will be on 
the Clipboard. Also, if you’re pasting something from another pro- 
gram, it’s useful to be able to see what is on the Clipboard. 
Now that you’ve seen a few general techniques for editing and 

manipulating text in WordPerfect, it’s time to take a look at a few 
specialized editing commands, such.as using special characters that 
aren’t on your keyboard, working with redline and strikeout, and 
changing the date format. 

Inserting Special Characters 
As you saw in the tutorial in Chapter 1, the Insert Literal command 

on the Edit menu (its shortcut is Command-I) lets you insert special 
characters in the font you’re using that aren’t normally visible on the 

screen. As you can see in Figure 2.8, most fonts have quite a few of these 
hidden characters, such as section and paragraph marks, graphics sym- 
bol keys, trademark and copyright marks, foreign-language diacritical 
marks, and so forth. Chicago is the font shown in the figure; blank boxes 
appear where no special character is available. 

file Edit Search Format Fort Special Winiouss 

Ee 

Nv 

=I 

[z[<|-|~]¢| 
MO 

Ce OOS 

Figure 2.8: The Insert Literal command lets you insert special characters into 
your text. The characters you see depend on the font you’ re using. 



har You can redline text 
as you type it, but 

you can use Strikeout 
only on text that’s 
already been typed. 
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After you press Command-I, you’ll see a grid showing the special 
characters available in the font you’re currently using. To insert a 

symbol at the insertion point in your document, click in its box. Click 

on the close box or press Command-K to close the window without 
inserting any special character. 

Using Redline and Strikeout 

Redline and Strikeout are features that you can use in documents 
that are going to be reviewed by others, such as contracts or drafts of 
a report. When you redline text, a vertical bar appears in the left 

margin when the document is printed. This is useful for indicating 
sections that have been revised so that all concerned can locate them 
quickly without having to read through the whole document. 

Strikeout works as its name implies: a dashed line is placed 
through each character in the text you’ve marked for strikeout. ‘This 
feature is often used in contracts to indicate provisions that have been 
deleted and must be initialed by the parties concerned. 

Figure 2.9 illustrates how struck-out and redlined text appear in a 
printed document. If you have a color monitor, you’ll see that these 

marks really are red. 
To redline or strike out text: 

1. Select the text you want to mark. 

In your sample document, select the first paragraph. 

2. Press Command-Y to choose Style from the Font menu; then 
choose Redline. (Command-Y B is the shortcut). 

Removing Redlining and Strikeout Marks 

After your document has been reviewed, you probably will want to 
remove any redlining marks and struck-out text before the final 
printing. To do so, choose Mark Text from the Special menu and 
then choose Remove. 

1. To remove the redlining from your document, choose Mark 
Text; then choose Remove. 

The redlining disappears from the screen. 
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" @ File Edit Search Format Font Special Windows _& file Edit Searc Se Te 
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2S Doc 3: redline & strikeout example 

While the Speller can correct your document, the Thesaurus can suggest 

words to you as you write. If you're looking for just the right word to use, 

or if you think you've overused a word and want to see other words that 

have similar meanings, use WordPerfect’s Thesaurus to see lists of nouns, 

verbs, and eee that ARRAS Tiley ina Sees case. The thessurus 

Figure 2.9: Redlining and striking out text call the reader’s attention to areas 
in the document that have been changed. 

Close your sample document now. You can practice with it some 
more if you like, but you won’t need it in other exercises. 
When you choose Remove, any struck-out text is deleted from your 

document. Any text that’s been redlined stays there, but the redline 
marks disappear. If you’ve marked text for strikeout that you want to 
keep, delete the [StrkOut] code at the beginning, before you remove the 
redlining and strikeout. You can search for this code and delete it. 

Inserting the Date and Time 

The Date command on the Special menu (Command-D) lets you 
insert the date and time in your document. You can choose either the 

first option, Insert Text, which inserts today’s date in your text, or 
you can choose the second option, Insert Function, which will auto- 
matically update the date that’s in your document each time you open 
it. The date function is especially helpful if you write routine letters in 

your slack time during the week and then want to print them all with the 
same date (on Friday, for example) because it dates them as of the day 
you send them to the printer. The date function even has a keyboard 
shortcut: Command-Shift-D. 
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Vr There’s no separate 
format for the time. 

You can include it with 

the date or choose to have 

the time with no date. 

When you choose Insert 
Text or Insert Function, 

the style you set in this 
dialog box will be used. 
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In addition to the date, you can insert the time or change the date 
format by choosing Date Format from the Date submenu. The 
default format is for the date as Month Date, Year (as in October 28, 
1988). As Figure 2.10 shows, there are 12 different formats you can 
specify: 

Day of Month— 25, 26, etc. 

Month Number— Or) 

Name of Month— February, March 

Four Digit Year— 1988 

Two Digit Year— 88 

Week Day Name— Tuesday, Wednesday 

Leading Zero— 01, 02 

Insert Tab— inserts a tab 

12 Hour time— 1,2 

24 Hour Time— 13, 14 

Minute— 19, 20 

am/pm— AM, PM 

To change the date format, click on the button of the style you 
want, and it will be inserted in the Date and Time Display Format 
box. Be sure to add any necessary punctuation and spacing. You can 
also type characters into your date format so that you could, for 
example, have the time appear as ““The time is 12:57 PM.” 

For example, in Figure 2.10, the date format was created by click- 
ing on Week Day Name, Name of Month Day of Month, Four Digit 
Year—12 Hour Time:Minute am/pm. The commas, spaces, and 
dashes were added from the keyboard. This produces a date and time 
like Monday, November 21, 1988—8:30 AM. 

When you use the date function, WordPerfect inserts a [Date] 
code in your text that shows the format you’re using. When you 
insert the date as text, no code is inserted. 

If you change the date format, it’s not automatically changed in all 
the places where you ’ve inserted the date function in a document. 
You’ll need to search for each of these codes and replace them with 

the new date format code. You can’t search for a date code and 
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Figure 2.10: You can specify the format WordPerfect uses for the date and 
time. 

replace it with a new one at the same time, so, after you’ve read 
Chapter 8, you may want to write a macro that searches for each 
[Date] code, presses Delete to delete it, and then presses Command- 
Shift-D to insert the new date function code. 

Looking Forward 

This chapter has discussed WordPerfect’s general editing tech- 
niques: selecting and deleting text, moving through your documents, 
searching and replacing, transposing letters and words, and working 

with multiple documents. It has also introduced two specialized fea- 
tures, redline and strikeout, that are used to mark text for revision. 
You've also seen a couple of other techniques for inserting special 
characters and changing the date and time format. 

Chapter 3 discusses formatting characters, lines, and paragraphs, 
and Chapter 4 discusses page formatting. Chapter 8 shows you how 
you can automate many of these features as macros. In addition, you 
may want to customize WordPerfect to work in some other ways that 
suit you best. Appendix C suggests several different ways you can tai- 
lor the program for your needs and preferences. 
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To format characters in WordPerfect, 

you use the Font and Format menus. 

To change the text’s font, size, or style, 

select the Font menu. Command-Y takes you directly to the 

Style submenu. 

To choose subscript, superscript, overstrike, 

redline, and strikeout, as well as font, size, and style, select 

Characters from the Format menu (or press Command-S). 

To quickly pick the basic styles—plain, bold, underline, italic, 

outline, and shadow, 

click the corresponding P, B, U, I, O, or S box on the Status 

line with the mouse. Each of these styles also has its own key- 

board shortcut; for example, Command-Shift-B for bold. 

To choose justified text, 

display the Ruler (choose Show Ruler from the Format menu 

or press Command-R) and click the full-justification icon. 

To center text, 

press Command-Shift-C. To place it flush right, press 
Command-Shift-F. 

You can choose left-justified, right-justified, centered, or decimal 

tabs. You set tab stops by using the Ruler (Command-R) or by 
choosing Tabs from the Line submenu. 

To indent a paragraph of text ‘ 
to the next tab stop to the right, press Command-Shift-T. 
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Left-Right Indent 

(Command-Shift-L) indents the beginning of each line in a 

paragraph one tab stop to the right and the end of each line one 
tab stop to the left. 

Margin Release 

(Shift-Tab) “‘indents”’ the beginning of a line one tab stop to the 

left. If you indent a paragraph and then press Shift-Tab to 

move the first line left, you create a hanging indent. 

You can choose either Automatic or Auto Aided hyphenation. 

With Automatic hyphenation, WordPerfect follows its built-in 

set of hyphenation rules. If you choose Auto Aided, you’ll be 

prompted to confirm or change each hyphen. 

WordPerfect uses a hyphenation zone 

to decide whether a word should be hyphenated. You adjust the 

zone by dragging the gray area at the top of the ruler line. 

WordPerfect hyphenates words more frequently in a smaller 

H-zone. 

To change line height 
and leading as well as specify line spacing, select the Line sub- 

menu’s Spacing command. 

Kerning and letterspacing 
refer to the spacing between characters. Choosing Kerning lets 

you decrease the amount of space between one letter and the 

next, while choosing Letterspacing lets you increase the spacing 

between letters. 
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You may find it 

faster to type out 
text and then format it 
later, especially if you 
prefer using the mouse to 
using the keyboard. 

3 

THIS CHAPTER DISCUSSES HOW YOU CAN FORMAT 
characters, lines, and paragraphs in WordPerfect. You practiced 

some of these techniques when you took the tutorial in Chapter 1, but 

there are many more. Also in this chapter, you’ll want to pay special 
attention to the codes that are inserted when you make format 
changes. Understanding what these codes are and how they work 
allows you to control the appearance of your documents. 

When you first use a new copy of WordPerfect, you’ll find that 
many of its format features, such as line spacing and tab stops, are 
already set. Single spacing is being used, the right margin isn’t jus- 
tified, and the font is Geneva. These initial default settings are listed 
in Table 3.1. You can change any of them as you work, and the 
changes you make will stay in effect until you quit WordPerfect. 

The next time you use the program, though, you’ll find that the 
default settings are in effect again. ‘Io change any of the default set- 

tings to the ones you want to use each time you start WordPerfect, 

you have to use the WP Defaults command on the File menu to 

change the WP Defaults file. Chapter 7 contains step-by-step instruc- 
tions on how to do this. 

Open a new window or a saved document so that you can practice 
some of these techniques as you go through this chapter. You don’t 

have to type a lengthy document, but you can use any existing docu- 
ment or just enter a few words in a new window for practice. 

Table 3.1: WordPerfect’s Initial Default Settings 

The font is Geneva. 

Automatic single spacing is in effect. 

Justification is off, but if you justify text, it will be displayed on the screen. 

Page size is 8.5 by 11 inches. 

i ins 
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Table 3.1: WordPerfect’s Initial Default Settings (continued) 

There are one-inch top, bottom, right, and left margins. 

Left-aligned tabs are set every 0.5 inches. 

The alignment character is the period (.). 

Hyphenation is on. 

The hyphenation zone begins at the 6.75-inch mark on the ruler and extends 

to the 7.5-inch mark. 

Page numbers will be printed at the 1-inch mark if you choose left page num- 

bers. If you choose the center position, they’ll be at the 4.5-inch mark. Right- 

aligned page numbers appear at the 7.5-inch mark. 

Text will be printed at six lines per inch. 

Footnote and endnote numbers are superscripted. 

The date format is Month Day, Year, as in February 16, 1988. 

The underline stype is for single noncontinuous underlining. 

Widow/Orphan protection is off. 

Formatting Characters 

The basic unit of text is, of course, each individual character. You can 

adjust a character’s font (Geneva, Chicago, and so forth) as well as its 
style (italics, shadow, outline, and so forth) and size. WordPerfect uses a 
few terms that may be unfamiliar, so we’ll look at them first. 

Fonts and Type Styles 

In the vocabulary of traditional typesetting, a font is one typeface 
in one particular style and size, such as 10-point Helvetica bold or 24- 
point Chicago italic. 

A font’s size is measured in points (a point is 1/72 inch). This is the 
measurement from the lowest descender (the tail of a letter such as y) 
to the top of the ascender (the top of a letter such as d). The design of 
a font affects the length of these descenders and ascenders, so one font 
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in 10 point type may actually look larger or smaller than another font 

that’s also 10 point (Figure 3.1). 

Proportional and Nonproportional Fonts 

In a proportionally spaced font, each character can occupy a 

different amount of space: an i, for example, takes up much less hori- 

zontal space on a line than an m. A monospaced font is like type- 
writer type: each character occupies exactly the same amount of 

space. You’ll probably find that proportionally spaced fonts produce 
more pleasing results in printed text than monospaced (nonpropor- 

tional) fonts. However, if you’re using columns of text or numbers 

and want them to line up exactly with each other, you may want to 
switch to a monospaced font. Apple’s monospaced fonts are Monaco 

on the ImageWriter and Courier on the LaserWriter. 

Using Other Fonts | 
As you may already know, a huge range of fonts are available for . 

the Macintosh—not just the fonts that came with your Mac, but also | 

2 

This is 12-point Geneva. } 

This is 12-point Helvetica. 

This is 12-point Times. 

This is 12-point Palatino. 

This is 12-point Chicago. 

This is 12-point New Century Schoolbook. 

Figure 3.1: One font may look larger than another but actually have the same 
point size. 

OS et ne ee a 



To return to the font 

you were previously 
using, just skip over the 
code on the right by 
pressing >. To convert 
all the text from the 
insertion point onward to 
the new font, delete the 

code on the right. 
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fonts from other manufacturers. Once you’ve installed any of these 
fonts in your System file, they’re available to you in WordPerfect. 
Because the subject of installing fonts can get quite extensive, 
depending on what kind of printing you want to do, it’s discussed in 
Chapter 6 on printing. 

Changing Fonts 

‘To change fonts as you type, simply choose a new font from the Font 

menu, or select Characters from the Format menu (Command-5 is its 
shortcut). Pressing Command-5 brings up the dialog box shown in Fig- 

ure 3.2, which lets you change several things at once. If you select a new 

font, a [Set Font] code is inserted to the left of the insertion point, and 
from there on the text you type will be in the new font. 

To change text you've already typed to a different font, select the 
text and then choose the font you want it to be in. When you change 

fonts in existing text, WordPerfect inserts two [Set Font] codes in 

your document: the first one (to the left of the selected text) changes 
the text to the new font, and the second code (to the right of the 
selected text) is the code for the font you were using before you 

" @ tile Edit Search Format Font Special Windows 

CD Superscript 

CJ Subscript 

CJ Overstrike 

C) Strikeout 

OC Redline 

Avant Garde C1 Bold 

Bookman CJ Underline 

Chicago C Italics 
Courier Oo Outline 

Dover 

Dover PS [El Siedew 

va 
= Underline Style 

@ Single ©Continuous 

© Double @Non-continuous 

Figure 3.2: The Character dialog box lets you change font, font size, and 

style, as well as specify the underlining style. 
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changed fonts. If you make a font change in the middle of existing 

text without first selecting text, the same two codes are inserted—the 
code for the new font at the left of the insertion point and the code that 
reverts to the old font at the right. Anything you type at that point is 
inserted between the codes and appears in the new font. 

Take some time to practice changing fonts in your sample docu- 
ment. Open the Codes window so that you can see what happens as 
you make each change. < 

For example, Figure 3.3 illustrates a section of text where the font 
has been switched from Courier to Times. As you can see, all 

the text that was typed after the new code was inserted is in Times, 
while text that’s located to the right of the Courier code remains in 
Courier. 

You can use WordPerfect’s search and replace commands to 

search for [Font] codes, but you can’t search for a specific font, such 
as Courier or Helvetica. You can also search for [FontSize] codes. 
You can’t replace them automatically with other codes, but you can 
delete them all by leaving the Replace pattern blank. 

& File Edit Search Format Font Special Windows 

Doc 1: fig change fonts 
q Tip: to change back quickly to the font you were using, press the 
: right arrow key and then LYp Sy, Ue tserion Beant Na skip over the code 
H that puts you back in your orizyinal font. 

(Set Font:Courier)Tip:odchangeobacksquicklyet osthes ontovo ueweredusing press athe 4st) 

rightoarrowsk eyoandet hendtyp e.o[SetfontsTimes)T hedins erti ondp ointowilllf Get fontcourier)dskipsoversthescode 

thatsputsdyousbackdindyourdoriginalé ont. 

Figure 3.3: When you change fonts, the code for the new font precedes the 
code for the old font. 
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Changing Font Sizes 

WordPerfect gives you two ways to change the size of the charac- 
ters in your document: 

¢ The Characters dialog box (Command-5) 

e The Font menu 

Using the Font menu is the fastest way, if all you’re changing is the 
font’s size, not the font itself or the style. 

To change the size of text you’ve already typed, select the text and 
then choose the new point size. To switch to a different size as you 

type, just choose the new size; a [Font Size] code is inserted to the left 
of the insertion point. 

When you change the font size in the middle of text you’ve already 
typed, the program inserts two [Font Size] codes in your text around 
the insertion point (just as with [Set Font] codes), as shown in Figure 
3.4. If you selected text before changing font size, the two codes go at 
the beginning and end of the selected text. As with [Set Font] codes, if 
you move the insertion point past the code on the right, what you 

type from there on will be in the font size you were using previously. 

&@ File Edit Search Format Font Special Windows 

Doc 1: 3B Formatting 

To change the size of text you've already typed, select the 

text and then choose the new point size. To switch to a different 

size as you type, just choose the new size. 

When you change the font size, the program inserts two [Font 

Size:] codes in your text around the insertion point. The code on 

the right of the new size, 10 points insertion point changes the 

(When oyoudchange othe ofont osize, othe program Oinserts otwo o[ Font G28) 

Size:] Ocodes OinOyour text Oaround othe Oinsertion Opoint.OThe Ocode Oon SRE) 

the oright Oof othe o [Font SizelO)new Osize, o 10 Opoints off(Font Size:12)i nser Goft-}tion © point Ochanges othe 

fontosize oback Oto Othe Oone o youdwere Ousing before Oyoudmade othe GSA%) 

change. > GBR) 

Figure 3.4: Changing font size in the midst of text inserts two codes in your 
document. 
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On the Font menu, the sizes that give you the best results for dot- 

matrix printing in the font you’re using are outlined. In the Charac- 

ters dialog box, they’re the sizes that appear under “‘Size:’’ as you 

highlight each font. 

Using the Characters dialog box lets you specify a font size that’s not 

listed on the menu, but you may not be pleased with the results, because 
the Macintosh has to create from scratch sizes that aren’t listed on the 
menu. Test print before you get too creative. You can specify a size up to 
127 points (that’s huge). To give you an example of sizes, this book is set 

in 111/2-point type with 15-point first-level heads. 

Changing Styles 

In WordPerfect, a character style refers to bold, underline, italic, 

outline, shadow, or plain—or any combination of those styles. You 

can have bold italic outline shadow characters, if you like. WordPer- 
fect also provides superscripts and subscripts, overstrike, strikeout, 
and redline styles. 

As you took the tutorial in Chapter 1, you practiced several ways 
of changing styles by using the boxes on the status line, the Style sub- 
menu (Command-Y), and the keyboard shortcuts. 

If you recall, you can click on the boxes in the status line or use a 
Command-Shift key sequence to choose Plain, Bold, Underline, 

Italic, Outline, and Shadow. If you use the boxes in the status line, 

you’ll see the styles change as you click on them, indicating which 
style or styles are in effect as you’re typing. The B changes to B, and 
the I changes to J, for example. To turn off a certain style, click on its 
box again (or press its Command-Shift combination again— 
Command-Shift-B for bold, and so forth). 

Pressing Command-Y brings up the Style submenu, where you 
can select eleven different styles or any combination of them, 
although strikeout, redline, overstrike, and super/subscripting are 
generally used alone. (But you can have strikeout shadow outline 
bold, if you prefer.) 

‘True to the Macintosh tradition of giving you several ways to do 
almost everything, you can also select Characters from the Format 
menu or press Command-5 to change character styles. 

If you’re changing several of the basic styles and staying in the same 
font—for example, changing a word to bold underline—click the boxes 



7] When you change 
from italics to regu- 

lar text, the last italic 

_ character sometimes 

crowds the next regular 
text character. To solve 
this problem, you can 
insert a space that’s wider 
than a regular space but 
smaller than two spaces 
after the italic character 
by pressing Option-space 

_ bar. (Enter-space bar 
inserts a required space.) 

If you’ve been 
changing styles 

often and your screen 
looks ‘“‘jumpy,”’ you’ve 
probably got a few format 

change codes in there that 
- WordPerfect is having to 
read each time it rewrites 

the screen. Press 
Command-7 to see the 
codes that are in your 
document and delete any 
that you’re no longer’ 
using. 
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on the status line or use the keyboard shortcuts. But if you’re changing 
font and/or size at the same time as style, Command-5 is fastest. 

‘Take some time now to experiment with these different ways of 
changing styles in your practice window. Type some text, select it, 
and then try changing styles by using: 

e The Style submenu (Command-Y) 

e The boxes on the status line 

The Command-Shift shortcuts 

The Characters dialog box (Command-5) 

You’ll probably find that the method you use most often is the boxes 
on the status line—at least, I find it fastest. 

WordPerfect uses two codes for each style change. One turns on 
the effect and the other turns it off. Open the Codes window now and 

see what’s happened to your practice text as you changed styles. 
(Appendix A lists all the format codes for your reference.) If you’re 
deleting text in a document and the insertion point runs across any of 
these codes, you’ll get a ‘‘Delete?”’ dialog box. Click OK (or press 
Command-O) to delete the style or click Cancel (or press Return) to 
leave it in place. You won’t get the dialog box if you’ve got the Codes 
window open. 

Using Superscripts and Subscripts 

Superscript and Subscript produce characters in a smaller point 
size than the characters you are using, raised or lowered on the line. 
For example, in Figure 3.5 the regular text is in 12 point, and you can 

see that the supers and subs are in a smaller point size. WordPerfect 
adjusts the size for whatever font you’re using. 

To create the expression 3x” + 4°*”: 

1. Type 3x and choose Style from the Font menu; then choose 
style 7, Superscript (or use the shortcut Command-Y 7). 

From now on until you choose Superscript again, what you type 
will be raised above the regular text line and will appear in a 
smaller font size. 
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Don’t confuse Out- 
™ lining with the 

Outline style. The code 
for outline style text is 
[Outln]; for outlining, it’s 
[{#:- auto]. 
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. Type 2. 

. Choose Style from the Font menu again; then choose style 7, 

4. Type + 4 and choose Superscript again. 

5. Type (n+1) and turn off Superscript by choosing it again. 

You may find it more convenient to type out super- and subscript 
material as one line and then go back and select what is to be 
superscripted and subscripted rather than select as you type. How- 

ever, if you’re using this method and switching back and forth from 
italics at the same time (for variables in equations, for example), be 
warned about what happens when you designate text as Plain: you 
lose superscripts and subscripts and have to put them in again. 

Figure 3.5: You can use superscripted and subscripted text to‘create equations. 

The 2 appears as a superscripted exponent. 

Superscript (or use the shortcut Command-Y 7). 

Choosing Superscript when it’s checkmarked turns it off. 

Fine point: For correct form, there should be no extra space 
around superscripted or subscripted operators (like the plus 
sign), whereas there should be one space around operators that 
aren’t superscripted or subscripted. 

If you’re doing a lot of mathematical typing, write yourself three 

ormat Font Special Windows 

=== Doc 2: supers & Subs | 
12-point Geneva with superscript and subscript. 
This makes it possible to type complex equations and formulas such as 

Hane s2 

B12 eqs pointsGenevarwith> Ser Scripts up erscript GSerScript} an de sub Script>s ubscri pt GusScript). GARY) 

Thisomak esditop ossiblest ostyp ede omplexde quations sen dé ormulas¢s uch das (aRS) 
Center>xGurSeripddio< Sub Script) =9{n (sur Script Cour Script) > (Req) 1) $3 SurScript> 2 SurScript 
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M@8 underlined spaces 
between words, select 

each word individually 
and then choose Under- 
line. If you select a whole 
phrase, such as nolo 
contendere, and then 

choose Underline, it’ll 

appear as nolo contendere 
instead of nolo contendere. 
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Command-Option macros: one that converts the next character you 
type to a superscript, one that converts it to a subscript, and one that 

changes it back to plain text. (See Chapter 8 for more on macros.) 

Using Overstrike 

Choosing Overstrike lets you create symbols that aren’t in the 
fonts you have installed in your System file. After you choose Over- 
strike (its keyboard shortcut is Command-Shift-V), the next charac- 
ter you type will be superimposed over the one you’ ve just typed. 

To see the symbols that are available in the font you’re using, 

choose Insert Literal from the Edit menu (or press Command-I). You 
can also choose Key Caps from the Apple menu and then press 

Option and Option-Shift to see what special characters are available. 

Changing Underline Styles 
You can choose either double or single underlining in Word- 

Perfect. Double underlining looks like this. Single underlining looks 

You can also select either continuous or noncontinuous underlin- 
ing. Continuous underlining means that underlining will continue 
when you press Tab, which you might want to use if you’re creating a 
table where column headings are separated by tabs. Noncontinuous 
underlining does not underline when you press Tab but does con- 
tinue the underline in the spaces between words. 

To set any of these styles (the default setting is for single noncontin- 
uous underlining), press Command-5 or choose Characters from the 
Format menu. 

Justifying Text 
WordPerfect is preset to give you ragged right (nonjustified) text. 

To select justified text, display the Ruler (choose Show Ruler on the 
Format menu or press Command-R) and click the right-justification 
icon, as illustrated in Figure 3.6. If you want text to be justified on 

both the right and left margins, click the full-justification icon (the 

rightmost icon with lines in it). Once you’ve turned on justification, 
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slows the program down. 

WordPerfect’s default 
mode is to display justi- 
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H-zone Right margin Page number positions Left margin 

it Aearch Format Font Special Windows 

Doc 1: Untitled =X 

Columns off/on 

Column definition 
Left justify 

Center 

Right justify 

Full justification 

Revert to original settings 

Figure 3.6: The Ruler allows you to select whether you want your text right 
justified and controls many other format changes. 

all the text you type from that point on will be justified. 

When text is justified on both margins, WordPerfect inserts extra 
space between words so that lines are of equal length when they’re 
printed. This sometimes results in odd spacing, especially if you’re 
using a lot of hyphenated words. To turn justification off, display the 
Ruler and click the other justification icon—the one with the lines 
aligned ragged right. 

Even though you may not want your whole document to be right 
justified, you may find that it’s convenient to justify parts of it, such 
as quoted material, for example. To justify a block of text in an other- 
wise unjustified document, select the text and then justify it by dis- 
playing the Ruler and clicking on one of the justification icons. 
When you justify text, WordPerfect inserts [ Justify:Left], [ Justi- 

fy:Right], [ Justify:Full], or [ Justify:Center] codes. 
If you prefer to have justified margins in all or most of your docu- 

ments, you can make that the default setting, or you can set up other 
custom formats for particular kinds of documents. See Chapter 7 for 
details about changing default formats and creating custom formats. 

You can’t tell from looking at the screen whether full justification is 
on or off, since the justification may not be displayed. To see whether 
it’s on, press Command-Shift-P (or choose Print Preview from the 
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Print Options submenu). You can also display the Ruler and check to 
see which icon is selected. 

CC ©60 F NE Ruler Line 

The Ruler line allows you to change several other format options 

besides justification. As Figure 3.6 shows, you can also use it to 

¢ Reset right and left margins by dragging the left- and right- 
pointing arrowheads 

e Set different types of tabs by clicking on the icon of the type 
you want and then clicking on the Ruler line 

e Change the page number position by dragging the # symbols 

that indicate where page numbers are to appear if you choose 
left-, center-, or right-aligned page numbers 

e Center text by clicking on the centering icon 

e¢ Change the hyphenation zone by dragging the shaded bar at 

the upper right 

e Revert to the original settings the Ruler line had when you 
first displayed it by clicking on the X icon 

In addition, you can define newspaper columns and turn Columns 
on and off by clicking on the Column Definition and Columns On/ 
Off icons. Columns are discussed in Chapter 5, and the rest of the 

Ruler line’s features are discussed in more detail in this chapter and 
Chapter 4. 

Centering Text 
WordPerfect lets you center text in two different ways, each of which 

has slightly different effects. You can center text by using the Ruler line 
or by using the Center command, which is located on the Line submenu 
of the Format menu and whose shortcut is Command-Shift-C. If you’ve 

made a selection that’s less than a full line of text, WordPerfect centers 

the text between the right and left margins on the next line, as Figure 3.7 

illustrates, and inserts [ Justify:Center] and [ Justify: Left] codes around 
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" @& File Edit Search Format Font Special Windows — _. Ree 

== Doc 1: Untitled 
ou center text you've selected, 

WordFertect displays 
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Figure 3.7: The selected text has been centered. 

the text. The [ Justify: Left] code formats whatever you type following 

that code as regular left-justified text, so you can center text and quickly 
return to regular typing. 

If you center an entire paragraph, each line in the paragraph is cen- 
tered. As you can add text to the paragraph, the program will adjust the 
centering automatically. If you select a sentence within a paragraph and 

then center it, the program will display it on the next line. 

However, if you’re using the Center command as you type, where 
the text gets centered depends on the location of the insertion point. If 
it’s on the left margin, text is centered between the right and left mar- 
gins, as usual, but if it isn’t on the left margin, text is centered around 

the insertion point. This is handy for centering text at any point on 
a line. 

That’s the theory. Here’s some practice. 

Centering Text Between Margins 

1. Move the insertion point to the left margin. 

2. Choose Center from the Line submenu (or press Command- 
Shift-C). 
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o If you move the 
insertion point to 

the middle of a line 
you ve already typed and 
then press Command- 
Shift-C (or choose Cen- 
ter) without first making 
a selection, some text will 

disappear from your 
screen. What’s happen- 
ing is that the Center 
command is centering the 
text that was to the right 
of the insertion point, and 
that text is now overwrit- 
ing some of the text that 
had been on the left, as 

you can see if you press 
Command-7 to see the 
codes. You can press | 
Commanca-Z to undo the 
centering as long as you 
haven’t done anything 
else. Otherwise, you’ll 
need to delete one of the 
[Center] codes. 

3. Type the text that you want to center. 

Any text you type will continue to be centered on the page. After you 
press Return, the text you type will be flush left on the next line. 

Alternatively, you can center text by using the Ruler line: 

1. Display the Ruler line by choosing Show Ruler from the For- 
mat menu or pressing Command-R. 

2. Click the centering icon. 

All the text you type from that point on in your document will be 

centered between the right and left margins. If Columns are on, text 
will be centered between the column margins. 

Centering Text You’ve Already Typed 

1. Select the text you want to center. 

2. Press Command-Shift-C or display the Ruler line and click the 
centering icon. 

Centering Text at a Specified Point 

Instead of centering text between the margins, you can specify the 
point where it is to be centered. For example, you may want to center 
headings over each column in a table created by tabs, as shown in 
Figure 3.8. (If you recall, you did this in the tutorial in Chapter 1.) 
You can use the following method to center the headings: 

1. Use the space bar or the Tab key to position the insertion point 
where you want the text to be centered. 

2. Press Command-Shift-C. 

3. Type the text you want to center at that point. 

To center headings over the other columns on the same line, as shown 
in Figure 3.8, move to those positions by pressing the Tab key or the 
space bar. If the columns have been created by the Columns feature 
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Financial Highlights 

1986 1987 1988 

Net Sales 1,900,876 4,901,963 2.778,099 

Net Income 76,114 64,009 217,009 

Earnings per Share . 88 420 1.90 

Figure 3.8: You can also center text at the location of the insertion point, 
rather than between the left and right margins. 

instead of by tabs, use the column-centering technique described in 
the next section. 

Centering Text in Columns 

If you have turned Columns on, choosing Center or clicking the 
centering icon with the insertion point anywhere in a column centers 

text between the column’s margin settings, instead of centering it 
between the right and left margin settings. You’ll get practice in cen- 
tering text in columns in Chapter 5. 

Uncentering Text 

Unfortunately, the Center command doesn’t toggle back and 
forth, so you can’t center text and then repeat the command to 
uncenter it. When WordPerfect centers text, it inserts a [Center] or 
[ Justify:Center] code at the beginning of the text. To remove center- 
ing, you can either delete one of these codes or select the centered text 

and click one of the other justification icons (right, left, or full) on the 
Ruler line. 
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Flush Right 
Another format you’ll often use is flush right, in which text is 

aligned to end at the right margin. Figure 3.9 illustrates a common 
situation that uses the flush-right format—the address block and date 
in a business letter. 

You have two different ways to align text flush right: you can use 
the Flush Right command (it’s on the Line submenu, and 
Command-Shift-F is its shortcut) or you can click the right-justified 
icon on the Ruler line. Each method has slightly different effects. 

If you use the Flush Right command, the insertion point will move 
to the right margin, and whatever you type will be aligned on the 

right margin until you cancel the command by pressing Return. A 

pair of [Align] codes will be inserted around the text you type. 
If you click the right-justified icon on the Ruler line, all the text 

you enter from that point on in your document will be justified flush 
right, until you choose another type of justification or remove the 

[ Justify: Right] code that the program inserts. 
Try it in your practice document. 

1. Press Command-Shift-F and type September 15, 1989; then 
press Return. 

é File Edit Search Format Font Special Windows 

Doc 1: Untitled 
8800 South Hampstead 
San Mateo, CA 91123 

January 21, 1988 

lis Rhonda Wallace 
Creative Consultants 
554 Easy Street 
Menlo Park, CA 94025 

Dear Ms Wallace: 

The supplies you ordered are out of stock, but your order has been 
placed on our priority list. As soon as we receive them, they'll 
be sent to you by Express Mail. 

Thank you for your patience. 

Figure 3.9: Flush right is a common format for headings in business letters. 
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o) The [Align] codes 
generated by the 

Flush Right command 
can cause trouble when 
you edit text that’s been 
formatted flush right, just 
like the Center codes we 
discussed earlier. As you 
add words within the 
codes, text is pushed to 
the left, since the hard 

return stays in position at 
the end of the line. Some 
text that had been to the 
left of the flush-right text 
may be overwritten and 
disappear from your 
screen. 
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The date will be flush right, but after you press Return, the inser- 

tion point will move back to the left margin. 

2. Display the Ruler line (Command-R) and click the right- 

justified icon. 

3. Type 8800 South Hampstead and press Return. Then type San 
Mateo, CA 91123 and press Return. 

When you use the right-justified icon, text is right justified until 
you choose another type of justification or delete the [ Justi- 
fy:Right] code. Pressing Return doesn’t take you to the left mar- 
gin, as it does when you use the Flush Right command. 

To align text that you’ve already typed flush right, select it and 
then choose Flush Right (or press Command-Shift-F), or click the 
right-justified icon on the Ruler line. If you’ve selected only a word 
or phrase in a typed line, WordPerfect will break the line at that point 
and place the flush-right text on a line by itself. 

Removing Flush Right Codes 

Like the Center command, the Flush Right command doesn’t tog- 
gle back and forth. To delete the flush right format from your text, 
you have to delete the code that controls it—either the [Align] or the 
[ Justify:Right] code. 

Combining Centered and 
Flush-Right Formats on the Same Line 

You can combine the Center command with the Flush Right com- 
mand to format a line that includes flush-left text, centered text, and 
flush-right text. For example 

Volume |, No.2 December 4, 1988 Page 56 

The way to do this isn’t as straightforward as you would hope. 
You’d think that you could type out all the text in one line, then select 
the words that you want to have centered and flush right, and then 
format them flush right and centered. But WordPerfect inserts a hard 
return before and after text you’ve selected and formatted flush right 
and centered. 
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- Some codes can 
actually hide text 

that’s on the screen 
because of the way they 

work. Text governed by 
the Center, Tab Align, 

_and Flush Right codes 
overwrites any other text 
competing for the same 
space, so if you type text 

in front of any of these 
codes, it may disappear 
from your screen. You 
can usually bet that if you 
seem to have lost some 

text, you probably 
pressed one of the follow- 

ing key sequences by 
mistake: Command- 
Shift-C (for Center), 
-Command-Shift-F (for 
Flush Right), or 
-Command-Tab (for Tab 
Align). Open the Codes 
window and delete the 

codes if this happens to 
you. 
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Here’s how to get around the problem. You do not select and 

realign existing text. You enter the centered part of the text first, then 
the flush-left part, then the part that’s flush right: 

1. First, with the insertion point at the left margin, press 
Command-Shift-C (or choose Center) and type the text you 
want to have centered (December 4, 1988 in this example). 
Press Return to end the centering. 

You’re now on the next line, so you have to move back up. 

2. Press t to move the insertion point back to the text line and to 
the left of the first [Center] code. Type the text you want to 
have aligned with the left margin— Volume I, No. 2 in this 
example. 

3. Then move to the end of the line, past the second [Center] 
code. (If you have a numeric keypad, press 1, which is the End 
key, to move there quickly.) Press Command-Shift-F (or 
choose Flush Right) and type the text you want to have aligned 
at the right margin. 

This sequence isn’t all that easy to remember, so there’s a macro in 
Chapter 8 that will remember it for you. 

Setting Tabs 
WordPerfect’s initial default settings are for left-aligned tab stops 

at every half-inch mark on the Ruler line. You practiced using left- 
aligned and decimal tabs in the tutorial in Chapter 1. However, you 
can use seven different kinds of tabs in WordPerfect: 

e Right-justified tabs, where the right side of the text is on the 
tab stop 

e Left-justified tabs, where the left side of the text is on the tab 

stop 

e Center tabs, where the text is centered around the tab stop 

e Decimal tabs, where the decimal point in the text is on the 

tab stop 
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har If you want exact 
spacing in your 

printed document, use 
the Tab key instead of the 
space bar. With fonts that 
have proportional spac- 
ing, the width of the 
space character can vary 
from font to font. 

To check what tab 
M® settings are in effect 

at a certain point in your 
document, press 
Command-R to display 
the Ruler line. You can 
keep working with your 
document while the Ruler 
line is visible, which helps 
if you’ re setting up tables. 
When you’re ready to put 
the Ruler away, press 
Command-R again. 
(Clicking on the close box 
that looks like it’s part of 
the Ruler line actually 
closes the document 
window.) 
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e Left, right, or decimal tabs with dot leaders to the left of the 

text 

After you set tab stops, only tabs that you insert following the tab stop 

setting are affected. 

Setting Tabs with the Ruler Line 

As you saw in the tutorial in Chapter 1, you can set and change tab 
stops when the Ruler line is displayed. The four icons in the upper-left 
corner of the Ruler represent left, right, centered, and decimal tabs, and 

the three icons to the right of these represent tabs with dot leaders. 
To set a tab stop, click on the icon representing the type of tab you 

want to use. You’ll see the pointer change to a small icon for that tab. 
For example, in Figure 3.10 the pointer has changed to a decimal 
tab. Click anywhere in the Ruler line to set the tab. To remove a tab 
stop, click on it with the tab pointer in the Ruler line. 

Figure 3.11 shows the effects of setting these different kinds of tabs. 
Notice that with any type of dot leader tabs, the dots precede the text. 
When you set tab stops, WordPerfect inserts a [Tab Set] code at the 

insertion point. This code does not list the specific tab stop settings. This 

" € File Edit Search Format Font Special Windows 

SS__S_]_]-]=== Doc 1: Untitled 

Decimal tabs 

Figure 3. 10: Click on the icon for the type of tab you want ane then click in the 
Ruler line to set it. 
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Right Left Centered 234.55 
Jusitified Justified Text 44.99 

Figure 3.11: You can specify several different types of tabs in WordPerfect. 

can be confusing if you’re used to a program that displays the Ruler line 
at the place in the text where you set the tab. WordPerfect’s Ruler line is 
always at the top of the screen, but there may be several [Tab Set] codes 
in your text, marking places where the tab stop settings have been 
changed. ‘The closest one before the insertion point is the one that’s in 
effect. To see the Ruler line with the specific tab stops associated with 
that code, choose Show Codes from the Edit menu (or press Command- 
7). Then move the insertion point anywhere to the right of or below the 
[Tab Set] code and display the Ruler. 

If you want to delete the settings on a certain Ruler line, delete the 
[Tab Set] code associated with it, and the next [Tab Set] code above 
in your text will take effect. 

In addition to the [Tab Set] code that controls the location and type 
of tabs, when you press the Tab key WordPerfect inserts codes 
around the text that you type at each tab setting. The kind of codes 
inserted correspond to the type of tab stop you are at. For example, if 
you press Tab and then type text at a regular left-justified tab stop, 
you’ ll see the code [Tab] in front of the text. If you press Tab and type 
text at a right-justified tab stop, the text will have the codes 
[Align][Align] around it, and text at a centered tab stop has the codes 

[Center][Center]. If you press Tab and move to a decimal tab stop, 
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you'll see the [Align] codes, one at the beginning of the text you type 

and one at the decimal point, which is the character the text is aligned 

on. If you look carefully at Figure 3.12, which illustrates the codes for 
each kind of tab, you’ll see how the codes are being used. 

If you’re editing material that’s been previously set with tabs, you 
can get unexpected results if you aren’t careful to position the inser- 
tion point properly before you add or delete text. If you delete a for- 
mat code by mistake, your text will reformat. For this reason, it’s best 
to edit tabbed material with the Codes window open. That way, you 
can be sure you are only adding or deleting the text between the codes 

and aren’t deleting the codes that position the text. 
There’s no Cut/Copy column command for columns created with 

tabs in WordPerfect for the Macintosh. If you click at the top of such a 
column and then shift-click at its bottom, most of your table will be 
selected, as Figure 3.13 shows. (WordPerfect’s Select Column com- 
mand refers to columns that have been created with the Columns 
feature—newspaper or parallel columns, discussed in Chapter 5.) To 

revise material in tabbed columns, you’ll need to either cut or copy each 
individual entry (without its format codes) or erase the whole line (with 
Command-1 on the numeric keypad) and retype it. If you include the 
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Doc 1: tabs 

Right Left Centered 234.55 
Jusitified Justified Text 44.99 

WGetFont: Courier) GE Sed [Align>Rig ht Align] JL eft Hy) [Center>C ent ere d Center] Align 234 Giga]. 55 (HBG) 
H [Align> Jusititi e d Align] (24) J ustiie d 2%) [Center>T ext Center] [Aign> 44 Align]. 9 9 (GARG) 

| E50 [Aig Rights Cign] Align Giga ett GE Se) ED 
[Align with Alga] [Align> <@lign} with (GHG) 
HH [Align> Leaders Glign][Align> Glign]L eaders Set Font:Helvetica 

Figure 3.12: Each type of tab has its own special format code. 
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Doc 1: table 

Financial Highlights 

1937 
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Figure 3.13: You can’t highlight just one column created by tabs and cut or 
copy it. 

[Tab] codes surrounding the entries when you select and delete or move 
text, your table will reformat in ways you may not expect. 

Here are a few tips that may come in handy when you’re creating 
tables: 

e Save the table before you start to revise it. That way, if you 
make a mistake, you can get your original version back. 

e If you’re writing tables, you probably don’t want to have 
them split between pages. To prevent a table from being 
split, select the table and turn on block protection by choos- 
ing Page from the Format menu; then choose Block Protect. 
(The keyboard shortcut is Command-2 6). You can also use 
Print Preview (Command-Shift-P) to see how the pages will 
look in their final form and then add any hard page breaks 

that may be necessary. 

e A quick way to estimate the tab stops for column headings is 
to type out the column headings and then adjust the space 
between them with the space bar. If you’re displaying the 
Ruler line, you can set a tab at the space where each heading 
begins. 



104 Mastering WordPerfect on the Macintosh 

CHe3 

car Pressing Enter three 
times and then 

pressing the < key moves 
the insertion point to the 
beginning of a line, 
before any codes. Press- 
ing Enter three times and 
then pressing the t key 
moves the insertion point 
to the beginning of the 
document, before any 
codes. If you’ re inserting 
codes that manipulate a 
line, a paragraph, or a 
page, you can use these 
Enter-key sequences to 
position the insertion 
point before any other 
codes. 

e If your column entries are longer than one line, use parallel 

columns instead of columns with tabs. They’ll be much eas- 

ier to revise. See Chapter 5 to learn how to work with parallel 

columns. 

Other Kinds of Indents 

Other commands and keys besides the Tab key also create indents. 
Although they’re mentioned elsewhere, we’ll review them briefly 
here, because they also work with tab stops. When you change a tab 
stop, the amount of space by which these commands indent text also 

changes. 

e Indent (Command-Shift-T) indents text to the next tab stop 
to the right. Indenting stops when a hard return is reached— 
either when you press Return as you’re typing, or when the 

program reaches a hard return that’s in the text, if you’re 
indenting text that’s already been typed. 

e Left-Right Indent (Command-Shift-L) indents the begin- 
ning of each line one tab stop to the right and the end of each 
line one tab stop to the left. It also stops when a hard return is 
reached. 

e Margin Release (Shift-Tab) ‘‘outdents” the beginning of a 
line one tab stop to the left. If you press Command-Shift-T to 
indent the text and then press Shift-Tab for margin release, 
you will create a hanging indent, where the first line of the para- 
graph starts at the left margin and the rest of the lines in the 
paragraph are indented. Margin Release is also an option on 
the Line Format submenu. 

¢ ‘Tab Align (Command-Tab) aligns text on the decimal point 
(or on another character you specify, as will be discussed 
later). With the decimal point (period) as the alignment char- 
acter, Tab Align causes the same effect as the decimal tab. 

¢ Center (Command-Shift-C) centers text between margins if 
the insertion point is at the left margin or if a selection has 
been made in that line. 
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Figure 3.14 illustrates the effects of using these other types of 
indents. 

Setting Tabs with the Tab Format Box 

If you’re setting several tabs that are uniformly spaced or deleting 
all the tabs so that you can set new ones, you’ll probably want to use 
the Tab Format dialog box, which you get by choosing Line from the 
Format menu and then choosing Tabs. 

The Tab Format dialog box (Figure 3.15) also shows you the Ruler 
line, but that’s just so you can check the spacing. You can’t set tab 
stops by clicking on the Ruler line when the Tab Format dialog box is 
on the screen. 

Setting Uniform Tabs 

If you want to set tab stops at uniform intervals, use the Uniform 
Tabs box. 

& File Edit Search Format Font Special Windows 
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Right justified with dot leaders 

Left justified with dot leaders 
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Right justified 

Centered 

Left-justified 

Figure 3.14: You can create different indents by using some of WordPerfect’s 
other commands and keys. 
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Figure 3.15: The Tab Format dialog box allows you to manipulate all the tab 
settings at once. 

1. In the Starting Position box, type the position for the first tab 
stop. 

For example, if you wanted the tabs to start one inch from the left 
edge of the paper, you would type 1. 

2. In the Repeating Every box, type the interval you want to 
have between the tabs. 

If you wanted tabs every quarter inch across the page, you would 
type .25. 

3. Click Set to set the tab stops; then check the Ruler line to make 
sure that’s what you want. 

You don’t have to click Set; the tabs are set when you click OK. 

4. Click OK when the tabs are set as you want. 

Setting uniform tabs adds the new settings to the ones that are 
already on the Ruler line, so if that isn’t what you want, you’ll need 
to delete all the tab stops before you set new ones. 
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Deleting All Tab Stops 

‘To delete all the existing tab stops, click Delete. The Revert button 
returns you to the tab settings that were in effect before you brought 
up the Tab Format dialog box. 

Changing Tab Settings 

When you change tab stops, WordPerfect inserts a [Tab Set] code 
in your document. You can delete this code, copy it, and search for it. 

Often you’ll find that deleting one [Tab Set] code and copying 
another into its place is the fastest way to change tab settings. For 
example, suppose you’ re formatting a table and have set specific tabs 
for each of the columns. After you’ve typed the table, you want to 
return to the tab settings you were using in the text of your docu- 

ment. You can simply search backward for the previous [Tab Set] 
code, copy it, search forward to the position where you were, and 
paste the copied [Tab Set] code. 

Using Tab Align 
If you press Command-Tab instead of Tab, the insertion point moves 

to the next tab setting of whatever type and aligns whatever you type on 
the period. (You can change this character, as you'll see later.) This is a 
fast way to get a decimal tab, but if you’re using a lot of decimal tabs, 
you'll find it more convenient to set that type of tab stop on the Ruler 

line and just use the Tab key, instead of Command-Tab. 
To use Tab Align: 

1. Set whatever tab stops you want to use. 

2. Press Tab Align (Command-Tab). 

The insertion point moves to the next tab stop. 

3. Type the text. 

The text you type appears to the left of the insertion point until you 

press the period. Any text you type after that appears to the nght of 

the poe (and the tab stop). 
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If you’re using Tab 
Align, you’ll need to 

leave enough space for 
your text to the /eft of the 
insertion point. If you try 
typing text at the left 
margin, for example, it 
will disappear off the left 
of the screen. Press the 
Tab key repeatedly until 
you have enough space 
for the text you’re going 
to type; then press Tab 
Align and type the text. 

When you use Tab Align, WordPerfect inserts a pair of codes, just 
as it does when you place text flush right or center it. In this case, the 
codes are [Align][Align]. Editing text that’s been aligned can get 
very tricky because of these codes surrounding the text (Figure 3.16) 
and because new text is inserted to the left of the insertion point. You 
may want to make your corrections with the codes visible on the 
screen so that you can position the insertion point correctly. If this 
gets too tedious, just delete the line and retype it. That’s usually the 
fastest way. - 

Changing the Tab Alignment Character 

WordPerfect allows you to change the character on which tab 
aligned text normally aligns. This character is preset to be the deci- 
mal point, but you can change it to any other character, such as a dol- 
lar sign or comma, or even no character at all (a blank space). For 
example, you can align the headings in a memo on the colon, as illus- 
trated in Figure 3.16. 
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Figure 3.16: Changing the alignment character allows you to align text in for- 
mats like this one, where the colon is used as the alignment 
character. 
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Here’s how to get the format shown in Figure 3.16: 

1. Choose Tabs from the Line submenu (or press Command-4 3). 

2. Double-click in the Tab Align box; then type a colon. 

If you don’t delete the character that’s already there, you’ll have 
two alignment characters and WordPerfect will give you an error 
message until you delete one of the characters. 

3. Click OK. 

4, Press Command-Tab (Tab Align). 

Now try typing in the text that’s shown in Figure 3.16, as follows: 

1. Press Tab enough times to leave room for the headings you’re 
going to type. 

Remember, the text is going to align to the left of the insertion 

point until you type the colon. You’ll need to make enough room 
on the left for the words MEMO TO., which is eight spaces. If 
your tabs are set every five spaces, pressing Tab gives you five 

spaces, and when you press Command-Tab, you’ll get another 
five. If you were typing longer text, you’d need to press Tab 

repeatedly to get enough spaces. 

2. Press Command-Tab (Tab Align) and type the words MEMO 
TO: 

3. Press Return to move to the next line; press Tab, and then 
press Command-Tab. Then type FROM: as shown in the fig- 
ure. This time, press the space bar and then type your name as 
the sender. 

Notice that after you type the colon, anything you type is entered 

normally. 

4, Press Return and, for practice, enter the rest of the headings in 
the memo. 

Remember to press Tab before you press Command-Tab. 

Other characters you may want to use as the alignment character 

include the dollar sign ($) for financial tables or the comma for 

European-style columns of numbers in which the comma is used 

instead of the decimal point. You can also specify that the equals sign 
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Turn hyphenation 
off and write your 

document first; then go 
back and hyphenate it. 
That way you won’t be 
bothered with hyphen- 
ation dialog boxes as you 
write. When you turn 
hyphenation on, choose 
Auto Aided. WordPerfect 
follows the same set of 
rules no matter which 
option you choose, but if 
you choose Automatic, 
you may get hyphens you 

don’t approve of in your 
document. 

If you change your 
mind and want to 

hyphenate a word for 
which you cancelled 
hyphenation, delete the 
[Cncl-] code that Word- 
Perfect inserts when you 
click Cancel. 

be used as the alignment character to align equations like this: 

ax + by = cz 
BY Se? ae by: & CZ 

xy-xz = 4a + 3bx 

Hyphenating Words 
WordPerfect is preset for hyphenation to be on so that you'll get 

professional-looking documents. Ragged-right margins will be less 
ragged, and there’ll be less white space between words in right- 

justified text. 
You can choose either Automatic or Auto Aided hyphenation. Auto- 

matic is the default setting. With Automatic hyphenation, WordPerfect 
follows its built-in set of hyphenation rules and doesn’t prompt you for 
where to insert a hyphen unless it can’t figure out where to put it, as in 
an acronym, for example. If you click Auto Aided, each time the pro- 
gram needs to hyphenate a word you’ll be prompted to either confirm 
WordPerfect’s choice or move the hyphen. 

For example, in Figure 3.17 WordPerfect is asking where to place 
the hyphen in the word Letterspacing. Click on the right or left arrows 
to move to the place where you want to hyphenate the word, if you 
don’t agree with WordPerfect’s suggestion. In this example, the 
hyphen was moved to go between letter and spacing by clicking on 
the left arrow. If you don’t want to hyphenate the word at all, click 
Cancel. WordPerfect will insert a [Cncl-] code in the text. 
When WordPerfect hyphenates a word, it inserts a soft hyphen 

code in your text, which looks just like a hyphen on the screen. If you 
look in the Codes window, though, you’ll see that it’s a [Soft-] code 
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Figure 3.17: To change the position of the hyphen, click on one of the arrow 
keys. : 



6 If you import a 
3 document from 

another program, such as 
Microsoft Word or 
MacWrite, and you have 
hyphenation on, you’ll be 
asked to position each 
new hyphen. Turn 
hyphenation off before 
you import documents. 

her If you like, you can 
turn hyphenation on 

and off to hyphenate only 
in a specific section of a 
document, such as a 

three-column list. (The 
narrower the column, the 

more critical the hyphen- 

ation.) 
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(see Figure 3.18). When you edit a line of text that has a soft hyphen 
at the end, you may see the hyphenation disappear from the docu- 
ment on the screen, if the word no longer falls at the end of a line. If 
you look at the Codes window, you’ll see that the [Soft-] code is still 
there, telling WordPerfect where to break the word in case it has to 
hyphenate it again. 

If you later change your mind about where a word should be 
hyphenated, you can relocate the hyphen by moving the insertion 
point to it and pressing Delete. As long as hyphenation is still on, 
you'll be prompted again for where to insert the hyphen. 

To turn off hyphenation, Choose Line from the Format menu. 
Then click Hyphenation. When hyphenation is on, an X appears in 
the Hyphenation box. 
When you turn hyphenation on, the program inserts a [Hyph] 

code in your document. When you turn it off, it inserts another 
[Hyph] code. You can search for these codes. 

The hyphens you type by pressing the hyphen key (-) are required 
(hard) hyphens. They tell WordPerfect to type a hyphen at that point 
under any circumstances, not just at the end of a line. However, you 
can also insert a soft hyphen manually by typing Command-hyphen. 

You might, for example, want to make sure that a certain word not in 
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Figure 3. 18: When WordPerfect hyphenates, it inserts a [Soft-] code in your text. 
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Turn hyphenation 
off temporarily 

whenever you're using 

the Speller, scrolling, 
searching, or moving the 
insertion point to the 
beginning or end of the 

document. Otherwise 

you'll be constantly 
prompted to hyphenate 
words. When you’re 

finished with the opera- 
tion you’re carrying out, 
hyphenation will auto- 
matically come back on. 

= If you’re not using 
either type of auto- 

matic hyphenation, you 
still may want to indicate 
where a word should be 
broken, Don’t type a 
hyphen! Type a soft 
hyphen instead 

(Command-hyphen) so 
that if the word no longer 
needs to be broken after 
editing changes are 
made, WordPerfect won’t 
put a hyphen in it, 

WordPerfect’s rule book (such as your company name, an acronym, 
or the name of a character in the novel you’re writing) is hyphenated 
in a certain way whenever WordPerfect needs to break it between 
lines. On the screen, both types of hyphens appear the same, but in 
the Codes window, the required hyphen is slightly thicker than the 
soft hyphen. It also has a [Req-] code. Figure 3.18 shows both types 
of hyphens. 

Changing the H-Zone 

When hyphenation is on, WordPerfect uses a hyphenation zone to figure 
out whether a word should be hyphenated. Initially, this zone is preset to 
begin at the 6.75-inch mark and to end at the 7.5-inch mark on the 
Ruler line, with the nght margin also set at the 7.5-inch mark. When- 
ever you type a word that starts before and ends after the ends of the H- 
zone and hyphenation is on, WordPerfect will hyphenate it (or ask you 
to, depending on which option you’ ve chosen). If the word starts within 
the H-zone and extends beyond the right margin, the word won’t be 
hyphenated but will be wrapped to the next line. 

For example, in the first sentence in Figure 3.19 the word hyphenation 

€ File Edit Search Format Font Special Windows 
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In this sentence, WordPerfect hyphenates hyphena- 

tion because it starts before the left side of the hyphena- 

tion zone. 

In this sentence, WordPerfect doesn't hyphenate 

hyphenation, but breaks the sentence because the word 

starts after the left side of the H-zone and extends 

beyond the right side of the H-zone (the right margin). 

Figure 3.19: WordPerfect hyphenates a word if it extends beyond the H-zone 
when hyphenation is on. 



To insert a minus 
MS sign instead of a 

hyphen, press Enter 
hyphen. To insert a 
double dash, press Enter 
hyphen hyphen. For an 
em dash (the width of the 
letter M), Option-Shift- 
hyphen. For an en dash 
(the width of the letter 
N), Option-hyphen. 

Oe) Don’t set the right 
H-zone to the right 

of the right margin you’re 
using, or some lines may 
print beyond the right 
margin and characters 
may overprint. 
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would have extended beyond both sides of the hyphenation zone. 
Hyphenation is on, so WordPerfect hyphenates the word. In the second 
sentence, hyphenation does not extend over the right side of the zone, so it 
isn’t hyphenated. 

When you change the right margin, the H-zone will move with it. 

However, you may still want to change the preset H-zone accord- 

ingly. For instance, if you’re working with narrow columns— 
especially right-justified columns—you’ll want to set the left side of 
the H-zone closer to the right margin so that more words are hyphen- 

ated and fewer moved entirely out of the line. That way you’ll get 
better spacing between words or a less ragged right margin. 

On the other hand, the larger the H-zone, the more accurate Word- 

Perfect’s automatic hyphenation can be. This is because the program 
hyphenates only between those characters that occur within the H- 
zone. If your H-zone is only five characters wide, there are only four 
possible places for WordPerfect to insert the hyphen. 

To change the H-zone: 

1. Display the Ruler line by choosing Show Ruler from the For- 
mat menu (or pressing Command-R). 

2. Drag the H-zone icon on the Ruler line to make the H-zone 
larger or smaller. It’s the dark area at the top of the Ruler line. 

3. Choose Hide Ruler (or press Command-R) to hide the Ruler. 

Spacing Lines 
WordPerfect’s initial setting is for single spacing. To change line 

spacing: 

1. Choose Line from the Format menu; then choose Spacing. 

2. In the Spacing dialog box, click on either the up arrow or 

down arrow to change line spacing in increments of half lines. 

3. Press Return (or click OK). 

After you’ve changed line spacing, only the text following the place 

where you’ve made the change will be affected. A [Spacing Set:n] 

code is inserted; the n indicates the line spacing you’ ve chosen. 



114 Mastering WordPerfect on the Macintosh Se a erg MOC ere On a eee 

CH. 3 

Line Height 

Line height refers to the vertical distance between the baseline (the 

invisible line on which the text rests) of one line of text and the base- 

line of the next line of text. WordPerfect calculates appropriate line 
height automatically, depending on the font size you’re using, and 
adds a set amount of leading (extra space between lines). If you want 
the baselines of all the text in your document to be evenly spaced no 
matter how often you change fonts, specify a fixed line height by 
clicking Fixed at # Points and then typing the line height (in points) 

that you want to use. 
If you’re accustomed to working with line heights of 6 or 8 lines per 

inch and you want to know how to convert that measurement to points 
in the font and font size you’re using, click either 6 LPI or 8 LPI. 

A [LineHt:7] code is inserted when you change the line height. 

Leading 

Leading (pronounced Jedding) is the vertical distance in points 
that’s often added between lines of typeset type to make it more read- 
able. The extra space helps the eye to locate the proper line when 
moving from the right to the left margins. A common setting for lead- 
ing 1s one or two additional points that are added to the size of the font 
you are using. If you were using 12-point type, for example, you 
might want 2 points of leading, which increases the line height to 14 
points. You may see this expressed as ‘“Times 12 on 14” or “12/14 
Times,” for example. On very wide pages or with larger font sizes, 
more leading is appropriate. 

Figure 3.20 illustrates the effects of using leading and of using no 
leading at all. WordPerfect automatically adds leading in its line 
height calculation for the font you’re using, but you can specify addi- 
tional leading by selecting Line from the Format menu; then choos- 

ing Spacing. In the dialog box that appears, enter the number of 
leading points you want to add in the Leading box. For example, in 
the last example in Figure 3.20, 4 points of leading were used with 
12-point type. 

A [leading:n] code‘indicates where you’ ve specified leading. 
Chapter 5 has more examples of situations in which you’d use 

leading and line height changes. 
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WordPerfect automatically adjusts leading for you, 
but you can change it. 

These lines of type were "set solid"-- 
that is, with no leading between them. 

These lines, which are in 12-point Helvetica, 

had 4 points of leading added between them. 

Figure 3.20: Adding leading lets you create different effects in your printed 
documents. 

Kerning and Letterspacing 

Kerning and letterspacing control the spacing between characters 

of type. Choosing Kerning allows you to decrease the amount of 
space between specific letter pairs, while choosing Letterspacing 
allows you to increase the spacing between two letters. 

Each character in a font has a specific width that was built into it by 
the designer of the font. However, some character pairs, such as 70 

and WA, often look too far apart with the built-in spacing, especially 
when they are used as display type in sizes larger than 14 points. 

Kerning allows you to reduce the amount of white space between 
pairs of characters that should overlap slightly. Table 3.2 lists charac- 

ter pairs that are often kerned. 

For example, in Figure 3.21, the space between the J’and the ¢ has 

Table 3.2: Character Pairs That Are Often Kerned 
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har You may not notice 
the results of kern- 

ing on the screen if the 
amount is very small, but 
you’ ll see it in your laser- 
printed documents. 

her If your printer isn’t 
capable of propor- 

tional spacing (and the 
ImageWriters I and II 
aren’t), you can’t use 
kerning and letterspac- 
ing. They depend on the 
printer’s ability to print 
the different widths 
among the letters of the 
alphabet. The ImageWri- 
ter LQ has proportion- 
ately spaced fonts, as do 
laser printers. 

been kerned by three points. In the same figure, three points of letter- 

spacing have been added in the word SYBEX. Letterspacing is in 
vogue right now for company logos and letterheads in which charac- 

ters are spaced out to take up an entire line. 

When you use letterspacing and kerning, you indicate the number of 
points of space you want adjusted between the characters. The number 
you enter is subtracted for kerning and added for letterspacing. 

To use kerning and letterspacing: 

1. Type the text that you want to use kerning or letterspacing in. 

Usually, this is display text, larger than 14 points or so. The 
effects of kerning and letterspacing aren’t as visible at much 
smaller sizes of type. 

2. Move the insertion point to the place where you want to kern 
or add letterspacing. 

3. Choose Line from the Format menu; then choose Kerning (or 
Letterspacing). The keyboard shortcut is Command-é4 6. 

4. For less space between characters, click Kerning and enter the 
number of points you want space to decrease. For more space, 
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Before kerning: tb ed 

After kerning: Tea 

Before letterspacing: eh B EX 

} After letterspacing: ke ‘ B E X| 

Figure 3.21: Kerning allows you to decrease space between characters, while 
letterspacing adds space. 
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click Letterspacing and enter the number of points you want 
to add between the characters. 

Remember, a point is 1/72 inch. If you choose Letterspacing, Word- 
Perfect will insert the extra space between the letters that surround 
the insertion point. For Kerning, it decreases the space between the 
two characters. You’ll see more examples of kerning and letterspac- 
ing in Chapter 5. 

Looking Forward 

The techniques in this chapter have covered many ways that you 
can format characters, lines, and paragraphs of text in WordPerfect. 
You may have noticed that the Format menu also contains a Para- 

graph command that displays a submenu with options for number- 
ing paragraphs and creating outlines. These features will be 
discussed in Chapter 10. 

Chapter 4 discusses how you can apply formatting techniques to 
entire pages of text, such as using headers and footers and specifying 

that text be kept together on one page when page breaks occur. 
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Fast Track 

The Page submenu of the Format menu 
controls top and bottom margins, binding width, centering text 
vertically on the page, page numbering, headers and footers, 

suppressing combinations of formats on a specific page, page 

length and width, and methods of keeping text together on a 

page. The keyboard shortcut for viewing these options is 

Command-2. 

The Page Layout command 

(or the shortcut Command-2 1) allows you to change the top, 
bottom, right, and left margins; center text from top to bottom 

on a page; and change the binding width for documents that 

are going to be printed two-sided and bound. 

To change right and left margins, 
you can also drag margin icons on the ruler line. 

WordPerfect doesn’t automatically number pages 
unless you use the Page Numbers command. It’s on the Page 

submenu, and its shortcut is Command-2 2. You can start page 

numbering, specify the style you want (arabic or roman), start 
numbering with a new number, insert a page number automat- 

ically in your text, or change the position of the page number 
on each page. 

To create headers and footers, 

choose Headers-Footers from the Page submenu or type the 
keyboard shortcut Command-Shift-H. You can have different 
headers and footers for different parts of your document. 
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The Suppress Format command 136 
on the Page submenu lets you stop headers, footers, and page 
numbers from being printed on a specific page. 

The Conditional End of Page (EOP) command 138 
tells WordPerfect to keep a certain number of text lines together 

when a page break occurs. Its shortcut is Command-?2 5. 

The Block Protect command (Command-?2 6) 139 
tells WordPerfect not to break a block of text you’ve selected, 

such as a table. 

The Widow/Orphan command (Command-2 7) 139 
tells Wordperfect to move widows and orphans (stray single 

lines) to the next page. 



CHAPTER ] 

PAGE FORMATTING IN WORDPERFECT REFERS TO 
several options whose effects don’t usually appear on your screen as 
you type but can be seen if you choose Print Preview or print your 

document. These options are located on the Page submenu of the 

Format menu, and the keyboard shortcut for viewing them is 
Command-2. They include 

e ‘Top and bottom margins 

¢ Binding width 

¢ Centering text vertically on the page 

e Page numbering 

e Headers and footers 

¢ Suppressing combinations of formats on a specific page 

The effects of other page formatting options do appear as you type. 
They include 

e Page length and width 

¢ Methods for keeping text together on a page, such as condi- 
tional end of page breaks, widow and orphan protection, and 
block protection commands 

WordPerfect automatically breaks pages according to the top and 
bottom margin settings. These soft page breaks are represented by a 
thin line of dashes across your screen and have the code [SPg]. 
They’re adjusted as you edit your document. 

You insert page breaks manually by pressing Command-Return 
at the point where you want a page break to occur or by choosing 
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Page Break from the Page Format submenu. For example, you 
might want to end a short page at the end of one section of a report so 

that the next main topic would begin a new page. These hard page 
breaks are represented by a thick line of dashes across the screen (as 

in Figure 4.1); they have the code [HPg]. Hard page breaks will not 
change unless you delete the [HPg] code that generates them. 

To begin this chapter, open a new document so that you can prac- 
tice some of these techniques as you follow the discussion. 

& File Edit Search Format Font Special Windows 

Doc 1: Speller ch 

Before you use the Speller and Thesaurus, you 

need to tell WordPerfect where you're keeping your 

Speller and Thesaurus dictionaries. If you dor Soft page break 

this step. the program will list the files on the disk 

and you'll have to locate the WP Dictionary and open it 

each time you use the Speller. If you're using the 

Thesaurus, you'll have to find the WP Thesaurus file 

It's much simpler just to tell the program where these 

Hard page pe 
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dictionaries are or, if you have a hard disk, copy the 

Figure 4.1: Hard page breaks are inserted by you; soft page breaks are 
inserted by WordPerfect. 

Page Layout 
Choosing the Page Layout command brings up the Page Layout 

dialog box illustrated in Figure 4.2. (The keyboard shortcut for dis- 
playing this dialog box is Command-2 1.) It allows you to change the 
top, bottom, right, and left margins; center text from top to bottom 

on a page; and change the binding width for documents that are 
going to be printed on two sides and bound. 
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vr You can’t print at 

the very top of a 
page with the LaserWri- 
ter even if you set the top 
margin at 0. It will 
always give you at least a 
0.25-inch top margin. 

e) If you have already 
reset the margins for 

your document once and 
you try to do it again, 
pressing Enter three 
times and then pressing 
will place the insertion 
point before your earlier 
margin setting code, so 
the new code would have 
no effect. Go ahead and 
type in the new code, but 
make sure you delete the 
code you inserted earlier. 
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seis EME PE A ESL aoe a Some Th 

Page Layout 

Bottom[1.0 _|in. 

Right [io Jin. 

CJ Center Page Top to Bottom 

Binding Width (0 _| Inches 

Figure 4.2: The Page Layout dialog box lets you change margins and center 
text vertically on a page. 

Margins 

You’ll probably change right and left margins by dragging the 
margin icons on the ruler line, but if you use the Page Layout dialog 
box, you can change the top and bottom margins (as well as the right 
and left margins) by clicking next to the margin you want to change 
and typing in a new value. If you’re printing mailing labels or enve- 
lopes or printing on paper other than 8.5 by 11 inches, you’ll want to 
change the margins. 

The margins—all of them—are preset to one inch for 8.5 by 
11-inch paper. When you change a margin setting, it’s reflected in 

the document from the insertion point on. If you want consistent 
margins throughout a document, go to the beginning of the docu- 
ment and move the insertion point to the left margin before you reset 
margins. (Pressing Enter three times and then pressing the ¢ key will 
take you there directly.) If the insertion point isn’t on the left margin, 
WordPerfect inserts a hard return in your document, which may give 
you an unwanted extra line. 
When you change a margin setting, WordPerfect inserts a [Mar- 

gin Set] code that you can search for with the Find command, as dis- 
cussed in Chapter 2. 
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If you’re centering 
M text horizontally as 

well, as in Figure 4.3, 
select the entire block and 

center it with Command- 

Shift-C instead of center- 

ing each individual line. 
It’s faster. 

[| If you’re printing a 
document on only 

one side of the paper, just 
increase the size of the left 
margin instead of chang- 
ing the binding width. 

Margin Release 

The Margin Release key (Shift-Tab) moves the insertion point 
and any existing text one tab stop to the left. It can take you beyond 
the left margin, which is a handy way of placing paragraph numbers 
outside the left margin. Combined with the Indent command 
(Command-Shift-T), the Margin Release key lets you create hang- 
ing paragraphs, as you saw in Chapter 3. 

If you press Shift-Tab with the insertion point in the middle of the 
line, some text may disappear from your screen, because Margin 

Release works like a backtab and the text it pulls left overwrites any 
text that preceded it. If this happens, view the codes and delete the 
[< Mar Rel] code that WordPerfect inserted in your document. 

Centering Pages Top to Bottom 

The Center Page Top to Bottom option lets you center text on a 

page vertically, which is useful for cover sheets, short tables, and let- 
ters that are less than one page. You centered the letter you wrote in 
the tutorial in Chapter 1; another example of vertical centering 
appears in Figure 4.3. 
When you use this option, move to the beginning of the page, 

because the [Cntr Page] code must come before any other codes on 
that page. Then choose Page from the Format menu and Page Lay- 
out from the Page submenu (or press Command-2 1). Click in the 
Center Page Top to Bottom box, and your page will be centered ver- 

tically when you print it. 
When you center a page top to bottom, nothing will happen on 

your screen, but if you choose Print Preview from the Print Options 
submenu (or press Command-Shift-P, which is its shortcut), you’ll 
see your centered page. 

Changing Binding Width 

If you’re printing a document on both sides of the paper and bind- 

ing it, you may find that in long documents the pages in the middle 

won’t open wide enough for you to read all the text conveniently. You 

can specify that text be shifted to the right on odd-numbered (right- 

hand) pages and to the left on even-numbered (left-hand) pages so 
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Audience Response and Commercial Length 

A Report Presented to the 
Society of Professional Advertisers 

January 22, 1988 

Figure 4.3: Centering a page top to bottom is useful for title pages and short 
letters. 

that this won’t happen. It’s also useful to change the binding width if 
your document is going to be punched for a three-ring binder or 
bound with a plastic comb. | 

The binding width shifts the text away from the bound side of the 
page. On left-hand pages, the text is moved left by the amount you 



tar If you want the pages 
of your document 

numbered consecutively 
from 1 to the end, be sure 

to move to the beginning 
of your document before 

using the Page Numbers 
command. Otherwise page 
numbering will begin on 
the page where your inser- 
tion point is, or on the next 
page if the insertion point 
isn’t at the top of the page. 
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specify, and on right-hand pages, it is moved that much to the right. 
The number that you type for the binding width will be registered in 
inches unless you’re using centimeters or points as your units of mea- 
surement. 

To change the binding width, 

1. Press Command-2 1 (or choose Page Layout from the Page 
submenu). 

2. Double-click in the Binding Width box and type in the 
amount by which you want to shift the text. 

For example, type .5 to set the binding width at one- half inch. If 

both margins were set at one inch, you’ll get 1.5-inch left margins 
and .5-inch right margins on right-hand pages and .5-inch left 
margins and 1.5-inch right margins on left-hand pages. 

3. Click OK. 

There’s no code inserted in the text when you set the binding 
width, so if you want to change it or reset it to zero, use the Page Lay- 
out dialog box again. 

Using Page Numbers 
WordPerfect doesn’t automatically number pages unless you tell it 

to by using the Page Numbers command. It’s on the Page submenu, 
and its shortcut is Command-2 2. This command brings up the Page 

Numbers dialog box (Figure 4.4), where you can start page number- 
ing, specify the style you want (Arabic or Roman), start numbering 
with a new number, or change the position of the page number on 

each page. 
To start numbering pages, go to the top of the page where you 

want page numbering to start. Choose Format, then Page, then Page 
numbers. Choose a page numbering position and then click OK. 
There are eight different positions from which to choose, as you can 
see in Figure 4.4. When you click on a page number position, the No 
Page Numbering button automatically goes off. 

When you use page numbering, you’ll get two fewer lines of text 
per page than the normal number of single-spaced lines, because the 
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CEs 

If you want page 
numbers to appear in 

the same position through- 
out a document, move to 

the beginning of the docu- 
ment before you change 
the page number position 
on the ruler line. Selecting 
a page number position 
automatically turns on 
page numbering. 
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Figure 4.4: The Page Numbers dialog box lets you specify the style and posi- 
tion of page numbers. 

program subtracts one line to separate text and page numbers and 

another line for the page number itself. You won’t see page numbers 

on your screen (except in the status line), but you can check their 
position by choosing Print Preview (Command-Shift-P). 

Page numbers will normally be printed at the default margin set- 
tings (one inch from the right and left edges of 8.5 by 11-inch paper) 
or centered on 8.5 inches. Changing the margins doesn’t change the 
page number position. ‘To change the position of left, right, or cen- 
tered page numbers, drag their icons on the ruler line, as shown in 
Figure 4.5. Be sure to change the page number position settings before 
you select page numbering if you want to make sure the page num- 
bers are in the correct place on the page. 

When you’ve turned on page numbering, WordPerfect inserts a 
[Pg#:Pos] code in your document. To stop numbering pages after a 
certain point in your text, click on No Page Numbers. To stop num- 
bering pages for the whole document, find the [Pg#:Pos] code, which 
indicates that you’ve selected page numbering, and delete it. 

Here are some more tips-that may come in handy when you’re 
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" € File Edit Search Format Font Special Windows 

SS! Doc 2: untitled 
ae 

Page number position icons 

Figure 4.5: To change the position where left, right, or centered page numbers 
will appear when your document is printed, drag the page number 
icon on the ruler line. 

numbering pages: 

e Ifyou want to turn off page numbering for one page at a ttme— 
say, for a title page and a contents page—don’t turn off num- 

bering in the Page Numbering dialog box. Use the Suppress 
Format command (option 3 on this submenu) instead. 

¢ Ifyou choose Bottom Center or Top Center, page numbers will 

be centered between the margin settings. This may not be the 
exact center of the paper you’ re using if your right and left mar- 

gins are not equal in size or you have set a binding width. 

e Don’t ask for headers or footers and page numbers, because 

they may overprint. Instead, put the page number in the 
header or footer. You’! see how in the next section. 

e Ina formal report or book, front matter (title page, contents 
page, foreword, and so forth) is usually numbered in Roman 
numerals, and the body of the report is numbered in Arabic. 

You can switch styles at the beginning of the first text page. 
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isk &: 

If you want to num- 

ber pages in the 
style 5-1, 5-2, 5-3, and so 

on for the pages in Chap- 
ter 5, don’t use the New 

Number box. Instead, 

put the page number in a 

header or footer as dis- 

cussed in the next section. 

ber There are three 
page numbering 

codes that look very 
similar. The [Pg#:Pos] 
code indicates that page 
numbering is on. The 
[Pg#:n] code indicates 
where you’ve started a 
new page numbering 
system. The [Page#] code 
appears when you’ve 
inserted a current page 

number reference in your 
document, when you’ve 
clicked the Page Number 
icon in the Header/Footer 
editing window, or when 
you’ ve inserted a ~ B in 
your text. 

e Ifyou’re creating tables of contents, indexes, or lists with Word- 

Perfect’s special features, you’ll need to be aware of how they 

affect page numbering in a document. See Chapter 12. 

Beginning with a New Page Number 

If sections of a document are saved in separate files, such as chap- 

ters of a book, you may want to begin page numbering for each file 

with a specific number, so that the pages for the whole document will 
be numbered consecutively. To do this, type the number you want 
the first page of each section to begin with in the New Number box. 

You’ll see that new number on the status line, and WordPerfect will 

insert a [Page#] code in the document. 

Inserting a Page Number in Text 

You can use WordPerfect’s Insert Page Number feature to have 

the program automatically insert the number of the current page as a 
reference in your document. For example, you might want to remark 

that “‘this discussion has gone on for 5 pages’’ when you’ re on page 5. 
To insert the current page number: 

1. Choose Page from the Format menu; then choose Page Numbers. 

2. Click Insert Page Number and press Return (or click OK). 

WordPerfect inserts the number of the page you’re on and puts a 
hidden [Page#] code in the document. As you add text to your docu- 
ment or delete text so that it repaginates, this number will change. 

Creating Headers and Footers 
You create headers—text that appears at the tops of pages—and 

footers—text that appears at the bottoms of pages—by choosing 
Headers-Footers from the Page submenu or by typing the keyboard 
shortcut Command-Shift-H. A Header/Footer Specification box 
appears, as shown in Figure 4.6. Headers and footers can contain 
such items as the date, the page number, a chapter title, or a mes- 
sage such as ‘‘Confidential.”’ 



(+| If you’re using 
M@ headers and footers 

in a document and you 
change the left or right 
margin settings, the new 
margin settings won’t 
automatically take effect 
in the headers and foot- 
ers. To make sure that a 
document with headers 
and footers has consistent 
margin settings, go to the 
beginning of the docu- 
ment and do a word 
count through the Speller 
(Command-E 6). 
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$ file Edit Search Format Fort Special Wiatouws 

Doc 3: Untitled p 

Header/Footer Specification 

Type Occurrence 

@ Header A © Discontinue 

© Header B @ All Pages 

© Footer Aa © Odd Pages 

© Footer B © Even Pages 

Figure 4.6: The Header/Footer Specification box lets you select which kinds of 
headers and footers you want to use. 

A header is printed starting at the top margin with one line of space 

added to separate it from the main text. A footer is printed with the 
last line at the bottom margin, working upward, with one line of 

space added to separate it from the main text. You won’t see headers 

and footers in your document, but you can press Command-Shift-P 

to see them (or choose Print Preview from the Print Options 
submenu). 

You can have two different headers (Header A and B) as well as 
two different footers (Footer A and B). They can all be on the same 
page as long as you specify different locations for them, as has been 
done in Figure 4.7, where the B headers and footers were preceded 
by the Flush Right command. 

You can also use different headers for left and right pages. For 
example, you might want the title of a book as Header A on left-hand 
pages and the chapter title as the Header B on right-hand pages. In 
Figure 4.7, Header A Even is SYBEX Manuscnpt, Header B Even is 
the date, Footer A Even is the word Page and the page number, and 
Footer B Even is the word Confidential. Header A Odd is the phrase 7o 
Production, Header B Odd is Editorial Document, Footer A Odd is Internal 
Document, and Footer B Odd is the word Page and its number. 
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takes up much less horizontal space on a line than an m, for example. A 
nonospaced font is like typewriter type: each character occupies exactly the same 

Amount of space, You'll probably find that proportionally spaced fonts produce the 
most pleasing results in printed text. However, if you're using columns of text or 
numbers and want them to line up exactly with each other, you may want to switch 
to a monospaced font. Apple's monospaced fonts are Monaco on the ImageWriter 
and Courier on the LaserWriter, 

Using Other Fonts 

As you probably already know, a huge range of fonts are available for the 
Maciniest-not ist ie fons inal care with your Mac, but also fonts from other 

rers, Once you've installed any of these fonts in your System file, they're 

To Production Editorial Document 

When you change fonts in WordPerfect, the program inserts wo (Set Font} 
codes in your document: the first one (to the left of the insertion point) changes the 
text t.the new font, and the second code (to the right of the insertion poind) is the 
code for the font you were using before you changed fonts. Figure 33 illustrates 
section of text where the font has been switched from Courier to Stuttgart. As you 
can see, all the text that was typed after Stuttgart was selected is in Stuligart; text 
that's located to the right of the Courier code is still in Courier, 

Tip: to change back quickly to the font you were using, press the ~RA key and 
keep typing. The insertion point will skip over the [Font Changel code that 
puts you back in your original font 

You tam use WordPerfect’s search and replace commands to search for [Font] codes, 

ble to you in WordPerfect, Because the subject of installing fonts can get quite 
ve, depending on what kindlefpantingiyou want fa.do, it's diecussed in the automatically with other codes, but you can delete them all by leaving the Printing chapter rather than here. This chapler discusses only Kow you éan change ata Hagieivac actus sie ucxcrie a Ban nlncfoRt codes es emsaineelin 

fonts and character styles, not how you install them or why you would want to, See Baers 
the Printing chapter for that 

Changing Font Sizes Changing Character Styles eae 
WordPerfect gives you two ways to change the size of the characters in your 

document: you can use the Characters dialog box (Command-5) or the Font menu 
Using the Font menu is the fastest way, if all you're changing is the size 

In WordPerfect, style refers to bold, underline, italic, outline, shadow, or 
plain~or any combination of those styles, You can have bold italic outline shadow 
characters if you like. WordPerfect also provides superscripts and subscripts, 
overstrike, and strikeout and redline styles, 

All of these character formats are represented on WordPerfect’s Font menu. 
(Command-¥ takes you directly to the Style submenu). In addition, a series of boxes 
on the status line at the bottom of the screen let you quickly pick the basic styles~ 
plain, bold, underline, italic, outline, and shadow~by clicking with the mouse. Each 
of these styles also has its own keyboard shortcut~Command-Shift-B for bold, 
Command-Shift-I for italic, and so on, And true to the Macintosh tradition of giving 
you several ways to do almost everything, you can also select Characters... from the 
Format menu or press Command-5 to change character styles. 

If you're changing several of the basic styles and staying in the same font—for 
example, changing @ word to bold underline~click the boxes on the status line or use 
the keyboard shortcuts. But if you're changing font and/or size and style, Command- 
5 is fastest. It brings up the dialog box shown in Figure 3.2, which lets you change 
several things at once. 

Tip: Using the Characters dialog box lets you specify a font size that’s not 
listed on the menu, but you may not be pleased with the he 
Macintosh has to create sizes that aren't listed on the mei 
print before you get too creative. You can specify a size up to 
huge) 

To change the size of text you've already typed, select the text and then choose 
the new point size. To switch to a different size as you type, just choose the new size 

When you change the font size, the program inserts two (Font Size:} codes in 
your text around the insertion point, as shown in Figure 3.4. The code on the right 
of the insertion point changes the font size back to the one you were using before 
you made the change. 

The WordPerfect documentation tells you that to change back to your original 
size you can delete the new code, but in practice it's simpler just to choose whatever 
size you want from the menus and dialog boxes as you go along. You'll usually 
want to delete the codes only if you're using macros to change sizes throughout a 
long document, for example, or if you're getting strange results on the screen and 

Changing Fonts 

To change to a different font as you type, simply choose a new font from one 

tae 

Confidential 
Internal Document 

BSE 

Figure 4.7: You can use alternating headers and footers on opposite pages. 

WordPerfect automatically leaves one blank line between headers 

and footers and the text of your document, but you may want more 
white space than this on a crowded page. If so, press Return at the 
end of a header definition or at the beginning of a footer definition to 
add another blank line. 

In general, here’s how to create a header or footer. You’ll practice 
creating one on your own in the next section. 

If you’re using two 
headers or footers 

on the same page, be sure 
to press Command-Shift- 
F at the beginning of one 
of them to position it 

flush right, or insert a 
blank line before one to 
print it on a different line 
from the other. Other- 
wise, they may overprint. 1. Move to the beginning of the page where you want the first 

header or footer to appear. 

If the [Hdr/Ftr] code isn’t at the very top of the page, the header 
won’t print. You can search backward with Command-B to 
move up to the [SPg] or [HP] code. If you use many different 
headers and footers, a macro that takes you to the top of the page 
will be helpful. There’s one in Chapter 8. 

If you’re using 
MM headers in a docu- 

ment, the [Hdr/Ftr] code 
must be the first thing on 
the page so that the 
header will print as the 
first line. To make sure 
the code remains at the 
top of the page if you add 
or delete text, put a hard 
page break just before it. 

2. Choose Page from the Format menu; then choose Headers- 
Footers (or press Command-Shift-H) to bring up the Header/ 
Footer Specification box. | 

3. Click on a Header/F rates type; then pick either All Pages, 



(| If your headers for 
MS even-numbered 

pages aren’t being 
printed out, try inserting 
the even-page header and 
footer codes at the begin- 
ning of the second page in 
your document. Put the 
odd ones at the beginning 
of the first page. 
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Odd Pages, or Even Pages from the Occurrence box. Then 
press Return. 

If you want one header (Header A) on all pages throughout your 
document, just press Return (or click New). 

4. Type the text of the header or footer. 

‘Text for headers and footers can be as long as you like (up to one 
page, of course) because WordPerfect subtracts text lines from 
your document to make room for them. If a footer is longer than 
one line, the last line sits on the bottom margin. 

5. Click on the Close box (or press Command-K) to close the 
header/footer window. 

If you open a header/footer window and close it without adding 

any text, a [Hdr/Ftr] code and [HPg] code will still be inserted into 
your text. Choose Show Codes and delete these codes so that you 
don’t get an extra line of blank space. Or use Command-. (Cancel) to 
cancel the header or footer instead of closing the window. 

Formatting Headers and Footers 

You can insert format codes for centering and flush right in head- 

ers and footers. You can also mix different fonts and styles, insert 

graphics (a small company logo, perhaps), change margins, and 
change line spacing. 

To have the page number in a header or footer, click on the # icon 
at the bottom of the window in the text of the header or footer where 

you want the page number to appear. 
Using formatting commands in headers and footers can create 

strange results if you don’t use the codes carefully. You may want to 
keep the Codes window open as you’re writing and formatting a 

header or footer. For example, to create a footer like the one in Figure 
4.8, in which the company name is flush left, the word Page and the 

page number are centered, and the date is flush right, take the follow- 

ing steps in your sample document: 

1. Press Command-Shift-H to bring up the Header/Footer Speci- 

fication box. 
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Figure 4.8: By inserting a sequence of formatting and function codes, you can 
create footers like this one. 

2. Click Footer A for the footer to appear on every page; then 
press Return. 

You need to insert your centered text first; otherwise it will over- 
write the other text on the line. 



Headers and footers 
usually look better on 

a page if they’re ina 
smaller type size than your 
main text. You can also 
use an italic or bold style 
for them. Be sure to put 
any font, size, or style 
changes at the beginning of 
the header or footer, in the 

header/footer window. 

her You can use the 
Speller and Thesau- 

rus while you’re writing 
or editing a header or 
footer. Also, when you 
run the Speller for your 
document, it will auto- 

matically check the text of 
your headers and footers. 
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3. Choose Line from the Format menu; then choose Center (or 
press Command-Shift-C) to center the page number. 

4. Type Page and press the space bar to add a space between the 
word and the page number; then click on the # box to indicate 
that the current page number should be inserted in the footer. 

Next, you’ll insert the text that’s to be flush right. 

5. Press the > key to move the insertion point past the second 
[Center] code. 

6. Choose Line from the Format menu; then choose Flush Right. 

7. Choose Date from the Special menu; then choose Insert Text. 

If you click on the clock to insert the date function or choose Date 
Function, an extra line will be added to your footer. 

8. Press Enter twice; then press the < key to move to the begin- 
ning of the line. Type SYBEX, which will remain flush left. 

9. Click on the close box or press Command-K to close the 
Header/Footer Specification box. 

You can print your sample document or just choose Print Preview 
to see how it will look. 

Editing, Suppressing, 
and Deleting Headers and Footers 

If you want to change the text of a header or footer, you’ll need to locate 
the [Hdr/Ftr] code that generates it. WordPerfect will find the code 
located before the insertion point when you click Edit in the Header/ 
Footer Specification box. If you’re at the beginning of the document 
when you click Edit, it finds the first [Hdr/Ftr] code in the document. If 
that’s not the header or footer you want, you can search for other [Hdr/ 
Ftr] codes. The Codes window displays the first 50 characters of headers 

and footers, so you can see if WordPerfect has found the header or footer 

you ’re looking for. 
To edit a header or footer, 

1. Press Command-Shift-H to bring up the Header/Footer Speci- 
fication box. ; 
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2. Click on the header or footer you want to edit (A or B). 

3. Click Edit. 

You’ll see the text of the closest header or footer above the inser- 

tion point, since WordPerfect searches backward and locates the 

nearest header or footer. 

4, Change the text of the header or footer; then close the Header/ 

Footer Specification box. 

To discontinue a header or footer so that it won’t be printed after a 

certain point in the document, click Discontinue in the Occurrence box. 
You can have different headers and footers for different parts of 

your document. Just move the insertion point to the page where you 

want the new header or footer to begin and press Command-Shift-H 
again. (Remember to go to the beginning of the page if you’re writ- 
ing a header.) You don’t have to discontinue the old header or footer; 
simply create a new one. 

To delete a header or footer that you no longer want, locate its code 

(you can search for it) and delete it. 
If you don’t want a header or footer to appear on a certain page, 

you can suppress it, as discussed in the next section. 

—_. Suppressing Page Formats 
The Suppress Format command on the Page submenu of the For- 

mat menu lets you temporarily stop headers, footers, and page num- 

bers from being printed on a single page. You may want to turn off 
these items for a title page or on the first page of a business letter, for 

example. If you’ve turned on page numbering, you can also use this 
command to specify that the page number be placed at the bottom 
center of this page, rather than at its usual position. 

To use this feature: 

1. Move to the top of the page on which you want to prevent a 
header, footer, or page number from printing. 

2. Press Command-2 3 (or choose Page from the Format menu; 
then choose Suppress Format). 

You’ll see the dialog box shown in Figure 4.9. 



If you want to sup- 
MS press headers, foot- 

ers, and page numbers 
from printing on the first 
page of a document, such 
as the cover sheet, go 
ahead and define them at 
the top of the first page 
anyway. Then immediately 
suppress them for that 
page. That way, you’ll be 
sure that the codes for the 
headers and footers are at 
the nght place in the 
document and won’t get 
accidentally moved when 
you edit. 
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Doc 3: Untitled 

Suppress Page Format 

For This Page Only 

CL Place Page Number | ¢ 

at Bottom Center 

(J Page Numbers 

(] Header a 

CJ Header B 

[] Footer Aa 

L] Footer B 

Figure 4.9: The Suppress Page Format dialog box allows you to temporarily 
stop headers, footers, or page numbers from being printed. 

3. Click the features you don’t want to have printed on this page. 

Clicking All turns off page numbers, headers, and footers. Click- 
ing Page Number at Bottom Center applies to page numbers that 

are being inserted with the page numbering feature, not page 
numbers that are indicated in headers, footers, or text by the 
Insert Page Number feature. 

A [Suppress:n] code is inserted in your document. The n is the 
code for the format or formats you’ve suppressed. 

Keeping Text Together 
When you check a document before printing, you’ll usually find 

several page breaks that aren’t quite as you want them. Headings 

may appear at the bottom of the page, for example, separated from 

their text. Tables may be split between pages. The first line of a para- 

graph may appear by itself at the bottom of a page (called a widow) or 

the last line of a paragraph may appear on the first line of a new page 

(an orphan). WordPerfect gives you three different ways to protect 

your document against bad page breaks and keep relevant text 
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together on the same page. All are on the Page submenu of the For- 

mat menu: 

e The Conditional End of Page (EOP) command tells Word- 

Perfect to keep a specified number of text lines together when 

a page break occurs. Its shortcut is Command-2 5. 

° The Block Protect command (Command-? 6) tells WordPer- 

fect not to break a block of text you have selected, such as a 

table. This command is dimmed unless you have selected 

some text. 

e The Widow/Orphan command (Command-2 7) tells Word- 

Perfect to move widows to the next page and also to move the 
next-to-last line of a paragraph to the next page to prevent 

orphans. 

Conditional EOP 

= hace oe text With the Conditional EOP command, you specify how many lines 

SOE Bees: wae nite of text should be kept together so that they won’t be split between 

ditional EOP instead of pages if a page break occurs. 
inserting a hard page 

break. Using Conditional 1. Move the insertion point above the lines that should be kept 
EOP won’t create a short hy 
page in your document together. 
unless it is necessary, 2 eee . Press Command-2 5 (or choose Page from the Format menu; 
whereas inserting a hard : 
page break can cause a then choose Conditional EOP). 
very short page even if : . ee hoc 3. Enter the number of lines you want to have kept together if a 
enough space on that page break would otherwise occur between them. 

page for the lines you 
wanted to keep together. 

WordPerfect will break the page before the lines if necessary. 

4, If you want to keep a certain number of inches of text together 
instead of a certain number of lines, click the Inches button 

and enter the number of inches of text to keep together. 

If you’ve changed the default unit of measurement to points or 
centimeters, you'll see a button for points or centimeters instead 
of inches. 

5. Press Return (or click OK). 

A [ConditionalEOP] code will be inserted in your document. 



If you want to keep 
paragraphs of three 

lines or less together, use 
Block Protect. Use Con- 
ditional End of Page for 
section headings to keep 
the heading together with 
the first two text lines that 
follow it. 

If you copy or cut 
the block you’ve 

protected, be sure to copy 
or cut the [Protect] codes, 
or the block may get 
broken between pages in 
the new location. It’s easy 
to forget this if you’re 
moving protected tables. 

Bai If you set a docu- 
= ment’s format with 

a macro, you can include 
the Widow-Orphan 
command in it. 
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Block Protection 

The Block Protect command lets you prevent a selected block of 
text from being broken when page breaks occur. The main reason to 

use it instead of Conditional EOP is that you can edit the text in the 
block freely and still be assured that it will always be printed on the 
same page. With Conditional EOP, only the number of lines you’ ve 
specified will be kept together. 

To protect a block of text, such as a table, from being broken 

between pages: 

1. Select the text you want to keep together. 

2. Choose Page from the Format menu; then choose Block Pro- 
tect (or press Command-2 6). 

3. Click anywhere in the document to turn off Select. 

You won’t see anything appear on the screen, but if you choose 
Show Codes, you'll see that WordPerfect has inserted [Protect] 
codes around the block you selected. If there’s a [Protect] code 
anywhere in a line, that whole line is protected. If you add text 

between the [Protect] codes, it will be protected also. 

Avoiding Widows and Orphans 

Widow/Orphan protection is not automatically on when you start 
WordPerfect. It’s a good idea to turn it on at the beginning of a docu- 
ment so that you get professional-looking page breaks with no stray 

single lines at the beginnings or ends of pages (orphans and widows, 

respectively). 
To turn on Widow/Orphan protection: 

1. Move to the beginning of the document (or to the place where 
you want the feature to take effect). 

You can turn this feature off and on as many times as you like ina 

document, but you might as well leave it on throughout the 

entire document. 

2. Press Command-2 7 (or choose Page from the Format menu; 

then choose Widow-Orphan). 
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You won’t see anything new on the screen, but a [W/O] code will 

be inserted to instruct WordPerfect to paginate the document so that 

the first line of any paragraph won’t appear on the last line of page. 

Also, the last line of any paragraph won’t appear by itself as the first 

line of anew page. To do this, WordPerfect places page breaks above 

any paragraph that would otherwise be widowed or orphaned. You 

may get pages that are occasionally short one or two lines, so if hav- 

ing all pages the same length is important, don’t use this feature. 

—_-~S- Looking Forward 

This chapter has shown you how to use some fairly sophisticated 

behind-the-scenes commands that can help you produce 

professional-looking pages. You’ve seen how to specify special mar- 

gins for printing, use different page numbering systems, suppress 

certain elements from being printed, work with headers and footers, 

and specify that text not be broken between pages. 
Chapter 5 will continue to explore some advanced formatting tech- 

niques you can use in your documents, such as combining columns 

of text with graphics. 
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Fast Track 

To format text longer than one line into columns, 145 

use WordPerfect’s Columns feature instead of setting tabs. 

As many as 24 columns can be on a page, 145 

and they can be either newspaper columns or parallel columns. 

Different types of columns can be on the same page, 146 

so you can begin a page in a one-column format, switch to two 

or three columns, and change back to one column if you like. 

To define newspaper columns, 147 

use the Ruler (drag the Column Definition icon) or choose 

Column Options from the Format menu’s Columns submenu. 

To create parallel columns, 149 

choose Column Options from the Columns submenu. 

WordPerfect calculates evenly spaced columns 149 

for you, but if you want columns of unequal width, you’ll need 

to calculate their margin settings. 

To turn columns on 152 

after they’re defined, select Columns On from the Columns 

submenu or press Command-Shift-K. 

If you’re using newspaper columns, 154 

you can retrieve, reformat, or paste text you’ ve already typed, 

to fit it into the columns. 
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Insert graphics in your document 165 

by pasting them from the Clipboard or Scrapbook. You can 
resize, copy, or cut a graphic image. 

To capture your readers’ attention 172 
and draw them to the text, use one main visual element like a 

main headline or graphic image. You can then have many sec- 

ondary or lesser design elements. 

To save time and produce professional-looking results, 173 

use a grid or layout system and follow a few basic rules when 

you plan your documents. 



CHAPTER 5 

EVEN THE SIMPLEST OF COLUMN DESIGNS CAN MAKE 

your documents look more professional, and by combining text and 

graphics you can produce some outstanding results with your Macin- 

tosh and WordPerfect. You can create brochures, catalogs, news- 

letters, business forms, menus, and magazine layouts. Even if you 

don’t use columns of text, you’ll find that using graphics can make 

even routine reports stand out, as in Figure 5.1. The examples you'll 

see in this chapter were created easily—so easily that I couldn’t quite 

believe it until they rolled out of the LaserWriter. 

WordPerfect as a word processor actually offers more features than 

many desktop publishing programs that are available today. For 
example, it has automatic headers and footers, easily insertable drop 

caps and bullets, parallel columns that keep text together horizontally 
on the page, footnotes and endnotes, and automatic section number- 

ing and page referencing. What you see on the screen is what you get 

on the printed page, so you can format as you write. You don’t have 

to create text and then import it into another desktop publishing pro- 
gram and format it there. 
A complete course in desktop publishing, including design theory 

and graphics preparation, is well beyond the scope of this book, so 
what you’ll get in this chapter—in addition to the basic techniques 
you use to create columns—is a lot of practical tips and techniques 
that you can use in your own documents. You’ll have to look else- 
where for theory; here you'll find the tricks. 

The graphics examples in this chapter were mainly taken from 
various clip-art collections, whose sources are listed. If you see some- 
thing you like, you can find the manufacturer’s address and phone 
number listed at the end of the chapter. 

4’ 
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Memo to: Jane Randall 
From: Dan Zamczyk 
Date: August 24, 1988 
Subject: Market Share 

Jane, we're having difficulty in penetrating the cost-conscious market in 
the Northwest, and it can't all be due to the blue-and-orange packaging 
we're test marketing there. 

Our latest results produced the following analysis: 

Levisons All others 

yy
 

iy (ay) 
Wyyy 
Yi. 

(ify Se 
CLA 

% Procker end Dort 

25% 

As you can see, our market share is only 18 percent. Our major 
copmpetitor, Levisons, has a quarter of the market, and their major 
competitor, Procker and Dort, have a 23 percent share. Between the two 
of them, they dominate almost half the market. When you consider the 34 
percent controlled by other vendors, it looks like that market's going to 
be a hard one to crack. 

What we need is some really creative thinking to reposition our product 
in the consumer's mind. Got any ideas? 

Let's meet Wednesday at i0. 

Figure 5.1: Using graphics even in simple documents can add a new dimen- 

sion to your presentation. 

Creating Text Columns 

Whenever you need to format text that’s longer than one line into 

columns, use WordPerfect’s Columns feature instead of setting tabs. 

You can have as many as 24 columns on a page, and they can be 
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tor You’ll probably find 
it easier to separate 

the tasks of entering text 
and formatting it. With 
newspaper columns, it’s 
often faster and more 
convenient to format text 
you’ve already entered, 
especially in complex 
page layouts. 

If you want columns 
mm that are wider than 

the margins of the text 
you’ve been typing, 
change the margins 
before you define the 

columns. 

either newspaper columns or parallel columns. Use parallel columns 

when you want the material in the columns to stay grouped side by 

side on the same page, as in scripts, where stage directions are in the 

left column and dialog is on the right, or in name-and-address lists. 

Use newspaper columns (also called winding or snaking columns) when it 

doesn’t matter how the material in one column lines up with the mate- 

rial in the column next to it—whenever the material reaches the end of a 

column, the continuation is wrapped to the top of the next column. 

You can mix different types of columns on the same page, so you 

can begin a page in a one-column format, switch to two or three 

columns, and change back to one column. In fact, you can set up 

some very sophisticated page layouts, as you’ll see later. 

No matter what type of columns you use or how many, the way 

you create them is similar: 

1. Define the columns. 

If you want newspaper columns, you can define them by using 

the Ruler or by choosing Column Options from the Columns 

submenu of the Format menu. If you want parallel columns, you 

need to choose Column Options. WordPerfect automatically 

turns columns on when you define them. 

2. Insert the text that’s to be in the columns. 

If you’re using newspaper columns, you can retrieve, paste, or 

reformat text you’ve already typed. 

3. To return to a one-column format, turn off Columns by select- 
ing Columns Off (or pressing Command-Shift-K). 

There can be more than one column definition code in a docu- 
ment. For example, you may want to use two parallel columns at one 
place in a document and three newspaper columns in another. Word- 
Perfect follows whichever code is closest before the insertion point. 
You can search for a [ColDef] code and copy it to use again in another 
place in your document. 

The [ColDef] code doesn’t indicate which type of column it 
defines. You’ll need to keep track of which code is which if you have 
several different types:of columns in one document. You can define 
columns at the beginning of your document and then turn them off 
and on as needed. 



With the Column 
Options dialog box 

WordPerfect can auto- 
matically calculate mar- 
gin settings for equally 
spaced columns, so you 

may find it helpful for 
newspaper columns that 
you want equally spaced. 
Otherwise, the ruler line 

is faster for defining 
newspaper columns. 

No matter which 
type of column 

you’ re defining, Word- 
Perfect calculates 
columns according to the 
print area of the printer 
you’ve selected with the 

Chooser. When you 
define columns, make 

sure the printer you’ve 
selected is the one you’ re 

going to use. 

More than four 

columns on an 8.5 

by 11-inch page are hard 
to read, unless you’re 
working with very narrow 
columns, like index 

entries. 
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Newspaper Columns 

Use newspaper columns in brochures or newsletters where text flows 
down one column, to the top of the next column, and so on to the top of 

the next page. When you add text to newspaper columns, the following 

text is automatically pushed down and to the right—even to the next 
page, if necessary—so they’re easy to revise. 

You can set up newspaper columns either by using the Ruler or by 
using the Column Options command. As the procedure for the Column 
Options command is basically the same for both newspaper and parallel 
columns, we’ll cover using the Ruler for newspaper columns and dis- 
cuss using Column Options in connection with parallel columns. 

Setting up Newspaper Columns with the Ruler Line 

To set up newspaper-style columns by using the Ruler line, click 

on the Column Definition icon. Notice the pointer becomes a 

Columns pointer with two outward-pointing arrowheads. Then sim- 

ply click on the Ruler at the points where you want the columns’ 
margins to break. Each place where you click becomes the midpoint 

of a 0.25-inch ‘“‘alley’’ separating two columns. You can set up as 
many as 24 columns this way. You’ll see shaded areas on the Ruler 

that indicate where the columns are, as Figure 5.2 illustrates. 

When you’ve set up the columns as you want them, click on the 
Columns On icon. You can then start typing text in columns. 

When you enter text in newspaper columns and you reach the bot- 

tom of a page, WordPerfect wraps the text to the top of the next 
column. A [SPg] code is inserted at the end of each column, as illus- 
trated in Figure 5.3. To break a column before the end of the page, 
press Command-Return. This inserts a page-break code. However, 

in a column, this code merely breaks the column and moves you to 
the top of the next one, as you’ll see in a later practice session. In this 
context, the [HPg] code can be called a column break. 

To reformat an existing document into newspaper columns 

quickly, place the insertion point above the text you want to refor- 
mat, display the Ruler and click on the Column Definition icon (the 
one with two arrowheads). Click on the Ruler line where you want 
the column margins to be; then click the Columns On/Off icon (the 
two-column one). Your document will instantly reformat into 
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Figure 5.2: To set up newspaper columns quickly, use the Ruler line. 
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Doc 1: Scandalous trireme 

arrangement, intervals by long withdrew, leaving 
OAR LENGTH inves- tigators ropes. her prey yul- 
The Greek trireme __ were first stymied nerable to 
used three as to how many INCREASING following battle 
different lengths rowers could be SPEED vessels. 
of oars, operated packed within To increase the 
by teams of such a small speed of the As often as not, 
rowers seated on space. yessel, square the trireme would 
oar banks. Over sails were used, put into shore and 
150 of these However, the but these were collect her sails, 

re] 
rowers seal edoon (4sR8) 

oardbanks Over (gsat) 

[iS0sofsthese(S?s) <—————— End of column 

rowers were (4sRh) 

require détodpropel(gsat) 

adtrireme, dwhich(4S8} 

Figure 5.3: WordPerfect inserts soft page break codes to end newspaper 
columns. oa 

columns. To change it back or to a different number of columns, click 
on the Revert icon (the X). 



bar You can’t define 

columns when 

columns are on. Turn 

them off first by pressing 
Command-Shift-K. 
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Parallel Columns 

‘To set up parallel columns, you’ll need to use the Column Options 
command. (Newspaper columns can also be set up with this com- 
mand, but it’s usually faster to use the ruler line.) 
When you specify parallel columns, WordPerfect uses block pro- 

tection codes to keep the parallel groups of text together, as Figure 5.4 
shows. The [Picture] code that generates the ball is in the left column, 
and you can see the [Protect] code that WordPerfect inserts whenever 
you press Command-Return to place the [HPg] code that ends the 
column. Just like newspaper columns, pressing Command-Return 
in parallel columns also ends one column and begins the next, but in 
this case the horizontal group of columns is kept together, as you’ll 
see in some practice exercises later. 

Evenly Spaced Columns 

To set up evenly spaced columns, 

1. Choose Columns from the Format menu, then choose Column 

Options. 

(dee SRG. ASUS IRB eR ES TM ea i pe ee Tete 

Built of rugged American cowhide, this 
sturdy basketball will give years of hard 
usage. Meade to the standerds of the 
American Basketball Association, this 
standard -sized ball is discounted in lots of 
10 to 20 dozen, 

Basketball, cat.no. 17701 

1-10 doz, $40.95 @; 10-20 doz, $35.95@ 

Shipping weight 91b., 4 oz. 

Pg1 Col 1 Ln7 

Cicture)ll Protect] Ha) <————. End of column 

Setfont Bookman) Built oof oruggedoAmericanocowhide, Othis 

Figure 5.4: Codes for parallel columns are block protection codes. 
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You’ll see the Column Options dialog box, illustrated in Figure 5.5. 

2. Click Parallel if you want parallel columns. The default setting 

is for newspaper columns. 

3. In the Number of Columns box, enter the number of columns 

you want. a 

The default is two. How many columns do you need? Keep in 

mind that it can be hard to read the text in columns that are too 

wide or too narrow. Of course; the more columns you use, the 

narrower each one will be. 

If you want two newspaper columns that are a quarter of an 

inch apart on a standard page, just click Evenly Spaced Columns 

and press Return. 

4, If you want to change the amount of space between columns 

(0.25 inch is the default setting), enter the space you want in 

the Space Between Columns box. 

5. Click Evenly Spaced Columns. 

@ file Edit Search Format Fort Special Wintouss 

Column Options 

Spacing Type 

Number of Columns (2-24) © Newspaper 

Space Between Columns in. O Parallel 

Evenly Spaced Columns 

Column Margins (In Inches) 
Left Right 

] Columns On 

Left Right Left Right 

9: 

10. 

11. 

12. 

13. 

14. 

15. 

‘16. SN ANRUN> 

Figure 5.5: The Column Options dialog box allows you to set up as many as 
24 columns per page. ~ 



- Before you define 
columns for a page 

other than 8.5 by 11, use 
the Page Setup command 
on the Print Options 
submenu of the File 
menu to indicate which 
paper size you’ll be 
using. WordPerfect can 
automatically calculate 
column settings for any of 
the page sizes listed there. 
If you want to print 
sideways on the page, be 
sure to click the orienta- 
tion icon in the Print 
dialog box so that the 
program can calculate the 
right margin settings for 
your columns. 

ber You’ll need one 

fewer between- 

column alley than the 
number of columns 

you’re using. 

For ease of reading, 

a narrow column 

should have at least four 

words per line. On the 

other hand, a column’s 

width shouldn’t be more 
than would be required to 
print two and a half 
alphabets in that font. 
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WordPerfect automatically calculates the margin settings. 

6. Press Return. 

If you don’t want the text you type next to be in the column for- 
mat you just specified, click the Columns On box, removing the 
X from it, before you leave the Column Options dialog box. Oth- 
erwise, WordPerfect will turn on columns for you. ‘‘Col’’ 
appears on the status line when columns are on. 

Unequal Columns 

If you want columns of unequal width, you’ll need to calculate the 

margin settings yourself and enter then in the Left and Right 
Column Margins boxes. (Press Tab to move between the boxes.) 
Remember, you have 6.5 inches to work with on a standard 8.5 by 
11-inch page with one-inch margins. 

First, calculate the amount of space you want to have between 

columns (the alleys). For example, if you’re using three columns that 
are spaced 0.25 inch apart, you’ll need to allow 0.5 inch for the spac- 

ing between columns, leaving 6 inches to work with. 

Now allocate the space available to the various columns. Out of six 
available inches, four example, you could create one 1-inch, one 2- 
inch, and one 3-inch column. To create them in that order, you 
would set margins at 1.0 and 2.0, 2.25 and 4.25, and 4.5 and 7.5 

inches. Table 5.1 lists some suggested settings for unequally spaced 

columns. You can use these for both newspaper and parallel columns. 
If you enter margin settings that would create overlapping mar- 

gins or extend beyond the page margins, you’ll get an ‘‘Error”’ in the 

appropriate box when you click OK. Check your calculations and 
enter another number. 

If you’d rather ‘“‘eyeball’’ than calculate, use the Ruler line as 
though you were setting newspaper columns. Choose Show Position 
from the Screen submenu to see the exact horizontal position of the 
insertion point as you press the space bar or type sample entries. You 

can read right and left margin settings from the Status line (make a 

note of them) and use them in the Column Options dialog box 
instead of calculating margins. 
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Table 5.1: Suggested Margin Settings for Unequal Columns, Standard Page 

Size of Columns Margin Settings 

Two columns, ean 52 

0.5 inches apart, 

8.5 by 11-inch page har re aca france, 

Three columns, 12, Deane 3” 

0.25 inches apart, 

8.5 by 11-inch page 

ads BA and 1-2 . 

Bie ey and ee 

Three columns, 2” 2 and 4: 

0.5 inches apart, 
11 by 8.5-inch page 

ide s 
(si way ) 4”, Doe and De: 

Four columns, Alle PAO MAREE vate | aS) 

0.25 inches apart, 

11 by 8.5-inch page 

(sideways) 

Working with Text in Columns 
In the following sections you'll get practice in working with text in 

columns. First, we’ll preview what you’re going to practice. 
After you’ve defined columns, you can begin typing text in 

columns, or you can turn them off and wait until you get to the place 
in your text where you want columns to begin and then turn them on 
(Command-Shift-K is the keyboard shortcut). If you’ve defined 



You can enter text 

in columns when 
the ruler is displayed. 
The gray bars at the top 
indicate the columns, and 

the H-zone indicator 

shows the hyphenation 
zone in the column 
you’re working in. You 
can drag the H-zone icon 
to make it narrower if 
you want more words to 

be hyphenated, instead of 
dropped to the next line 
entirely. (Move the left 
side of the H-zone, not 

the right.) 

With parallel 

columns, always 
insert a hard page break 
before you reach the 
bottom of the page. If 
you don’t, you’ll find the 
insertion point at the left 
margin when the next 
page starts. 

eo) Some keyboard 
shortcuts work 

differently in columns. 
Think of each column as 
a page. If you’re using 
the numeric keypad 
shortcut Command-3 
(Delete EOP), it deletes 
the rest of the column, 

not the rest of the page, 
for example. 
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them as newspaper columns, you can retrieve or paste existing text 
into the column format. 

You can also reformat existing text into columns by defining the 
columns and turning them on where you want them to start. For 
newspaper columns, use the tip mentioned earlier about using the 
ruler line. For parallel columns, you’ll need to define columns by 

using the Column Options dialog box and then insert hard page 
breaks at the end of each column entry. 

Moving Between Columns 

After you’ve got columns on the screen, you can click in any one of 
them to move the insertion point. When you reach the bottom of one 
column, pressing > moves you to the top of the next column. If 
you're at the top of a column, pressing < takes you back to the bot- 

tom of the previous column. 

You can also,use Goto (Command-G) combinations to move 
around columns. They move the insertion point to the beginning of 

the same line in a different column: 

Goto < Moves to the same line in the previous column 

Goto > 

Goto Enter <- Moves to the same line in the first column on the page 

Moves to the same line in the next column 

Goto Enter > Moves to the same line in the last column on the page 

Figure 5.6 illustrates how these shortcuts work in columns of text. 

Deleting Columns 

To delete a column format entirely, delete the [ColDef] code. To 
return to aone-column format temporarily, just turn the columns off. 

You can turn them back on at a later point. 
To convert parallel columns to one-column text, delete both the 

[Column] code that turns on columns and the [Protect] codes associated 

with it. WordPerfect will insert a page break at the end of each column, 
but you can delete them wherever you don’t want page breaks. 
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Figure 5.6: Using keyboard shortcuts can move you quickly between columns. 

You can use com- If you want to change the number of columns, you’ll need to locate 

a eae er the [ColDef] code that’s generating the columns and either delete it 
t tia : 

Be She any or create a new [ColDef] code to its right. Like many of the other for- 
end of the line, and so on : 

in columns, but you can’t mat codes, the nearest [ColDef] code before the text is the one that 

use footnotes in columns. controls the format. 

—___-—Ss- Exercise: Formatting Existing 
Text into Newspaper Columns 

To get an idea of how easy it is to set up newspaper columns in text 
you’ve already written, try this exercise. You can use any existing 

document. 

1. With any document on your screen, press Command-R to dis- 
play the ruler line. 

2. Click on the Columns Definition icon, the one with left- and 

right-pointing arrowheads. Then click on the 3.5-inch mark. 

Unless you define more columns, WordPerfect assumes you 
want two columns, with a 0.25-inch alley that is centered on the 



oS If you type text or 
move the insertion 

point, clicking on the 
revert icon won’t restore 

the previous format. 
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3.5-inch mark you clicked. You’ll see gray bars appear on the 
ruler line, indicating where your column material will be. 

3. Click on the Columns On icon, the one with two small 

columns. 

Your text is instantly reformatted into two newspaper columns 
from the insertion point on. That’s all there is to it. 

Click on the Revert icon, the one with the X, to immediately 

change everything back to a one-column format (or to change to the 
previous format, whatever it was). To add or delete columns, click 

with the Columns Definition icon in the ruler line again. Clicking in 
the white space of an alley between columns deletes this space. 

Exercise: Retrieving Text 
into Newspaper Columns 

If you’re not converting text that you’ve already typed, you’ll 
probably find it faster to type out all your new text for the newspaper 
columns and then retrieve it into the column format instead of defin- 
ing the format and then typing the text. 

For practice, type out the document illustrated in Figure 5.7. You 
can then define a newspaper-column format and retrieve the text. 

1. Enter the text shown in Figure 5.7 and save it as Shipping. 

2. Open a new document. 

3. Define two equally spaced newspaper columns by opening the 
Column Options dialog box and clicking Evenly Spaced 
Columns (Figure 5.8). 

4. Choose Retrieve from the File menu; then select your Ship- 
ping document. 

The program retrieves the text you typed into the two-column 

format. This text doesn’t fill one column of an entire page, so you 
can insert a column (page) break. 
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File Edit Search Format Font Special Windows 

Doc 6: Shipping 

Arriving Monday, February 14 

Bulk carrier Oregon Sierra of Panamanian registry into the 

Port of Oakland, berth OH-2 

Chemical tanker Sealift II of Japanese registry into Alameda. 

* berth ENT 
Container ship Maryellen Lorraine of Danish registry into 

Richmond, berth 35 
Container ship Executive Class into San Francisco, berth 90-A 

Departing Monday, February 14 

Oil tanker Texas Star of American registry, from Richmond, 

berth TCH 
Oil tanker Dry Well of American registry from San Francisco. 

berth 6 
Bulk carrier World Class of Japanese registry from Oakland. 

berth 4 

Figure 5.7: This sample text will give you practice working with newspaper 

columns. 

@ tile tdif Search Format Font Speeial Uadouss 

Column Options 

Spacing Type 

Number of Columns (2-24) © Newspaper 

Space Between Columns |0.25 in. O Parallel 

Evenly Spaced Columns 
: (J Columns On 

Column meengue Ce Inches) 
0 Left Righ Left. Right Left Right 

Figure 5.8: These settings,define two newspaper-style columns that are evenly 
spaced on an 8.5-inch-wide page. 



Turn hyphenation 
off before you 

retrieve or paste text into 
narrow columns, or you'll 
be asked to position the 
hyphen frequently. Do 
the hyphenation later, if 
you wish. 

If you want to keep 
text together in the 

same newspaper column, 

use the Conditional EOP 

or the Block Protection 

commands on the text 

you don’t want broken. 
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5. Move the insertion point to the beginning of the Departing 
Monday, February 14 line and press Command-Return. 

Instead of breaking the page at this point, WordPerfect breaks the 
columns, as Figure 5.9 illustrates. If you press Command-Return 
when you’re in the rightmost column of a page, WordPerfect moves 
the insertion point to the beginning of the next page. 

Go ahead and enter some more text into the middle of the first 
column. You’ll see that WordPerfect pushes the existing text down to 

make room. When the text can no longer fit in the first column, it 

moves to the top of the second. Now the column (page) break you 
inserted at the end of the first column is in the second column, so the 

second column must break at that point. The text that had been there 

gets ‘“‘bumped’’; it has to move on to the beginning of the next page. 
If you hadn’t used a column break there, WordPerfect would have 
simply pushed the second column’s text downward to make room for 
the text you added. 

The Codes window shows codes in a one-column format; the next 

column appears below, instead of side by side. This can be confusing 

" & File Edit Search Format 

Doc 1: Shipping 

Joc 2: Untitled SS__a_j_=_]=]laa=====]=Alz 
Departing Monday, February 14 

Font Special Windows 

Arriving Monday, February 14 

Oil tanker Texas Star of 
American registry, from Rich- 
mond, berth TCH 
Oil tanker Dry Well of 

American registry from San 
Francisco, berth 6 
Bulk carrier World Class of 

Japanese registry from Oakland, 
berth 4 

Bulk carrier Oregon Sierra 
of Panamanian registry into the 
Port of Oakland. berth OH-2 

Chemical tanker Sealift II 
of Japanese registry into 
Alameda, berth ENT 

Container ship Maryellen 
Lorraine of Danish registry into 
Richmond, berth 35 

Container ship Executive 
Class into San Francisco, berth 
90-A 

Pot Col? Lat [P[BIU]I[O[S | iemertmemenerensenmanmeteremmenimenak apt LOLS) 

Figure 5.9: Pressing Command-Return forces a column break. 
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until you get used to it. For example, in Figure 5.10, the insertion 

point is at the bottom of the first column, but you can see the first line 

of the next column under it. When you move into the second 

column, the Col indicator on the status line will change to 2. 

You may notice that the tabs are unequal in these two columns. 

However, you can display the Ruler and reset tabs after you’ve for- 

matted text into columns. There are several other ways to improve 

the appearance of text columns, as you’ll see later in this chapter in 

some desktop publishing applications. 

&é File Edit Search Format Font Special Windows 

Doc 2: Untitled 

Arriving Monday, February 14 

Bulk carrier Oregon Sierra 
of Panamanian registry into the 
Port of Oakland, berth OH-2 

Chemical tanker Sealift II 
of Japanese registry into 
Alameda, berth ENT 

Container ship Maryellen 
Lorraine of Danish registry into 

Departing Monday, February 14 

Oil tanker Texas Star of 
American registry, from Rich- 
mond, berth TCH 
Oil tanker Dry Well of 

American registry from San 
Francisco, berth 6 
Bulk carrier World Class of 

Japanese registry from Oakland, 

Richmond, berth 35 berth 4 

Container ship Executive 
Class into San Francisco. berth 

90-A 
Pg 1 Col 1 Ln 14 

@Bcontainer OshipoExecutive GSR) 

Class Ointo OSanoFrancisco, oberth(sas} 

90 Req-JANGESS) 

|_DepartingoMonday,oFebruaryo | 4(8)) 

Figure 5.10: Although your text is in two columns, the Codes window shows 
only one column. 

——____._ Exercise: Working with Parallel Columns — 

For practice in working with parallel columns, you can set up the 
example shown in Figure 5.11. It’s one of the most common uses for 
parallel columns: a phone list. 

To begin, choose Columns from the Format menu; then choose 
Column Options. You'want to‘have three equal parallel columns, so 
type three, click Evenly Spaced Columns, and press Return. 



o The keys on the 
numeric keypad 

don’t function as arrow 
keys with the Goto com- 
mand. Use the arrow 
keys at the bottom of the 

keyboard instead. 
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File Edit Search Format Font Special Windows 

Doc 1: fig 5.12 

3411 South Euclid Avenue 555-3398 ancy Dorfman, Regional 

q Coordinator 

SoS 7755 1/1 i Ladoris Whiteman, Media 66 Hillview Ave., Apt. 9C 

y Specialist 

H John Tansy, Staff 555-6620 

q Supervisor 

5633 Westmoor Way 

i wv, 

Bp fac Cotit bate eL SO] 0] Speen a 
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: 34114¢SouthdEuclid¢Avenue (Hg) 

555 ffeq=)3398 Protect] Columa) 

H [Protect [Column> Ladoris¢Whit eman, Me dia sk!) 

Figure 5.11: Setting up an phone list like this one will give you practice in 
working with parallel columns. 

You can then enter the text as shown in Figure 5.11. When you 

reach the end of each entry in each column, press Command-Return 
to insert a [HPg] code and move to the top of the next column. When 
you make the last entry, press Command-Return again so that the 

correct codes will surround the last group of column entries. 

After you’ve entered the text, move to the top of the screen and press 
Command-7 to view the codes that WordPerfect has inserted. As you 
can see in Figure 5.11, [Protect][Column] codes surround each series of 
three entries so that they’ll always be kept together. Hard returns sepa- 
rate the three column entries in each horizontal group. 

Moving Between Columns 

Now you can practice moving between columns. (The same meth- 
ods work with both newspaper and parallel columns.) With the inser- 

tion point at the beginning of the first column, 

1. Press Command-G (Goto) and press the > key. 

The insertion point jumps to the beginning of the next column in 

that group. 
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2. Press Command-G (Goto) and then press the < key. 

The insertion point moves to the beginning of the previous 

column. 

3. Press Command-G (Goto) and press the 1 key. 

The insertion point moves to the bottom of the column. 

4. Press Command-G (Goto) and press the f key. 

The insertion point moves to the top of the column. 

5. If you have a numeric keypad, press End (1 on the numeric 

keypad). 

The insertion point moves to the end of the line. 

6. Press Enter; then press the < key. 

The insertion point moves to the beginning of the line. 

Editing Parallel Columns 

Suppose you wanted to alphabetize your entries by last name. 

You’ll need to move all three columns at the same time, and this can 

be tricky unless you select all the right codes. You can do it by search- 

ing for the codes. Open the Codes window before you begin, so you 

can see exactly what’s going on. 
Before doing any 

MM editing on parallel 
columns, save your table 
first. That way, if you 

1. Move the insertion point to the beginning of Ledori White- 
man’s columns by pressing Enter three times and then press- 

make a mistake, you can ing the + key when the insertion point is in the first line of 
get your original version that column entry. 

back. 
It should be before the [Protect] and [Column] codes on that line, 
as Figure 5.12 illustrates. 

2. Turn on Select by pressing Command-Shift-N; then choose 
Forward from the Search menu (or press Command-F). 

3. Scroll the codes box on the right until you see the last [Column] 
code; then click on it and click Insert to insert it in the search 

box. 

4, Click Find. 

WordPerfect locates the last [Column] code in the group and, 



Pressing Enter three 
times and then 

pressing the < key takes 

you to the beginning of 
the line you’re on (that is, 
the left margin of the 
column), in front of all 
the codes. 

To change a column 
definition code, 

locate it and put the 
insertion point to its 
right. Then, when you 
choose Column Options, 

you'll see the column 
definition settings you 
made earlier. 
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SSS Doc 1: fig 5.12 

Nancy Dorfman, Regional 3411 South Euclid Avenue 555-3398 

q Coordinator 

Ladoris Whiteman, Media 66 Hillview Ave., Apt. 9C 5S 5=2o 11 

# Specialist 

John Tansy, Staff 5633 Westmoor Way 555-6620 

4 Supervisor 

555 (feq}3398 Protect] Column) 

[Protect> Column Ladoris¢Whit eman,oMe dia(Sk%) 

4 Specialist(HPg) 

66 eHillviewsAve .,oApt.o9C, 

f 555 [Req-)2311 Protect} Column] 

Figure 5.12: Positioning the insertion point is critical when you copy or cut 
columns. 

since Select is on, selects all three column entries for this group of 
parallel columns. 

5. Press Command-X to cut the columns. 

6. Press Delete Right (the period on the keypad) to delete the 
extra blank line. Press Enter three times; then press the key 
to move to the end of the document, after the last code. 

7. Press Command-V to paste the cut columns. 

Your screen should like like Figure 5.13. Your address list should 
be in alphabetical order, with Dorfman, ‘Tansy, and Whitehead’s 
entries in that order. 

If you’ve made any mistakes in this exercise, you can see why edit- 

ing parallel columns can be tedious. Not using the proper codes can 

cause strange things to happen on the screen, making you glad you 

saved your table before you began to cut. However, if you search to 

select the [Protect] and [Column] codes before and after each group 

of parallel column entries, you can cut and copy horizontal groups 

accurately. There’s a macro in Chapter 8 that will select columns for 

you automatically. 
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& File Edit Search Format Font Special Windows a ee 

= —— Doc 1: fig 5.15 
Nancy Dorfman, Regional 3411 South Euclid Avenue 555-3398 

Coordinator 

John Tansy, Staff 5633 Westmoor Way 555-6620 

Supervisor 

Ladoris Whiteman, Media 66 Hillview Ave., Apt. 9C 555-2511 

Specialist 

Figure 5.13: After you’ ve pasted the cut group of columns, your screen should 

look like this one. 

Moving Parallel Columns 

But what if you wanted to change the order of the columns? 

Maybe you’d like addresses or phone numbers to come first. In this 
case, you can use WordPerfect’s built-in Select Column command. 

When you choose Column from the Select submenu, the program 

selects the column the insertion point is in—from the first character 

in the column to the last character in the column, including the 
[HPg] code that separates the column entries in a group of parallel 
columns. It also inserts a new [Protect] code at the end of the selec- 
tion. If you cut the selected column, you can paste it after a [Protect] 
code, and your table will keep its formatting. 

To switch John Tansy’s name and address columns (open the 
Codes window to see what’s going on): 

1. Position the insertion point in the name column, on John Tan- 
sy’s name. 

2. Choose Select; then choose Select Column (or press Command-6 
5). 
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The material in the column is selected from the first character 
through the [HPg] that ends the column (see Figure 5.14). 

If you want to delete 3. Cut the column. 
an entire column, 

including its text, cut the The remaining two columns shift to the left. 

ee ore the 4. Move to the middle column by pressing Goto (Command-G) 
columns. 

and the > key. 

This positions your insertion point at the beginning of the middle 
column. 

5. Paste the cut text. 

The original first column’s new text appears in the middle 
column, and the formatting in the table stays the same, as shown 

in Figure 5.15. 

= Delete the extra hard page break represented by the line across 
the screen by pressing End and Delete Right. 

This way of cutting and pasting columns works fine as long as you 
aren’t cutting the last (rightmost) column in a table. In that case, 

" € File Edit Search Format Font Special Windows 
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Figure 5. 14: Selecting columns with the Select Column command assures that 

the correct text and codes are highlighted. 
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e) The very last entry in 

a table won’t have a 
[Protect][Column] code 
following it unless you 
enter a hard page break 
when you finish the table. 
To paste into the very last 
entry in a table of parallel 
columns, you'll need to 

press Command-Return 
to insert a new [HRt] at 
the end of the last entry. 

Windows 

Nancy Dorfman, Regional 3411 South Euclid Avenue 555-3398 

Coordinator 

5633 Westmoor Way John Tansy, Staff 555-662d 

Supervisor 

Ladoris Whiteman, Media 66 Hillview Ave., Apt. 9C 565-25 11 

Specialist 

[Pot col sina [ple] 

Figure 5.15: After you cut and paste the first column, your table should 

resemble this one. 

selecting a column with the Column Select command selects through 

the last [Protect][Column] codes that define the arrangement of the 

parallel columns, and you’d lose your formatting when you cut and 

pasted the column. So don’t use Select Column on the last column in a 

table of parallel columns. Instead, manipulate the other columns so that 

you don’t have to select the last column. Then use the special column- 

movement cursor commands instead of guessing where the correct 

insertion point should be. For example, to transpose columns 2 and 3 in 

a three-column table, cut column 2 and paste it where column 3 used to 

be by using End Goto > to move to the last column. 
To move the phone numbers column: 

1. Select and cut the middle column. 

The last column’s text moves to the left, and the last column is 

blank. 

2. Press End; then press Goto > to move to the last column’s 
position. 

¢ 

3. Paste the cut column. 



If your column isn’t 
wide enough for a 

graphic, you’ll need to 
redefine the columns or 
resize the graphic. 
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You can then transpose columns 1 and 2 to get phone numbers in 
the first column. 

Working with columns takes a little practice, which is why we’ve 
spent so much time on it. However, if you’re going to create desktop 
publishing applications, you’ll want to be familiar with the way 
columns work so that you can use them in your documents and com- 
bine them with graphics. 

Incorporating 
Graphics in Your Documents 

WordPerfect lets you insert graphics in your documents very eas- 

ily. After you’ve got a graphic image in your document, you can 
resize it, copy it, or cut and paste it. 

You can use almost any painting or drawing program to create 
graphics from scratch, or you can use graphics from clip art collec- 

tions. If you’ve got a spreadsheet program like Excel that lets you 
create charts, you can paste those into WordPerfect documents also. 

Later in this chapter you’ll see some tips to use with popular graphics 
programs. 

To insert a graphic image in a document: 

1. Copy the graphic from the original program where it was cre- 
ated (or from the clip art collection it was in). 

When you copy, that image goes into the Clipboard. If you want 
to copy more than one image, use the Scrapbook. 

2. Quit the program you’re taking the graphic from. 

3. Open the WordPerfect document that you want to use the 
graphic in. 

4, Position the cursor where you want the graphic. 

If you’re pasting the graphic into a columns format, make sure 
that columns are now on and that the insertion point is in the cor- 

rect column. 

5. Paste the graphic into WordPerfect. 

You’ll see the graphic in your document. A [Picture] code is also 
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To keep the graph- 
ic’s proportions the 

same when it’s reduced 

or enlarged, use the 
handle in the lower-right 
corner. Dragging on 
either of the other handles 

will distort the image. 

If you’ve distorted 
or resized an image 

and you want the original 

back, delete the distorted 

image by pressing Delete 
when the graphics box is 
visible. Then paste the 

original back in. It’s still 
on the Clipboard or in 
the Scrapbook. 

It can be hard to tell 
when a graphic is 

selected, depending on 
what else is on the screen. 
To make sure, open the 
Codes window. The 
[Select] code should be to 
the left of the [Picture] 
code. 

inserted. To delete the graphic, you can either delete the [Picture] 

code or click on the graphic to select it then press Delete. You'll get a 

‘Delete Picture?” dialog box. 

Sizing Graphics 

Once you’ve got a graphic image in WordPerfect, you can change 

its size. To resize an image: 

1. Click anywhere on the image. 

A box with three “handles” appears around the image. Drag- 

ging on any of the handles changes the image’s size. 

2. Drag on one of the handles to change the image’s size. 

3. When the graphic is the size and shape you want, click any- 

where outside the box to hide the graphics box. 

WordPerfect automatically adjusts space in any existing text after 

you’ve resized a graphic. 

Copying and Moving Graphics 

You can also make copies of graphic images or move them to 

different places in your documents by cutting and pasting. All you 

need to do is drag across the graphic to select it; then use the Cut or 

Copy commands. 

If you want to append the graphic to the end of another document, 

use the Append command while it’s selected. 

What kind of graphics can you use? Basically, almost anything that 

you can create with another Macintosh program, as long as it’s either 

e A bit-mapped image 

e A PICT file 

e A PostScript file 

To get a little background about the differences in these types of 
graphic files and how you work with them, we’ll look at each one 
briefly to give you a general overview. 
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bar To bring in images 
you’ve captured 

with a scanner, paste 
them into a program like 
CricketDraw first. Word- 
Perfect won’t directly 
accept the TIFF (Tag 
Image File Format) files 
created by a scanner, but 
CricketDraw and other 
graphics programs that 
have Save As format 
options can convert these 
files into PICT format. 

Types of Graphics 

Paint-type graphics, produced by programs like MacPaint or 
FullPaint, are bit-mapped images. Because the image is composed of 
a map of dots, resizing it in the paint program often produces unac- 
ceptable results. Each dot, or pixel, is a bit in the Mac’s memory. To 
whiten or erase a black area, you turn off that bit. (That’s why you 
can’t neatly correct typos in MacPaint or change fonts and sizes after 
you ve clicked the mouse.) 

PICT files can contain both paint-type graphics and draw-type 
graphics. Draw-type graphics consist of mathematically defined 

objects whose shapes can be easily altered after they’re drawn.(These 
are often also called object-oriented graphics.) Instead of treating 
everything on the page as a series of bits, each item is considered to be 

a separate object and is stored as a set of QuickDraw commands. 
(QuickDraw is the Mac’s built-in library of graphics routines.) To 
resize an object, you can simply stretch or compress it instead of hav- 

ing to erase and redraw it. Because these commands aren’t stored as 
a fixed number of dots, the results you get on a laser printer appear 

much nicer than the 72-dpi resolution you see on the screen. 

PostScript is a page-description language that mathematically rep- 

resents font information as well as images. It allows you to create spe- 

cial effects such as rotating fonts, clipping parts of characters and 

using them as design elements, printing background images on a 
page, and so forth. Chapter 6 has an example of a PostScript file, and 
it’s used in the dinner menu example in this chapter (see Figure 
5.27). Unfortunately, PostScript programming is a vast subject in 

itself; I can’t tell you how to do it, but you’ll find an excellent refer- 
ence book mentioned in Chapter 6. 

EPS (Encapsulated PostScript) files consist of a bit-mapped image 
that can be displayed on the screen as well as a PostScript image and 
a PostScript interpreter required to print it. This type of file is created 

by Adobe Illustrator and other sophisticated drawing programs. 
If you’re using PostScript graphics, you’ll need to use the Print 

Options submenu to insert the PostScript commands as described in 

Chapter 6. 
If you’re not sure what type of graphic you have, just try pasting it 

into a document. WordPerfect will tell you if it can’t accept it. 
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If you use a lot of graphics in your documents, consider purchasing a 

product like Glue or SmartScrap from Solutions International. 
Glue lets 

you transfer graphics as large as a printed page from any Macintosh 

application. SmartScrap is an enhanced Scrapbook that lets you main- 

tain several indexed scrapbooks as well as select only portions of the 

images it holds. Sources are listed at the end of the chapter. 

Graphics Tips 

You’ll probably use a graphics program at some point to create 

= simple images for your documents. The subject of creating and 

Py paie going te manipulating graphics could be a book in itself, but here are a few 
use several graphic : AY rth ee j \acPai b 

iiades inca document, tips that may help you. A lot of these tips relate to MacPaint, because 

paste them into the almost all Macintosh users either have or have access to MacPaint. 

Scrapbook. When you However, since Macintosh programs tend to use a standard inter- 
want an image to paste : ; : 

ies csaopemiie face, youmay find that these tips apply to the program you ’re using, 

Scrapbook quickly, with- even if it isn’t mentioned by name in this chapter. 

out having to go to your 

graphics program. 
Avoiding Extra White Space 

When you paste graphics to the Clipboard with the lasso or selec- 

tion box in painting programs like MacPaint, FullPaint, or Hyper- 

Card, the graphic carries extra white space with it that may obscure 

the surrounding text in your document. (If you’re using MacDraw, 

the object is transparent and won’t obscure your text.) 

You can solve this problem by holding down the Command key 

when you select the graphic with the selection tool, assuming that the 

image has a white background. If it has a patterned background, this 
won’t work. The selection rectangle will pick up only the small rec- 
tangle defined by the borders of the image. Use the lasso for images 

with irregular edges. 

Reversing Out Text 

You can produce reversed-out text (white on black, as shown in 
Figure 5.16) in a painting program like MacPaint and bring it into 
your WordPerfect documents. To do this in MacPaint, create a black 
rectangle and then choose a font and size. (The larger sizes of the 
fonts work better for this.) Choose Outline style and type the text you 
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Reversing Out Type 

Figure 5.16: To produce reversed-out type, create it in a graphic program and 
bring it into WordPerfect as a graphic image. 

want to have reversed out. You may need to use the paint bucket to 

fill in some areas in the letters, particularly in smaller font sizes. 

If the typeface is small, you’ll need to go into FatBits to touch up 

your reversed-out type. Double-clicking on the pencil takes you to 
FatBits; to move around while you’re there, press the Option key 

while holding the mouse button down. The pointer will change to the 

grabber, letting you move around. 

The Full Clipboard Problem 

This may happen to you: You’re ready to replace a graphic image 

with an image that’s in the Clipboard, which holds only one item at a 
time. If you cut the old image, you’ll replace the new image in the 
Clipboard. Instead, use Delete to delete the old image, or just select 

the old image and paste in the new one. 

Creating Duplicate Images 
You can create duplicate images in MacPaint. Select an image 

with the selection box or lasso; then hold down the Option key. You 
can ‘‘peel off’ copies and reposition them one copy at a time. Using 
the Command-Option sequence creates multiple copies, as shown in 
Figure 5.17, and holding down the Shift key at the same time makes 
sure that they stay in a straight line. 

Resizing Images 

Although you can resize images in WordPerfect, you may want to 

resize them in the graphics program so that you can embellish them 
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(-] Work with the 
Codes window open 

when you’re editing or 
correcting documents that 
contain graphics. The 
insertion point can often 
appear to be somewhere 
that it isn’t, but the 

Codes window shows 
exactly where it is. 

Figure 5.17: You can create special effects in graphics programs, such as mul- 

tiple images and stretched typography. 

with other styles or frame them. First, select the image you want to 

resize; then cut or copy it. Draw a selection box that’s the size of the 

final image you want and paste the cut image into it. It will automati- 

cally be resized to fit in the new selection box. 

Special Typographic Effects 

You can create special typographic effects in a graphics program or 

in WordPerfect. To stretch type in a program like MacPaint, select 

the text with the selection box or lasso, hold down the Command key, 

point to one edge of the image, and drag it. If you don’t want distor- 

tion, hold down the Shift key as well. 
For example, in Figure 5.17, the first centered AWX logo was 

typed in 24-point Stuttgart in MacPaint. Two duplicates were made 
below it; then the first was stretched with the Command key down. 
The second was reduced with Shift-Command down, so that the let- 

ters weren’t distorted. 
If you want even more special effects in your typography, consider 

a program like ClickArt Special Effects, which is a desk accessory for 
MacPaint. It lets you distort, stretch, and change perspective 



To change font sizes 
quickly in Mac- 

Paint, press Command- 
< or ->. Pressing 
Command-Shift- > or -< 
takes you to the next or 
previous font listed on the 
Font menu. 
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in MacPaint documents, which you can then paste into your Word- 
Perfect documents. 

Working with Text in Graphics Programs 

Because you’ll probably want to create logos and headlines for 
your documents, here are some tips about handling text in graphics 
programs. 

Paint-type programs have trouble handling text in some of the 

ways you probably want to use it. This happens because the program 
treats the text you typed as bit-mapped graphics after you click 
the mouse. 

When you change the font, size, or style of any text you’ve entered 
in a painting program, all the text you typed since the last time you 

clicked the mouse will change to the new settings. This is unlike what 
happens in WordPerfect, where the change goes into effect only for 

text that you type from that point on. If you don’t want all your text 

to change, press the Enter key before you make a font change; then 
only the text you type from that point on will change. 

If you transfer text to MacPaint from WordPerfect by cutting or cop- 
ying it, you’ll lose its formatting. To transfer it with its formatting intact, 
take a screen shot of it in WordPerfect (Command-Shift-3). This creates 
a MacPaint document named Screen 0 on your startup disk (if you’re 
using a color monitor, you have to turn the color off first). Go to the 
Desktop and double-click on Screen 0 (it may have another number if 
you’ve taken other screen shots). Select the text with the selection box or 
lasso and copy it. Then return to the place in the MacPaint document 
where you want the text to appear and paste it in. 

In MacDraw, you’ll find that word wrap doesn’t work the way 
you think it should when you’re inserting text with the text tool in a 
rectangle you want to use as a border or frame. ‘To make words wrap 
correctly, draw the rectangle and just start typing. If you select the 

text tool, the words don’t wrap right. 
Now, you may be wondering where all this is leading. These are 

all desktop publishing tricks. As far as WordPerfect is concerned, 

desktop publishing is simply word processing. There are no addi- 

tional commands to use with the program; you know how to do eve- 

rything already. The only additional things you need to know are a 

few design tips and shortcuts, which the next section will cover. 
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Designing Your Publications ———————— 

Although the subject of desktop publishing could be a book in 

itself, some general design rules and tips can help you get started. For 

additional information about design, you can refer to books like Jan 

White’s Editing by Design (R.R.Bowker, 1982), Roy Paul Nelson’s (no 

relation) Publication Design (William C. Brown, 1984), or Howard 

Penn Hudson’s Newsletter Publishing (Scribner’s, 1982). 

The first rule in desktop publishing is this: Don’t be afraid to 

experiment. Look at what others are doing in as many publications 

as you can. Steal their ideas. Modify them to suit what you’re work- 

ing on. If you find something that looks good, save it; then keep 

on working. 

Your first goal is to capture the attention of your readers. Only 

then will they read what you’ve written. If too many graphic ele- 

ments on the page are competing for attention, your readers may not 

know where to start. Be sure to use only one main visual element, like 

a main headline or graphic image, to draw your reader’s eye to the 

text. You can then use many secondary or lesser elements to structure 

the page. 

However, remember to keep it simple. There’s a real temptation 

to put as many fonts and font styles on a page as you can, but mixing 

more than two or three typefaces can disturb an elegant layout. 

(Using too many fonts can also slow down or even stop your printer, 

as explained in Chapter 6.) 
Also, be consistent in your publications. Use a standard size of 

type and a standard typeface for first-level, second-level, third-level, 

(and so forth) headings. Keep the headings visually subordinate to 

each other. For example, don’t use 14-point caps and lowercase for 

first-level headings and 14-point bold caps for second-level headings. 

Keep the spacing between each level of heading and the text the 

same. Keep the white space around graphics similar. Use a standard 
indentation—one tab, a three-space tab, or no tab at all. In short, try 

to make each page appear regular—your readers will appreciate it, 
and your publications will look well-thought-out, not as if you rein- 
vented the design with each page. The next section explains how a lot 

of pros do it. é‘ ‘ 
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Using a Grid System 

One trick professional designers use is to set up a grid system in 
which graphic elements are interchangeable. For example, in Figure 

5.18, the page is formatted into four equal columns. By manipulating 
the basic unit—the column—you can produce several variations 
on the basic layout, as the figure illustrates. You can use two standard 
columns to produce a two-column page, or you can mix one column 
of text with one column of white space in addition to a two-column 

unit to create a completely different visual effect. If you print side- 
ways on legal-sized paper, you can create much more complex for- 
mats, perhaps using a basic six-equal-columns design. (Four 
columns are used as the basic design here because four, or at the most 
five, columns are the most readable on an 8.5 by 11-inch page.) 

Basic Grid 

Figure 5.18: By using an underlying column structure like this four-column 

design, you can change page layouts that will still “work” 

together. : 
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In Figure 5.19 the basic design is three equal columns; one column 

width is being used for the text on the left, and the other two col- 

umn widths are being used for the second column. 

By combining different illustration and type sizes in headlines with 

National Sales Results 
Opossum 555 Wins Big in South 

Quarterly Results Are in-Looking Good Out There! 

August was an 
especially good month 
for the Southeastern 
region. Sales of the 
Opossum rose 14% 
over the same period 
last year. The Turbo 
Opossum gained in 
popularity in the mid- 
size auto range. 

As sales 
continue to climb, all 
eyes are on Jerry Cal- 
lahan and his sales 
associates who are 
leading the pack in 
the Southwest. 

New TS 
For those who desire a roomier 

interior, the TS Opossum seats five 
comfortably. This model is making inroads 
in the normally price-resistant Nor- 
theastern region. 

Turbo Talk 
The Turbo Opossum puts out 132 

horsepower, a healthy increase over the 
standard Opossum engine. Torque is up to 
180 lb.-ft., giving an 0-60 time of 8 seconds. 

Standards and Options 
The detachable fold-down cover is the 

latest addition to the option line. After the 
rear seats are folded down, there's 22 cubic 
feet of storage space in the back. 

Remote locking for the left gate plus a 
wiper for the rear window can also be added 
as an option on the Opossum 555. 

Figure 5.19: This figure uses an ‘underlying three-column design to produce 
two text columns; the column on the right is the width of two 
standard columns (Clip art: DrawArt from Desktop Graphics). 
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the basic column design, you can get greater variety in your page lay- 
outs, as Figure 5.20 illustrates. (At the end of this chapter, you'll see 
how this page was created, and you’ll get specifications for all the 
other sample pages shown here.) 

VoL 5., no. 4 

Thinking The credit union offers 
low rates both on new 

about a and used car loans. In 
New addition, we can 
Car? introduce you to a 

3 special discount 
Check program provided by 

our Auto local dealers who sell 
Loan ata set percentage 
Rates above dealer cost, so 

you'll be sure of a 
hassle-free sale. 

serving the financial community 

What to Watch for When You Step on the Lot 

Don't fall in love at first sight 

Check models at several different 
dealers before you decide on the car 

you want. If you let your heart rule 
your head, you may feel it in your 

wallet. 

Don't talk trade-in until you've 
picked out the car and established 
its selling price, which is often not 
the same as the car's sticker price. 
Check with a consumers' group to 

determine the true wholesale cost.®& 

October 1988 

Auto Loans? 

now only 9% 

Call Today--X3 768 

Figure 5.20: You can set up elaborate pages with WordPerfect and your graphics 
program (Clip art: ClickArt Special Effects, HyperCard). 
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Don’t stack head- 

MS ings in too many 
lines. Three lines is about 

the maximum that should 

be used for headings. 

If you’re printing two-sided documents, consider the layout of 

each two-page spread. (Even-numbered pages are always on the left, 

and odd-numbered pages are always on the right.) Use Print Preview 

frequently to see how your pages look together. 

Design Hints 

The following sections present some straightforward design tips 

that can help you in designing many different types of publications. 

Italics versus Roman Type 

Use italics sparingly. They are harder to read than roman type. 

They also give your publications an informal feel, as do ragged right 

margins. For example, in Figure 5.19, italics were used as a floating 

left column that’s not an integral part of the next column. 

Serif or Sans Serif? 

Sans serif type (type without the little finished endings, called sertfs, 

that appear at the tops, bottoms, and ends of letters) is considered 

hard to read by many people, including myself. You may want to use 

a serif face for text type and a sans serif type like Helvetica for head- 

ings. That’s what’s been done in Figure 5.21, where the sidebar and 

displayed material are 14-point Helvetica bold and the text is 14- 

point New Century Schoolbook. Putting the footer in another sans 

serif face, Geneva, also gives a finishing touch to the page. (This 

book, by the way, is also set in a mixture of serif and sans serif type. ) 

Heading Tips 

If your headlines are long, consider using only one initial cap 

instead of Caps and Lowercase, Which Bounce the Reader’s Eye Up 
and Down. For example, the third-level heading in Figure 5.19 
would probably look better and be smoother to read if only an initial 
cap had been used. 

Instead of headings, use displayed quotes to break up long 

columns of text, as was done in Figure 5.21. You can get by with 
more than the three-line limit, since the displayed material is part of 
the text. 



Up to 
now, 
the 
world 
has 
had 
little 
idea of 
how 
the 
Greeks 
sailed 
the seas 

It must have been 
interesting for the naval 
archaeologists who dis- 
covered the wreck of the 
trireme off the coast of 
Athens to puzzle out the 
special seating arran- 
gement that allowed 
three rowers, one above 
the other, to operate in 
perfect unison and 
propel the strange- 
looking craft smoothly 
through the seas at 
speeds greater than 10 
knots. 

The Greek 
trireme used three 
different lengths of 
Oars, operated by 
teams of rowers 
seated on oar 
banks. 

Over 150 of these rowers 
were required to propel a 
trireme, which was 
designed as a wartime 
speed vessel, not as a 
cargo ship or troop 
carrier. At dusk her 
crew was required to 
debark and seek shelter 
on land, for there was no 
room for the rowers and 
crew to remain on board. 

In puzzling out the 
lattice-like seating 
arrangement, inves- 
tigators were first 
stymied as to how many 
rowers could be packed 
within such a small 
space. 

However, the ancient Greeks 
were considerably shorter than 
we are today. The average 
height was about 5 feet 6 
inches, a significant difference 
between the height of the 
average crewman today. 

The trireme, by the 
nature of its design, had a 
weak hull. To help hold the 
hull together, it was bound at 
periodic intervals by long 
ropes. 

To increase the speed of 
the vessel, square sails were 
used, but these were often 
removed and left on shore 
during a battle so that the 
vessel would ride higher on the 
water and thus have more 
maneuverability. 

The trireme basically 
operated as a ramming 
vehicle; it was equipped with a 
battering ram on its prow as 
part of the nautical design. 
After ramming another vessel, 
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Figure 5.21: Mixing serif and sans serif typefaces can be quite effective in page 

design. 

Changing the Layout 

You can take the same text and give it a completely different feel 

just by changing the column layout, the typeface, and a few head- 

ings. Compare Figure 5.21 to Figure 5.22. 
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Archaeologists Unearth Ancient Vessel 

150 Men in a Boat? 

Mystery of the centuries solved 

by Sandra Schuler, Staff Writer 

It must have 
been interesting 
for the naval ar- 
chaeologists who 
discovered the 
wreck of the 
trireme off the 
coast of Athens 
to puzzle out the 
special seating 
arrangement 
that allowed 
three rowers, 
one above the 
other, to operate 
in perfect unison 
and propel the 
strange-looking 
craft smoothly 
through the seas 
at speeds greater 
than 10 knots. 

OAR LENGTH 
The Greek 
trireme used 
three different 
lengths of oars, 
operated by 
teams of rowers 
seated on oar 
banks. Over 150 
of these rowers 
were required to 

National Voyeur 

propel a trireme, 
which was 
designed as a 
wartime speed 
vessel, not asa 
cargo ship or 
troop carrier. At 
dusk her crew 
was required to 
debark and seek 
shelter on land, 
for there was no 
room for the 
rowers and crew 
to remain on 
board. 

SEATING 
ONBOARD 
In puzzling out 
the lattice like 
seating arran- 
gement, inves- 
tigators were 
first stymied as 
to how many 
rowers could be 
packed within 
such a small 
space. 

However, the 
ancient Greeks 
were con- 

siderably shorter 
than we are 
today. The 
average height 
was about 5 feet 6 
inches, a 
significant 
difference 
between the 
height of the 
average 
crewman today. 

The trireme, by 
the nature of its 
design, had a 
weak hull. To 
help hold the 
hull together, it 
was bound at 
periodic 
intervals by long 
ropes. 

INCREASING 
SPEED 
To increase the 
speed of the 
vessel, square 
sails were used, 
but these were 
often removed 
and left on shore 
during a battle so 

that the vessel 
would ride 
higher on the 
water and thus 
have more 
maneuverability. 
The trireme 
basically 
operated as a 
ramming 
vehicle; it was 
equipped with a 
battering ram on 
its prow as part 
of the nautical 
design. 

AFTER BATTLE 
After ramming 
another vessel, 
the trireme 
withdrew, 
leaving her prey 
vulnerable to 
following battle 
vessels. 

As often as not, 
the trireme 
would put into 
shore and collect 
her sails, which 
had been 
discarded before 

March 1988 

Figure 5.22: Changing the page layout and a few headings gives the same 
article a completely different look. 

Use headings set in all capital letters sparingly—and only when the 
lines are short. Figure 5.22 can use all caps for headings because the 
columns are narrow. ° 
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Figure 5.23 illustrates one way you can deal with the problem of 

columns of unequal length. The main graphic image and headlines 
are centered, as are the elements in the footer, so that the unequal 

Out of Line 

a compendium of 

Desktop Publishing Hints 

The first basic rule in desktop publishing is: don’t be afraid to try 
out new possibilities. If you find a format that looks good, save it; then 

Your first goal is to 
capture the attention of 
your readers. Only then 
will they read what you 
want them to know. If 
too many graphic 
elements on the page 
are competing for 
attention, your readers 
may not know where to 
Start first. Be sure that 
you have only one main 
visual element, like a 
main headline or graphic 
image, to draw your 
reader's eye to the text. 
You can have many 
secondary or lesser 
elements. 

Chapter 5 

keep on trying. 

Use justification if you 
want a formal tone in 
your publications. It also 
saves space. If space is at 
a premium, use Times as 
your text font. It's a very 
readable font, but it takes 
up much less room than 
most other typefaces 
In general, the wider 
your column, the larger 
your font should be. 
Narrow columns look 
good in smaller type 
sizes. 

Headers and footers can 
indicate to the reader 
what's being discussed 
on the page. 

Different borders can be 
used to emphasize 
headlines. 

Desktop Publishing Tips 

Teach yourself to 
visualize text in columns 
as well as on facing 
pages. Each page should 
visually balance the one 
it opens with. Check 
each two-page spread 
with Print Preview before 
you print. 

Even the simplest of 
column designs can 
make your documents 
look more professional. 

Figure 5.23: In some situations, columns just won’t balance, so make that a 

part of the page design (Clip art: HyperCard). 
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columns seem to hang from them. If you do this, try to keep the mid- 

dle column either significantly longer or shorter than the others to 

maintain balance. 

Consider the shape of 

the white space on Kerning and Letterspacing 

the page. ‘Too much a Take the time to go back and kern headlines. It will add an ‘‘invisi- 

2 i Cals be oi a ble” professional touch to your documents. In Figure 5.23, the word 

page. Too little white space Publishing in the heading was kerned to delete one point of space 

can make the page seem between each character. Otherwise, it would have been spaced out 

crowded. : : 
like this: 

Publishing 

You can also use letterspacing to create eye-catching visual effects. 

For example, in Figure 5.23 the main heading has been letterspaced 

4 points. You’ll often see even more letterspacing than this used in 

some logos. 

Headers and Footers 

Headers and footers indicate to the reader what’s on the page and 

can also balance the text elements on the page. If your page is basi- 

cally a “‘centered’’ page, use centered footers and headers as well (see 

Figure 5.23). If you’ve got a ragged-right page, with headings flush 

left, consider using a flush-right footer for balance, as was done in 

Figure 5.21. 

Leading and Vertical Rules 

If you’re using wide columns, use extra leading, as has been done 

if Figure 5.24. The extra white space between the lines makes them 

easier to read. Here 3 points of leading have been added, so the text is 

Helvetica 14 on 17. The sidebars are Helvetica and New Helvetica 

narrow, and the main heading is Avant Garde, which mixes well with 

Helvetica. These are two unequal parallel columns. The vertical 

rule? It’s redlining. 
4 
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Desktop Publishing Possibilities 

Part Ill 

Where the Action Is 

One of 

the 
nicest things 

about 
WordPerfect 

on the 
Macintosh is the 

ability it gives 
you to blend text 

with graphics. 

It doesn't even 
take much 

practice to do it, 
because you use 
the commands 
you're already 
familiar with, 

and what you see 
on the screen is 
what you get in 

your printed 
newsletters and 

brochures. 

You may be wondering how the vertical rule 

got there. (It's redlining.) The sidebar has had 

its line spacing altered so that there's more 

white space between lines. This makes the 

text stand out and catch the reader's atten- 

tion. 

If you do much desktop publishing, you 

can save these exotic formats as default files 

so that you can use them for all the docu- 

ments you create in one work session with 

WordPerfect. 

You'll probably find it faster to enter all 

your text in Geneva and then go back and 

experiment until you find a good combination 

of fonts for text and headlines. 

Here we're using Avant Garde 24 for the 

main headline and Helvetica and New Hel- 

vetica Narrow for the sidebar. The text of the 

article (what you're reading) is in New York. 

To add another professional finishing 

touch to your documents, you can insert a 

tiny graphic to indicate the end of an article. 

Figure 5.24: Use extra leading in wide columns so that they’re easier to read 
(Clip art: DigitArt Laser Graphics). 

Subheadings 

Give your subheadings some variety—but not too much. Figure 

5.25 illustrates several unusual ways to deal with subheads to make 

your pages visually interesting. You can keep them flush left, center 
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The first basic rule 

in desktop publishing 
is: don't be afraid to 
try new possibilities. 
If you find a format 
that looks good, save 

it; then keep on 
trying. 

Flush left head 

Your first goal is to 
capture the attention of 
your readers. Only then 
will they read what you 
want them to know. 

Outdented head 

If too many graphic 
elements on the page 
are competing for 
attention, your readers 
may not know where to 

Flush right head 

Avoid the orphan that's 
at the top of .this 
column! If space is at a 
premium, use Times as 
your text font. It's a very 
readable font, but it 
takes up much less 
room than-most other 
typefaces. "~ 

Italic lead-in. In 
general, the wider your 
column, the larger your 
font should be. Narrow 
columns look good in 
smaller type sizes. 

Bold lead-ins can give 
interest to the ap- 
pearance of type on the 
page. 

time creating a 
masthead for your 
newsletter, but once it's 
done, it’s done. 

Drop caps can also be 

used as design 
elements on the page. 
Just select the letter 
and select a larger type 
size. 

Even within a column 
format, you can 

select certain 
paragraphs and make 

them flush right for 
emphasis 

Teach yourself to 
visualize text in 
columns as well as on 
facing pages. Each page 
should visually balance 

start first. Don't do Special quotations can the one it opens with. 
everything on your be emphasized with Check each two-page 
pages that’s been done leading, redlining, a spread with Print 
on this one! style change, and Preview before you 

Indented head 

Be sure that you have 
only one main visual 
element, like a main 
headline or graphic 
image, to draw your 
reader's eye to the text. 

Centered head 

Use justification if you 
want a formal tone in 
your publications. It 
also saves space. If 
you're using narrow 
columns, adjus! the 
hyphenation zone for 
better hyphenation. 

a flush left format 

CAPS CAN BE effective 
as very short lead-ins. 
SMALL CAPS, perhaps 
two points smaller than 
your text face, are even 
better. 

Different borders or 
symbols can be used 
over and under 
headlines and between 
sections; these are Zapf 
Dingbats. 

Bo 

You may have to spend 
a certain amount of 

print. 

"Floating" quotations 
can break up long lines 
of text columns. Use a 
larger face and extra 
leading in them to 
make them stand out, 
as in the example to the 
left. 

Keep headlines short 
and to the point, about 
three lines maximum, 
to attract attention. 

Even a simple column 
design can improve 
your documents. 

Figure 5.25: Using a few—but not all—of these techniques can make your 

document visually interesting. 

them, make them flush right, or run them into your text. They can 
even be ‘‘outdented”’ into the margin by using Margin Release 

(Shift-Tab). ; 4 



Avoid widows and 

orphans in your 
published products. Turn 
on Widow-Orphan 
protection. 
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Mixing Flush-Left and Flush-Right Text 
You can use both flush-left and flush-right text even within jus- 

tified columns, as Figure 5.25 illustrates. For flush-right text, just 
highlight the lines and choose Flush Right from the Line submenu or 
click the right-justified icon on the ruler line. For flush-left text, high- 
light the text and click the left-justified icon on the ruler line. 

Mixing Leadings 

If you want to switch leading at various points in your text, as has 
been done in Figure 5.26, you can’t just highlight the lines and then 
change the spacing, because the Spacing command will be dimmed. 
Use the Line command to change the spacing from the insertion 
point to the end of the document; then move to where you want the 
extra leading to end and insert another spacing command to return 
to automatic leading. Do the same with line height changes. 

Drop Caps 

Drop caps—in this context simply oversized initial capital letters 
that begin a chapter or paragraph—not only attract the reader’s eye 
to the beginning of the text but also work as a design element, as Fig- 
ure 5.25 illustrates (second paragraph, third column). 

Switching Column Formats 

You can also switch column formats within a page. In Figure 5.26, 

the graphic border design is in a one-column format, while there are 
two other column formats, mirror images of each other, on the page. 
How was it done? First, the rule (the thick horizontal line) was copied 
from MacPaint and pasted into the document. Then two unequal 
parallel columns were defined, the ball was pasted in, and 
Command-Return was pressed to break to the next column. After 
the text there was typed, columns were turned off and another rule 
was pasted in. Columns were defined again, this time with the wider 
column coming first. The text was typed, a hard return ended the 

column, and the second ball was pasted in. Columns were turned off, 
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Sports Catalog 
May 1988 

aE
 

Built of rugged American cowhide, this 

sturdy basketball will give years of hard 
usage. Made to the standards of the 
Ameri¢an Basketball Association, this 

standard-sized ball is discounted in lots of 

10 to 20 dozen. 

Basketball, cat. no. 17701 

1-10 doz, $40.95 @; 10-20 doz, $35.95@ 

Shipping weight 9 Ib., 4 oz. 

Its center of long-lasting polypropylene, 
this built-to-take-it soccer ball is manufac- 
tured to the exacting specifications of the 
American Youth Soccer Organization. 

Soccer ball, cat. no. 66410 

4-10 doz., $39.95 @; 10-20 doz., $32.95 

Shipping weight 8 Ib, 5 oz. 

Only the NFL could produce a hard-wearing 
pigskin like this one. Sealed and sewn, it's 
ready for the hardest play your team can 
give it. Specially discounted through 
December 31. 

Football, cat. no, 5580 

1-10 doz., $32.95 @; 10-20 doz., $29.95 

Shipping weight 7 Ib. 6 oz. 

Vol. 4., No. 6 Page 348 

Figure 5.26: By mixing column formats, you can create a well-balanced com- 
bination of graphic images and text. 

the rule was pasted in, and columns were redefined, using the origi- 
nal column definition. (You can search for it and copy it to make sure 
you have exactly the same definition.) 
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Using Special Symbols 

Experiment with the special characters that are available in each 
font. Using the Insert Literal command to insert special characters 
with diacritical marks can give your documents a sophisticated look. 

For example, in Figure 5.27, special characters from New Helvetica 

DINNER MENU 
ca 

Hors d'Ouvres 

Escargots au buere dail... cisco es tyre ww od 6.95 
Snails in garlic butter 

Paté.defoiedevolaill€.. 0. ce we ee 5.95 
chicken liver paté 

HIGNO AMDM crac gate concur tes Siar erissiar foment ancestor 4.95 
ham quiche 

te 

Soupes 

Sounealoignonits 4 a cavhdi ee Sea an Reet 5.95 
onion soup 

Rotage:Cepinands aii su diavieecn scam le eke ct evel 5.95 
Spinach soup 

. 

Frults de Mer 

Coquilles St. Jacques Parisienne 
scallops in parsley butter 

Le loup en croute 
striped bass in crust 

Soufflé roulé farci aux crabes 

Crépes de poularde 
chicken crépes 

Supremes a la Bemoise 
chicken breasts with cream sauce 

Boeut a la mode 
beef braised in red wine 

Boeuf ala Normande . . 
beef with oysters and mushrooms 

Paté chaud bourgeois, 
pork, chicken, and liver in pastry 

Lo 

Vegétaux 

BrOGORON DUGG rae en et pcccen a cea Peet nan cep ene 2.95 
pureéd broccoli 

HanCOIS VERS on wera tions WIRE eG ete 2.95 
green beans and onions 

CarOtBBaViGh ya. vce ky cw Mineiro acti vs ote 2.95 
glazed carrots 

@ 

Figure 5.27: Using special characters, tabs with dot leaders, and justified text 

helped produce this elegant menu. 
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Narrow and symbols from Zapf Dingbats were used to create an ele- 

gant menu. (The heading was created by the PostScript commands 

discussed in Chapter 6, without the showpage command.) 

Project: Creating a Newsletter 
To get some “‘hands on”’ experience in setting up a document with 

text columns and graphics, you can walk through the steps for creat- 

ing the newsletter shown earlier in Figure 5.20. (It’s reproduced for 

you here as Figure 5.28 so that you can follow along step by step.) In 

preparation for this newsletter, the double rules were drawn in Mac- 

Paint and pasted into the Scrapbook. The Auto Loan ad was also cre- 

ated in MacPaint, using Helvetica Outline, and the remaining white 

spaces were filled in with the paint can and in FatBits. ‘Then a single 

unfilled rectangle was drawn around the black rectangle. Since you may 

not want to take the time to do this, and the clip art that was used in this 

newsletter may not be available to you, feel free to substitute your own 

artwork, or just use these steps as a roadmap for creating your own 

document. 

1. Copy the artwork for the masthead from your graphics program. 

In this case, the masthead was taken from a clip art collection in 

ClickArt Special Effects. 

2. Open a new WordPerfect document and paste the artwork at 
the beginning of the page. 

3. Size the masthead by dragging on the handle in the lower-right 
corner. 

4. Paste the double rule from the Scrapbook. 

5. Create the banner under the rule: center the middle phrase, 
place the date flush right; then move the insertion point to the 
left of the first [Center] code and type the volume numbers. 

The banner’s in 12-point Geneva bold. 

6. Turn justification off, if it’s on. Then define three unequal 
newspaper columns with margin settings at 1.0 and 2.0, 2.25 
and 4.25, and 4.5 and 7.5 inches. Turn columns on if you’re 
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serving the financial community 

Thinking The credit union offers 
low rates both on new 

about a and used car loans. In 
New addition, we can 
Car? introduce you to a 

“special discount 
Check program provided by 

our Auto local dealers who sell 
Loan ata set percentage 
Rates above dealer cost, so 

you'll be sure of a 
hassle-free sale. 

What to Watch for When You Step on the Lot 

Don't fall in love at first sight 

Check models at several different 
dealers before you decide on the car 

you want. If you let your heart rule 
your head, you may feel it in your Auto Loans? 

wallet. 
now only 9% 

Don't talk trade-in until you've 
picked out the car and established 
its selling price, which is often not Call Today--X3 768 
the same as the car's sticker price. 
Check with a consumers' group to 

determine the true wholesale cost.& 

October 1988 

Figure 5.28: Follow the steps in the text to recreate this newsletter. 

using the ruler line; just click OK if you’re using the Column 

Options dialog box. 

7. Change font to Helvetica 18 and type the sidebar heading. 

Change to 14 bold and type the subheading. Then select the 
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14. 

18. 

19. 

20. 

headings and press Command-Shift-F or click the right- 

justified icon on the ruler line to make each line flush right. 

Press Command-Return to end the column. 

. For the text, change font to Bookman 12. Then type the text in 

the second column. 

. When you reach the end of the column, press Command- 

Return to end the column. 

. Paste the graphic from the Scrapbook (this one’s from Hyper- 

Card). Then press Command-Return to end the column. 

. Turn columns off and paste the double rule from the Scrap- 

book again. 

. Change font to Helvetica 18 bold and type the heading. 

. Type the subheading in 14-point Helvetica bold underlined 

italics. 

Change back to 12-point Bookman and type the text. Then 

select it and align it flush right. 

. For a finishing touch to the last text column, switch to Zapf 

Dingbats and choose Insert Literal . . . . Then select a symbol 

and click in its box (this one’s at coordinates A,8). 

. Press Command-Return to end the column. 

. Paste the previously created ad from the Scrapbook, using the 

handle to size it after it’s pasted. 

For the footer, go to the beginning of the document and press 
Command-Shift-H (or choose Headers-Footers from the Page 
submenu). 

Change font to Geneva 9 bold and type the date; then use the 
Flush Right command and click on the # box to insert the page 
number automatically. 

Preview the document in its final form. Choose Print Preview 

or press Command-Shift-P. 

You can now print the document and also save it to use as the 
design basis for another newsletter. Remember, once you find a 



You may need to do 
some editing to keep 

columns at their correct 
lengths, and using a 
mockup of the physical 
foldout brochure is 
invaluable in keeping 
track of what you’re 

doing. 
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newsletter format you like (basic font, line length, and so forth), you 
can save it as a custom default format. By double-clicking on that 
default format’s icon in your System folder, you can reuse those set- 
tings in a session with WordPerfect. Chapter 7 explains how to set up 
custom default formats. 

Setting Up Foldout Formats 

‘To set up a two-sided foldout brochure on 8.5 by 14-inch paper, 
choose US Legal from the Page Setup submenu and click sideways 

orientation. WordPerfect can then calculate the correct column set- 
tings for you. (Chapter 6 explains how to do two-sided printing.) 

Fold a sheet of legal-size paper the way you want it to open; then 
number the columns in the order you want the reader to read them as 

the brochure is opened. Note the column numbers on that sheet so 
that you can write them in the right order. You’ll probably find that 
you want the first column (“‘page’’) to be on one side of the paper and 
most of the other columns on the other side. For an eight-page foldout 
brochure with one column per page that opens consecutively, your 
first page will begin with the text for column 2, as Figure 5.29 illus- 
trates. The second page will begin with the text for column 6. You 

can have more than one column on a page, but you’ll need to keep 

track of their order and allow for extra space between the columns 
that occur between folds in the paper. 
How you order your columns depends on the way you fold the 

paper. For example, if you want a brochure that opens outward, fol- 
low the order of columns in the second example in Figure 5.29. 

Specifications for the Examples 

In case you’ve seen anything in this chapter that you’d like to use, 

here are the settings that were used to create the sample documents. You 

can also get these documents on the disk you can order with this book. 

Figure: 5.19 (Opossum) 

Headings: New York 24, Helvetica 18, New Century School- 

book 14 

Text: New Century Schoolbook 12 

Type of columns: Newspaper 
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Column setup Fold 

Continuously 

opening 

brochure 

5 

3 

“French door” 

brochure 

4 

Use for ————_>— 

mailing address 

8 |2)\1 

Figure 5.29: The drawing illustrates the correct numbering of columns for 
various foldout layouts. 

Column margins: First—1.5, 3.25; second—3.5, 7.0 

Special effects: Clip art (Draw Art) 
¢ 

Figure 5.20 (Newsletter) 
Headings: Helvetica 24, 18, and 14 
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Text: Bookman 12 
Type of Columns: Newspaper 

Column margins: First—1.0, 2.0; second—2.25, 4.25; 

third—4.5, 7.5 
Special Effects: Clip art (ClickArt Special Effects, 

HyperCard) 

Figure: 5.21 (Trireme) 
Headings: sidebar and quotes Helvetica 14 bold 
Text: New Century Schoolbook 
Type of columns: Newspaper 

Column margins: First—1.25, 2.0; second—2.25, 4.25; 

third—4.5, 7.0 
Special effects: Drop caps Helvetica 24, New Century School- 

book 14, redline for vertical rule 

Figure: 5.22 (Scandalous Trireme) 
Headings: Geneva 12 italic, Avant Garde 24, Geneva 10 and 

12, Helvetica 12 caps 
Text: New Century Schoolbook 12 
Type of columns: Newspaper 

Column margins: Automatically set (equal) 
Special effects: Footer Geneva 10 bold 

Figure: 5.23 (out of line) 
Headings: New Century Schoolbook 
Text: New Century Schoolbook 12 
Type of columns: Newspaper 
Column margins: Automatically set (equal) 
Clip art: HyperCard 

Figure: 5.24 (Desktop Publishing) 
Headings: Avant Garde 24 and 14 
Type of columns: Parallel 
Column margins: First—1.25, 2.75; second—3.0, 7.0 

Special effects: Sidebars Helvetica 14 with 3 pt. leading; New 

Helvetica Narrow 10; redlining; clip art (DigitArt Laser 

Graphics) 

191 
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Sources for Clip Art and Graphics 

Figure: 5.25 (Sample Columns) 

Headings: Helvetica bold 

Text: New Century Schoolbook 12 

Type of columns: Newspaper 

Column margins: Automatically set (equal) 

Special effects: Margin Release for outdented head, flush left 

and right within justified column, redline for vertical rule 

Figure: 5.26 (Catalog) 
Headings: Helvetica 10 

Text: Bookman 12, Helvetica 10, Geneva 12 

Type of columns: Parallel 

Column margins: First—1.25, 3.25; second—3.75, 7.5 alter- 

nating with first-—1.25, 5.0; second—5.25, 7.5 

Special effects: full-width graphic rule; header and footer Hel- 

vetica 10; clip art (Mac Art Dept.); rule created in 

MacPaint 

The following suppliers are by no means all that are available to 

you. They represent only a small sample of ready-made graphics and 

graphics programs that are on the market. 

Mac Art Department 

DigitArt Laser Graphics 
Image Club Graphics, Inc. 
2828 19th St. NE 
Calgary, Alberta 
T2E6Y9 Canada 
(403) 250-1969 

ClickArt Special Effects 
T/Maker 
1973 Landings Dr. 
Mountain View, CA 94043 
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HyperCard, MacPaint, and MacDraw 
Apple Computer 
20525 Mariani Avenue 
Cupertino, CA 95014 

DrawArt 

Desktop Graphics 

400 Country Drive 
Suite H 

Dover, DE 19901 

(302) 736-9098 

Glue and SmartScrap 
Solutions International 
PO Box 989 
Montpelier, VT 05602 
(802) 229-9146 

Looking Forward 

This chapter has perhaps given you enough hints and tips to help 
you create fairly complex documents on your own. You’ve seen how 
to work with text in columns and combine them with graphics. 

The next chapter contains valuable information about printing, 
which you’ll also be interested in if you’re going to do desktop 
publishing. 
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Fast Track 

To print the document that’s on the screen, 

choose Print from the File menu. Its keyboard shortcut is 
Command-P. 

To print a saved document 

that isn’t displayed on the screen, use the File Management 

dialog box (Command-L) instead. 

To print text 

that is highlighted on your screen, use the Print Selection 

command. 

To choose the print quality, 
the number of copies to be printed, and specify which pages are 

to be printed, use the Print dialog box. 

To specify the page setup you want to use, 
preview a document before it’s printed, print a section of text 

instead of an entire document or page, or insert special Post- 

Script commands in your document, use the Print Options 

submenu. 

To preview your document, 
to see how it will look when it’s printed, choose Print Preview 

from the Print Options submenu. Its keyboard shortcut is 

Command-Shift-P. 
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CHAPTER 

= The printer you’ve 
selected with the 

Chooser determines how 

WordPerfect formats your 
document. 

6 

YOU CAN EASILY PRODUCE: AN INCREDIBLE VARIETY 

of special effects in your printed documents with WordPerfect on the 

Macintosh. You can combine text and graphics and choose from a 
huge variety of fonts and type styles—even bold italic outline 
shadow, if you like. If you’ve been using WordPerfect on another 
computer, you’ll find that most of the time-consuming printing 
chores have disappeared in WordPerfect on the Macintosh. To 
change fonts or switch printers, you simply click with the mouse. 

WordPerfect uses the printers you’ve installed in your System 
folder, so whatever printer your Mac can use, the program can use 

also. If you’ve got more than one printer, select the one you want to 
print with by using the Chooser on the Apple menu. 

The Apple printers are most commonly used with the Macintosh, 
so this chapter will provide tips and specifics about using those 
printers as well as a general discussion of WordPerfect’s printing 
techniques. 

Printing a Document 

In WordPerfect, you can print the document that’s on the screen 
by choosing Print from the File menu. Its keyboard shortcut is 
Command-P. If you want to print a document that has been saved 
but isn’t currently displayed on the screen, use the File Management 
dialog box (Command-L) instead. Option 2 on the File Manage- 
ment menu lets you print WordPerfect files without opening them. 
Either of these methods takes you to a Print dialog box that’s specific 
to your printer. 

You can also print a,highlighted selection on your screen by using 
the Print Options command on the File menu. Option 3 on the Print 
Options submenu, Print Selection, prints the text you’ve selected, 
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without displaying a Print dialog box. It’s a quick way to get a print- 
out of a small amount of text. 

Choosing Print displays the Print dialog box, which lets you 
choose the print quality, the number of copies to be printed, and 
specify which pages are to be printed. The dialog box you see 
depends on which printer you’ve selected with the Chooser. Figure 
6.1 shows an ImageWriter II Print dialog box, while Figure 6.2 is the 
Print dialog box for a LaserWriter Plus. 

Later in this chapter, we’ll look in more detail at the options that 
the Apple printers give you, but first let’s look at some printing fea- 
tures that are common to most printers. 

Print Quality 

Most Print dialog boxes let you select different print qualities. 
Depending on which printer you’re using, you may see several print 
quality choices in the dialog box. If you select the highest-quality 

printing your printer can provide, be prepared for it to take longer 

than the lower qualities. Graphics in your documents also slow print- 

ing down. Draft quality is fastest, but it is usually in a monospaced 

" é File Edit Search Format Font Special Windows 

Doc 1: Speller ch 

ImageWriter Co alee 

Quality: O Best © Faster O Draft aa iid 
Page Range: @All © From: Pea To: ae 

Copies: ne 4 

Paper Feed: @Automatic © Hand Feed 

Ll] Every other page ([]Print backwards 

Figure 6.1: The ImageWriter Print dialog box appears if you’ve selected the 
ImageWriter with the Chooser. 
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If you’re using an 
ImageWriter driver 

version 2.3 or later, you 
can speed up the Faster 
printing time slightly by 
holding down Option- 
Shift-Caps Lock as you 
click OK in the Print 
dialog box. This sets the 
ImageWriter II’s print 
head to print in both 
directions. 

& Fite: Edits Search | FocmatiLont - Species ee eee peel iets ATES | a 

LaserWriter “LaserWriter Plus” 

Copies: Pages:@ All © From: ba | To: 

Cover Page: @NoO First Page © Last Page 

v5.0b6 l ok | 

Paper Source: © Paper Cassette © Manual Feed 

LJ Every other page L] Print backwards 

Figure 6.2: A LaserWriter Plus’s Print dialog box contains options different 
from an ImageWriter’s. 

font (like Monaco), and uses only plain, bold, and underline styles. 
Also, draft quality doesn’t print the graphics in your document. 

Printing Selected Pages 

To print several pages or just one page, click in the From box and 

enter the starting page number; then click in the To box and enter the 

ending page number. The printer prints to the end of the last page 
number you use, so to print only one page—say, page 5— print From 
page 5 To page 5. 

Number of Copies and Paper Feed 

Most printers also let you select the number of copies to print and 
the method that’s being used to feed the paper into the printer. For 
example, laser printers use cassettes of single-sheet paper, while most 
dot-matrix printers use continuous-form paper. However, on either 
type of printer you can select Manual or Hand Feed when feeding 
the printer single sheets or envelopes. If you’ve selected Manual or 

Hand Feed, you’ll usually see a dialog box before the printer prints 
each page, prompting you to insert the next sheet of paper. 
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WordPerfect for- 
mats your docu- 

ments according to 
whatever printer is listed 
in the Page Setup dialog 
box. Whenever you 
switch printers by using 
the Chooser, go to the 
Page Setup dialog box 
and click OK so that your 
documents will be for- 
matted for the new 
printer. If you don’t, you 
may get odd margins. 

Make sure the page 
setup is correct before 

you print. If you changed 
paper sizes earlier without 
quitting WordPerfect, the 
latest setting is still in 
effect. 

Other Features 

Depending on your printer, you may also have choices about whether 
you want the document printed backward, starting with the last page 
and leaving page 1 as the first face-up page, or whether you want a cover 
sheet to be printed with the document. We’ll look at some common 
ImageWriter and LaserWriter options later in the chapter. 

Changing Print Options 

Before you print a document, you can change certain printing 

options. The Print Options submenu lets you specify the page setup 
you want to use, preview a document before it’s printed, print a 

selected portion of text instead of an entire document or page, or 
insert special PostScript commands in your document. 

Page Setup 

Like the Print dialog box, the Page Setup dialog box is associated 
with the printer you’re using, so the choices that are available vary 

from printer to printer. A few features are common to most printers. 

Paper Sizes 

US Letter is standard 81/2 by 11-inch paper. US Legal is 81/2 by 14- 
inch paper. A4 Letter is 81/4 by 11?/s inches, a popular size in Europe. 

B5 Letter is 9°/10 by 7 inches, a popular Japanese size. International 

Fanfold (also called continuous form or computer paper) is 81/4 by 12 
inches. 

Not every printer provides the same amount of print area, though. 
Table 6.1 lists a few common print areas for the Apple printers. If you’re 

using columns in your documents, the print area available with your 
printer will influence how WordPerfect calculates columns. 

Orientation 
If you’re printing envelopes or printing sideways on the page, you’ll 

want to change the orientation of the printing. You may see icons of an 
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Table 6.1: Print Areas for the LaserWriters and ImageWriters 

Printer Paper Size Print Area 

LaserWriter US Letter 8.0 3 TI SIO) Sven Gieday 

US Legal 8.5 x 14 8.0 x 13 

A4 Letter 8.25 x 11.67 V8 x thet 

B5 Letter 08 x7 7.69 x 10 

ImageWriter US Letter seeieeoallll ESA Vion Ul 

US Legal 8.5 x 14 8.0 x 14 

A4 Letter 8.25 x 11.67 iy We as WY’ 

On an ImageWriter LQ, you can print from 3.5 to 13.6 inches wide, as it has 

a 15-inch carriage. 

upright figure and a horizontal figure on a page, or you may have the 
choice of Landscape (sideways) or Portrait (upright). 

Other Page Setup Features 

Depending on the printer you’re using, you may also be able to 
have the printer substitute printer fonts for the screen fonts you see 
on the screen, have it ‘‘smooth”’ graphic images, or reduce or enlarge 
the printing. You may also be able to rotate images horizontally and 
vertically. 

If you’re using an ImageWriter, you’ll see a screen similar to the one 
in Figure 6.3; with a LaserWriter, it will resemble the one in Figure 6.4. 

The actual screen you see will also depend on the version of the printer 
software you ve installed. 

Imagewriter Print Options 

If you’re printing with an ImageWriter, you can select the size of the 
paper, create certain special effects, and change the orientation 
of the printing. 
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@ File Edit Search Format Font Special Windows 

ImageWriter 

Paper: @US Letter © A4 Letter 

© US Legal © International Fanfold Cancel 
© Computer Paper 

Orientation Special Effects: [Tall fidjusted 

fa []50 % Reduction 
easy LJ No Gaps Between Pages 

Pos Semin PIB oN Tols | se Fe 

Figure 6.3: The ImageWriter’s print options are different from those for the 
LaserWriter. 

" & File Edit Search Format Font Special Windows 

Doc 1: Untitled 

LaserWriter Page Setup y5.0 

Paper: © US Letter © A4Letter Reduce or F 
OuS Legal O©OB5 Letter Enlarge: [ool 

Orientation Printer Effects: 

XX] Font Substitution? 

XX] Smoothing? 
XX] Faster Bitmap Printing? 

Figure 6.4: A LaserWriter’s print options dialog box may be similar to this one, 
depending on which LaserWriter you’ re using. 
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On an ImageWriter, choosing Tall Adjusted causes it to print at a 

density of 72 dots per inch by 72 dots per inch. Normally, an ImageWn- 

ter prints 80 dots horizontally and 72 dots vertically, which causes circles 

to be printed as ovals. If there are graphics in your documents, choose 

Tall Adjusted, and circles will print as circles. 

Choosing 50% Reduction prints your document at half its original 

size. Choose No Gaps Between Pages if you have also selected the Com- 

puter Paper option. 

LaserWriter Print Options 

On most LaserWriters, the Page Setup dialog box contains other 
options to control paper size, printing orientation, amount of reduction 

or enlargement, and special effects. 

If you enlarge type, it For example, you can reduce print to 25% of its size or enlarge it to 
rie ne eniaear fae oe 400%. The 100% setting prints it at its normal size. 

If you check Font Substitution, the LaserWriter substitutes its built-in 
fonts for the Macintosh screen fonts. ““Smoothing”’ makes graphics cre- 
ated in a paint-type program such as MacPaint or FullPaint look 

smoother when printed, but slows printing time down slightly. Faster 
Bitmap printing speeds up the printing of paint-type graphic images. 

For the best Ay a Depending on which version of the LaserWriter printing resource 
printing with the : : : : . : 

TW itor doaclest the you’re using, other options may be available if you click Options. For 
Faster Bitmap Printing example, Precision Bitmap Alignment automatically reduces bit- 
option. Choose Precision mapped graphics for better printing. You may also have an option for 
Bitmap Alignment and : : : ) : 
Pate Praha from selecting a larger print area if you aren’t using many download- 

the Options dialog box. able fonts. 

For more information on screen fonts and bitmap printing as well 
as printing graphics, see the specialized printer sections later in 
this chapter. 

Print Preview 

WordPerfect displays most of your document on the editing 
screen, but it doesn’t display headers and footers, footnotes, and top 
and bottom margins. ‘To see how your document will look with these 
when it’s printed, you can choose Print Preview from the Print 
Options submenu. Its keyboard shortcut is Command-Shift-P. 

When you choose Print Preview, you’ll see the page the insertion 
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point is on, as Figure 6.5 illustrates. The status line will indicate the 
number of the displayed page. To look at the page following that page as 
well, click on the double-page icon on the left of the Print Preview 
window. 

Choosing Print Preview is also a good way to see how tables are 
being broken between pages so that you can insert any hard page 
breaks that may be needed. 

You can click on either of the other two icons in the dialog box to 
move forward and backward through the document. To inspect a 
page at its actual size, click on the part you want to look at more 
closely. The document will then be displayed full-screen size; you 

can’t edit it, but you can check to see what it contains. To return to 
the Page Preview window, click anywhere in the document. 

To stop previewing a document and return to the regular editing 
screen, click on the close box. 

Using PostScript Commands 

You can also embed PostScript commands in your WordPerfect 

documents. PostScript is a page-description language that is used by 

search Format Font Special Windouss 

Print Preview 

Abedaves, ere imped tee erireprerverti chee | ard Muar the ahabrge 
Wengatrhg md remadag GorVacs rib serene 0 Mumgee via birvtetire 
wre resid fer Initiative md terry eure pasate Sr anercgring the 
aide of caper she mikes; cmphagres Win Inthe pact worn rrworied tar they 
Wiese: bo nage oablited they rad ome Aftrw aopervts arena. Ih 
ihe cing Wf tmcirame Gre, Oral sheep Ba orgag reales rb mg 
be mata 

(ta coma brs tha hechoes bc Mealng rts chafbagn, timers prt enather 
thaleng tor sanding fo Lire prevth A urvisbachoe anes! be hand ta 
wings :H runt anus Oo araing Dar he Aime Te dtm, hewn ana, mg 
ree trerdterten rater then tomer mreartretin ae wera a rig. 
Vit sarther tape of thinirhe be reqried:thut eT orevang phavre « 

Tina Gift tac rf Metre mer! mung ererw ct of pte ta 
revisor carver stably virte paring fr firs mguacten Bish poorere 
treat ka oi te Jugt ane not eT earmorve ve mcmmrmpiians whe al the ume tes 
oral g 2 flan of Magy Femgrative prapartine tel mrmorec Mee aid be 
Wer Gr fee ord hayed Ded Thiet sro neared; wee Meard, tg aurerend 
mevieet onerne 

1 SIC Oarad, Paver ewire Mnvtet Hote 11MLE. WL 

0 POL @hcrne, Ranbeaeveeed IGitces x Prreidety, 1088, 

sundaibal en eeem rey rerroonnen 
(ane ee Ure tinass Rerate le Crocmn hy Yerba hil Now 

Figure 6.5: If you choose Print Preview, you’ll see your document as it will 
print, but in a reduced size. 
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e) Any PostScript 
commands you use 

should be “‘well 
behaved.” To avoid 
causing trouble, don’t use 
initgraphics, erasepage, 
copypage, grestreall, 

initmatrix, initclip, band- 

device, framedevice, 

nulldevice, and render- 

bands. Also, be aware 

that including a ~Q ina 
Postscript command will 
terminate your print job. 

many laser printers and some typesetting equipment. It represents 

fonts mathematically, so by issuing commands in PostScript you can 

produce characters in any size, at different rotations, and in different 

resolutions. You can control the way text and graphics appear on the 

page in ways that aren’t possible with traditional typesetting. For 

example, you can bend or stretch letters, clip portions of them, shade 

them, and use the letters themselves as graphic elements. In fact, you 

can modify the style of any font or even design your own fonts. 

Although the subject of PostScript programming is beyond the 

scope of this book, you can refer to David Holzgang’s Understanding 

PostScript Programming (SYBEX) for an excellent introduction to the 
language. The example that follows is taken from that book. 

The example of PostScript programming in Figure 6.6 creates the 
words ““DINNER MENU” across the top of a page. It will be cen- 
tered one inch from the top and printed as an outline shape in 
36-point Times Italic. The printed results are illustrated in Figure 6.7. 

For additional information on PostScript, refer to Appendix C of 

72 mul } def 

/centerText 
{ /Right exch def 

/Left exch def 
dup 
stringwidth pop 
2 div 
Right Left sub 2 div 
exch sub 
Left add 
Line moveto 

/Times-Italic findfont 36 scalefont setfont 
/Line 10 inch def 
(DINNER MENU) 
1 inch 7.5 inch centerText 
false charpath 
stroke 
showpage 

Figure 6.6: This sample PostScript program creates the heading shown in 
Figure 6.7. 
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DINNER MENU 

Figure 6.7: Embedding PostScript commands allows you to create special 
effects as shown in this headline. 

In addition to stan- 
M8 dard PostScript 
commands, you Can use 

the PostScnpt Language Reference Manual and a supplementary publica- 
variables like $§VPOS tion, called PostScript Structuring Conventions. Both are direct and useful 
and $$HPOS (vertical sources, published by Adobe Systems, Inc.; their address is in the list 
and horizontal position), of font suppliers at the end of this chapter. 
$$PNUM (page num- 
ber), $$}BMAR, 

$$TMAR, $$LMAR, 
$$RMAR (margins), and 1. Choose Print Options from the File menu; then choose 
$$DATE. PostScript. 

You’ll see a dialog box like the one in Figure 6.8. 

To insert a PostScript command: 

2. Type the PostScript command or set of commands you want to 
send to the printer. 

If you’d rather write the PostScript command file on the editing 
screen, you can do so and then copy it; then just paste it 
(Command-V) into the Printer Command dialog box. 

3. Click OK. 

You won’t see the embedded Postscript commands on the screen, 
but you can see them by viewing the Codes window. They won’t 
affect the format of your document on the screen, but when you 
print your document, the special effect you called for will be 

created. 
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Oe) The position of your 
PostScript com- 

mands is important. Ifa 
PostScript routine located 
in the middle of a page 
contains a showpage 

command, the page will 
print when WordPerfect 
reaches the showpage 
command instead of 
printing the full page of 
text. 

% fie f€dit Search Format Font Special Wty OIE Sa aco AE 

PostScript 

Jinch 
{ 72 mul ) def 

/centerText 
{ /Right exch def 
/Left exch def 
dup 

stringwidth pop 

2 div 

Right Left sub 2 div 

exch sub 

Left add 

Line moveto } 

/Times-ltalic findfont 36 scalefont setfont 

/Line 10 inch def 
(DINNER MENU) 

1 inch 7.5 inch centerText 

Figure 6.8: The PostScript dialog box lets you issue PostScript commands to 
your printer. 

You can click on the Previous and Next buttons to edit PostScript 

commands that are already inserted in a document. If the command 

is above the insertion point, click Previous; if it’s below it, click Next. 

You can continue to click either button until you’ve found the com- 
mand you’re looking for. 

Now that we’ve covered WordPerfect’s printing commands and 
options, it’s time to take a closer look at how some of the actual 
printers work. You'll also find valuable information in the next sec- 

tions about working with screen and printer fonts. 

Installing Printing Resources 
When you buy a new printer or get an updated version of the sys- 

tem software, you’ll need to install it on your startup disk by using 
the Installer. You’ll also want to copy any new fonts that you acquire 
into your System file, but you use Font/DA Mover for that. We’ll 
look briefly at both procedures even though they’re not WordPerfect 
operations. Consult your Macintosh manuals for more information 
about them. 



WordPerfect needs 
System version 4.1 or 

later. If you install a newer 
system, use Font/DA 
Mover to put your fonts 
and desk accessories back 
into your System file, or 
the default settings will be 
wrong. 

After you’ve 
8 installed a new 

printing resource, choose 
Page Setup before you 
print any document. You 
don’t have to change 
anything in it, but choos- 
ing it activates the new 
printing resource. 
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Using the Installer 

To install new system files and printing resources, you use a pro- 

gram called the Installer, which WordPerfect provides on the System 
disk. Its icon and the icons of the scripts it uses resemble a page with a 
large left-pointing arrow (Figure 6.9). You may receive new Installer 
scripts from time to time as you upgrade your WordPerfect program 

and new printing and system resources become available. 

To use the Installer, you’ll need to start your Macintosh with a 
startup disk other than the one you’re updating, because the system 
will be using the system files on the startup disk. 

After you’ve started your Macintosh, open the Installer by double- 
clicking on its icon. If you’re installing a new script, such as one for 
background printing, first copy it into the Installer Script folder so 
that it will be available to the Installer. Then insert the startup disk 
you want to update. 

When the Installer starts, you’ll see a list of the printing and sys- 

tem resources that you can install. Click on the resources you want to 

install; then click Install. You can click on the Drive button to change 
the disk you’re updating. 

@ File Edit View Special 

A System Tools a 

3 items 761K in disk 

System Folder 

a 
Update Folder 

3 items 761K in disk 

Apple HD SC Setup Installer 

Figure 6.9: The Installer puts new printing resources into your System file. 
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Your printing resources all need to be the same version. The 

Installer won’t let you install a new version of a background printing 

script into a system file that also has earlier versions of the LaserWri- 

ter and LaserPrep resources. 

Using Font/DA Mover 

You use Font/DA Mover to copy screen fonts into your System 

file, as illustrated in Figure 6.10. Once they’re in your System file, 

any application can use them. Unlike the Installer, Font/DA mover 

can copy fonts into the current startup disk, so you don't need to 

restart your Macintosh first. 

Font/DA Mover copies only screen fonts, not printer fonts. Be 

sure to copy each font’s printer version (if it has one) into your Sys- 

tem file by dragging its icon. A printer font’s icon looks like a minia- 
ture printer, while a screen font’s icon resembles a stack of paper. 

To copy new fonts into your System file (or remove unwanted 

fonts to save space): 

1. Open the font file that has the new fonts. This also starts Font/ 

DA Mover. 

© Font 
© Desk Accessory paeee 

[Athens 18  —«{Q| [ >> Copy >> _} [Avant Garde 12 
Cairo 18 | Avant Garde 18 
Courier 9 Bookman 10 
Courier 14 Bookman 12 

Courier 18 Bookman 14 

Courier 24 5990 bytes = [chicago 12 
Helvetica 9 selected Courier 10 

Fonts i : System 
onhome stuff | :  onhome stuff 

i 23554K free 

Cairo 18: HG = bade 63, OO if 

Figure 6.10: When you acquire new fonts, copy their screen versions into 
your System file by using Font/DA Mover. 



You can install fonts 
in your WordPerfect 

application instead of 
your System file. Hold 
down the Option key 
when you click Open in 
Font/DA Mover. You’ll 
see a list of applications; 
choose WordPerfect. If 
you don’t have a hard 
disk, this process can save 
you some space on other 
program disks that you 
use as startup disks but 

don’t really need a wide 
range of fonts for, like a 
spreadsheet program. 

oS If you switch 
between using an 

ImageWriter and a 
LaserWriter, be sure to 

click Tall Adjusted in the 
ImageWriter’s Page 
Setup box. Otherwise, 
formatting in your docu- 
ments will change as you 
switch from one printer to 

the other. With Tall 
Adjusted on, page 
breaks, line breaks, and 

margins are the same for 
both the LaserWriter and 
the ImageWriter. 
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You’ll see a list of the fonts in that file in the left-hand box. 

2. Open your System file in the right-hand box. 

You may have to move through several folders to find it. 

3. Click on each font you want to copy; then click Copy (or 
Remove). 

You'll see a a sample of the font at the bottom of the screen. You 
can shift-click to select several fonts. 

4, Click Quit when you’re through. 

For example, in Figure 6.10, the Cairo font is being copied to the 
System file on a disk named home stuff from a file named Fonts on 
the same hard disk. 

Now that you’ve reviewed the process of installing printers and 

fonts, you can look in more detail at some specific printers and how 

they work. 

The Apple Dot-Matrix Printers 
The Apple ImageWriters printers are dot-matrix printers. They 

form characters that are composed of tiny dots. Using Faster (stan- 

dard) printing mode, an ImageWriter prints 72 dots per inch (dpi). It 
prints about 150 dpi in its Best-quality mode. Apple calls this near- 
letter-quality. The ImageWriter LO can print at 216 dpi, which 

Apple refers to as letter quality. In contrast, the LaserWriter has a 

resolution of 300 dpi, and Linotronic typesetters have resolutions 
from 1200 to 2500 dpi. 

Basically, an ImageWriter prints a dot-by-dot representation of the 
image you see on your screen. The characters on your screen are also 
represented at 72 dots per inch, so what you see is exactly what you 
get with Faster quality printing on an ImageWriter. 

ImageWriter Fonts 

The basic ImageWriter fonts are all named after places: Chicago, 

New York, Monaco, Venice, Geneva (the default screen font), and so 

forth, but many other fonts are available. A list of sources for addi- 

tional fonts is given at the end of this chapter. 
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1) Don’t delete 
Geneva 9 or 12, 

Chicago 12, or Monaco 
9: the Macintosh’s system 
uses them. If you need 
more disk space, delete 
the icons for printers that 
you aren’t using, or 
delete any document files 
that may be on your 

startup disk. 

her If you want to use 
small caps in docu- 

ments that are to be 
produced on an Apple 
dot-matrix printer, you’ll 
need two sizes of the font 
in your system file—four 
if you’re doing Best- 
quality printing. For 
example, for 12-point 
caps with 9-point small 
caps, you'll need the 9-, 
12-, 18-, and 24-point 

sizes on an ImageWriter, 
and the 9-, 12-, 27-, and 

36-point sizes on the 
ImageWriter LO. 

Seattle, a font from Microsoft, is a good font to have if you’re 

doing a lot of typing of numbers in columns and rows. It has mono- 

spaced numbers but proportionately spaced letters, so you can align 

figures in columns and rows while producing attractive column head- 

ings and text with the proportionately spaced letters. 

The Macintosh stores each character in a screen font as an array of 

pixels, called a bitmap. Special QuickDraw routines create the char- 

acters on the screen as you type, and send them to the printer when 

you print. Storing this kind of information requires a lot of memory 

(for example, the full set of fonts for the Imagewriter LO takes up 

about 2.6 megabytes), so if you’re using floppy disks, keep only the 

fonts you use regularly on your startup disk. 

The sizes of the fonts you’ve installed are important, too. In Best- 

quality mode, the ImageWriters I and II look for a font size that’s 

twice as large as the one you specified and reduces it by 50 percent. 

For the best results, make sure that you have both sizes in your Sys- 

tem file. For example, if you’re going to use 12-point Geneva heads, 

make sure the System folder contains both 12-point and 24-point 

Geneva. You can tell which sizes you’ve installed by looking at the 

Font menu: the installed sizes for the font that’s checked are outlined. 

(You can use the other sizes, but the results won’t be as pleasing.) 

In contrast, the ImageWriter LQ achieves its letter-quality (216 dpi) 

output by looking for a font that’s three times as large as the one 

that’s on the screen. It then prints the characters by using the dot pat- 
tern of the font that’s three times as big, but in the size that’s on the 
screen. The printed dots are thus three times closer together than 
they would normally be (72 x 3 = 216). So if you’re using an 
ImageWriter LQ to do letter-quality printing, you’ll need to install 

fonts that are three times the size you’ll normally be using. If you 
want to print 12-point Geneva, you’ll need to install both 12-point 

and 36-point Geneva. 

You can also print in color on an ImageWriter LQ. The color 
option is automatically activated when you install a color ribbon. 
Four basic colors—yellow, cyan (blue-green), magenta (reddish pur- 
ple), and black—are used to create other colors such as orange, 
green, and purple by overprinting. 

If you’re not doing letter-quality printing on an ImageWriter LO. 
or Best-quality printing on an ImageWriter, don’t worry about the 
extra sizes. In the Faster quality mode on both printers, the screen 



If you’re using a 
LaserWriter II SC, 

you’ll need to install fonts 
that are four times the size 
you'll normally be using. 
Like the ImageWniter LO, 
this printer creates high- 
quality printing by scaling 
down the dot pattern of a 
larger font. 

If you run out of 
® space for fonts in 

your System file, get a 
program called Suitcase 
or Font/DA Juggler Plus. 
They let you install more 
fonts and desk accessories 
than your Macintosh’s 
system allows. Suitcase 
also has a nice utility 
called Pyro that will 
automatically protect 
your screen when you 
leave your Macintosh 
unattended for more than 
a few minutes. See the list 
of font suppliers at the 
end of the chapter. 
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font is sent directly to the printer. You can save space on your disk by 
not installing the extra sizes in your System file. 

The Apple Laser Printers 

The Apple Laser printers—the original LaserWriter, the LaserWriter 
Plus, the LaserWriter II NTs, and the LaserWriter II SC—were 

designed especially to take advantage of the Mac’s graphics capabil- 
ities. Unlike dot-matrix printers, all but one of these laser printers 
store in their own memory information about the characters they 
produce, and they produce these characters in a very different way 
from the ImageWriters. (The LaserWriter II SC is the exception; it is 
a laser printer that uses QuickDraw commands to produce its text 
and graphics, like the ImageWriters. ) 

Instead of being composed of dot patterns, laser font characters are 
built from instructions in PostScript, which also handles the place- 
ment of text and graphics on a page. In PostScript, each character is 

described as a set of points that are connected by lines and curves. 
The laser printer generates variations in style, such as boldface or 

italic, from the original font description. 

Laser Fonts 

Each font used on a PostScript printer consists of two versions: a 
screen font that you see on the screen and the PostScript printer font 
that the printer uses. For the best match between what you see on the 
screen and what you get in your printed document, you'll need to 
install a screen font for each style (plain, italic, boldface, and so on). 
You only need to store one size of a printer font, because the Post- 
Script routines in the printer can scale the font to the size you specify. 

Apple only provides roman screen fonts for the LaserWriter. The 
bold and italic you see on your screen are generated from the roman 
version. (You may have noticed distorted characters on the screen 
when you chose font sizes other than those installed in your System 

file, too.) For better legibility on the screen and exact WYSIWYG 

when you print, install italic, bold, and bold italic screen fonts in your 

System file. You can buy them from Adobe-or download them from 

the Adobe Forum on CompuServe (see Chapter 14 for more about 

accessing CompuServe). When you install these screen fonts, install 
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If you’re using a 
m8 LaserWriter with 

fonts that allow for frac- 

tional widths, you can 
choose Fractional Widths 

from the Screen menu for 

more precise justification 
in WordPerfect. Font 

Substitution won’t be 

possible in a document 
with Fractional Widths 

on, though. 

only the same sizes as the roman font you’ve already got. WordPer- 

fect will use them when you choose italic or bold; you don’t have to 

select the separate italic or bold font from the Font menu. 

The basic LaserWriter comes with four fonts—four font families, 

to be precise, as each contains style variations such as bold or italic. 

They are stored permanently in the LasérWriter’s ROM (read-only 

memory): 

e Times—a proportionally spaced serif face, the equivalent of 

Times Roman 

e Helvetica—a proportionally spaced sans serif face, which is 

also called Optima or Univers in the typesetting world 

e Symbol—a special collection of symbols 

e Courier—a monospaced font that resembles typewriter output 

On the LaserWriter Plus and the LaserWriter II NTs, you also get 

Palatino, Bookman, Zapf Chancery, Zapf Dingbats (in printing ter- 

minology, dingbats are symbols), Avant Garde, Helvetica Narrow, 

and New Century Schoolbook, in 10, 12, 14, 18, and 24 point. 

Using Additional Fonts 

Other fonts for the LaserWriter have to be purchased separately. 

An enormous variety of fonts and type styles can be acquired this 

way. You'll find that building a laser font library can be a serious 

investment, as laser fonts are not inexpensive. A list of commercial 

sources for additional fonts is provided at the end of this chapter; you 

can often locate public domain fonts (freeware) or fonts at a very low 

cost (shareware) on many of the Macintosh-oriented electronic bulle- 

tin boards. 

Downloading Laser Fonts 

Any additional LaserWriter fonts will have to be downloaded to 
the printer. First, you’ll need to use Font/DA Mover to install the 
screen versions of these fonts to see their representation on the screen. 

You’ll then need to copy the new printer fonts and the downloader 



Unless you’re using 
a hard disk or 

double-sided (800K) 
floppies, using automati- 
cally downloaded 
LaserWriter fonts is 
impractical because of the 
amount of disk space they 
require. 

qi in a hurry? Fonts 
MNS stored ina 

LaserWriter’s ROM are 
the fastest to print. Fonts 
that are downloaded 
automatically take a few 
seconds longer than fonts 
that are manually 
downloaded. 

If you’re not sure 
MS why a document 

won’t print, try printing 
it in one of the fonts in 
the LaserWriter’s ROM, 

such as Times or 
Helvetica. If it prints 
now, you were probably 

trying to use too many 
fonts in the original 
document. 
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into your System folder. The downloader icon resembles a LaserWri- 
ter that has a sheet of paper sticking out the top with a T on it. You 
download the fonts to the LaserWriter using a program provided by 
the font vendor. 

You can either manually download them to the LaserWriter before 
printing, or you can have them automatically downloaded as they 
occur in your document. Manually downloading a font sends the 

font to the LaserWriter’s memory before it prints your document. 
With automatic downloading, each time your document needs a 

font that isn’t in the LaserWriter’s memory, the Mac searches the 
System folder and downloads the font to the LaserWriter when it 
finds it. 

If you’re using only one or two fonts (and if nobody else is printing 
with downloadable fonts, when sharing a LaserWriter), it’s best to 

download manually. Fonts that are downloaded manually remain 

available until you turn the printer off. If you’re using more than 
three fonts, download automatically. Each font stays in the LaserWri- 
ter’s memory only until that document is printed. This is slower than 
downloading manually, but because the fonts are removed from 
memory, you have more memory available for the next document. 

Mixing Fonts in a Document 

It’s easy when you first begin printing on a LaserWriter to overdo 
the use of fonts because there are so many to choose from. However, 
your printed documents will look much more professional if you keep 

the number of fonts you use to two or three—perhaps a serif type 
such as Times for the text and a sans serif such as Helvetica for the 
headings. Not only will your documents look clearer, but they’ll also 
print faster, since the more fonts you use, the longer it takes a 
LaserWriter to print a document. 

If you are using too many fonts, you’ll get a message that you’re 
running out of memory—but these messages don’t remain on the 
screen for very long. So if you’re downloading fonts automatically 
and leave the printer to get a cup.of coffee, you may return to find 
that your document hasn’t printed out, with no indication as to what 
went wrong. If you’re downloading fonts manually and run out of 
memory, the LaserWriter will probably restart itself and print a new 

startup page. 
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Printing Tips and Techniques 

The following sections present various tips and techniques and 

other useful hints for dot-matrix as well as laser printers. These tips 

assume you’re printing only a few envelopes at a time. For merge 

printing from a secondary file of addresses, see Chapter 9. 

Printing Envelopes on an ImageWriter 

For regular business-size envelopes preprinted with a return 

address, follow these steps. If you print envelopes often, you may 

want to record them as a macro, as discussed in Chapter 8. 

. Copy the address block at the beginning of the letter. 

. Open a new document for your envelope format. 

. Set the left margin at 4 inches. 

em GC NH -& _ Press Return seven times to create seven blank lines at the 

beginning of the envelope page. 

. Paste the address block on the eighth line. 

6. Choose Print Options from the File menu; then choose Page 

Setup. Click on sideways orientation; then press Return. 

Or 

7. Choose Print from the File menu (or press Command-P). 

Select the Hand Feed option and press Return. 

Insert the envelope lengthwise. The ImageWriter advances the 

paper before it begins to print, so roll back the envelope until the edge 

is under the platen, past the pressure rollers. You may also want to 

adjust the printer’s thickness control to 2, as the envelopes will proba- 

bly be thicker than the paper you’ ve probably been using. The thick- 

ness control level is under the ImageWriter’s cover, on the right. 

Press it once to adjust the thickness to 2. 

Printing Envelopes on a LaserWriter 

If you’re going to print envelopes on the Laserwriter, you’ll also 
need to set up your document so that you can hand feed the envelopes 

into the printer. 



Oo If you’re hand- 

feeding paper into a 
LaserWriter, you have 
about a minute and a half 
in which to insert the next 
page or envelope. If you 
take longer than that, the 
LaserWriter will probably 
cancel the job. 

i If you’re not using a 
8 Macintosh IJ ora 
LaserWriter, Command- 

Shift-4 will print the 
contents of the active 
window. Hold down the 
Caps Lock key as well to 
print the entire screen. 
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For regular business-size envelopes that have been preprinted with 
a return address, follow these steps to print the address block: 

1. Copy and paste the address block from your letter into a new 
document. 

. Set the left margin at 4 or 5 inches. 

. Select sideways orientation from the Page Setup dialog box. 

. Select Manual Feed from the Print dialog box. 

. Insert the left end of the envelope, face up, when the “‘ready”’ 
light comes on. 

oO Be & ND 

Place the envelope face up against the guide on the far side of the 

paper feeder tray and push it in slightly. You may need to help pull it 
out, too. 

Because you can’t print in the top half inch of the sheet on a 
LaserWriter or LaserWriter Plus, you probably won’t want to print 

return addresses. On the LaserWriter IIs, you can print to within 0.2 

inches of the edges of the paper, however, and they have optional 
envelope cassettes. 

Printing lmageWriter Fonts on a Laser Printer 

The LaserWriter produces ImageWriter fonts in two different 
ways. If you turn Font Substitution on, it converts the basic Image- 
Writer fonts to laser fonts whenever it encounters them in your docu- 
ment. New York becomes Times, Geneva becomes Helvetica, and 

Monaco becomes Courier. If you turn Font Substitution off, the 
LaserWriter creates its own PostScript version of the fonts it finds in 
your document. This can take a while, and you may not be pleased 

with the results. 

If you want to use ImageWriter fonts—such as Athens, San Fran- 

cisco, Venice, and so forth—on the LaserWriter, keep a large-size 

version of them in your System file. The LaserWriter uses the largest 

version it can find and scales it down for laser printing, so the larger 

the size, the smoother the curves in the printed result. 
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If you’re using a 
Macintosh II with a 

color monitor, you’ll need 

to change the monitor type 
in the Control Panel to 
black and white before you 
can do screen printouts. 

Getting a printout 
mm of the screen can be 

useful if you’re using a 
symbol font like Zapf 
Dingbats, where you may 
want to see the symbol 

assigned to each key. 
Choose Key Caps from 
the Apple menu; then 
choose Key Caps from 
the menu that appears 
and select the font you 
want to see. Get a screen 
printout of the keyboard 
with and without the Shift 
key down as well as with 
the Option key down so 
you'll have the full range 
of symbols. 

Printing the Screen 

Pressing Command-Shift-3 produces a MacPaint file of what’s on 

your screen. Each time you press Command-Shift-3, the Macintosh 

creates a new file named Screen 0, Screen 1, and so forth, up to 

Screen 9, on your startup disk. After you’ve created ten of these 

screen files, you’ll hear a beep. You'll then need to rename the screen 

files, allowing the system to create ten new files named Screen 0 

though 9. 

To print or edit any of these screen files, double-click on its icon to 

start MacPaint (assuming it’s available). 

Printing Bit-Mapped Graphics | 

Graphics produced by programs that use bit-mapped images (like 

MacPaint) may sometimes appear splotchy when they’re printed. 

This happens because the bit-mapped images are defined at 72 dots 

per inch for the screen but must be rescaled to be printed on a laser 

printer that may have a resolution of 300 dots per inch or higher. 

Since 72 doesn’t divide evenly into 300, you don’t get a proportion- 

ally rescaled image. You can get excellent results by printing paint- 

type graphics at a reduced size on a laser printer, but pay attention to 

the resolution: the bit-mapped graphics are 72 dots per inch, and the 

laser printer prints at 300 dpi, so at reductions of 96, 72, 48, or 24 per- 

cent, the printout will be proportional and no distortion will occur. 

Printing Special Characters 

You can generate very useful special characters by using Option 

key combinations. For example, Option-; (semicolon) produces a 

true ellipsis, which is three periods spaced closely together to indicate 

an omitted word or words. It looks like this: 

If you’re justifying text and type three periods, they may not remain 
closely spaced together. However, if you use the ellipsis character 
instead, it will remain attached to the word that precedes it, and the peri- 
ods won’t be spaced out, even when you use right justification. 
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You can also create special variations of the hyphen called em and 
en dashes by using the Option key. In typesetting, an em dash is used 
as a long dash—to indicate an aside, for example. An en dash, so 
called because it is the width of an uppercase N in the font you are 
using, is used to separate durations of time and lengths: 1939-45, for 
example, or pp. 389-452. Here are what they look like when pro- 
duced in your printed documents: 

em dash — Option-Shift-hyphen 

en dash -  Option-hyphen 

hyphen - hyphen 

Renting Time on a LaserWriter 

In many places, you can rent time on a LaserWriter even if you 
don’t own one. Here are a few tips you may want to keep in mind if 
you’re planning to do so. Basically what you need to do is set up a 
startup disk to work as though you had a LaserWriter actually 

connected. 
First, make a copy of your WordPerfect disk to take with you. It 

should be a startup disk (one with a System file) and should contain 
the documents you want to print. Copy the LaserWriter fonts you 
want to use as well as the LaserWriter icon into the disk’s 

System folder. 
Select Chooser from the Apple menu; then select the LaserWriter 

icon and AppleTalk. Select Page Setup from the Print Options sub- 
menu and make any changes you want for printing out on a 

LaserWriter. For example, a LaserWriter won’t print in the first half- 
inch area on the right or left side of the paper. If your line length is 
longer than 8 inches and you’ re printing on 8.5 by 11 inch paper, you 
won’t get the results you anticipate. 

Finally, change the fonts in the document to the LaserWriter fonts 
you want to use; you'll get much better results than if you use Font 

Substitution. 
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Sources for Additional Fonts 

Before you order Depending on your needs, you may want to purchase additional 

Sean fonts, including fonts for foreign languages such as Hebrew or Rus- 
look at a printed sample. F TS eee 5 z ; 

Because only a name can sian; scientific, architectural, or commercial symbols; decorative 

be copyrighted, not the borders; or display type for headlines. 

een ey The following manufacturers are only a small sample of those 
already have a similar : : : ; a 

Cot wah a dissimilar available to you. Check with a Macintosh user’s group for additional 

name. reliable sources of laser and ImageWriter fonts. 

Image Writer Fonts 

Technical and business fonts: 

21st Century Software 
306 Cotner Avenue 
Los Angeles, CA 90064 
(213) 829-4436 

For whimsical fonts for newsletters and such: 

Mac the Knife 
Miles Computing 

21018 Osborne St. #5, 

Canoga Park, CA 91304 
(818) 341-1411 

Fluent Fonts (foreign-language fonts, also available in laser versions): 

Casady Company 
P. O. Box 223779 
Carmel, CA 93922 

(408) 646-4660 

And, to edit your own ImageWriter fonts: 

FON Tastic 

Altsys Corp 
P. O. Box 865410 

Palo, TX 75086 
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Laser Fonts 

A partial selection from Adobe Systems includes Palatino, ITC 
Bookman, ITC Zapf Chancery, ITC Avante Garde Gothic, New 
Century Schoolbook, Optima, ITC Souvenir, and many others. 
Contact the company for an up-to-date listing. Prices (as of this print- 
ing) are $185 per font. Each font comes in roman (plain), bold, bold 
italic, and italic. 

Adobe Systems, Inc. 
1870 Embarcadero Road 

Palo Alto, CA 94303 

(415) 852-0271 

LaserFonts from Century Software include Willamette (similar to 
Avant Garde), Styx (a futuristic face), Congo (Futura Black), and 
Thames (calligraphy) in one package, and Columbia, Mannistee, 
Devoll, and Spokane (Peignot) in another. Each is provided in con- 
densed, expanded, and regular versions 

LaserFonts 

Century Software, Inc. 
2306 Cotner Ave. 
Los Angeles, CA 90064 
(213) 829-4436 

NeoScribe International offers Hebrew, Greek, and specialty type- 
faces for PostScript printers: 

NeoScribe International 

P.O. Box 633 

East Haven, CT 06512 

(203) 467-9880 

For serious laser printer users, Fontographer is a PostScript typeface 
design tool that allows you to build and edit fonts: 

Fontographer 
Altsys Corp 
P. O. Box 865410 
Palo, TX 75086 
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For those of you who need lots of fonts, Suitcase and Font/DA Jug- 

gler Plus let you install as many as you’ve got disk space for: 

Suitcase 
Software Supply 
599 N. Mathilda Ave. 
Sunnyvale, CA 94086 

Font/DA Juggler Plus 
ALSoft, Inc. 

P QO. Box927 
Spring, TX 77383-0927 

Looking Forward it ieee ee 

You’ve reviewed the subject of printing on the Macintosh pretty 

thoroughly in this chapter. Because the number of printers the Mac- 

intosh supports is constantly growing, chances are that you may be 

using a printer we haven’t discussed. However, most of the general 

rules and techniques will still apply to whatever type of printer you 

may be using, and you can contact WordPerfect Corporation for any 

up-to-date information they may have. Your best source for unan- 

swered printing questions is probably your printer manual, though, 

because WordPerfect prints through the printing resources it finds in 

your Macintosh’s System folder and doesn’t “‘speak”’ directly to the 

printer itself. 

The next chapter discusses how you can manage your files in 

WordPerfect and gives you tips about how you can avoid going out to 

the Finder. 



/ — Managing Your Files —__ 

mB 



Instead of using the Finder, 

you can use the File menu’s File management command 

(Command-L) to retrieve documents, rename and delete docu- 

ments and folders, copy and print documents, get information 

about them, and create new folders. 

To see the contents of documents, 

complete with all their formatting codes, just as if using a full- 

screen Codes window, use the Look option (Command-3). 

To search through all the files 

that are being displayed, locate a specific word or phrase or 

match a pattern, use the Word Search option (Command-9). 

To open, close, retrieve, and save documents, 

use the File menu. 

To save documents in formats 

other than WordPerfect Macintosh format, such as IBM Word- 

Perfect format, ASCII text format, and others, use the Save As 

command. 

To quit WordPerfect and start another program 

at the same time, use the Transfer command. 

To assign passwords to your WordPerfect documents, 

use the Save As command. 
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To set up a system of custom default files with specialized formats, 243 
use the WP Defaults command. 

To protect your documents with WordPerfect’s timed and origi- 244 
nal backup options, 
use the Backup Options command. 
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CHAPTER 

If you view the 
contents of folders 

by name, WordPerfect 
usually shows up near the 
end, because it begins 
with w. The Finder lists 
folders beginning with 
numbers before folders 
beginning with letters, so 
name your main Word- 
Perfect folder 1WordPer- 
fect (or lwp). If you’ve 
got a large number of 
folders on a disk, this tip 
can save you some scroll- 

ing time. 

lig 

ALTHOUGH YOU ALREADY KNOW HOW TO USE YOUR 

Macintosh’s operating system (the Finder, which is also called the 

desktop), it’s important to also be aware that WordPerfect has many 

built-in commands and features that can save you a trip to the Finder. 

For example, you can copy files and folders, rename them, and delete 

them without ever leaving WordPerfect. In addition, the program has a 

Transfer command that lets you transfer to another program without 

first returning to the desktop. Also, WordPerfect has a word search fea- 

ture that lets you search through files for a specific word or phrase and a 

look option that lets you see what’s in a document without opening it. 

You can’t do that with the Finder! 

Files and Folders 

As you know, on a Macintosh you organize documents and pro- 

grams into a system of folders so that you can locate them quickly. 

You can organize folders into whatever system best suits the way you 

work. For example, you might want to keep WordPerfect and Mac- 

Draw or some other graphics program in one folder and keep your 

WordPerfect documents in a system of folders within that folder. One 

document folder might contain your business letters, another your 

personal correspondence, and a third your reports and papers. You 

may want to organize documents by date to see your most recent 
work but first organize programs by name. The Finder’s View menu 
lets you choose different systems. wy 

If you often use WordPerfect to open new documents rather than 
to edit documents you’ ve already created, you may want to keep the 
WordPerfect icon out on the Desktop for easy access. You can also 
keep an empty folder there so that you can locate it quickly if you 
need to start a new folder in the Finder. 



ay If you’re revising a 
document, you 

don’t have to start Word- 
Perfect and then choose 
Open from the File 
menu. Just double-click 
on the document’s icon in 

the Finder. This automat- 
ically starts WordPerfect 

and opens the document 
at the same time. 

eo) You can’t use a 

colon (:) in file or 
folder names. The Mac- 

intosh uses the colon to 

separate items in a path 
name, just as DOS uses 
the backslash (\). 

ae7 Managing Your Files 

One further word about the Finder: Replacing a folder replaces 
everything it contains, not just items that have the same names in 
both folders. If the old folder contains files that aren’t in the new 
folder, those files will be deleted. If you’re used to working with the 
IBM version of WordPerfect, you may not be aware of this, because 
in DOS copying simply replaces items with the same names and 
leaves the others unchanged. 

Naming Files and Folders 

You can name files using up to 63-characters, which makes it very 

easy to assign descriptive, meaningful names to help you locate docu- 

ments quickly. However, the disk menu displays only the first 20 
characters, and if you view by icon, you’ll see even fewer characters. 

Two or more folders can have the same name providing they’re 
stored in separate folders having different names. 

File Management 

You can perform several file management tasks within WordPer- 
fect without having to exit to the Finder. You can, for example, 

e Create new folders 

e Open files 

e Delete, rename, and copy files 

e Search through files to locate a particular word 

¢ Combine several files into one file 

Look into documents and folders to see what they contain 

All these tasks and others can be accomplished through WordPer- 
fect’s File Management window, which you reach by pressing 
Command-L (for List Files) or by choosing File Management from 

the File menu. 

Figure 7.1 illustrates a typical File Management window. The 

name of the currently opened folder or disk is displayed at the top of 
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the window, and below that name is a list that displays the files in that 

folder or disk. If you’re looking at the contents of a folder, you can 

click on the folder name to see whether there are any other folders 

available. If there are, you can drag and choose another folder or disk 

name to see its contents. Clicking on the Drive button presents the 

contents of the disk that is in your floppy disk drive(s). 

Use the five File Types buttons located under the file list to select 

which files you want to display: 

© Click WP Files to display only WordPerfect documents and 

folders. 

© Click Text Files to display only files that have been saved in 

ASCII (American Standard Information Interchange) for- 

mat, also called text format. Text files have had most format- 

ting information removed from the text so it can be used by 

other programs. 

° Click Macro Files to display only WordPerfect macro files. 

You cannot retrieve these files into a document. 

File Edit Search Format Font Special Windows 

Retrieve File 
Ci macros 

D Reference Aids ‘ Print WP File 
& Speller Utility Look File/Folder 

D Tables of Contents Copy File 

OQ WP Dictionary Rename File/Folder 

OC wp docs Delete File/Folder 

OC WP Formats File/Folder Info 
Q WP Thesaurus Create New Folder 

Word Search 
File Types 

OwP Files QOfextFiles | | home stuff 
O Macro Files @ All Files Space Available 

© Importable Files 27,979,776 Bytes 

0g ane OT TTS 

Figure 7.1: WordPerfect provides a File Management window that lets you 
carry out many of the tasks normally done on the Finder. 



To open a document 
quickly, just press 

Return when it’s name is 
highlighted. 

Files beginning with 
numbers are dis- 

played first. Saving files 
that you work with often 
with a number as the first 
character in the name— 
1September Report—will 
cause them to appear at 
the top of the list, where 
they are easier to locate. 
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¢ Click All Files to display all files in a folder or disk—such as a 
list of the names of applications and system files. 

¢ Click Importable Files to display all files that can be opened 
in WordPerfect. 

You can move through the list of files quickly by typing the first few 
letters of the file name you’ re looking for. If you don’t know the file’s 
name, you can use the arrow keys or the scroll bar to scroll through 
the list. Only nine files are displayed at a time. 

The File Management window also tells you how much space is 

available on the disk whose contents are being displayed. It’s a con- 
venient way to see how much room is left on the disk for saving and 

copying documents. Otherwise (unless you’re running under Multi- 
Finder), you would have to exit WordPerfect, select the disk icon, 
and then choose Get Info from the Finder’s File menu to check how 
much disk space is left. 

To the right of the file list are nine numbered option buttons pro- 

viding some very useful functions. You can click on these buttons or 

use the command-keyboard shortcut to activate these procedures. 
For example, pressing Command-1 retrieves the contents of the 
highlighted file (the first one on the list) into the document you cur- 
rently have open. Command-9 allows you to do a word search 

through the listed files. We’ll look at each of these options in detail. 

Retrieving a File 

When you click the Retrieve File option (or press Command-1), 
the contents of the document you have highlighted in the file list is 
retrieved into your current document at the insertion point. This is a 
fast way to combine files. Unlike the Open command, which opens a 
document into a new window, Retrieve brings the highlighted docu- 
ment into the current window at the insertion point. 

In addition to retrieving from the File Management window, you 

can also use the Retrieve command on the File menu. If you already 

know the name of the file whose contents you want to retrieve, using 

the Retrieve command from the File menu is faster. If you want to 

review the names of files and choose one or more from the file list, use 

the File Management window instead. 



SSS ——~te 

230 Mastering WordPerfect on the Macintosh 

CH. 7 

Printing from the File Management Window 

You can print a WordPerfect document from the File Manage- 

ment window. When you press Command-2 (or click its button), 

you'll be asked to confirm that the highlighted file is the one you want 

to print. If you press Return, you'll immediately see the Print 

Options screen, where you can change print options before you 

print, as described in Chapter 6. 

Looking into a File or Folder 

The Look option is a tremendously useful feature because it lets 

you see what’s in a WordPerfect file without taking the time to 

retrieve its contents to the editing screen. You can look in several files 

to locate the file you’re looking for. 

When you type Command-3 or click its button, you'll see the first 

screen of the highlighted file in a special Look window. It will be com- 

plete with all its formatting codes, just as if you were looking at a full 

screen Codes window (Figure 7.2). You can’t do any editing in this spe- 

cial window, only check to see if this is the file you want. Pressing any 

key or clicking the mouse returns you to the File Management window. 
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Figure 7.2: WordPerfect lets you look at the contents of a file without opening it. 



If you’re copying 
several files to 

another disk, create a 

folder to hold them, copy 
them into the folder, and 

then copy the whole 
folder to the other disk. ° 
You'll find it easier to 
reorganize on the other 
disk because you’ll know 
which files are new. 

eo) Don’t name files 

with any words that 
the Mac might confuse 
with names that are used 

in its operating system, 
like ‘‘Minifinder.”’ Like- 

wise, don’t name docu- 

ments after applications, 
like ‘‘WordPerfect”’ or 

‘““MacPaint.”’ 

her You can’t have two 

items with the same 

name in the same folder. 

There’s no difference 

between uppercase and 

lowercase, so January 
Report and january 
report are considered to 
be the same name. 
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You can also use the Look option to view the contents of folders 
and see the names of the files they contain. 

Copying Files 

The Copy File/Folder option (Command-4) lets you copy a file or 

folder whose name you have highlighted. When you choose this option, 

you'll see the file’s name in a new window under a dimmed list of the 
current folder or disk’s contents. If you want to create a new file, enter a 
new file name. If you want to replace the contents of one file with 

another, enter the name of the file whose contents you want to 
replace. For example, if you want to copy Document 1 into Docu- 

ment 2, you would highlight Document i, click Copy File/Folder, 
and type Document 2. You’ll be asked to confirm that you want to 
replace the contents of Document 2. 

If you want to copy the file into a different folder, select a different 

folder in which to copy the file. By clicking on the Drive button, you 
can switch to a different disk in another drive. Click on Eject to eject 
the disk that’s in the drive and insert a new one. 

Renaming Files and Folders 

The Rename File/Folder option (Command-5) saves you from going 
to the Finder to rename files and folders. Click on the name of the file or 
folder you want to rename, press Command-5 or click on the button, 
and enter the new name. Press Return to return to the File Manage- 
ment screen. 

Deleting Files and Folders 

When you use this option (Command-6), you’ll get a dialog box 

asking you to confirm whether you want to delete the file. Click OK 

(or press Return) to delete the file. Once you’ve deleted a file, you 

can’t open it again. 

You can also delete folders by using this option, but they must first 

be empty. If you get a ‘‘File is busy or directory not empty” message, 

you’ll need to open that folder and delete its files before you can 

delete the folder itself. 
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Getting Information About Files and Folders 

When you use this option (Command-7), you'll see a dialog box 

like the one in Figure 7.3 displaying information about the file or 

folder whose name you highlighted in the File Management window. 

Normally, perhaps all you’ll be interested in is the date the file was 

last changed or its size, but WordPerfect also provides technical infor- 

mation about each file. If you import documents that were originally 

created on non-Macintosh computers, you’ll need to use this dialog 

box to change the file’s creator and type, but most of the information 

it contains, as well as the following discussion, is fairly technical. You 

can skip it unless you’re curious. 

The date the file was first created appears first, followed by the date 

on which it was most recently changed. Below that is additional tech- 

nical information. 

Data fork and resource fork require a little explanation. Basically, 

on a Macintosh every file has two parts, or ‘‘forks.”’ Ifa file is a docu- 

ment, its text is kept in the data fork; if it’s an application program, 

the data fork will probably be empty, but you will see a value in the 

resource fork box. In a Macintosh program, the resource fork holds 

" @ tile dit Search Format Font Special Windows 

Name: File Management Chapter 

Dates and Sizes 

Created: 12/9/87 7:23:20 AM 

Modified: 12/9/87 2:55:27 PM 
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Figure 7.3: The File/Folder Information option gives you detailed data about 

each file. 
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Make sure you have 
the WordPerfect File 

Formats icon in the same 
folder as WordPerfect 
before you try to open a 
document created by 

another program. It 
contains the conversion 

processes for importable 
documents. 

If you have 
difficulty importing 

a document, try changing 

its type to TEXT in the 
File/Folder Information 
dialog box. It may not 
always work, but it’s 
worth a try. Just make a 
note of the type it origi- 
nally was so that you can 
change it back if you 
have to. 

all the things the program needs to perform its job: the icons it dis- 
plays, the menus that appear, and the appearance and content of its 
dialog boxes. 

In the next box are listed the file’s creator and type. When you 
click on a file’s icon in the Finder, it looks at these two pieces of 
information—file type and creator signature. 

Creator lists the ‘creator’ of the file. That’s not you; it’s the soft- 
ware that created it. This four-letter creator signature tells the Finder 
what program the file belongs to. For example, SSIW is WordPerfect 
Corporation (Software Systems International was its original name), 
and MPNT is MacPaint. 

Type is the type of file. WPDC in this box means it’s a WordPer- 
fect document. If the file was created on an IBM PC, you'll see 
WPPC here. A MacPaint file type is PT'NG, and a text-only file type 

is TEXT. The file type determines, among other things, the icon that 
the Finder uses to represent the file. 

When you bring in via network or modem a WordPerfect file that 
was originally created on another computer, such as an IBM PC ora 

VAX, you have to change the file’s creator and type. For example, to 
change a WordPerfect IBM PC file to a Macintosh WordPerfect file, 
you highlight the creator box and type SSIW; then highlight the 

Type box and type WPDC. (If the original file is one of your dictio- 
nary files that you used with the Speller on another computer, the 
Creator should be changed to SSIU and the Type to WPSP.) The 

Macintosh will then recognize the file as one of its own, and you 
can work with it like any other WordPerfect document. Chapter 
14 has more information about communications with Macintosh 

WordPerfect. 
To the right you’ll see several dimmed boxes, such as Busy and 

Cached. They represent additional technical information about the 
system attributes and internal file status for Macintosh program- 
mers. For example, a check mark in the Busy box means the file is 
currently open, and a check in the Cached box means the file can be 
shared by several users. You can’t change any of these attributes 
using WordPerfect, so they’re always dimmed. 

Below are additional attributes that you can change, but you 

should be careful if you change any of them: 

e On Desktop—indicates whether the file resides on the 

desktop or is in a folder on a disk. 
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1) Don’t make a file 

invisible if you want 

to be able to find it again 

on the desktop. An invisi- 

ble file will be listed here, 

but not on the desktop. 

You can hide a file this 

way, but be careful you 

don’t lose it. 

er You can have fold- 

ers with the same 

name as long as they’re 

in different folders. 

1) When you retrieve a 

file, it appears in the 

document that’s currently 

open. If you’re not in a 

new document window 

when you do a word 
search, retrieving a file 
will bring its contents into 

your current file. 

¢ Invisible—indicates that the file’s icon won’t be displayed on 

the screen. 

e Bundled—indicates whether certain information associated 

with the file must travel with the file as it is moved from disk 

to disk. 
: 

© Protect—indicates that the file can’t be copied. 

© Locked—indicates that -the file can be copied but can’t be 

changed. Once a file is locked, a small padlock appears in its 

title bar. 

© Inited—indicates that the Finder has information 
about that 

file. (The Finder doesn’t ‘‘know”’ about any new file you 

create until you quit the application that created it.) 

You can turn any of these attributes on or off by clicking on their 

boxes, but you should know exactly what you’re doing or you may 

inadvertently alter an attribute that the Finder needs in order to use 

the file. For additional technical inform
ation, refer to a book like Mac- 

intosh Revealed (vols. I and II) by Steph
en Chernicoff (Hayden, 1985). 

If you change any attributes and want to revert to the original set- 

tings, click Revert. Otherwise, to save changed settings, click OK. 

Clicking Cancel exits you from the dialog box without making 

any changes. 

Creating a New Folder 

This option (Command-8) lets you create a new folder without 

going to the Finder. Click on the option’s button (or pres: 

Command-8) and type the name you want the new folder to have. 

Searching Files for a Specific Word 

The ninth option, Word Search, lets you search through all file 

being displayed to locate a specific word, phrase, or pattern of letter 

(up to 20) that you specify. This can be very 
helpful if you know thé 

the file you’re looking for contains a certain word, but you can 

remember which file it’s in. 



If you’re searching 
for a specific file 

whose name you know 
but you don’t know 
which folder it’s in, use 

the Apple desk accessory 
Find File. If you’ve 
installed it, it will be on 

the Apple menu. Word 
search in WordPerfect 
searches the contents of 
files; Find File searches 

through file names. 

1) In version 1.0. you 
can’t import files 

that were saved with 
Microsoft Word’s Fast 
Save option. Resave the 
document with a regular 
save in Microsoft Word; 

then import it. 
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For example, suppose you’re looking for a report on plastics. To 
see the names of all the files that contain the word Plastics, press 
Command-9 and enter plastics in the dialog box. When WordPerfect 
completes its search through the files in the list, it then produces a list 
of the names of the files that contain the word plastics. You can then 
press Command-3 (Look) to view the beginning of these files or 
Command-1 (Retrieve) to retrieve them to the editing screen for a 
more detailed look: 

You can also select other folders and disks to search through by 
clicking and dragging on the name displayed in the box at the top of 

the list, or by clicking on Drive to display the contents of a disk in 
the drive. 

Other File Commands 

The commands Open, Retrieve, Close, Save, Save As, Save Copy 

As, and Quit are also on the File menu. (If you’ve highlighted a selec- 
tion before you select the File menu, Save As appears as Save Selection 

As. These commands are pretty straightforward, but we’ll briefly cover 
them here. There’s also a new one, called Transfer, that lets you switch 
to a different program. 

Open 

When you choose Open from the File menu (or press Command-O), 
you'll see a dialog box listing all the files in the current folder or disk. 
You can click the List only WP files box to see only the names of Word- 
Perfect documents, or leave the box unchecked to see the names of all 

the files. 
If you’re not sure which files you can open, use the File Manage- 

ment dialog box instead. It has an option for displaying the names of 

only the importable files. 
You can also open WordPerfect documents that were created on non- 

Macintosh computers, but it takes one additional step. See ‘Getting 
Information About Files and Folders”’ earlier in this chapter. 
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Retrieve 

When you retrieve a document, its contents appear at the insertion 

point in your current document. If you’re new to WordPerfect, it can 

be disconcerting to have the contents of another document retrieved 

into whatever you’re working on. If you keep retrieving, your cur- 

rent file will get bigger and bigger...If you’ve used another version of 

WordPerfect before, you know that this is a program feature, not a 

bug, so you won’t try to retrieve a document each time you save it. 

It’s really designed to let you merge two or more documents together. 

Close 

Close (or Command-K) closes a document window. If you haven’t 

saved the document in that window, or if you’ve made changes to it 

since you last saved it, you’ll be prompted for whether you want to 

save it. 

Save 

If you haven’t previously saved the document you’ re working on, 

choosing Save from the File menu (or pressing Command-S), brings 

up a dialog box that prompts you for a file name. You can enter up to 

63 characters, and uppercase and lowercase are considered to be the 

same. After you’ve saved a file once, Command-S replaces the ver- 

sion on disk with the version that’s on your screen. 

As you work, save your document often, especially if you are running 

under MultiFinder. You can also set WordPerfect for a tumed backup or 
an original backup, as will be discussed later in the chapter. 

= Save As 
(+ If you get a ‘““Disk : 

Full” message while The Save As command lets you save a document under a different 

you’re working, use the name. When you use Save As, the copied document (the one with the 

: apie esi aN new name) becomes the document on the screen. Use this option if 
your document—use the iy sud ‘ ; ‘ eae 
name of'anvold file-you no you want to ‘‘freeze”’ ‘a documient at a certain point while continuing 

longer need so that the to modify it under a new file name. 
saved file overwrites the 

old one. 



If you’re transfer- 
ring a small docu- 

ment or a few paragraphs 
to another program on 
your Macintosh, you can 
copy and move it via the 
Clipboard. 

To see which version 

date you’ve got, 
choose About WordPerfect 
from the Apple menu. 
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Saving Files in Special Formats 

WordPerfect also lets you save documents in formats other than 
the WordPerfect Macintosh format. When you choose Save As you’ll 
see buttons at the bottom of the dialog box that let you select other file 

formats. The IBM WP 4.2 format is for transferring files to be used 
with version 4.2 of WordPerfect on other machines, such as a PC, a 

VAX, or a Data General computer. If you click Other, enter a name, 

and click Save, you’ll see a list of other formats that you can save doc- 
uments in. These available formats are in a special file called File For- 
mats that came with your WordPerfect disk. You should have copied 
it to the WordPerfect folder or disk you’re using. 

Choosing ‘Text Files saves the document as an ASCII file in which 
only text and hard returns remain. All other formatting codes are 

removed. ‘This format is accepted by most other programs, so if the 
program whose format you need is not listed, use this option. 

Choosing MacWrite saves the WordPerfect document as a 

MacWrite document. Most of the format codes are transferred, but 

footnotes are not transferred (at least not in version 1.0). 
If the format you need isn’t listed, contact WordPerfect Corpora- 

tion to see if they have made it available. If not, save the document as 
a text file and convert it when you get it into the other program. 

Save Copy As 

Save Copy As lets you save a copy of a document under a new file 
name, but the document you were working with remains on the 

screen. Use this option if you want to “‘freeze”’ a document at a cer- 
tain point while continuing to modify it under its original file name. 
You can open a protected document from the File Management 
screen, but you can’t print one from there. A protected document 

must be on the screen if you want to print it. This ensures that no one 

can print the document without knowing the password you assigned 

to it. 

Quit 
You should always exit WordPerfect by choosing Quit or pressing 

Command-Q. If you simply turn off your Macintosh, you may 

create fragmented files on the disk. This can also happen after a 
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(Cleat. 

WordPerfect doesn’t 
need a RAM cache, 

so if you’re running it 
under MultiFinder, you 
can disable the RAM 
cache, as long as none of 

the other programs 
you’re running need it for 

speed. 

If you’re running 
WordPerfect under 

MultiFinder, you won’t 
be able to open as many 

documents as you can 
with the Finder. Multi- 
Finder is a memory hog, 

and it can cause difficulty 
with earlier versions of 
the program. 

power failure. After several improper exits, you may want to run 

Disk First Aid, an Apple utility, on your disk to clean it up. 

Transfer 

As you work with WordPerfect, you may sometimes want to bring 

in spreadsheet data from other programs or use graphics created in a 

graphics program such as MacDraw. If you’ve already created the 

spreadsheet or drawn the graphic, you can bring it in via the Scrap- 

book or Clipboard, but if you need to visit the other program, you'll 

find the Transfer command on the File menu a quick way to quit 

WordPerfect and start the other program at the same time. It’s no 

substitute for MultiFinder, but it’s fast, and it certainly requires less 

memory than MultiFinder. 

To transfer to another program, 

1. Choose Transfer from the File menu. 

You’ll see a dialog box listing the contents of your current folder 

or disk. 

2. Choose the program you want to transfer to. 

You can open other folders or eject disks and insert new ones until 

you locate the program you want to transfer to. If you have any 

documents open, you’ll be prompted to save them before Word- 

Perfect quits and the new program starts. 

Protecting Your Files 
You can assign passwords to your WordPerfect documents so that 

they can’t be opened or printed without the password. WordPerfect 
doesn’t provide a “‘back door’’ to password-protected documents, 
though, so if you forget the password, you won’t be able to open the 
document. Keep a record of your passwords in a safe place! 

To assign a password to a document, 
. 2 

1. Open the document and choose Save As from the File menu. 

If you’ve saved the document before, its name will appear in the 
dialog box. You can change the name or use the same name for 
the document. 



! 6 If you’ve saved the 
; document before— 
as you worked on it, for 
example—there may be 
another copy of it saved 
under a different name on 
your disk. For maximum 

security, delete this copy 
and any others (copies 
that may have been made 
with the original backup 
feature, for example). 

bar You can’t save a 

locked document, 

but you can use the Save 
-As command on it. 
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2. Click Password Protect. Then type the name you want to save 
the document under, if you want to use a different name. Press 
Return. 

3. Type the password you want the document to have; then click 
OK or press Return. 

You can use as many as 59 characters, including spaces, but the 
longer your passwords are, the harder they’ll be to remember. 

4. Type the password again and click OK. 

‘To prevent somebody looking over your shoulder and reading 

your passwords, WordPerfect shows apples instead of the charac- 
ters of the password on the screen as you type. It asks you to type 
the password again just in case you made a typo the first time. (If 

you typed a wrong character and didn’t know it, you wouldn’t be 
able to open the document.) 

Your document is now saved with that password. From now on, 

when you open it, you’ll be asked for the password. After it’s open, 

there’s no indication on the screen that it’s a protected document. 

When you save a password-protected document, you’ll be asked 

for the password again. You can use the same password or change it 
to a different one by following the procedure just described. To 
unlock a password-protected document, click OK instead of typing a 
password when you’re asked for one. 

You can open a protected document from the File Management 

screen, but you can’t print one from there. A protected document 
must be on the screen if you want to print it. This ensures that no one 
can print the document without knowing the password you assigned 

to it. 

Locking Files 

You can also lock a file by using the Finder. Locking a file in this 
way prevents it from being changed or deleted, but you and others 
can open it and print it, if it’s a printable file like a document. For 
example, if you’ve created graphics for your company’s logo or a 
masthead for your newsletter, you may want to lock those files to pre- 
vent them from being altered. 
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If you’re in the 
@§ Finder, here’s a 

quick way to see whether 

a file is locked without 
having to choose Get 
Info. Select the file and 
move the pointer to its 

name in the title bar. If 

it’s locked, the pointer 
remains an arrow; if it’s 

not locked, the pointer 
becomes an I-beam. 

To lock a file in the Finder, 

1. Select the file’s icon. 

2. Choose Get Info from the Finder’s File menu. 

3. When the information window appears, click Locked. 

After you’ve locked a file, a small padlock will appear next to the 

time the file was last modified when you’re viewing a folder’s con- 

tents by name. If you’re not viewing by name, you’ll need to choose 

Get Info from the Finder’s File menu to see whether a file is locked. 

You can lock a file from within WordPerfect by using the File/ 

Folder Info option of the File Management window. After you click 

Lock, you’ll get a message saying that the file is locked. If you click 

OK at that point, you’ll return to the File Management Window. 

When you open a locked file, you'll get a message saying that the 

document can’t be opened for writing. If you click Proceed, you'll get 

the document on your screen, but a small padlock will be in its title 

bar. The Save command on the File menu will be dimmed. 

To unlock a locked document, repeat this procedure, this time 

clicking on the Locked box to deselect it. 

To delete a locked document in the Finder, hold down the Option 

key while you drag it to the Trash. You can’t delete it in WordPerfect 

unless you unlock it first. If the power goes off before you’ve quit 

WordPerfect, you may find that the document you were working on 

has mysteriously become locked. Also if you click Continue to open a 

document that’s already open, a copy of it will appear on your screen 

with a lock next to its name. This happens because when you are con- 

nected to a network, only one user can edit a file at any one time, 

although others may read it. The system interprets the second 

attempted access as being from another user. 

Default Files and Folders 

Chapter 3 listed the default settings that come with WordPerfect. 

These settings are stored in a file named WP Defaults in your System 

folder, Every time you start WordPerfect or open a new document, the 

settings that are specified in this file take effect. You can change these 

default settings. For example, you may want all your documents to open 



If you forget to open 
a new document 

when you save settings 
and change your WP 
Defaults file by mistake, 
Just trash the WP Default 
file. A new one will be 
generated when you start 
WordPerfect. 

Managing Your Files 24] 

with a different font (I use Courier because I find Geneva hard to read), 
with double spacing or justification in effect, using 6-inch text lines 
instead of 6.5-inch lines, or with columns defined. 

To change the settings in the WP Default file: 

1. Open a new document. 

Opening a new document prevents you from getting any 
unwanted format changes from the last document you’ve been 

working with. You will get exactly the settings that you specify. 

2. Make the format changes that you want in the new document. 

For example, you may want to reset the right margin at the 

6.5-inch mark on the ruler line if you’re using a 9-inch screen. 
You can also change tabs, set new line spacing, and so forth. 

3. Choose WP Defaults from the File menu; then choose Save 

Settings. 

WordPerfect doesn’t automatically save the settings you just 

made. 

4. Click Save; then click OK. 

The new format settings will be saved in the WP Default file and 

will be in effect each time you open a new document from now on. 

Creating Custom Default Files 

You may want to set up a system of custom default files, each con- 
taining specialized formats—one for weekly reports, another for 
interoffice memos, perhaps a multi-column one for newsletters. 
Then, when you’re ready to create one of these specially formatted 
documents, you’ll have a template ready for it. 

You create custom default files by following the procedure just dis- 

cussed for changing the WP Default file, with one exception. When 

the Save Settings dialog box appears, name the file anything except 

WP Defaults; then click Save. 

These default files will be saved in your System folder. Whenever 

you want to use one of them, open it from the System folder. Word- 

Perfect will start automatically, and the text you enter will be format- 

ted according to the settings you used when you set up the default file. 
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When you open a 
default file, the title 

bar in the documents you 
open or retrieve won’ tell 
you which format’s being 
used; it just reads Unti- 
tled or lists the name of 
the document. It’s up to 
you to remember which 

format you’re using. 

For example, in Figure 7.4, I’ve set up two default files—one named 

Newsletter and another for monthly reports. The newsletter file is 

formatted for two columns and the Times font; the monthly report is 

double spaced with footers and page numbers. 

Another excellent use for default files is to maintain formats you 

use in your work group so that everyone’s documents follow the 

same format. 

To reformat an existing document into one of the default tem- 

plates, use the Retrieve command on the File menu to read the file 

into the empty template. 

Changing the Beep Option 

If you don’t like the beep WordPerfect makes when it can’t find 

something, when hyphenation is on, or when an error occurs, you 

can turn it off. Choose WP Defaults from the File menu; then choose 

Beep Options. Click on any of the settings you want to change; then 

click OK to make the changes. Remember to choose Save Settings if 

you want these settings in effect the next time you start WordPerfect. 

&é File Edit View Special 

System Folder 

17,304K in disk 24, 167K available 

BReaK * K 
DA Handler Scrapbook File Key Layout Clipboard File WP Defaults Monthly Report Newsletter 

a= &ag eb 
MacsBug Keyboard AppleTalk ImageWrite disable Finder MultiF inder 

LaserWriter — InterMail Laser Prep Easy Access Mouse 

Sil ea 
Color Finder Startup Monitors General Sound AppleShare Prep Spel Polder 

Figure 7.4: Setting up custom default files lets you open WordPerfect from the 

System folder with those default settings in effect. 
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retrieve until you quit 
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format, quit and then 
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clicking on a document 
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For more information about how you can custom-tailor WordPer- 
fect to suit the way you work, see Appendix C. 

Setting Default Folders 

The Default Folders option lets you specify which folder is to be 

your work folder. When you save documents, they’ll be saved in this 

folder. It’s also the folder whose contents will be automatically pre- 

sented when you first select Open. In addition, this option lets you 
tell WordPerfect where your macro files are stored as well as the loca- 

tion of the temporary files and the Speller and Thesaurus. 

To specify which folders you want to be used for these purposes: 

1. Choose WP Defaults from the File menu; then choose Default 

Folders. 

The Default Folders dialog box appears, as shown in Figure 7.5. 

2. Click on the button of whichever folder you want to specify; 
then click Set. 

A list of files and folders on the current disk appears. Click and 

file €dif Search Format Font special Windows 

Set Default Folders 

Work Folder 
O home stuff:1 wp:wp docs: . | 

Temporary Files Folder 
O home stuff:1 wp:wp docs: | 

Macro Files Folder 
(@) [home stuff :1 wp imacros: | 

Speller/Thesaurus Folder 
© [home stuff:1wp: 

Cx 

Figure 7.5: The Default Folders dialog box lets you specify which folders will 

automatically be used to hold your saved documents as well as 

your dictionaries and macros. 
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(+) WordPerfect is 

preset to save tem- 
porary files in the system 
folder. 

drag on the folder name at the top of the list to open other folders. 

Click on Drive and Eject to see the contents of other folders in a 

different drive. 

3. When the folder you want to use is highlighted, click on Open. 

Then click Set. 

4. Continue the process for each of the folders you want to specify. 

You’ll see in Figure 7.5 that I’ve chosen the wp docs folder as the 

work folder as well as the folder for temporary files. Macro files 

are stored in a folder named macros, and the Speller and Thesau- 

rus are in the 1wp folder. All these folders are on a hard disk 

named home stuff. 

5. When you’re done, click OK; then save the settings. 

Clicking Revert changes all the folders back to their original values, 

and clicking Cancel cancels any changes you may have made. 

Backup Protection Schemes 
It’s sad but true: nothing makes you appreciate the value of back- 

ups except losing valuable information that isn’t backed up. Once 
that happens to you (and it will, sooner or later), you’ll appreciate the 
insurance of a consistent backup scheme. 

Of course, you’ll want to pick a backup strategy that best suits 
your own work habits and needs. We’ll skip the standard paragraph 
warning about power failures and inquisitive three-year-olds playing 

with the mouse and get down to a few basic ideas and suggestions 
about maintaining backup files. 

There are two kinds of backups: file backups and disk backups, 
and we’ll discuss file backups first. WordPerfect has two options for 
making file backups: timed backups and original backups. Both of 
these serve different purposes. 

Timed Backups 

WordPerfect’s timed backup option automatically saves a backup 
copy of the document you’re working on every so many minutes as 
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specified. If you’re in an area where you lose power often, set the 
timed backup for frequent saves. 

To set the timed backup: 

1. Open a new document (Command-N). 

Opening a new document makes sure that any format change 
you’ ve made in the document you are working on won’t be saved 
into the WP Defaults file. 

2. Choose WP Defaults from the File menu. Then choose Backup 
Options. 

3. In the Backup Options dialog box, click on Timed Backup and 
enter the number of minutes you want between timed backups. 

I keep mine set at 10 minutes so that I never lose more than 10 
minutes’ work. 

4. To specify the folder where you want the backup saved, click 
on Set. 

A list of folders on your disk appears. 

5. Open the folder in which you want your timed backups to be 
saved. 

You can click on the folder name at the top of the list and drag to 
select other folders. To select a folder on a disk in a different 
drive, click on Drive; then open the folder you want. 

6. Click on Set to set the path name of the folder for your timed 
backup. 

You’ll see a path name in the dialog box. For example, mine 

reads 

home stuff:1wp:wp docs: 

because my hard disk is named home stuff and I’m directing the 

timed backup to a folder named wp docs that’s within the 1wp 

folder. If the path name isn’t what you want—if you’ ve opened 

one too many folders, for example—repeat the process above to 

change it. 
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1) To open an original 

backup file, you 
need to rename it so that 
backup isn’t the last six 
characters in its name. 
Don’t just delete Backup 
from the name, or your 
file will have the same 
name as the last-saved 
version of the document 
you were working on. 

7. Click OK when the path name is correct. 

If you’ ve set a timed backup, you'll probably want to have it take 

effect each time you start WordPerfect. To do this, you need to 

save the timed backup setting to the WP Defaults file. 

8. Choose WP Defaults from the File menu. Then choose Save 

Settings. 

9. Click Save; then click OK. 

After you’ve set the timed backup option and saved it to the WP 

Defaults file, WordPerfect will automatically make a copy of the doc- 

uments you’re working on as often as you specified. These copies will 

be named Time Backup Doc 1, Time Backup Doc 2, and so forth, 

depending on how many documents you have open. If you lose 

power or turn off your Mac without quitting WordPerfect, you'll see 

a ‘‘Warning! Backup files exist”” message when you start up again. 

Click Open to save them under new names. As they will probably be 

the most recent versions of the documents you were working on, you 

may want to save them as those documents. If you don’t want to save 

the backup files, click Delete. 

When you quit WordPerfect normally by choosing Quit from the 

File menu, these backup files are deleted. 

Original Backups 

WordPerfect’s original backup feature is designed to maintain a 

copy of the previously saved version of the document you’re working on 

so that you have a version that’s one generation older than the cur- 

rent one. If you’ve specified original backups, the program saves the 

original document (the one you previously saved) each time you save 

the document you’re working on. 

For example, if you’ve set the original backup option and then 

save a document named Chapter 5, the last version of Chapter 5 that 

you saved becomes Chapter 5 Backup and the current version is 

saved as Chapter 5. If you want to be able to get an earlier version of 
your document back, use the original backup option. It’s also on the 
Backup Options dialog box, and you set it and specify which folder 
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the backup files are to be directed to as just discussed for the timed 
backup option. 

Disk Backups 

You also need to make backups for your disks from time to time. 

Be sure to make a backup copy of WP (and any other applications 
programs you’re running) onto a separate floppy disk, no matter 

whether you’re using a hard disk or floppy disks. If you didn’t do it 
when you first got WordPerfect, do it now. 

Keep the backup disk in a dust-free place, safely away from pos- 
sible liquid spills and sources of magnetism. This place should ideally 
be away from your computer and in a different room. 

As you work, you’ll want to make backup disks of the disks you 

create. All you have to do is drag the original disk’s icon over the icon 
of the backup disk, and then name and label the backup disk. 

This procedure copies every file on the original disk onto the 
backup disk. As you work and your files build up in volume, you’ll 
probably want to copy only the files that have been changed since you 
last made a backup. (You can continue to copy all the files if you have 
the time and space available.) It’s simple, though, to copy only the 

changed files: 

1. Sort the files on the original disk by date. 

Use the View menu of the Finder. 

2. Insert the backup disk and check the date of the last backup 
(the most recent date). 

3. Copy only those files that have dates more recent than the date 
on the backup disk. Shift-click to indicate all the files you want 
to copy; then drag their icons to the backup disk’s icon. 

Backing Up Hard Disks 

If you’re using a hard disk, it’s easy to use it as your backup. But 

don’t do it. If your hard disk fails for any reason, you can lose hun- 

dreds of files. Although this has never happened to me on the Macin- 

tosh, it has on the big-business-brand computer I use. I make it a 

point to back up my work onto floppies every day. 
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From time to time, it’s a good idea to make backups for the entire 

contents of your hard disk. Backing up a hard disk that’s holding 

hundreds of files can be a real chore. In fact, you’ll need about 20 or 

25 800K disks to back up the contents of a 20-megabyte hard disk. 

Many hard disk utilities are available that speed up the process of 

backing up your hard disk—either as a complete backup or as incre- 

mental backups that back up only those files that were changed since 

the last backup. These utilities also can let you copy the backed up 

files back onto the hard disk—a process called restoring. Since I don’t 

know which backup utility you’ll be using, I'll resort to the usual out: 

‘follow the documentation that came with your utility.” 
No matter which backup utility you use, you’ll want to follow 

some consistent schedule for backing up your disks and files. For 

example, maybe you’ll decide to back up the hard disk on the last 
business day of every month, and make daily backups of all files cre- 

ated or changed since your last monthly backup. 
Another scheme uses three sets of backup disks: one holds the 

monthly backup files, and you alternate incremental daily backups 
between the other two sets of files on different disks—one set one day 

and the other the next. This way, if something happens to one set of 
your incremental backup files, you still have the other. You’ll lose 
only one day’s work at the most. 

If you’re lucky, you won’t have to restore these backed-up files to 
the hard disk, which you keep up-to-date with your daily saves. 

However, if for some reason the hard disk fails or if you buy a new 
one and want to transfer your files to it, you’ll be glad to be able 
to restore the backed-up files. To restore the files on the hard disk, 
restore the monthly backup disk files first; then restore your daily 
backup files. 

WordPerfect’s Files 

As you work with WordPerfect, it automatically creates certain kinds 
of files. Normally, you won’t have to be concerned with these files, but 
in case you ever need information about any of them, here it is. 

WordPerfect uses what is called virtual memory. This means when 
your Macintosh’s RAM is filled, it transfers part of the document 
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another document you’ve 
already created and saved 
but no longer need. The 
“Insufficient Memory”’ 
error message means 
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it as you work, you'll 
need to close some docu- 
ments, because your 
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full. 
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you’re working on into overflow files that are on disk, so the size of your 
document is limited by the size of your RAM plus the space that’s avail- 
able on disk. 
Any text that’s above the insertion point that needs to be put in an 

overflow file goes into a file named TV1 (top virtual file); any text 
after the insertion point goes into a file named BV1 (bottom virtual 

file). If you’re working with more than one document, you’ll see 

TV2 and BV2 listed for document 2, and so forth. These files are 

automatically created in the system folder. 

If you’ve filled up all your available memory, you may get a mes- 
sage that your WP disk is full when trying to open a document. This 
means that the documents you’re working with have filled up the 

available RAM and all the available space on the WordPerfect disk. 

This can easily happen when you’re using a two-drive system with- 
out a hard disk. You can redirect these overflow files to another disk 
by choosing a different default folder for your temporary files, as 
described in “‘Setting Default Folders’’ earlier in this chapter. 

Normally, these temporary files are deleted each time you quit 

WordPerfect. However, if you have a power failure and don’t quit in 

the usual way, these files will remain on your WordPerfect disk in its 
folder. Delete them to regain disk space. 

The program also creates Undelete files that contain the last three 
deletions you make in each document you’ re working on. Normally, 

they’re automatically deleted when you quit the program, but if you 
don’t exit in the normal way, you may also see them in your Word- 
Perfect folder. They’ Il be deleted the next time you quit WordPerfect. 

The WP Defaults file is automatically created in your System 
folder when you first start WordPerfect. As you’ve seen in this chap- 

ter, you can create other custom default files and save them in the 

System folder. 
Table 7.1 lists the various files that the WordPerfect program uses, 

just in case you need to find out what any of them do. If you need 

additional disk space, delete some of these files. For example, if you 
don’t have any need to convert documents to other formats, you can 
trash the WP File Formats icon, and if you’re to the point where you 

don’t need help, you can also delete the WP Help file. 
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Table 7.1: WordPerfect Files 

File Name Description 

Programs and 
Utilities eZ 

WordPerfect The WordPerfect pro- 

; gram file 
WordPerfect 

The program that allows 

a ) you to add words to the 

er Utility main dictionary 

Speller Utility 

Spell 

WP File Formats 5 The file conversion 

program 

WP File Formats 

The WordPerfect Help 

text file 

Document Files 

WP Document A WordPerfect document 

WP 4.2 Document A WordPerfect IBM 4.2 

document 

Text File , A file you’ve saved as text 

only 

resume text 
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Table 7. 1: WordPerfect Files (continued) 

File Name Icon Description 

Dictionaries 

WP Dictionary A The main WordPerfect 

dictionary; you can create 

others. 

The dictionary of all the 

words you’ve added as 

you ran the Speller 

User Dictionary 

The WordPerfect 

Thesaurus 

WP Thesaurus 

WP Thesaurus 

Formats and Startup Macros 

WP Defaults The file containing your 

default settings; you can 

create other default files 

The macro file that is 

executed each time you 

start WordPerfect (see 

Chapter 8 and Appendix 

C.) 

Startup Macro 

Temporary Files 

The timed backup file 

that WordPerfect auto- 

matically creates if you’ve 

chosen timed backups. 

Time Backup Doc 1 

The overflow files that 

WordPerfect automati- 

cally creates. TV2 and 

TV 1 BY 1 BV2 refer to Document 

2, and so forth. 
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__ SC Looking Forward ————_—_____ 

This chapter has discussed all sorts of ways to manage your Word- 

Perfect files on the Macintosh. You’ve seen how using the File Man- 

agement screen can carry out many of the tasks you used to have to 

go to the Finder for. You’ve also reviewed different ways of organiz- 

ing and backing up the files you create, seen how to search files for 

word patterns, and learned how to protect your files so that others 

can’t open them. In addition, you’ve had a look at how WordPerfect 

manages memory and what kinds of information the Finder uses to 

manipulate files. 

Chapter 8 discusses one of the most fascinating and time-saving fea- 

tures of WordPerfect: macros. By using macros, you can automate most 

of the boring and repetitive tasks you do as well as the complicated pro- 

cedures that are often hard to remember. If you’re really not interested 

in macros, skip to any of the later chapters that discuss WordPerfect’s 

specialized features for creating reference aids, using the Speller, or 

working in an environment with other computers. 



8 — Using Macros to 
Automate Your Work —_— 



To record a macro, 

choose Macro from the Special menu; then choose Define 

Macro (or use the keyboard shortcut Command-Shift-M). 

To turn off macro definition 

after you’ve recorded a macro, press Command-Shift-M 

again. 

To execute a macro, 

choose Execute Macro (or press Command-Shift-X). 

To insert a pause in a macro, 

choose Macro Pause. Then choose Macro Resume and con- 

tinue recording the macro. (The shortcut for both is 

Command-M 6.) 

To insert a prompt in a macro, 
choose Macro Input (or press Command-M 5). 

To insert a delay factor in a macro, 
choose Macro Delay (or press Command-M 4). 

To chain one macro to another, 

choose Chain Macro (or press Command-M 3). Then select 
the macro to chain. 

To repeat a macro, 

press Esc and enter the number of times you want the macro to 

repeat; then press Command- Shift-X to choose a macro to 
execute. ( 
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| To set up conditional chains, 268 
ig record all the macros that are involved before you begin to 

record the master macro. One macro must be a search macro. 
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iar Tey ouehoutthis 
chapter and scat- 

tered through the rest of 
the book are many 
macros that you can put 
to work. You can type 
them exactly as they are 
listed, or you can modify 
them for the particular 
situation you want to use 
them in. If you want to 
use the macros but don’t 
want to take the time to 
type them in, you can 
send for a disk that con- 
tains all the macros dis- 
cussed in this book. See 
the order form on the last 
page of the book. 

ONE OF THE GREAT STRENGTHS OF WORDPERFECT IS 

its ability to record a series of commands and keystrokes and then 

play them back whenever you want to repeat that sequence. These 

recorded command sequences are called macros, and they’re an easy 

way to get WordPerfect to do your work for you. Anything you can 

do with the program can be recorded as a macro. 

A macro can be text that you don’t want to retype each time you 

use it, or it can be a complex sequence of commands that set up a doc- 

ument format, save the document, and print it. It’s easy to think of 

ways to use macros for simple, boring tasks such as inserting a stan- 

dard letter closing, but you can also use them for complex sequences 

that you don’t want to have to remember, such as marking text for a 

table of contents, formatting the table, and generating it. 
WordPerfect lets you insert pauses in macros so that they will stop 

executing and wait for you to enter something from the keyboard. 
Thus, you can write one general macro that can be used in different 

situations. For example, you might want to record a macro that sets 

up a header but pauses for you to enter the chapter number that’s to 
be used in it. You can also write your own prompts in macros. 

Instead of just pausing for the chapter number, you could have 
WordPerfect display a dialog box asking the user to “Enter the chap- 
ter number and press Return’’. 

These are just a few examples of what you can do with macros. 
You can also set up macros that repeat themselves, execute other 

macros, or both. For example, you can record one macro that 

searches for a particular phrase and marks it to be included in a list or 
an index; then, when no more occurrences of that phrase are found, 

the macro calls another macro that generates the list. You’ll see in this 
chapter how to set up sequences like this. 

You can do some incredibly sophisticated things with macros, but 
what’s surprising is how easily you can create them. When you turn 
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(in this case caps and 
lowercase are the same), 
the numbers 0 through 9, 
or any symbol except the 
colon (:) to an Option- 
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instead of giving a macro 
a name. Once you’ve 
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Option-Command 
sequence, you don’t have 
to choose Execute Macro 
and then select the 
macro’s name. It will 

- execute when you press 
Option-Command and 
the character. 

Using Macros to Automate Your Work 257 

macro definition on, WordPerfect simply records your keystrokes, so 
all you have to do is carry out a procedure once. If you make a mis- 
take, just correct it, and WordPerfect records the correction. When 
the macro plays back, it works so quickly that you normally won’t be 
aware of the extra keystrokes from correcting the mistake. 

First, we’ll look at some simple macros. Before you begin, you 
need to tell WordPerfect where you’re going to keep your macros if 
you haven’t done that already. Create a folder for your macros; then 

choose WP Defaults from the File menu. Next, choose Default Fold- 

ers to tell the program where your macro folder is. If you need more 
information about setting default folders, see Chapter 7. 

Recording a Macro 
Recording a macro, simple or complex, consists or four basic 

steps: 

1. Choose Macro from the Special menu; then choose Define 
Macro. 

It’s faster to use the keyboard shortcut Command-Shift-M. 

2. Type a name for the macro and click Save. 

You can name a macro anything you like—up to the maximum 
of 63 characters for a file name. However, it’s best to keep your 
macro names short. You'll get a dialog box to select which macro 
you want to use each time you execute a macro, and it displays a 
maximum of 20 characters. Short, meaningful names can help 
you remember a macro’s function. 

3. Carry out all the operations that you want to record in the 

macro. 

The ‘‘Macro Def’’ message on the status line tells you that all 

your commands and keystrokes are being recorded. 

4, When you’ve finished the sequence you’re recording, press 

Command-Shift-M again to turn off macro definition. 

From then on, you can execute the macro you just wrote by press- 

ing Command-Shift-X (or choosing Execute Macro from the Macro 

submenu) and double-clicking on the macro’s name. 
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When you record a 

macro, you'll need 
to have something on the 
screen for the macro to 
work on. For example, 
you can’t record a macro 
that will delete text if 
there’s no text there to be 
deleted. If you’re working 
on an important docu- 
ment, you may want to 
switch to a different 
window and enter some 
“dummy” text to record 
the macro until you get it 
working correctly. 

Save a document 
M8 before you test a 
macro in it. That way, 
you can get the original 
version back in case you 
get unexpected results. 

Let’s try writing a few simple text macros that automatically gen- 

erate text for you. 

Writing Paragraphs Automatically 

If you write similar letters over and over again, you can use macros 

to automate each standard paragraph. The three macros that follow 

generate the first notice, second notice, and third notice in a standard 

customer account letter. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro first notice. 

2. Type the following paragraph: 

We’d like to remind you that you may have overlooked your 

unpaid balance. Enclosed is a postage-paid envelope for 

your convenience. 

3. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

4. To create the second notice, choose Macro from the Special 
menu again; then choose Define Macro (or press Command- 
Shift-M) to turn on macro definition. Then name the macro 
second notice. 

5. Type the following paragraph: 

Your account is overdue. We would appreciate receiving 

payment now. 

6. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

7. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro third notice. 

8. Type the following paragraph: 

We have not heard from you regarding your account. If you 
are unable to pay, please contact us to make other 
arrangements. 



Typing the first few 
Ml letters of a macro’s 
name takes you quickly to 
it in the list. 
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9. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

To execute any of these macros, press Command-Shift-X (or 

choose Execute Macro) and double-click on the macro’s name. As 
you’re writing a letter, you can choose which of the standard para- 

graphs you want to insert by selecting the macro that generates it. 
You can use macros like the one you just wrote to automate a lot of the 

repetitious writing you do. For example, you can have a macro that 
inserts your company’s letterhead or return address, or a macro that 
writes the whole letter for you. 

Now let’s look at how you can use macros to edit text. 

Editing Text Automatically 

You can record a macro that will transpose one sentence with the 

following one (as long as the second sentence ends in a period). To 
record this macro, you’ll need two sentences ending in periods on the 

screen. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro—?r sentence is a suggestion. 

2. Choose Select from the Edit menu; then choose Sentence (or 

press Command-6 2) to select the sentence the pointer is on. 

3. Press Command-X to cut the sentence, including the spaces 

after the final punctuation. 

4. Choose Find from the Search menu (or press Command-F) to 
find the next occurrence of a period. 

5, Enter a period into the Search For box; then press Return. 

WordPerfect locates the next period and selects it. 

6. Press Command-. to turn off Select. 

7. Press the space bar twice to insert two spaces between the sen- 

tences. 

8. Press Command-V to insert the cut sentence. 
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9. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

Now, whenever you want to transpose one sentence with the fol- 

lowing sentence, you can press Command-Shift-X (for Execute 

Macro) and select the tr sentence macro. 

There are many more text-editing macros at the end of this chapter. 

Formatting Text Automatically 

You can also write macros that handle formatting for you. This 

next macro changes to double spacing and inserts a hanging indent 

for the next paragraph that you type. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro hanging. 

2. Press Command-4 and type 5 (or select Line from the Format 
menu; then choose Spacing). 

3. Click on the up-arrow in the Line Spacing box to set the spac- 
ing to 2.0; then press Return (or click OK). 

4. Press Command-Shift-T to insert an indent. 

5. Press Shift-Tab (Margin Release) to move the first line of the 
paragraph one tab stop to the left. 

6. Press Command-Shift-M to turn off macro definition. 

When you execute this macro, the next text that you type will be 
double spaced and formatted as a hanging indent, like this: 

The first line of the paragraph will be flush left, but any subsequent 
lines that you type will be indented on the first tab stop. When you 
press Return, you’ll go back to the left margin of your document. 

You'll find other formatting macros at the end of this chapter. 
Now that you’ve had some practice in recording simple macros, we’ll 

look at some of the more advanced things you can do with macros. 
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7] WordPerfect doesn’t 
M@™@ record any key- 

strokes you make during 
a pause. 

Getting Input from the Keyboard 
WordPerfect lets you insert pauses and prompts in macros so that 

you can enter information that the macro needs in order to work. For 
example, you can pause a macro so that you can indicate a different 
right-margin setting or go to a specific page number. You can also 
insert a prompt (called Macro Input on the menu) that indicates 
what kind of information needs to be entered. If you’re creating 
macros that others will use, it’s good to be able to give the user a 
prompt for exactly what kind of information needs to be entered at a 

certain point. For example, you might want to insert the prompts 
“Enter the starting date”’ and “‘Enter the ending date”’ in a form let- 
ter to be used by others in your work group. 

Pausing a Macro 

To insert a pause in a macro that you’re recording, press Command- 

Shift-M and type 6 (or select Macro from the Special menu; then choose 

Macro Pause). These keystrokes aren’t recorded as part of your macro; 
they simply turn off macro definition temporarily. 

After you’ve chosen Macro Pause, choose Macro Resume and 

continue recording the macro. When you execute the macro, it will 
pause for your input. 

For example, in the next macro we’ll create a header that appears 
on all pages of a document. It will have the current date and the page 
number of the chapter. The macro will pause so that you can indicate 

which chapter number to use. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro header. 

2. Press Command-Shift-H to start the header. Click on Header 

A and All pages in the dialog box that appears; then press 

Return. 

If Header A and All pages are already selected, just press Return. 

3. Click on the clock at the bottom of the screen to insert the date. 

The date will be formatted in the default format style—for 

example, September 22, 1988. To change the date format, use the 

Date command on the Special menu. 
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To insert a pause 
when a dialog box is 

up, press Command-Shift- 
M and choose Pause in 
Dialog. The macro will 
automatically resume 
when you close the dialog 
box. 

4, Press Command-Shift-F to position the next text flush right. 

5. Type Page and press the space bar once. 

6. Select Macro from the Special menu; then select Pause Macro 

(or type 6). 

7. Select Macro from the Special menu; then select Resume 

Macro (or type 6). 

The 6 key is a toggle for Macro Pause and Macro Resume. 

When one is on, the other is off. 

8. Type a hyphen; then click on the # at the bottom of the win- 
dow to insert the automatic page number. 

The page numbers will appear in the style Page 5-1 where 5 is the 
chapter or section number you enter when you execute the 

macro. 

9. Press Command-K to close the header window. 

10. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

From now on, executing the header macro inserts this formatted 
header into your document. It will pause for you to type the chapter 
number. To resume the macro, choose Resume Macro after you’ve 
typed the chapter number. If you want the header to be on all the 
pages of the document, be sure to move to the beginning of the docu- 
ment before you execute the macro. 

Using Prompts in Macros 

If you want WordPerfect to display a prompt when it pauses for 
you to enter something from the keyboard, use the Macro Input 

command instead of the Pause Macro Command. You’lI see a dialog 
box where you can enter the prompt you want to be displayed when 
the macro pauses. When the macro executes, what you enter in the 
prompt’s box will be inserted in the document. If you’re entering text 
for a letter, for example, whatever you type will go into the letter. 

For practice, let’s record a macro that writes a standard boilerplate 
paragraph for a contract. It prompts the user to enter a start date and 
an end date, and it automatically writes the rest of the paragraph. 
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- Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro boiler. 

2. Press Return to begin a new paragraph. Then enter 

The estimated time required to complete Phase 1 is 

Press the space bar once to insert a space after the s in is. 

3. Select Macro from the Special menu and choose Macro Input. 

4. In the Macro Input dialog box, enter 

Enter number of days required for Phase 1: 

and press Return. 

5. Press the space bar to insert a space after the input that will be 
provided from the keyboard. 

6. Type 

days, beginning on 

and press the space bar. 

7. Insert another prompt by choosing Macro Input again. This 
time, enter the prompt as 

Enter start date for Phase 1: 

Press Return and type a period to end the sentence. 

8. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

Now execute the macro. Choose Execute Macro (or press Com- 
mand-Shift-X); then choose boiler from the list. You’ll be prompted for 
the number of days for Phase 1 as well as its start date. ‘The macro will 
then execute rapidly, and you’ll see a sentence like this: 

The estimated time required to complete Phase 1 is 30 days, 

beginning on September 24, 1988. 

The numbers and date that appear will depend on what you entered. 

As you can see, you can set up form letters and other documents 

that request many different kinds of information. After you or some 
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If a macro isn’t 
working as you 

expect, insert a delay 
factor of 1 so that you can 

see what it’s doing as it 
executes. It will run at 
top speed, but prompts 
and text will be visible. 

You may be able to 
quickly spot where the 
trouble is and then 
redefine the macro. 

other user enters all the requested information, WordPerfect con- 

structs the rest of the document quickly. Although we used only a 

short paragraph in this example, you can use the same technique to 

set up prompts that will guide another person through a complex 

series of prompts to fill out a form or create a letter. 

Using a Delay Factor in.Macros 

Macros normally execute so quickly that you can’t see them work- 

ing. You can insert a delay value into a macro to slow it down so that 

you can see the sequence of steps on the screen. The delay value you 
insert is in increments of 1/60th of a second, so to insert a 1-second 

delay, you’d enter a delay value of 60. Inserting a delay value of 0 
speeds the macro back up so it’s invisible again. 

For example, you may want to be able to read prompts and text on 

the screen as a macro is executing, or you may want to display text 
letter by letter across the screen v-e-r-y s-l-o-w-l-y to create anima- 

tion. Here’s how to create an “‘animated’’ macro that automatically 
writes across your screen. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro abc. 

2. Choose Macro; then choose Macro Delay. 

3. Enter 5 as the delay factor. 

Each step in the macro will occur at intervals of 1/12th of a sec- 
ond. You can insert a delay factor as large as 65367—that’s 
1089.45 seconds, or 18.16 minutes. 

4. Type 

Announcing... 

and press Return twice. 

5. Press Tab; then type 

A new line of special products! 

6. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 
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‘To try out your new macro, open a new window and execute abc. 
If you create presentations or tutorials, you can get some pretty spec- 
tacular results with this trick. 

Creating a Startup Macro 
Any macro that you name startup macro will automatically execute 

when you start WordPerfect. Here are a few possible uses for a start- 
up macro: 

e You can have WordPerfect display a daily to-do list for you. If 

you save a document named to-do list at the end of each day, 
your startup macro can open that document automatically 
the next time you start the program. 

e Ifyou normally start your day by writing letters, you can use 

the macro that creates your letterhead, changes to a different 

font, formats the letter, and inserts the date as your startup 

macro. 

e If you habitually begin work with a specific document, you 
can name a macro that opens it as your startup macro. 

¢ If you’re preparing a tutorial or a mail-merge application for 
other people, the instructions for using it can be the docu- 
ment that WordPerfect opens as the startup macro. 

Repeating Macros 

There are two ways you can have a macro repeat itself. First, if 

there’s a search in the macro, you can have it repeat itself until no 

more occurrences of the search pattern are located. This 1s called a 

repeating chain. If there’s no search command in the macro, you can 

use the Esc key to specify how many times a macro is to be repeated. 

By setting a large number (such as 1000) for the Esc value, you can 

make sure that the macro repeats itself as many times as you need it 

to, even in very large documents. 
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bor If you’re saving 
macros and docu- 

ments in the same folder, 

you can’t name a macro 
with a name you’ ve 

previously given to a 
saved document. Create a 
separate folder for new 

macros, as explained in 
Chapter 7, so that you 
will have more flexibility 
in naming them. 

Repeating Chains 

For example, here’s a macro that searches for all the italicized 

words in a document, changes them to plain text, and copies them 

into a document in a second window, where you can use the word list 

as the basis for a glossary. 

You’ll need a paragraph containing italicized words for the macro 

to work on, so enter this short paragraph into a new document and 

save it as glossary (you’ll use it again-Jater): 

Leading is the vertical distance in points that’s often added 

between lines of typeset text to make it more readable. Kerning 

and letterspacing refer to the spacing between characters of type. 

When you’re ready to start recording the macro, open another 

document window. This window will ultimately contain the word list 
that the macro will generate. Then, in the document with the itali- 

cized words, press Enter three times and press the t key to go to the 
beginning of the document, before any codes. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro glossary. 

2. Choose Forward from the Search menu (or press Command-F). 

3. Select the first [Ital] code from the box on the right; then click 
Insert to put it in the Search For box. 

4. Click Find to begin the search. 

WordPerfect locates the first [Ital] code. 

5. Press the period on the numeric keypad to delete the code; 
then click OK. 

6. Turn on Select by pressing Command-Shift-N. 

7. Press Word Right (Command-~) to select the word. 

8. Copy the word with Command-C. 

9. Press Cancel (Command-.) to turn off Select. 

10. Press Command-W to switch to the second window. 

11. Paste the copied word (Command-V). 
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Always use Select in 
macros instead of 

double-clicking with the 
mouse. If you’re moving 
the insertion point, use 
the arrow keys, not the 
scroll bars. WordPerfect 
remembers the position of 
the insertion point in 
relation to the screen 
(instead of to the docu- 
ment) if you use the 
mouse or scroll bars. 

Pi You can also use a 

macro like this one to 
compile a list of keywords 
or a selection of titles for 
suggested reading. 

12. Press Return to move to the next line. 

13. Press Command-W to switch back to the original document. 

14. Choose Macro; then choose Chain Macro (or press Command- 
M 3). Select glossary as the macro to chain. 

15. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

Now try out your new macro. Choose Execute Macro (or press 
Command-Shift-X) and choose glossary. You’ll be prompted for 

each deletion; press Command-O (for OK) or click OK. The macro 
will continue until there are no more occurrences of italics in the doc- 
ument. Then it will give you a “‘Not Found!” message and stop exe- 

cuting. Your word list will be in the second window, ready for you to 
start writing a glossary of terms. 

Although this example was deliberately kept short, you can begin 

to see how much time it would save you in a long document. 

Repeating Macros with the Esc Key 

You can also use the Esc key to repeat a macro a certain number of 

times. After you press Esc, enter the number of times you want the 
macro to repeat; then press Command-Shift-X to choose a macro to 
execute. 

For example, you can record a short macro that selects the word the 
insertion point is on and italicizes it. When you execute the macro, you 
can use the Esc key to italicize any number of words following the inser- 
tion point. 

You’ll need a few words on your screen to record this macro, and the 

insertion point should be within one of the words or at its beginning. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 

tion. Then name the macro ?tal. 

2, Press Command-Shift-N to turn on Select. 

3. Press Word Right (Command-~) to select the word. 

4. Press Command-Shift-I to italicize the word. 
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5. Press Cancel (Command-.) to turn off Select. 

6. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

Now try out your new macro. Press Esc; then press Command- 

Shift-X (or choose Execute macro). Next, choose ital as the macro 

to execute. 

The next eight words will be italicized, if you haven’t changed the 

default setting from eight. If you want to italicize fewer words or 

: more words than the default choice, you can type that number in the 

dialog box before you execute the macro. 

Nesting and Chaining Macros 
Macros can also start other macros that in turn carry out other 

iN) 

i 1) These macros are 

r going to get com- 
plex quite rapidly as they 
teach nesting and chain- 
ing techniques. There are 
a lot of useful, simple 

macros at the end of the 
chapter, so you may want 
to skip this section until 
you re ready to try com- 
plex macros. 

IF] When you nest 
MM macros, you'll need 

to record all the macros 
you’re going to use before 
you write the master 
macro. 

functions. Because you can connect macros this way, you can write 

short macros that carry out relatively simple functions and either 
chain them together or nest them within each other so that they carry 
out complex sequences of commands. 

First, we’ll look at the simplest case: nesting macros, in which one 
macro starts another. You can nest the header macro you wrote ear- 

lier inside another macro, and then nest another macro that saves 

and prints the document, which in effect creates an automatic page- 
numbering system for you. 

Nesting Macros 

The macro you’ll create will first move to the beginning of your 
document. It will then start the header macro. After you’ve created 
the header, the macro will save the document. It will finally call 
another macro that prints your document. 

Recording the Print Macro 

You’ve already created the header macro, but you’ll need to 
record a print macro before you start recording the master macro 
that will handle everything. You’ll use the print macro each time you 
print a document, so you can assign it to an Command-Option 
sequence. 
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1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then assign the macro to Command-Option-P by typing 
P in the box and pressing Return. 

2. Choose Print from the File menu; then click OK. 

When you record a macro that prints a document, it works only 
with the printer you’ ve selected with the Chooser. If you run the 
macro with another printer chosen, you’ll get an error message, 
and the macro will stop. If you use several different printers, 
define a print macro for each one and use the appropriate print 
macro in your master macro. 

3. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

i A master macro Fi 
bes’ t ave to do Recording the Master Macro 

penchiitself;except per> Now you’re ready to record the master macro that will have other 
haps move to different de nat 
places in the document macros nested 1n it. 

and call other macros ‘ 

from your macro library. 1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro page numbers. 

2. Press Enter three times; then press the t key to move to the 
beginning of the document. 

3. Choose Execute Macro; then choose header. 

The header macro pauses to let you enter a chapter number. 

4, Choose Resume Macro to resume. 

5. Press Command-S to save the document. 

If you haven’t saved the document before, you'll be prompted for 

a name. 

6. Choose Execute Macro; then choose Option-Command-P. 

7. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

Now, when you’ve finished with a document that needs a header 

with page numbers, you can execute this macro, supply the chapter 
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or section number, and let WordPerfect take care of creating the 

header in the right place, numbering the pages, saving the revised 

document, and printing it. 
= Nested macros are 

executed as you 

define them. Chained “27 ; 

macros aren’t, but all the Conditional Chains 

keystrokes in a chained You saw a little earlier how to set up a macro that will chain or repeat 
macro will take place ; one : at 

ea avai itself until it can no longer locate its search pattern. You can also set up 

starts. conditional chaining macros—one macro will execute when a particular 

search pattern is located, and the other will execute when the search pat- 

tern is not located. This is a little trickier than what you’ve done so far, 

because you record two macros before you begin to record the condi- 

tional macro. 

1. First, you record the macro that will run when the search pat- 

tern is not found. 

2. Next, you record the macro that will run when the search pat- 

tern is found. 

3. To record the conditional macro, turn on macro definition and 

chain the not-found macro as the first step. 

4, Then record the search macro’s keystrokes and commands. 

5, Finally, chain the name of the macro that will run when the 
pattern is found. 

For example, you could record a macro to search for a [Cntr Pg] 
code indicating a title page somewhere in the body of a report. If no 
title page were found, the macro would print the report; if a title page 
were found, it would prompt you to edit the title. In a long report that 
was assembled from several main sections written by other contribu- 
tors, this type of macro could save you a lot of time and allow you to 
check the wording of each title and the numbering of each section. 
You’d have to reexecute the macro each time a title page was locat- 
ed, though. 

A more useful type of conditional chaining macro is one that will 
repeat itself until the pattern is no longer located. It’s more useful 
because you can use this type of macro to automate repetitive 
searches in a document. For this kind of conditional chaining macro, 
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you simply chain the not-found macro as the first step, enter the 
search keystrokes, and chain the macro to itself. 

For example, you can set up the glossary example discussed earlier 
so that after all the italicized words are copied into a list, the list is 
saved and printed, and you have a hard copy to work with. 
Open the glossary document you saved earlier; then open a new, 

empty document window and switch back to the glossary document. 
Turn on your printer if it isn’t already on. Remember, macros need 
to be recorded under the same conditions they’Il be executed under, 
and this one requires two windows and a printer. 

Recording the Not-Found Macro 

First, you’ll need to record the macro that executes when the 
search fails—that is, when WordPerfect can’t locate any more itali- 

cized words in the document. This macro will then save the docu- 
ment and print it. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro print list. 

. Press Cominand-W to switch to the list in the second winduw. 

. Press Command S to save the list. 

. Press Command-P to print it; then click OK. 

oO PF & bs Choose Macro from the Special menu; then choose Define 

Macro(or press Command-Shift-M) to end macro definition. 

Recording the Entire Macro 

Now you can record the macro, which consists of the not-found 

macro (print list), plus the keystrokes for the search, plus a command 

to chain the macro to itself. You’ll recognize many keystrokes as part 

of the glossary macro you created earlier. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 

tion. Then name the macro do glossary. 
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First, you’ll chain the not-found macro. 

ae Choose Chain Macro; then choose print list. 

Next, you’ll record the search keystrokes. 

J 

4. 

Choose Forward from the Search menu (or press Command-F). 

Select the first [Ital] code from the box on the right; then click 

Insert to put it in the Search For box. 

. Click Find to begin the search. 

. Press Command-. to turn off Select. 

. Press Delete to delete the [Ital] code. 

. Turn on Select by pressing Command-Shift-N. 

. Press Word Right (Command-~) to select the word. 

. Copy the word with Command-C. 

. Press Cancel (Command-.) to turn off Select. 

. Press Command-W to switch to the second window. 

. Paste the copied word (Command-V). 

. Press Return to move to the next line. 

. Press Command-W to switch back to the original document. 

. Choose Chain macro; then chain the macro to itself by select- 
ing do glossary. 

. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

Now you can try out this rather complex macro. Open a new win- 
dow for the list. Close any other windows you may have open; then 
open the glossary document and move to the beginning, before any 

codes (press Enter three times; then press the t key). Execute the do 
glossary macro. 

All the italicized words in the document will be copied into a sec- 
ond window, the italics will be removed, and you’ll get a hard copy of 
your glossary list. 



cr You can’t retrieve 

macro files and edit 

them (at least, not in 
version 1.0). You have to 
rerecord the macro. Also, 

you can’t transfer Word- 
Perfect Macintosh macros 

to WordPerfect on other 

computers and vice versa. 
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Chaining More Macros 

You could continue to chain more macros to the macros in this 
example and create even more complex conditional chains, which 
could save you hours of time if you had to make each step manually 
in a long document. Later in this chapter you’ll find an example of a 
set of macros that automatically prepare front matter for you to give 
you an idea of the types of things you can do with conditional macros. 
With a little practice and imagination, you can set up some sophisti- 
cated macros. 

Building a Macro Library .- 

If you’ve used WordPerfect on other computers, you’ve probably 
built fairly complex instructions into your macros. One macro usu- 

ally performs several different tasks, such as marking text, generating 
lists, and saving and printing. You don’t have to do that in WordPer- 
fect for the Macintosh. Instead, you can break up long procedures 
into separate macros and write master macros that call each short 

macro as you need it. Thus, you can build a macro library of the tasks 
you routinely perform. Not only does this make your macro library 
more flexible—because you can use one macro as a “‘subroutine”’ in 
several different macros—but it makes the macros easier to record. 
Because the macros can be relatively short, you don’t have to record 20 
or 30 steps all over again if you make a mistake. 

To make your macro library useful, you’ll need to create and 
maintain a catalog of the macros you write so that you know what 
they do and what you’ve named each one. Then, as you assemble 
master macros from your library of subroutine macros, you can 
accurately choose which macros to use by displaying the catalog. 

Your catalog should include each step in the macro and provide an 

accurate description of what the macro accomplishes. You can invent 

a shorthand notation for keystrokes. For example, I notate a macro 

that finds a period like this: 

Find period @F .R 

The @ sign represents the Command key, and the R stands for 
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Insert a delay factor 
into a macro that 

isn’t working as expected. 
If you watch what hap- 
pens on the screen as the 
macro executes, you may 
be able to see where the 
problem lies. 

Macros can do what 
you want them to 

do only if they’re written 
under the same condi- 
tions in which they’ re 
going to be executed. If 
your macro needs text to 
operate on, make sure 
there’s text on the screen 
before you record the 

macro. 

You can rename 
macros by using the 

Rename File/Folder 
option of the File Man- 
agement window. Most 
of the macros in this 
chapter are identified 
with names, but 

Command-Option 
macros are faster to 
execute. Rename any 

name macros that you 
use frequently as 
Command-Option 
macros. 

Return, so in English it reads ““Command-F period Return.” This 

system may seem a little terse until you get used to writing macros, 

but you can invent a system that’s meaningful to you. Since Word- 

Perfect Corporation does not (yet) provide a macro editor with the 

program, a catalog of macros is especially useful. Aside from playing 

each macro, the catalog is the only way to see what each macro does. 

Your catalog should also provide a description of the conditions 

under which each macro operates. You may have noticed as you cre- 

ated the macros in this chapter that they each operate under a certain 

set of assumptions. For example, the tr sentence macro required sen- 

tences that ended in periods, and the glossary macro required some 

italicized words on the screen. Other macros may require your 

printer to be on, or they may require you to choose which printer you 

want to use with the Chooser. 

Useful Macros 

The next sections present macros that you can record or adapt for 

your own work. Many of these macros give you only keyboard short- 

cuts instead of menu choices, so that you can record them quickly. 

You can choose from the menus if you prefer; WordPerfect will 

record the macro correctly no matter which method you use. 

These macros are intended only to get you started writing your 

own. As you record them, you’ll get ideas for other macros that you 

can use in your own day-to-day work. They start out simple, but by 

the end of the chapter there are macros for a full-fledged macro appli- 

cation that automatically creates front matter for a report or paper. 

Text Editing Macros 

This section contains macros that are useful as you edit your docu- 

ments. To record any of these macros, you’ll need some text on your 

screen so that the macro will have something to work on as you 

record it. 
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Deleting a Word 

You can record a macro that will delete the word to the left of the 

insertion point when it’s in the middle of a word. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to define the macro. 

You may want to name it word left, or, if you’re going to use it fre- 
quently, you can assign it to a Command-Option sequence. 

2. Press Command-< to move the insertion point to the begin- 
ning of the word it’s on. 

. Press Shift-< to turn on Select. 

. Press Command-< to select the word to the left. 

. Press Delete to delete the highlighted word. 

DD a PS OC . Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

Deleting a Line 

This macro deletes the entire line, including all formatting codes. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) and name the macro. 

On the disk that you can order with this book, it’s named line 

delete, but you can name yours whatever helps you remember 

what it does. 

2. With the pointer anywhere in a line of text, press Enter three 
times and then press <. 

This moves the pointer to the very beginning of the line, before 

any format codes. 

3. Press Command-1 (End) to delete to the end of the line. 

4, Press the period on the numeric keypad to delete any hard or 

soft return that may be at the end of the line. 

5. Choose Macro from the Special menu; then choose Define Macro 

(or press Command-Shift-M) to turn off macro definition. 
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Deleting to the Beginning of a Line 

This macro deletes from the insertion point to the beginning of the 

line. 

A. 

oa & O&O HN 

Choose Macro from the Special. menu; then choose Define 

Macro (or press Command-Shift-M) and name the macro. 

l’ve named this macro delete bol, but you can name yours what- 

ever helps you remember what it does. 

. Press Command-Shift-N to turn on Select. 

. Press Enter and < to go to the beginning of the line. 

. Press Delete. 

. Choose Macro from the Special menu; then choose Define Macro 

(or press Command-Shift-M) to turn off macro definition. 

Converting a Line to Uppercase 

This macro is useful for situations in which you want to convert an 

entire line to uppercase. For example, you may decide that main 
headings in a document will stand out better if they are in uppercase. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) and name the macro. 

A suggestion for the name is line up. 

. Press Enter and then press the < key to move to the beginning 
of the line. 

. Choose Select from the Edit menu; then choose Select On (or 
press Command-Shift-N) to turn on Select. 

4, Press 1 (End) to select to the end of the line. 

5. Select Case Convert from the Edit menu; then type 1 for 
uppercase. 

. Choose Select Off (or press Command-Shift-N) to turn off 
Select. 

. Choose Macro from the Special menu; then choose Define Macro 

(or press Command-Shift-M) to turn off macro definition. 



+] WordPerfect has a 
built-in ‘““memory”’ 

for sentences: it won’t 
convert an uppercase 
letter after a period to 
lowercase. If you’re 
converting more than one 
sentence to lowercase, 

each will still begin with a 
capital letter. 
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Converting Sentences to Lowercase 

Suppose you’ve converted a section of text to uppercase and then 
decide it would look better in lowercase. To record a macro that will 

convert a sentence that’s in all caps to lowercase, take the following 
steps: 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro lower. 

2. Press Command-6 2 to select the sentence the insertion point 
is in. 

3. Choose Case Convert from the Edit menu; then choose To 

Lower. 

4, Press Command-. to turn off Select. 

5. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

Capitalizing the First Letter of a Word 

You’ll often find it necessary to capitalize the first letter of a word. 
The next macro does it for you quickly. When you record this macro, 
the pointer can be on any letter of a word except the first. 

1. Choose Macro from the Special menu; then choose Define 
Macro(or press Command-Shift-M) and name the macro. 

I’ve used the name cap. 

2. Press Command-< to move to the beginning of the word. 

3. Press > to move one character to the right. 

4, Press Command-Shift-N to turn on Select; then press < to 

select that letter. 

5. Choose Case Convert from the Edit menu; then type 1 for To 

Uppercase. 

6. Turn Select off by pressing Command-Shift-N. 

7. Press Command-—> to move to the next word. 
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8. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

Lowercasing a Capitalized Word 

This macro lets you convert a word that’s in caps to one that 

begins with a capital letter—CAPS becomes Caps. You’ll need a word 

that’s in all caps on the screen. 

i Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) and name the macro. 

You can call this macro lowercase. 

. Press Command-< to move to the beginning of the word. 

3. Press > to move to the second character in the word. 

4. Press Command-Shift-N to turn on Select; then press 

Command-~— to select the word. 

. Select Case Convert from the Edit menu; then choose To 

Lower (or type 2). 

6. Turn off Select by pressing Command-Shift-N. 

7. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

Capitalizing a Whole Word 

The next macro will quickly convert the word the insertion point is 

on to ALL CAPS. 

i 

a -®& C&C Nh 

Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) and name the macro. 

A suggested name is upper. 

. Press Command-< to move to the beginning of the word. 

. Press Command-Shift-N to turn on Select. 

. Press Command-~ to select the whole word. 

. Select Case Convert from the Edit menu; then choose To 

Upper (or type 1). 
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6. Press Command-Shift-N to turn off Select. 

7. Press > to move to the next word. 

8. Choose Macro from the Special menu; then choose Define Macro 
(or press Command-Shift-M) to turn off macro definition. 

Transposing Text 

Transposing text—switching it from one place to another—is 
another tedious task that macros can carry out for you. 

Transposing Letters 

One annoying habit my fingers have is typing letters out of 

sequence so that I get hte when I want the. You can record a macro that 
will transpose letters for you when the pointer is on the second letter. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) and name the macro. 

You can name the macro tr. 

. Press Command-Shift-N to turn on Select. 

. Press < to select the letter to the left of the pointer. 
To turn on Select 
quickly, press the . Press Command-X to cut the selected letter. 

Shift key and then press 
any of the arrow keys. You 
can extend the selection 
up, down, right, or left. 

. Press the < key again to move one position to the left. 

. Press Command-V to paste the cut letter. 

. Press the > key to move the pointer to the next character. 

CO. NY \Oy- Gv GO Ob . Choose Macro from the Special menu; then choose Define Macro 
(or press Command-Shift-M) to turn off macro definition. 

Transposing Words 
This is another editing macro that can save time. It switches the 

word the insertion point is on (or to the left of) with the word that’s to 
its left—to move becomes move to, for example. Type a few words so 

that the macro will have something to work with. 
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For typesetter’s 
quotes in WordPer- 

fect, use Option-[ and 
Option-Shift-[. For single 
typesetter’s quotes, use 

Option-] and Option- 
Shift-]. You can assign 
the sequences that create 

these symbols to macros 
that are easier to 
remember. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) and name the macro. 

On the disk that you can order with this book, it’s named word. 

2. With the insertion point in a word, press Command-< (Word 

Left) to move to the beginning of the word. 

. Press Command-Shift-N to turn on Select. 

. Press Command-> (Word Right) to select the word. 

. Choose Cut (or press Command-X) to cut the word. 

. Press Command-< (Word Left) to move to the word to the left. 

N HA Go BP GO . Choose Paste (or press Command-V) to paste the cut word. 

Then press the space bar to insert a space. 

8. Press Command-~> (Word Right) to move to the next word so 

that you can continue typing. 

9. Choose Macro from the Special menu; then choose Define Macro 

(or press Command-Shift-M) to turn off macro definition. 

Inserting Special Characters 

If you use a special character frequently, you can write a macro 

that inserts it into your document. For example, I often write bulleted 

lists. Instead of using the asterisk for bullets, I have a macro that 
inserts the bullet character (e) whenever I want the bullet. If you 
often use paragraph or trademark symbols, vowels with diacritical 

marks, or mathematical symbols in your documents, you can record 

routines that insert these special characters. 

To record a macro for inserting any of these special characters: 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) and name the macro. 

I assigned the bullet to Command-Option-B to make it easy to 
remember and quick to use. 

2. Press Command-I to bring up the symbol window. 

3. Click on the symbol you want to use. 



Using Macros to Automate Your Work 28] 

4. Press the space bar to insert a space between the symbol and 
the next character you type. 

5. Choose Macro from the Special menu; then choose Define Macro 
(or press Command-Shift-M) to turn off macro definition. 

Then, whenever you need to use the symbol, pressing Command- 
Option and the letter you assigned the symbol to will insert it in your 

text and position the insertion point correctly for you to type the next 
character. 

Converting to Superscript and Subscript 

If you do much mathematical typing, this next set of macros can 

save you time. They’re all Command-Option macros, so they’re 

quick to execute as you’re typing. The first, Command-Option-U 
(for Up) converts the next character you type to superscript. The 

next, Command-Option-D (for Down) converts it to subscript. 
The third, Command-Option-R (for Return) returns you to plain 

text so that the next character you type is on the normal text baseline. 

Converting to Superscript 

To create the macro that converts to superscript: 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Assign the macro to Command-Option-U. 

2. Press Command-Y and type 7 (for Superscript). 

3. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

Converting to Subscript 

To create the macro that converts to subscript: 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 

tion. Assign the macro to Command-Option-D. 
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You can also use 

these macros on text 
you’ ve highlighted if 
you’re converting several 
characters at a time to 
superscript or subscript, 
as in the expression 
n® +1) 

2. Press Command-Y and type 8 (for Subscript). 

3. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

Returning to the Regular Baseline 

To create the macro that returns to plain text: 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 

tion. Then assign the macro to Command-Option-R. 

2. Press Command-Y and type 1 (for Plain). 

3. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

Combining the Superscript and Subscript Macros 

Now try typing the expression (n, — DEE 

1. Type the left parenthesis and the n; then press Command- 

Option-D (for Down). 

2. Type the t; then press Command-Option-R (for Return). 

3. Type the space, the minus sign, the space, the 1, and the right 

parenthesis. 

4, Press Command-Option-U (for Up) and type the 2. 

5. Press Command-Option-R to return to regular text. 

Speeds things up a little, doesn’t it? 

Copying a Paragraph 

This macro quickly copies the paragraph you’re working on. 

1. Choose Macro from the Special menu; then choose Define Macro 
(or press Command-Shift-M) to turn on macro definition. 

A suggestion is cp, but you can name yours whatever helps you 
remember what it does. 



s If you use only one 
space between 

sentences, as some people 
do when typing material 
that’s to be typeset, 
WordPerfect automati- 
cally selects the one space 
following the final punc- 
tuation when you select a 
sentence. If you use two 
spaces between sentences, 
it selects both spaces. 
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. Press Command-6 and type 3 to select the paragraph. 

. Press Command-C to copy it. 

. Press Command-Shift-N to turn off Select. 

oa ®e® & bh . Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

After the paragraph has been copied, you can move to the location 
where you want it and select Paste (Command-V). 

You can write similar macros that copy the sentence, page, or 

column you’re working in. In place of the 3 in step 2, type 2 for sen- 
tence, 4 for page, or 5 for column. 

Likewise, you can change this macro so that it cuts instead of 
copies by substituting Command-X for Command-C in step 3. 

Moving to the Beginning or End of a Paragraph 

If you’re working in a long paragraph that isn’t all displayed on the 
screen, it’s handy to be able to move to the beginning or end of the 

paragraph quickly. These next two macros search for a tab code, so 

for them to work properly you should be indenting paragraphs with a 
tab. If you’re separating paragraphs with an extra line of space 
instead of indenting the first line of each paragraph, you can change 

the macros to search for two hard return codes instead. 

You’ll need a couple of paragraphs on your screen to record these 

macros. 

Moving to the Beginning of a Paragraph 

First, here’s the macro that searches for the beginning of a paragraph. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 

tion. Then name the macro begin para. 

2. Press Command-B to search backward. 

3. In the Search dialog box, scroll the list on the right until you 

see the [Tab] code. Click on it; then click Insert to put it in the 

Find: box. 
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4, Press Return (or click Find) to begin the search. 

When WordPerfect finds anything, it turns on Select automatically. 

5. Press Command-. to turn off Select. 

6. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

Moving to the End of a Paragraph 

Use macros like Now for the macro that searches for the end of a paragraph. The 

these to search for macro assumes that you’ve pressed Return to end the paragraph, so 
format codes in your 5 

y it searches for the next hard return. 
documents. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 

tion. Then name the macro end para. 

2, Press Command-F to search forward. 

3. In the Search dialog box, scroll the list on the right until you 

see the [HRt] code. Click on it; then click Insert to put it in the 

Find: box. 

4. Press Return (or click Find) to begin the search. 

5. Press Command-Shift-N to turn off Select. 

6. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

Selecting Parallel Columns 

If you do much revising of text in parallel columns, you may want 

to record a macro that will automatically select the correct codes so 
that you can manipulate as a unit all the parallel columns that make 

up a group. 
To record this macro, you’ll need some parallel columns on the 

screen. 

1. Choose Define Macro from the Macro submenu (or press 
Command-Shift-M) and name the macro. 

I suggest cut parallel, but you can name yours whatever helps you 
remember what it does. 



Macros like this one 

can automatically 
select the right format 
codes so that you can cut 
and copy accurately. 
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2. With the insertion point anywhere in the group of columns 
you want to move as a unit, search backward to locate the first 
[Protect] code. 

You'll need to choose the code from the list in the Search box (it’s 
between the As and the Bs) and click Insert to insert it. 

3. When WordPerfect locates the [Protect] code, press the < key. 

This turns off Select and positions the insertion point to the left of 
the [Protect] code. 

4. Turn on Select (press Command-Shift-N). 

5. Then search forward for the last [Column] code in the group. 

You’ll need to choose the code from the list and insert it in the 

Search box. 

6. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

When WordPerfect locates the [Column] code, all the correct codes and 
their text are selected, and you can copy or cut the columns as a unit. 

Text-Formatting Macros 

As you work, you’ll probably want to set up standard formats for 
the different kinds of documents you create. ‘The macros in this sec- 

tion show you how you can format documents automatically. 

Setting Up Style Sheet Macros 
You can use text-formatting macros in place of style sheets that for- 

mat each element in a document. For example, you can record a 

macro that formats Level 1 headings in New York 12-point bold with 

a blank line above and below, and name it Command-Option-1. 
Another macro, named Command-Option-2, formats Level 2 head- 

ings in New York 10-point bold with a blank line above and a tab 

indent below. A third, named Command-Option-3, sets up Level 3 

headings as run-in headings in 10-point New York italics. When you 

execute each macro, it prompts you to enter the text of the heading; 

after you type the heading and resume the macro, it automatically 
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adds the correct spacing between the heading and the text of the doc- 

ument. Another macro formats text for a displayed quotation in 

smaller type, centered between the right and left margins. 

Here are the macros. An example of a document created with them is 

in Figure 8.1. The body of the document is in 10-point New York. 

For the first-level heading macro: 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 

tion. Then name the macro Command-Option-1. 

2. Press Return twice to insert a blank line. 

3. Press Command-5 (or choose Characters from the Format 

menu). Then click on New York, 12, and Bold. 

4, Click OK. 

5, Choose Macro Input from the Macro submenu and enter the 

prompt as Enter first-level heading ; then click OK. 

6. Press Return twice to insert another blank line. 

First-Level Heading 

Text then returns to 10-point New York and continues in this style until you're 
ready for a second-level heading. Just press Command-Option-2; WordPerfect will 
insert the correct space for you. 

Second-Level Heading 
After you've written the text for the second-level heading, you're returned 

again to normal text type. 

Third-level headings are run-in italic The program then switches back to normal 
text type for you. If you want to insert a displayed quotation, press Command- 

Option-Q: 

You can then type a quotation that's as long as you like. When you resume the 

macro, you'll be returned to regular text. 

Text you type from then on will be in the 10-point size again. 

Figure 8.1: Macros can be used in place of style sheets to automatically format 
text elements like these headings and the quotation. 



If you don’t use 
M8 WordPerfect’s style 

_ feature, consider using 
macros like these. They 
can prompt you for each 
design element in your 

~ publication. 
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Now you'll need to return to regular text. 

7. Press Command-5 and click on 10-point and Bold (to turn it 

8. 

off). Then click OK. 

Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

For the second-level heading macro: 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro Command-Option-2. 

2. Press Return twice to insert a blank line. 

3. Click on the B in the status line. 

. Choose Macro Input fromn the Macro submenu and enter the 
prompt as Enter second-level heading; then click OK. 

6. Press Return and Tab. 

7. Click on the P in the status line to return to plain text. 

8. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

For the third-level heading macro: 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro Command-Option-3. 

2. Press Return twice to insert a blank line. 

3. Click on the I in the status line. 

4. Choose Macro Input from the Macro submenu and enter the 
prompt as Enter third-level heading; then click OK. 

. Press the space bar twice to insert two spaces. 

6. Click on the P in the status line. 

7. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 



288 Mastering WordPerfect on the Macintosh 

CH. 8 

Give formatting 
macros like these 

meaningful names as you 
record them. When 
you’ re ready to create a 

document with format- 
ting macros from your 
macro style library, 
rename them as 
Command-Option 
macros so that you can 
execute them quickly as 
you write. 

For the quotation macro: 

1s 

a & &S NW 

Choose Macro from the Special menu; then choose Define Macro 

(or press Command-Shift-M) to turn on macro definition. Then 

name the macro Command-Option-Q (for quotation). 

_ Press Return twice to insert a blank line above the quotation. 

. Press Command-Shift-L for a left right indent. 

. Choose 9 point from the Font menu. 

. Pause the macro (Command-M 6); then resume it again. 

When you execute the macro, you can type a quotation that’s as 

long as you like. If you had used a dialog box for input here, 

you’d be limited to 59 characters. 

. Press Return twice to add a blank line between the quotation 

and the text that follows. 

7. Choose 10-point from the Font menu to return to regular text. 

8. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

When you execute these macros, you’ll be prompted for each 

heading. The quotation macro will simply pause. 

As you can see, you can build a library of style macros, too. The 

macros you just recorded are only a beginning. If you keep a catalog 
of what each macro does, you can quickly format complex docu- 

ments by executing these macros. 

Clearing and Resetting Tabs 

This macro sets up a format for decimal tabs every two inches, 
beginning one inch from the left edge of the paper. This allows for 
three fairly wide columns on the page. 

1. 

a 

Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro decimal tabs. 

Press Command-é4 and type 3 (or choose Line from the Format 
menu; then choose Tabs). 



bar You may want to 
create other macros 

that format special docu- 
ments for you. For 
example, you can record 
a macro for a draft report 
format with double spac- 
ing and wide margins, 
another macro for a final 
report format with single 
spacing and 10-point 
type, or a macro that sets 
up two parallel columns 
for a script. 
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3. In the Starting Position box, type 1.0. In the Repeating Every 
box, type 2. 

4. Click Decimal tabs and press Return. 

5. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

Setting Up a Memo Format 

Almost every office has a standard memo format. If this one’s not 
the one your office uses, you can modify it. A memo produced with 
this macro is illustrated in Figure 8.2. As you can see, margins are set 
narrower than usual, and a dashed line separates the headings and 

text. The macro enters the headings, the date, and the distribution 
list automatically. 

When you execute this macro, it pauses for you to enter the recipi- 

ent’s name. In the FROM line, you can either enter your own name 

as part of the macro or insert another pause, as has been done here. 
The DATE line contains the date function so that your memos will 

always be dated correctly. 

Sheila Bonamarte 
Ken Ricardo 
March 10, 1988 

There have been reports that the shipping dock is 
understaffed during the noon hour. Can you spare an 

extra person for duty next week? 

(aun R. Hawkins 
S. Ventura 
N. Neilson 

Figure 8.2: Macros can automate setting up formats like this one and inserting 

standard text. 
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One other interesting thing to note abou
t this macro is its use of the 

Esc key to draw the dotted line. 

Open a new window to record this macro. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 

tion. Then name the macro memo. 

9. Press Command-R to display the ruler line. Drag the left- 

margin symbol to the 1.5-inch mark and the right-margin 

symbol to the 6.5-inch mark. 

_ Press Command-R again to hide the ruler line. 

_ Press Return three times to insert three blank lines. 

. Type TO: and press Tab twice. 

aa fF OO . Insert a pause in the macro by pressing Command-M and 

choosing option 6, Pause Macro. 

7. Resume the macro by repeating step 6, choosing Resume 

Macro. 

8. Press Return and type FROM: 

9. Press Tab twice and pause the macro again; then resume it. 

10. Press Return and type DATE:. 

11. Press Tab twice; then press Command-D to insert the date. 

Choose option 2, Date Function. 

12. Press Return twice to insert a blank line. 

13. Press Esc and type 50; then press the hyphen key to insert a 

dashed line of 50 hyphens. 

14. Press Return twice to insert a blank line. 

15. Insert a pause in the macro by pressing Command-M and 

choosing option 6, Pause Macro. 

When you execute the macro, it will pause for you to enter the 

text. 

16. Resume the macro and press Return twice to insert a blank 

line. 

17. Type the distribution list as shown in Figure 8.2. 



You can add one 
=H more step to this 

macro so that it will print 
as many copies as there 
are names in your stan- 
dard distribution list plus 
two (one for you and one 
for the recipient). 
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18. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

When you execute this macro, after you type the recipient’s name, 
choose Resume Macro to continue the macro. Each time the macro 
pauses, type the information that’s appropriate at that point; then 
choose Resume Macro again. 

Automatic Letterspacing 

Because letterspacing and kerning can get tedious, here’s a letter- 
spacing macro that adds one point of space between the characters 

where the insertion point is. Repeat the macro with the Esc key to 
add additional spaces—for example, press Esc, enter 4, and execute 
the macro to add 4 points of letterspacing. 

To record the macro, you’ll need at least two characters on the 
screen, and the insertion point should be between them. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro letterspacing or Command-Option- 
L so that it will be quick to execute. 

2. Choose Line from the Format menu; then choose Kerning (or 

press Command-4 6). 

3. Click Letter Spacing and type 1; then press Return. 

4. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

You can revise this macro so that it will decrease spacing between 
characters if you choose Kerning instead of Letter Spacing in step 3. 

Creating a Banner 

The following macro prompts you for text that’s to be centered, 

flush left, and flush right on the page. 

1. Press Command-Shift-M and name the macro—banner is a 

suggestion. 

2. Choose Center (or press Command-Shift-C) to center the text 
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car This macro illus- 

trates the use of a 

pause without a prompt. 

that’s coming next. Then pause the macro for input 

(Command-M 5). 

3. Type Enter text to be centered in the text box that appears; then 

press Return. 

4. Press Enter-< to move the insertion point to the left margin. 

5. Pause the macro for input again (Command-M 5). This time, 

type the text in the prompt box as Enter text to be flush left and 

press Return. 

6. Then move to the end of the line, past the second [Center] code 

(press End, which is 1 on the keypad). Choose Flush Right (or 

press Command-Shift-F). 

7. Pause the macro for input again. Type Enter text to be flush 

right and press Return. 

8. Press Command-Shift-M to end macro definition. 

Now, when you want to create a banner with three elements across 

a page—either in a page of text or in a header or footer—you can use 

this macro without having to remember where the codes are. It will 

prompt you to enter the three elements; after you’ve entered them, 

the macro will create the banner for you. 

Automatic Page Numbering Footer 

The next macro lets you number pages in the style Page J of 100, 

where 100 is the total number of pages in your document. It moves to 

the end of the document, pauses to let you note the page number, 

moves to the beginning of your document, creates a footer in 10- 

point type, and pauses to let you enter the number of pages in your 

document. You’ll need a short document on the screen to record 

this macro. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro page number. 

2. Press Enter twice; then press the / key to move to the end of the 
document. 
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3. Pause the macro so that you can note the page number of the 
last page. Press Command-M 6. 

4. Resume the macro by pressing Command-M 6 again. 

5. Press Enter twice; then press the t key to move to the begin- 
ning of the document. 

6. Press Command-Shift-H to insert a footer. 

7. Click Footer A and press Return. 

8. Choose 10-point type from the Font menu so that your footer 
will be smaller than the text type. 

If your text is in 10-point type, choose 9 point. 

9. Type Page, press the space bar, and click on the # at the bot- 

tom of the screen to insert an automatic page number. 

10. Press the space bar, type of, press the space bar again and 
insert a pause in the macro (Command-M 6). 

The macro will pause at this point for you to type the number you 

noted earlier. 

11. Resume the macro by pressing Command-M 6. 

12. Close the footer window. 

13. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

When you execute this macro, it will move to the end of the docu- 
ment. Note the number of the last page; then resume the macro. 

When it pauses again, type that number; then resume the macro 

again. 

Demonstration Macro 

If you’re a product manager who prepares on-screen demonstra- 

tions and presentations for conventions, you’ll appreciate this next 

macro. It’s appropriate in any situation where you want to set up a 

rolling demonstration on an untended Macintosh. It simply presents 

the first page of each document in a sequence, cycling endlessly among 

the windows until someone presses Command-. to stop the macro. 
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For example, if you’re in a real estate office, you could prepare a 

set of documents describing your current listings and set them up to 

be displayed at the front desk for potential clients to view while wait- 

ing. Figure 8.3 shows a typical document that you could prepare for 

each listing, showing number of rooms, asking price, and other infor- 

mation that buyers are usually interested in. (If you have access to a 

scanner and a special graphics program, you can prepare graphics of 

each property from a photograph. See the tip in Chapter 6.) When 

you’ve prepared each document that you want to display and saved 

it, you’re ready to record the macro. 

Creating the Documents to Be Viewed 

To create a simple two-document demonstration, first create the two 

documents to be viewed. Just for practice, your documents can contain 

only a few words—like screen one and screen two, for example. When 

you’re ready to create your own demo, you can use a graphics program 

and transfer graphics to WordPerfect, as was done in Figure 8.3. 

Save the documents as screen one and screen two. 

& File Edit Search Format Font Special Windows 

NEW LISTING 

Four bedrooms, 3 1/2 baths, 
g family room, study, AEK. Solar- 

Fx heated pool. Ladera school 
district, St. Vincent parish. 
Asking $350,000. See Kathryn 
Kobayashi. 

Figure 8.3: You can create a series of documents like this one to be displayed 
one at a tirne automatically. 
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= The size of your 
demo (number and 

complexity of documents) 
is limited only by the 
amount of RAM you have 
available. If you’ve got 2 
megabytes of RAM, you 
should be able to prepare 
some pretty umpressive 

demonstrations. 

cr This macro uses a 
delay factor to 

display each graphics 
screen. 

If you’re displaying 
MM a large number of 

documents, you may 
want to click the size box 
to make each document 
full-screen size. You can 
add that step to your 

macro. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro demo. 

2. Press Command-O and enter the name of the first document 

you want to view—in this case, screen one. 

3. Press Command-O and enter the name of the second docu- 
ment to be viewed—in this case, screen two. 

When you record a real demonstration macro, continue pressing 

Command-O and opening all the documents that will be in your 
demo. 

4. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to end macro definition. 

Cycling among the Windows 

Now all your documents are in RAM, so you can write the macro 
that cycles among the windows once you’ve opened the documents. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro display. 

2. Enter a delay factor in the macros so that each document will 
be displayed for a few seconds. In this case, enter 300 for a 
5-second delay. 

The time you choose depends on how much information is on 
your screens. Five seconds is enough for simple graphics; allow 
longer delays for windows with information that’s to be read. 

3. Press Command-W as many times as you have documents to 

be displayed. 

4, Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

To start the demo, execute the first macro, demo. When it stops, 

press Esc and enter a large number, such as 1000, to repeat the next 

macro, which cycles between windows and displays the document. 

The number you choose depends on how many documents you’re 

displaying and how long you want the demo to run. You can stop it at 
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| yy You can set up a 
B WordPerfect disk 

that has the demo 
macros, and then take it 

along to the convention 
with you or send it to 
your field representatives. 
The disk should have all 
the documents that will 
be displayed plus the two 
macros, and you should 
have set up WordPerfect’s 
default folders so that the 
program can locate the 
macros on that disk. You 
can also include a docu- 
ment containing instruc- 

tions on how to run the 
macros. Record the 
instructions as a macro 

named startup macro, so 

that when the user starts 
WordPerfect, the instruc- 

tions automatically 
appear. 
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any time by pressing Comman¢-. In fact, you may want to display 

that instruction at the bottom of each document so that the user will 

know how to stop the demo. 

Then execute the display macro that will display the documents in 

your on-line demonstration. 

Creating a Macro . 

Application: Automatic Front Matter 

The next set of macros automate the process of setting up a cover 

page and table of contents for a report or book. These macros show 

practical uses of almost all the techniques you’ve learned in this chap- 

ter, including inserting a delay value, pausing a macro, conditional 

macro chaining, and nesting macros. As you follow along, you'll see 

how macros like these can be used in a library of macro routines. 

Before you begin to record these macros, you may want to review 

the material on creating tables of contents in Chapter 12 if you 

haven’t done so already. 

You’ll need to record several macros before you chain them all 

together into a master macro: 

e A macro named cover sheet starts and immediately suppresses 

page numbering, centers the text horizontally and vertically, 

and prompts you for the name of the report. It then inserts a 

blank page 2. 

e A macro named define toc creates a page for the table of con- 

tents, types the contents title and centers it, and defines the 

style for the table of contents. 

e A macro named mark toc searches through the document for 

each special symbol @ that indicates a heading for the table 
of contents, deletes the @ symbol, and pauses so that you can 
indicate the level of each heading. It chains until no more 

occurrences of the @ symbol are found. 

e A master macro named front matter moves to the beginning of 
the document, calls the cover sheet macro, calls the define toc 

macro, starts the mark toc macro, and then generates the 

table of contents. 



bar You could set up 
your front matter 

pages for roman page 
numbering. Chapter 4 
has more information on 

page numbering. 
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As you write any document that’s going to be used with these 
macros, you'll need to insert the @ symbol at the beginning of each 
heading that’s going in the table of contents. That should be the only 
place the @ symbol is used in the text. 

To record the macros, you’ll need a document with headings that 
begin with @, like the one in Figure 8.4. Set up your sample docu- 
ment and save it so that you’ll have a saved version that hasn’t been 
marked for lists. You can use it to test the master macro at the end. 

Recording the First Macro 

To record the first macro, cover sheet: 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to define the macro. 
Name it cover sheet. 

2. Choose Page from the Format menu; then choose Page Layout. 

3. Choose Center Page Top to Bottom and click OK. 

4. Choose Page from the Format menu; then choose Page Num- 
bers. Click Arabic, Bottom Centered, and OK. 

r 
& File Edit Search Format Font Special Windows 

2 SSeS Doc 1: appletalk 

@Using AppleTalk 
If you've done any laser printing with WordPerfect, you 

already know that every Mac has a capability called AppleTalk 
built into its System file. In addition to allowing you to print 
with a LaserWriter, AppleTalk lets your Mac become a station ona 

network of other Macintoshes. All you need is a connector cable, 

which costs about $75. AppleTalk lets up to 32 machines (theoreti- 

cally) share facilities such as laser printers and hard disks at 
distances of up to 1000 feet, so several different computers in 

different areas of one floor--or even on different floors of an 

office building--can be connected. : 

Area Networks 
bpd most common AppleTalk network, or LAN (for Local Area Net- 

osed to vast electronic networks that you access by 

Ker Seleot olapiens lines) is one in which several people share 

the same laser printer. If you've used a LaserWriter to print your 

WordPerfect documents as described in Chapter 6, you're already 

femiliar with how to use the Chooser to turn on AppleTalk and then 

simply select the LaserWriter you want to use. LaserWriters have 

built-in file server software, so the process is simple. 

Figure 8.4: Set up a document with headings like these to record the front mat- 

ter macros. 
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5. 

Macintosh 

Choose Page from the Format menu; then choose Suppress 

Format. Click All and OK. 

This suppresses headers, footers, and page numbers from 

appearing on that page. 

_ Press Command-Shift-C to center. the title of the report. 

You can choose a different size or style for the cover sheet’s title. 

. Choose Macro Input from the Macro submenu. Then type 

Enter Title: and press Return. 

If you’re going to have a subtitle, you could add additional steps 

here to change to a smaller font, center it, and prompt the user 

for it. 

_ Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to end macro definition. 

If you test this macro, your title won't look centered top to bottom, 

but it will be when it’s printed. You can choose Print Preview to see it. 

Recording the Second Macro 

‘: 

Now you can record the second macro, define toc. 

Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M) to turn on macro defini- 

tion. Then name the macro define toc. 

2. Press Command-Return to insert a new page. 

3. Choose Page from the Format menu; then choose Suppress 

ND oO 

Format. Click All and OK. 

This suppresses headers, footers, and page numbers from 

appearing on that page. 

. Press Return twice to insert two blank lines 

. Press Command-Shift-C to center the text. 

. Type Contents and press Return twice. 

. Choose Define List; then choose Table of Contents (option 6). 
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8. To set the style for each of three levels of headings, click 1 and 
Flush Right with Leaders; click 2 and Flush Right with Lead- 
ers; click 3, click on the style, and click # Follows entries. 

You can choose whichever styles suit your report or paper. These 
styles produce flush right page numbers with dot leaders for Lev- 
els 1 and 2, and no dot leaders for Level 3 headings. Chapter 12 
has examples of the styles that are available. 

9. Click OK when you’ve defined all the level styles. 

10. Press Command-Return to insert a page break. 

11. Choose Macro; then choose Define Macro (or press Command- 
Shift-M) to end macro definition. 

Recording the Third Macro 

Now you can record the macro that marks the headings to be 

included in the table of contents. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to turn on macro defini- 
tion. Then name the macro mark toc. 

2. Choose Forward from the Search menu (Command-F); then 
enter an @ symbol in the Find box and press Return. 

WordPerfect locates the first @ in your document, which should 

be at the beginning of the first heading, if you’ve typed the head- 

ing correctly. 

3. Press Delete to delete the @. 

4, Choose Macro; then choose Macro Delay (or press Command- 
M and type 4) to insert a delay in the macro so that you can see 
what is happening on the screen as the macro executes. 

If you don’t insert a delay, you won’t be able to see each heading 
as it appears. In fact, you’ll think something has gone wrong with 
your macro, when all that’s happening is that it’s executing too 

fast for you to see it. 
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5. Enter 1 as the delay factor and press Return. 

6. Select the sentence the insertion point is on (Command-6 2). 

10. 

11. 

12. 

13. 

Since each heading is on a separate line, selecting it as a sentence 

makes sure that it’s selected to the next hard return. You could 

select it as a paragraph, but you’d get extra hard returns in your 

table of contents. 

. Choose Mark Text (Command-J) and then choose option 2, 
Table of Contents. 

A dialog box appears so that you can indicate which level the 
heading is to be in the table. 

. Choose Macro; then choose option 6, Pause, to pause the 
macro while you select from the dialog box. 

. Click on Cancel in the dialog box so that you don’t select any- 
thing right now. 

When the macro executes, it will pause for you to click on the 
appropriate button for the heading that will be selected. 

Press Command-. to turn off Select. 

Now you need to chain the macro to itself so that it will repeat 
until it can’t find any more @s in your text. 

Choose Macro; then choose option 3, Chain macro. 

Click on the macro’s name in the list that appears—in this 
case, mark toc. 

Choose Macro; then choose Define Macro (or press Command- 
Shift-M) to end macro definition. 

Recording the Master Macro 

You can now record the master macro, front matter. The front matter 

macro won’t do much itself except move the insertion point and call 
other macros. Because you’ve recorded each procedure separately, you 
can use the individual macros in other macros—like building blocks. It 
may have been tedious to get to here, but believe me, it’s worth it if you 
have to prepare tables of contents and lists often. 



Don’t put instruc- 

tions for moving to 
the beginning of a docu- 
ment into a macro that’s 
going to repeat until no 
more instances of a search 
pattern are found. The 
macro will return to the 
beginning of the docu- 
ment each time it exe- 
cutes and will continue to 
locate only the first 
instance of the search 
pattern. Either move to 
the appropriate location 
before you execute this 
type of macro, or put the 
moving instruction in a 
master macro in which 
the search-and-repeat 
macro is nested. Another 
trick is to either delete 
something from the pat- 
tern that the macro finds 
or add something to it, so 
that the macro doesn’t 
hang at the first instance 
of the search pattern. 

Don’t generate a 
table of contents 

until you’re through 
editing your document. If 
you add or delete text, 
page numbers may 
change. 
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Before you begin, get your sample document back with its @ sym- 
bols for headings and boldface for figures so that the macro will have 
something to work on. Just close the document you’ve been practic- 
ing on without saving it, and open the version you saved earlier. 

To record the front matter macro: 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to define the macro. 
Name it front matter. 

2. Go to the beginning of the document by pressing Enter three 
times and then pressing the t key. 

3. To execute the cover sheet macro, choose Macro; then choose 

Execute Macro (or press Command-Shift-X). 

4. Double-click on cover sheet. 

You’ll then be prompted to enter a title for the document. 

5. Execute the define toc macro. 

6. Execute the mark toc macro. 

You’ll be prompted for the level for each heading in your docu- 
ment as this macro executes. 

7. Choose Macro; then choose Define macro (or press Command- 
Shift-M) to end macro definition. 

When you’re ready to generate the table of contents, just press 
Command-Shift-G (or choose Generate from the Mark ‘Text sub- 
menu). The insertion point can be anywhere in the document. 

You could nest other macros inside this master macro. For 

example, you could add a macro at the end that saves and prints the 
document, or you could add a list-marking macro to create lists of all 
the figure captions and table titles, and then include them in the front 
matter. If you’re interested in expanding the macro to include these 

functions, a similar print macro is in this chapter, and the figs macro 

in Chapter 12 can be used as a list-marking macro. 
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Looking Forward 
If you’ve recorded any of the macros in this chapter, you’re on 

your way to building a library of useful macros. Perhaps the macros 
in this chapter will help you think of other applications for macros in 
your work. 

Chapter 9 shows you how you can combine macros in merge 
printing, and you’ll find other macros in Chapters 10 through 12. 



Q — Merge Printing 
for Personalized 
Documents 

Uj LEE 
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Fast Track 

To merge information 
from a data file (called a secondary file) into a form document 
(called a primary file), you first need to create both the data file 

and the form document. 

To merge from the keyboard, 

you only need a primary file. 

To pause a merge 
for entry from the keyboard, use the Console merge code (~ C). 

To insert the date 
in a primary file, use the Date merge code ( * D). 

To begin a merge, 

choose Merge from the Special menu. 

To indicate the end of a field, 

choose End of Field from the Merge Codes submenu ( * R) or 
press Command-Shift-R. 

To retrieve data from a field 

and insert it in the primary file, use the Retrieve Fields code 
(* F) by choosing it from the Merge Codes submenu or by 
pressing Command-8 F. 

To tell WordPerfect to go to the next record, 

insert a Next Record merge code ( ~ N). 
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To indicate the end of a record, 

choose End of Record from the Merge Codes submenu or press 
Command-Shift-E. 

To stop a merge, 

press Command-.. 

To change to a different secondary file, 

insert a pair of New Secondary merge codes ( ~ S) to enclose the 

new secondary file’s name. 

To send each document to the printer 

as it is completed, insert a To Printer merge code ( ~ T). 

To tell the program to continue to use the same primary file, 

use a pair of New Primary merge codes (~* P). 

To indicate the last record that’s to be used, 

insert a Quit merge code ( * Q) in the secondary file. 

To use a macro in merge printing, 
insert its name inside a pair of Go to Macro merge codes ( * G). 

To transfer merge codes 
into the document being created, use a pair of ~ V merge codes. 

305 

312 

317 

318 

320 

321 

321 

322 

329 



CHAPTER J 

WITH WORDPERFECT, NOT ONLY CAN YOU CREATE 
standard form letters and merge information from data files into 
them, but you can also do many other things that you may not auto- 

matically think of as merge printing. For example, you can do the 
following: 

¢ Have WordPerfect pause for you to fill out a form or blanks 
in a document 

e Create reports and lists from information in your files 

e Assemble new documents from existing ones, such as exami- 
nations from a test bank, a report from sections, or a book 
from chapters 

When you merge in WordPerfect, the program takes information 
from a data file (called a secondary file) and inserts it at the appropri- 
ate places in a form document (called a primary file) that contains all 
the text that does not change. For example, in a form letter like the 
ones you probably get regularly, the salutation (Dear :), the 
paragraphs announcing the prizes you may have won, and the clos- 
ing (Sincerely, Million-dollar Sweepstakes, Inc.) comprise the pri- 
mary document. This text is the same in each letter. The variable 
information—the words that change in each letter, like your name 
and address—are taken from a separate file called a secondary file 
that consists of many records containing names and addresses. 

In the secondary file, each item of information in each record— 
like the street address, state, and zip code—is put into a field. In the 
primary document, you use a special code to enter the number of the 
field that contains tHe correct information for that place in the letter. 
When WordPerfect carries out the merge, it takes the information 

in the fields in each record and creates one filled-out form document 
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for each record that there is in the secondary file. If you were filling 
out a form letter by using a secondary file containing 50 records, 
you'd get 50 filled-out letters, for example. 

You’ll get practice doing several different types of merges in this 
chapter. We’ll start with the simplest kind of merge—merging from 
the keyboard—and gradually get more complex. Some of the more 
sophisticated applications in this chapter will combine macros 
and merges. 

Merging from the Keyboard 

The simplest of all merges uses only one document and pauses to 
let you enter information from the keyboard. You can use this tech- 

nique to automate filling out a form that you use often, like a memo 
or status report. 

Preparing the Form Document 

To merge from the keyboard, you create the skeleton of the form, 

inserting ~ C (Console) merge codes at each point where you want to 
be able to type information from the keyboard later. This * C code is 
one of WordPerfect’s many merge codes that instruct the program to 
carry out various kinds of merge operations. In the practice exercise 

that follows, you’ll also use the ~ D (Insert Date) merge code and 
create a status report form that you can use with several different 

projects. 

1. Center the title by pressing Command-Shift-C or choosing 
Center from the Line submenu. Type Status Report— Week of 
and press the space bar. 

2. Choose Merge Codes from the Special menu and choose Date 

(or press Command-8 D). 

You’ll see a ~ D, but the date won’t appear. It will be taken from 

your Macintosh’s internal clock and will appear when you merge 

the document. 

3. Press Return twice to add a blank line. 

sean 
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When you insert 
merge codes, be 

sure to use the special 
Merge Codes menu or its 
keyboard shortcuts. 
Typing a caret (*) anda 

letter won’t insert a code; 

it inserts text. 

13. 

14. 

15. 

. Because you want the headings to align on the colon, choose 

Line from the Format menu; then choose Tabs. 

. In the Alignment Character box, delete whatever is there and 
type a colon (:); then click OK. 

From now on, whenever you press Tab Align (Command-Tab), 
the text you enter will align when you type a colon. 

. Press Tab to indent one tab, press Tab Align (Command-Tab), 
and type Project: and a space. 

. Choose Merge Codes; then choose From Keyboard (or press 
Command-8 C) to insert the first ~ C code where the program 
will pause to let you enter the project name. Then press 
Return. 

. Press Tab; then press Tab Align. Type Manager: and a space so 
you can insert the appropriate manager’s name later. 

. Insert another * C code and press Return. 

. Press Tab, press Tab Align, and type Status: and a space. 

. Insert another ~ C code. 

. Press Return five times to allow plenty of space for comments 
about the project’s status. 

Then press Tab, press Tab Align, and type From: and a space 
so that whoever fills out the form can provide the name of the 
preparer. 

Insert another ~ C code. 

Save the document as Status Report. 

Your screen should look like the one in Figure 9.1. You’ve created 
an automated form that will pause for you to insert information from 
the keyboard, 

Adding Text to the Form 

You’re now ready to merge the document with the text you'll add 
from the keyboard. 

1. Open a new document. 
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Doc 2: Status Report (9.1) 
Status Report--Week of *D 

Project: 
Manager: 
Status: 

Figure 9.1: You can insert special merge codes so that WordPerfect will stop to 
let you enter information from the keyboard into forms and 
documents. 

WordPerfect creates the merged document on your screen, so 

you should always open a new document when you begin a 
merge, or the merged document will become part of the docu- 
ment you’re working on. 

2. Choose Merge from the Special menu. 

You’ll see a dialog box asking you to select a primary file. The 
primary file is the form letter or report you’ve created; in this 
case, Status Report. 

3. Choose Status Report and click Merge, or double-click on Sta- 
tus Report. 

You’ll then be asked for a secondary file. If you were merging 
data from a file containing names and addresses or other infor- 
mation, you’d choose that file as the secondary file to use at this 
point. In this example, however, you’re merging from the 

keyboard. 

4. Click No file instead of choosing a secondary file. 

WordPerfect will stop at the first ~C in your form so you can 

enter the project name. 

eee — 

| 



310 Mastering WordPerfect on the Macintosh 

CH. 9 

5. Type a name for the project, such as Sales Brochure; then press 
Command-Shift-R to indicate that you’ve finished entering 
that field. 

If you look at the list of merge codes, you’ll see that item R is End 
of Field. Command-Shift-R is its keyboard shortcut. This tells 

WordPerfect that you’ ve entered all the information you want to 

have appear at that particular location. The program moves to 

the next * C in your document. 

6. Type Jeff Takagawa as the manager’s name; then press 
Command-Shift-R. 

7. For the Status information, type Out for bids on four-color work; 
then press Command-Shift-R. 

8. Type your initials and press Command-Shift-R again. 

Your screen should look like the one in Figure 9.2. The date on 
yours will be today’s date, which is automatically added by the date 
merge code. You can save the document and print it, if you like. Be 

sure to use the Save As command instead of Save, so that the original 

skeleton of the form will be preserved under the name Status Report 

‘ @ File Edit Search Format Font Special Windows 

SSS === Doc 1: untitled 

Status Report--Week of February 29, 1988 

Project: Sales Brochure 
Manager: Jeff Takagawa 
Status: Out for bids on four-color work Ri 

(veers tr ser Na 

i ie ead on dled ee 

Figure 9.2: After you’ve filled out the form, it should resemble this one. 
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and you can use it for other projects on other days. It’s easy to forget 
this and destroy a primary file that you’ve worked hard to set up. 
There’ll be a macro later in this chapter that will remember to choose 
Save As for you. For now, we’ll continue to the next type of merge: 
merging from a secondary file containing data. 

Merging from a Secondary File 

Most of the time you do a mail-merge operation in WordPerfect, 
you need another file: a secondary file that contains the records that 
youre going to insert into the primary file, or form document. When 
the program performs the merge, it takes a record from the second- 
ary file and inserts it into the appropriate places in the primary file. It 

repeats this process for each record in the secondary file until all the 
records have been used, creating a new merge file that consists of one 
filled-out document for each record. 

Each record in the secondary file is made up of numbered fields. 
The ~ F (Retrieve Field) code indicates that WordPerfect is supposed 
to retrieve data in a certain field and insert it in the primary file. For 
example, if the code were ~ F3, WordPerfect would insert the con- 
tents of the third field. 

Figure 9.3 illustrates a typical primary file with its Retrieve Field 
( * F) codes, and Figure 9.4 shows how the secondary file has been set 
up. For practice in working with a form letter, you can enter the pri- 
mary and secondary files illustrated here. 

Constructing the Secondary File 

In actual practice, you’ll probably have records before you have 
form letters, and you’ll construct your letters around whatever data 
you have available, not the other way around. So you’ll do it that way 

here, too. 

1. First, open a new document. Then choose Merge Codes and 
choose Next Record (or press Command-8 N). 

This tells WordPerfect to skip over the dummy record you’re 
going to create and begin merging with the next record. 

ome 
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her Create a dummy 
record at the begin- 

ning of each secondary 

file listing the field num- 
bers and their contents. It 
will be much easier to set 

up your primary file with 
the correct field numbers 
because you can see what 
information is in which 
field. (And, if you add 
new records to your 
secondary file later, it will 
help remind you of what 
each field contains.) An 
*N code tells WordPerfect 
to skip the dummy record 
and go to the next record, 
which is the first one with 
real data. 

_ A field can be more 

than one line, and 

you don’t have to have 
the same number of lines 

in each field. 
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" € File Edit Search Format Font Special Windows 

Doc 1: letter pf 

Dear “F8° “F7°: 

For this week only, “F1* can take advantage of our wholesale inventory cleara 

You'll need to show the enclosed pass identifying yourself as a representative 

‘Fi° at the door. If you need additional passes with names other than F6° F7* 

us at (800) 555-2233 before you come. 

Figure 9.3: This form letter, or primary file, will be filled out with data from 
the secondary file when it’s merged. 

2. Press Return to move to the next line. Type J and a dash; then 

type Company Name. Press Command-Shift-R to end the 
field. 

All the company names will go into field 1 in each record. 

3. Continue to fill out the other seven fields as illustrated in Fig- 
ure 9.4. 

You don’t have to press Return after each one. When you press 

Command-Shift-R, the insertion point moves to the next line. 

4. When you reach the end of the dummy record, press 
Command-Shift-E to insert an End of Record ( “* E) code. 

nr Then enter the actual data for the first record as shown in Fig- 
ure 9.4, Press Command-Shift-R at the end of each field and 

Command-Shift-E at the end of the record. 

Note that an “~ R has been inserted as the second line in the first 
record, even though there’s no suite or department given. This is 
because WordPerfect needs to have the same number of fields in 
each record, or it won’t be able to insert the data accurately. If 
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what’s in field 2 in one record is in field 3 in another record, 
you'd get very odd results in the printed form letters. 

6. Then enter the data for the second record, as shown in Figure 
9.4. 

7. Save your file as customer secondary, or under any other name 
you like. The word secondary simply helps you remember it’s a 
secondary file. 

A secondary file can " - . 
M contain an almost Setting Up the Primary File 

unlimited number of : 

records—as many as you Now you can set up the primary file—the form letter itself, which 
have disk space for. is shown in Figure 9.3. 

1. Open a new document and insert the Merge Date code ( * D) 
by pressing Command-8 D. 

2. Press Return twice to insert a blank line. Then select Merge 

Codes and Retrieve Field (or press Command-8 F). 

@ File Edit Search Format Font Special Windows 

Doc 1: customer sf 

-N 
1-Company Name*R 
2-Suite or Department*R 
3-Street Address*R 
4-City and State*R 
5-Zipcode*R 
6-First Name*R 
7-Last Name*R 
8-Title*R 

Hastings House*R 
oR 

Natural Fibers, Inc. “*R 
Dept. 400°R 
8800 Paul Blvd. “R 
Menlo Park. CA*R 
94025°R 
Raoul*R 
Martinez*R 
liracR 

Figure 9.4: The secondary file contains the actual data for numbered fields. 

(Screen captured on a Mac IT monitor.) 

oe 
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ber You can use the 

same field more 

than once. Also, you 
don’t have to use each 

field; you can use only 
those that your primary 
file requires. 

You’ll see a dialog box asking which field to use. A field can con- 

tain several different items of information, as long as you’re will- 
ing to use this information as a unit. For example, if a field 
contains a title, first name, and last name, you’ll always get Mr. 
John Doe, and you won’t be able to set up a primary file to say 
Dear John or Dear Mr. Doe. Placing the title, first name, and last 
name into separate fields allows you to vary salutations as the sit- 

uation requires. 

. Enter 1 and press Return. 

WordPerfect inserts ~ F1 * in the document. When you start the 
merge later, the contents of the first field from every record will 
be inserted at this point. Since you’ re filling out an address block, 
you want the company name (field 1), the suite or department 

(field 2), the street address (field 3), the city and state (field 4), 
and the zip code (field 5), in that order. 

. Go ahead and enter the remaining fields in the address block by 
choosing Retrieve Field and entering the correct field number. 
Press Return after entering each one to move to the next line. 

. Press Return twice and insert the salutation. You want it to 

include the recipient’s title and last name, so enter it as Dear 
“F8* “F7~ :. To do so, type Dear and press the space bar. 
Then choose Retrieve Field and enter 8. Press the space bar 
again; then choose Retrieve Field and enter 7. 

You can edit field numbers just as you edit text. Be careful to 
insert the codes with the Merge Codes command, not by press- 

ing the caret ( “ ) and typing a letter. Be sure to insert the appro- 
priate spaces and punctuation around Retrieve Field codes, or 
you won’t get the correct spacing in your printed document. If 
you’re not sure whether a space is there, open the Codes window 
(Command-7) to check. 

. Press Return twice and enter the body of the letter as shown in 
Figure 9.3, using the Retrieve Field command to insert the 
field codes. 

. When your screen looks like Figure 9.3, save the document as 
letter primary; then close it. 

The word primary simply helps you remember that this is a pri- 
mary file. 

—_— 



her Close the primary 
and secondary files 

before you begin a 
merge. Open a new 
document for the merge. 

When you do a 
simple merge such 

as this one, WordPerfect 

assumes that you want a 
new page for each record, 
that you want to use all 
the records in the second- 
ary merge file, and that 
you want to use the same 
primary file throughout 
the merge. 

— You can use format- 
ting codes like 

Center and Flush Right 
around field codes in 
primary files. You can 
also use styles like under- 
lining, boldfacing, and 
italics on merge codes to 
style the text in the 
merged documents. 
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Merging the Primary and Secondary Files 
Now you’re ready to merge the two files. Just as you did before, 

open a new document and choose Merge from the Special menu. 
This time, choose letter primary as the primary file and customer sec- 
ondary as the secondary file. 

You'll see the two filled-out form letters on your screen, as shown in 
Figure 9.5. If you print them, they’ll resemble the letters in Figure 9.6. 

Suppressing Blank Lines 

Note that there’s a blank line left in the first letter where there’s no 
department or suite. WordPerfect inserts a hard return if there’s no 

information for a field, but this may cause gaps that you don’t want in 
your documents. ‘There’s a way to get around this, but it’s not intuitive. 

First, in your primary file, put the code for the field that may or 

may not contain information on a line with another code, not on a 

5 @ File Edit Search Format Font. Special Windows 

Doc 1: Untitled 

April 5, 1988 

Hastings House 
3499 East 42nd St 

Chicago, IL 

Dear Mrs. Roberts: 

For this week only, Hastings House can take advantage of our 
wholesale inventory clearance. You'll need to show the enclosed 
pass identifying yourself as a representative of Hastings House 
at the door. If you need additional passes with names other 
than Wendy Roberts, call us at (800) 555-2233 before you come 

Natural Fibers, Inc.Dept. 400 
8800 Paul Blvd. 
Menlo Park, CA 

Dear Mr. Martinez: 

For this week only, Natural Fibers, Inc, can take advantage of 
our wholesale inventory clearance, You'll need to show the 
enclosed pass identifying yourself as a representative of 
Natural Fibers, Inc. at the door. If you need additional passes 
with names other than Raoul Martinez, call us at (800) 655-2233 

before you come.| 

Figure 9.5: When WordPerfect merges, you'll get all the filled-out forms in 

one large file, separated by hard page breaks. (Screen captured on 

a Mac II monitor.) 
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February 29, 1988 

Hastings House 

3499 East 42nd St. 
Chicago, IL 60611 

Dear Mrs. Roberts: 

For this week only, Hastings House can take advantage of our wholesale 

inventory clearance. You'll need to show the enclosed pass identifying 

yourself as a representative of Hastings House at the door. If you need 

additional passes with names other than Wendy Roberts, call us at (800) 

555-2233 before you come. ; 

February 29, 1988 

Natural Fibers, Inc. 

Dept. 400 

8800 Paul Blvd. 

Menlo Park, CA 94025 

Dear Mr. Martinez: 

For this week only, Natural Fibers, Inc. can take advantage of our 

wholesale inventory clearance. You'll need to show the enclosed pass 
identifying yourself as a representative of Natural Fibers, Inc. at the door. 
If you need additional passes with names other than Raoul Martinez, call 
us at (800) 555-2233 before you come. 

Figure 9.6: When the letters are printed, each one will be on a separate page. 

line by itself. The primary file you just created would look like this: 

*D 

pa on Ragin pe eo 
“~“F3* 

MEAS ORO 



har If you need to stop a 
merge, press 

Command-.. The pro- 
gram will stop merging 
and write any documents 
that have been generated 
so far to the screen. 
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Dear *F8* *F7*: 

The * F2 field is the one that may or may not have a suite or depart- 
ment number, and here it’s been put on the same line as * F1, the 
company name. 

Then, in the secondary file, press Return to insert an extra hard 
return in the records that do contain the information. The hard return 
should be on a line by itself before the field that contains the informa- 
tion. This is how it would look in the secondary file you just created: 

Hastings House * R 
“R 
3499 East 42nd St.*R 
Chicago, IL*R 

60611*R 

Natural Fibers, Inc. *R 

Dept. 400 *R 
8800 Paul Bivd. *R 
Menlo Park, CA * R 94025*R 

Raoul *R 

Martinez * R 

Mr.*R 

5 = 

When you merge, this trick suppresses the blank line that would oth- 
erwise be inserted in the records without the information. 

Selecting Different Secondary Files 
You can use a pair of codes to switch to different secondary files 

during a merge. For example, you might want to take additional 

information for the body of the form letter you wrote earlier from a 

different secondary file named vendor secondary that lists items 

available from each of your suppliers and their prices. You can start 

the merge using the name and address information in your address 
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Cink, Y 

har If you’re going to 

try this example in 
an actual merge, you’ll 
need to create a vendor 
secondary file first and 
add the appropriate 

merge field codes to your 
letter primary file, 

depending on how you 
set up the vendor second- 
ary file. 

To insert a pause so 
that you can select a 

new secondary file during 
a merge, put the codes 
*S*C*S in your pri- 
mary file at the point 
where you want to switch. 

secondary file and then switch to the vendor secondary file. To 
change to this secondary file, you use a pair of ~ S (New Secondary) 
codes to enclose the new secondary file’s name. 

For example, you could add a paragraph listing several of the sale 
specials and their prices: 

1. Open the letter primary file and add the following paragraph 
at the end: 

Here are examples of our unadvertised specials: 

2. Insert the New Secondary codes that tell WordPerfect to switch 
to the vendor secondary file by choosing Merge Codes and 
New Secondary. 

3. Type vendor secondary as the name of the new secondary file. 

4. Repeat step 2 to insert the final New Secondary code. 

You can then insert merge field codes to take information from that 
file instead of the address file you began the merge with. From that 
point on in your document, WordPerfect will use the records in the 
vendor secondary file until you insert a new set of ~ S codes to switch 
to a different secondary file. 

Switching to a secondary file by using this method in effect lets you 
switch between different databases (secondary files) and merge infor- 
mation from each database into your documents. 

You can also switch to different primary files during a merge. The 
most common use for this technique is when you’re assembling docu- 
ments from boilerplate during a merge. You’ see how to use it in the 
section on Document Assembly later in the chapter, 

A Quick Review —WWSSeeeseseseseseses—sSsS 
When WordPerfect completes a merge, it sends the merged file (all 

of it, including any separate documents it contains) to the screen and 
simply holds it in RAM. If you have a large number of records in 
your secondary merge file, it’s possible to run out of RAM before 
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WordPerfect generates all the merged copies. If this occurs, the pro- 
gram stops the merge when no more memory is available and proc- 
esses only part of your secondary file. If you’re merging a large 
number of records, you’ll want to merge to the printer instead of 
merging to the screen, as WordPerfect automatically does. 

As merging to the printer is a slightly more complicated proce- 
dure, let’s first review what you’ve learned so far. You may find it 
helpful to refer to this list as you’re creating your own secondary files. 

e Each item of data (field) must begin on a separate line. 

e Each line must be terminated by an ~ R (Merge Return) 
code, which indicates the end of a field. 

e Each record must end with an ~ E (Merge End) code, which 
indicates the end of a record. 

e Each record must have the same number of fields, although 
some of them can be empty. 

e A field can contain more than one line of data. For example, 
you can use a field to contain an entire standard paragraph or 
clause in a contract and simply insert it each time it is needed. 

Table 9.1 summarizes all of WordPerfect’s merge codes, both the 

ones you’ve already used and the ones you’ll learn about later in 
this chapter. 

Table 9.1: Merge Codes 

Merge Codes Function 

* C (Console) Pauses for keyboard entry 

* D (Date) Enters current date when merged 

“ E (End of record) Marks the end of a record 

* F (Field) Prompts you for a field number 

“ G (Macro) Executes a macro 

~N (Next) Moves to the next record 
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Oe) You can’t use hand- 

fed forms if you’re 

merging to the printer. 

hr If you don’t want to 

merge large files to 
the printer, try splitting 
them into smaller files— 

Say, one containing data 
for customers whose last 

names begin with A-M 
and another for cus- 

tomers whose last names 

are N-Z—and use first 

one and then the other of 

these files for the merge. 

Table 9.1: Merge Codes (continued) 

Merge Codes Function 

*P (Primary) As a pair of codes, encloses the name of the primary 

file to use 

*Q (Quit) Stops the merge 

“R (Return) Marks the end of a field 

“S$ (Secondary) As a pair of codes, encloses the name of the 

secondary file to use 

“ T (To printer) Sends merged text to the printer 

*U (Update) Rewrites the screen 

*V (Insert) Transfers merge codes into the document that is 

being created 

Now you’re ready for merging to the printer. 

Merging to the Printer 
A special code, ~* T, instructs the program to send each document 

to the printer as it’s completed and then to clear its contents from 
memory. You insert the ~'T (To Printer) code by selecting To Printer 
from the Merge Codes submenu (or pressing Command-8 T). When 
you use the * T code for merging to the printer, however, you’re no 
longer performing a simple merge. WordPerfect won’t automatically 
continue to use the same primary file, nor will it automatically move 
to the next record in the secondary file. You’ll need to add more codes 
that instruct the program to perform these functions. 

The * N (Next Record) code, as you saw in the previous example, 
tells WordPerfect to process the next record. In that example, you 
used it to tell the program to skip the dummy record and go to the sec- 
ond record in the file. Likewise, you can use this same code in a pri- 
mary file to tell WordPerfect to move to the next record. 



If you use the * T 
B® code alone, Word- 

Perfect automatically 
advances to the beginning 
of the next page when it 
finishes printing each 
document. You’ll get a 
blank page between each 
document unless you use 
Beinn IN) oP, Picodes 
with the * T code. 
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To tell the program to continue to use the same primary file, you 
add a pair of ~ P (New Primary) codes. If you insert a primary file 
name between these codes, WordPerfect will switch to that file, as 
you'll see in a later example. Inserting the ~ P * P codes with nothing 
between them tells the program to use the same primary file. 

So, to send each merged document to the printer as it is created, 

clear it from memory, advance to the next record, and use the same 

primary file, you enter these codes at the end of the primary file: 

“T*N*P*P 

You can try this with the two records you’ve created by inserting 
these codes as the last line in the letter primary file; then opening a 

new document and starting another merge with the letter primary 
and customer secondary files. 

In general, it’s a good idea to test print a document before you 
carry out a merge, substituting actual data from each field, so that 
you can see how your final document will appear when printed. 
WordPerfect automatically reformats paragraphs around the 
inserted data, so each paragraph in the merged document may have 

a different number of lines, depending on the length of the inserted 
records. You may, for example, want to insert hard spaces between 

words that should not be broken at the ends of lines, such as dates 

(October 15, 1988) and titles (Dr. Leona S. Cunningham), or go 
back and set hyphenation for certain words. 

However, if you have a large number of records, you may not 

want to print a document for each of them. If you know in advance 
where you want to stop amerge, you can put a ~ Q (Quit) code in the 
secondary file at that point. Otherwise, you’ll have to delete the 

records you don’t want documents for or create another secondary 

file containing only the records you want to use. 

Combining Macros and Merges 

You can even use macros with merges. You can start a merge with 

a macro and end a merge with a macro, but you can’t execute several 

merges from one macro. You can, however, chain macros one after 

the other at the end of a merge. By setting up merges with macros, 
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Make sure any 
macros your merge 

uses are available on the 
disk you’ re using, or 
you'll be prompted to 
locate the macro for 
WordPerfect before it 
starts the merge. 

hr No matter where 

you put the macro 
in the file, it won’t be 

executed until the merge 
ends. Be sure to put it 
before any ~ P codes, 
though, so that WordPer- 
fect will read the macro 
before it uses the new 
primary file the codes 
specify. 

you can have WordPerfect execute several different merges with one 
command. 

Macros are also useful for sending merged documents to the 

printer. For example, you can create a macro named print merge that 

pauses for you to enter a name for the merged document, saves it, 
and sends it to the printer. To use a macro in merge printing, you 

need to put its name inside a pair of ~G (Go to Macro) codes. If you 
record the print merge macro that follows, you can insert the codes 

“ Gprint merge * G in any primary file so that WordPerfect will 

print the document when it finishes the merge. 
Here’s how to do it with the status report you created earlier. First, 

open a new document. Then follow these steps. 

1. Choose Macro; then choose Define Macro (or press Com- 
mand-Shift-M). Name the macro print merge. 

2. Choose Print from the File menu (or press Command-P); then 
press Return to print the document. 

3. Choose Save As to give the merged document a name. 

4. Choose Macro (or press Command-M); then choose Pause 
Macro to pause the macro. 

When you execute the macro, it will start again as soon as you 
close the dialog box. 

5. Click Cancel to cancel the Save As dialog box that’s on the 
screen. 

6. Press Command-Shift-M to end macro definition. 

Now open your status report and insert the macro command as the 
first line in this primary file. 

1. With the status report on the screen, choose Merge Codes 
(Command-8) and choose Invoke Macro (or type G). 
A *G code is inserted in the file. 

2. Type print merge as the name of the macro. 

3. Choose Merge Codes and Invoke Macro again (Command-8 G). 
You should see “ Gprint merge * G at the beginning of your sta- 
tus report. 
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Save the status report (Command-S) and close its window; then 
open a new window to test the macro. Start the merge by choosing 
Merge; then choose Status report as the primary file and No File as 
the secondary file. Fill out a status report, pressing Command-Shift- 
R (end of field) after each entry and Command-Shift-E (end of 
record) after the last entry. The macro will then execute, allow you to 

save the filled out form, and print the form. 
If you’re using macros in merges, you can have WordPerfect 

pause and display a dialog box so that you can select the macro you 
want to use. To insert the pause, enter the codes ~G ~C * G at the 
place in the primary file where you want to choose a macro. For 

example, after a merge you might want to execute a macro that 
appends the merged documents you’ve just created to another file 

instead of selecting a macro that prints them. 
To see how this works, you can substitute the ~G ~*C%*G codes 

for the ~ Gprint merge * G codes in your status report. Then merge 
it again. When the merge starts, you’ll be allowed to choose the 
macro you want to execute at the end of the merge. 

Using Records from Other Programs 
If you’ve been doing merge printing in WordPerfect on another 

computer or with other software, such as a database or spreadsheet 
program, you probably have files that you want to be able to use in 
WordPerfect for the Macintosh. Most mail merge programs use a file 
type called delimited, in which each field is separated by a certain 
character (usually a comma), and each record is separated by 
another character (often a carriage return/line feed). In addition, text 
that is in a record may be enclosed in quotation marks. What you 
need to do is change the field delimiter to an ~ R merge code and a 
hard return, and change the record delimiter to a hard return and an 
* E merge code. You can do this quite easily, because WordPerfect’s 

Replace feature lets you replace merge codes. If you scroll to the end 

of the dialog box, you’ll see all the merge codes. 

If you’re using dBASE Mac, you'll need to use the Export option 

to convert your records to text files. You’ll be given a choice of delim- 

iters. Choose the comma for the field character and the carriage 

return/line feed for the record character. When you export the file, 
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The file may con- 
tain other 

commas—as in 

addresses, for example. 
To be safe, search with 

the Confirm option on so 
that you don’t delete 
commas where they’ re 
needed. 

Use a monospaced 
font like Courier or 

Monaco for filling out 
forms. 

itll be converted to a MacWrite document that you can open in 

WordPerfect. Press Command-H and replace the hard returns with 

* E; then search for the commas and replace them with ~ R[HRt]. 
If the database you’re using puts text in quotation marks, you can 

delete them quickly once you’ ve got the file in WordPerfect by choosing 
Replace and searching for quotation marks, replacing them with 
nothing. 

‘To convert IBM dBASE files to a format WordPerfect can use, 

you'll need to use dBASE to copy the file to type DELIMITED by 
using the command 

-COPY TO <filename> TYPE DELIMITED 

You can then run the IBM WordPerfect Convert program on the 

file to change it to a secondary file format. However, you’ll also need 

to search for each ~ E code and insert a hard return in front of it so 
that each “ E code is on a separate line. Once you’ve done that, you 
can transmit the IBM file to Macintosh WordPerfect (see Chapter 
14) and change its creator and type to SSIW and WPPC by choosing 
File/Folder Info in the List Management window. You can then use 
the document in Macintosh WordPerfect just as if you created it as a 
secondary file from scratch. 

Completing Forms 
When you use WordPerfect’s merge feature to complete a form 

you've designed, you should first set up the form, including its head- 
ings and tab stops, before you insert the merge codes you’re going to 
be using. That way, you’ll be able to place the merge codes in the cor- 
rect positions to fill out the form. 

You can use merge printing with preprinted forms, although it 
takes a certain amount of calculation and experimentation to get the 
spacing just right. In such a case, your primary file will contain only 
carriage returns, spaces, and the appropriate merge codes. 

First, you’ll need to run one preprinted form through your printer 
so that you can determine exactly where the codes should go. Mea- 
sure the form’s margins and set up a document to match in WordPer- 
fect. Then type out a line across the page and copy it down the page 



= If you’re merging 
information from a 

secondary file into a 
preprinted form, make 
sure that the fields don’t 
contain more characters 

| than will fit in the blanks 
| on the form. Switch to a 
_ smaller font if necessary. 

Don’t type headings 
in your records. 

Otherwise, each record 

will have a heading when 
it’s printed. Merge the 
list; then add any head- 

ings you want. 
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so that you’ve got a solid page of text. When the form is printed, it 
will be overprinted with text so that you can see the coordinates of 
each blank that’s to be filled out. You may want to use repeating 
numbers, like this: 

012345678911234567892 1234567893 1234567894123456789 
112345678911234567892 1234567893 1234567894123456789 

2123456789112345678921234567893 1234567894123456789 

After you overprint the form, note the coordinates of the beginning of 
each blank that you’re going to fill out. Choose Screen from the Spe- 
cial menu; then choose Show Position. Then, with the grid you cre- 

ated displayed on the screen, move the insertion point to each blank 

that you’re going to fill out and note those coordinates. With care, you 
can set tabs, press Return, and use the space bar to position the ~ F 
codes properly in a new document to retrieve each field. Save the grid so 

that you can use it for another form. 

Creating Reports 
You’re not confined to form letters with WordPerfect’s merge fea- 

tures. You can take fields from a secondary file and selectively reorder 
them to create lists and reports. As an example, we’ll take the records 
you’ve already created and restructure them into a name and ad- 

dress list. 

1. Open a new document. 

2. Define three equally spaced parallel columns and turn col- 
umns on. 

3. In the first column, enter ~F7*~, ~ F6* for last name, first 

name. (Note the space after the comma.) Then press Command- 
Return to move to the second column. 

4, In the second column, enter ~F1* for the company name. 

Press Command-Return. 

5. In the third column, enter the address as ~ F3*, ~ F4~ 

“ F5~ . Be sure to add the comma and spaces. 
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6. Press Command-Return and insert the codes ~N ~P*P. 

These codes tell WordPerfect to move to the next record ( ~ N) 
and use the same primary file (* P * P). If you don’t insert them, 
you'll get a page break between each record when WordPerfect 
prints the document. 

7. Save the file as address list primary and close it. 

8. Open a new document and choose Merge from the Special 
menu. 

9. Choose address list primary as the primary file and customer 
secondary as the secondary file. 

You'll get a formatted listing like the one in Figure 9.7. 

Addressing Envelopes and Mailing Labels 
You can use the same basic idea behind the previous example to set 

up a primary file for mailing label addresses. Once you’ ve created a 
secondary merge file that contains the records you’re going to use for 
a mailing, you can use the same records to create the mailing labels or 
address the envelopes. Although it may take some trial and error to 
determine the format that is best for the mailing labels you normally 
use, once you’ve set up this file, you can use it over and over for 
mailings. 

‘To create a new primary file for the addresses used in the form let- 
ter example earlier in the chapter, you would enter the following 
codes into a blank document and save it as a primary file, perhaps as 

Roberts, Wendy Hastings House 3499 East 42nd St., 
Chicago, IL 60611 

Martinez, Raoul Natural Fibers, Inc. 8800 Paul Blivd., 
Menlo Park, CA 94025 

Figure 9.7: When you merge the document, you get a formatted list. 



_ If you’re printing 
mailing labels, 

you’re probably using an 
ImageWriter, as the 
additional heat a laser 
printer generates can 
cause the labels to stick 
inside the printer. If 
you’re using a LaserWri- 
ter, be sure to get special 
laser-printer labels. 

To print duplicate 
sets of labels, omit 

the * N code next to the 
“F1%. In this example, 
youll get three duplicate 
labels for each record, 

printed across the page. 
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address primary: 

“F6* *F7~% [first name last name] 
*F1~* [company name] 

“F3~* [street address] 

“F4%* “F6~ [city and state] [zipcode] 
SNZSP AR. 

(The information in brackets is just to remind you what these codes 
are; don’t enter it into the primary file.) 
When you use this new primary file in a merge, give its name as 

the primary file and enter the name of the file containing the records 
as the secondary file. The resulting merged document can then be 
used to generate mailing labels and envelopes. 

To determine the correct settings for printing mailing labels, you’ll 
need to measure the length from the top of the sheet the labels are on 

to the position where you want the first line to start. Then use the 
Page Layout command to set the top margin and left margins to that 

distance, as it will almost certainly not be the program’s default one- 
inch margins. 

Next, define columns for as many labels as print side by side on 

your mailing label sheet. For example, if you’re printing three across, 
define three evenly spaced parallel columns. ‘Then turn columns on. 

Enter merge codes for each field in the addresses you are going to 

take from a secondary file, as illustrated in Figure 9.8. When you get 
to the last field in the last label, turn off columns. Then enter the 

“N * P* P codes that tell WordPerfect to go to the next record and 
use the same primary file. 

If you’ve been using WordPerfect on another computer, you 
should be aware that mailing labels do not opeate the same way in 
WordPerfect on the Macintosh. When you merge, WordPerfect will 

fill one page at a time with labels, as illustrated in Figure 9.9 (there 
were only six addresses in this secondary file). The size of the page 
depends on the size you select in the Print Options dialog box. You 

may need to adjust the spacing between the labels, but after you get 
one test sheet spaced correctly and your primary file set up to reflect 
those settings, the rest of the pages should print correctly. 

Some brands of labels print much better than others. The Avery 
labels seem to cause the least problems. If you’re having trouble with 
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6 The ImageWriter 
does an extra form 

feed between pages. You 
can manually feed sheets 
of labels into the printer 

to get around this. How- 
ever, don’t try to roll 
labels back out of the 
ImageWriter. They come 
loose quite easily and 
stick to the platen. 
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secondary file of addresses. 

4 @ File Edit Search Format Font Special 

Hastings House 

3499 East 42nd St. 

Chicago, IL 

60611 

Productions Unlimited 

4000 Sobrante Way 
Sunnyvale, CA 

94086 

Natural Fibers, Inc. 

8800 Paul Blvd. 

Menlo Park, CA 

94025 

WordPerfect 

1550 Technology Way 
Orem, UT 

84057 

Figure 9.8: Set up a primary file like this one to create mailing labels from a 

Windows 

Doc 1: Untitled 

Creative Enterprises 

33 East 67th Ave. 

Palo Alto, CA 

94303 

SYBEX Computer Books 

2021 Challenger Drive 
Alameda, CA 
9450] 

Figure 9.9: WordPerfect'generates the labels from the fields in the secondary file. 
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mailing labels, consider switching to the continuous-roll type with the 
perforations on both sides. 

Dual Merges 

You can use the * V (Transfer) merge codes in a primary file so 
that it can be used with more than one secondary file of records. 

When you enclose merge codes within a pair of ~ V merge codes, 
they will be transferred to the document you’re creating in the first 

merge, but the ~ V codes themselves will be removed. When the 
merge is finished, you save and close the file that was created. It will 

then contain the merge field codes for the second merge, so you can 

merge it again with another secondary file. It sounds complicated, 
but it gives you a lot of flexibility in how you store your records, and 
most of us don’t plan ahead sufficiently to create one all-purpose 
record file. We’ll take a simple example. 

Suppose you wanted to take information for a shipping document 
like the one shown in Figure 9.10 from two different secondary 

" @ File Edit Search Format Font Special Windows 

Doc 3: Untitled 

Packing List 

Invoice no. Quantity Item Description 

1299 yellow pads 4500-3 50 doz. 

Packing List 

Invoice no. Quantity Description 

4544 white pads 50 doz. 

Packing List 

Invoice no. Quantity Description 

3400 typing paper 50 doz. 

Figure 9.10: Dual merges let you take information from separate secondary 

files. (Screen captured on a Mac II monitor.) 
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You don’t have to 
use all the fields in 

any secondary file. You 
can simply use codes for 
the fields that contain the 
information you need. 

files—one containing item information such as part numbers and 

descriptions, and another containing invoice numbers and quantities 
ordered. First, you’ll need to set up the primary document with the 
merge codes for both merges—the codes that will be used in the sec- 
ond merge will be enclosed in ~ V codes. To create the primary docu- 
ment for this example, 

1. Open a new document and type the heading Packing List. 

2. Define four equally spaced newspaper columns for the four 
items—Invoice no., Quantity, Item, and Description. 

3. Type Invoice no. , press Return twice, and choose Merge Codes. 
Then choose Retrieve Field, type 1, and click OK. 

4, Press Command-Return to move to the next column. 

5. Repeat steps 3 and 4 for each of the remaining headings. 

When your screen resembles Figure 9.11, save the primary docu- 
ment as packing list. Then close it and open a new window to create 
the first secondary file. This file, called items, holds information 
about each item—its part number and description. We’ll keep it 
simple in this example, but in practice, your secondary files can con- 
tain many more fields than this one does. 

1. For the first field in the first record, which holds the item num- 
ber, type 1299. End the field by choosing Merge Codes; then 
choosing End of Field (or typing Command-8 R). 

2. For the second field, type yellow pads and insert an ~R merge 
code. 

3. End the first record by choosing End of Record from the merge 
codes list (or typing Command-8 E). 

4. Repeat steps 1 through 3 for each of the other two records illus- 
trated in Figure 9.12. 

When your screen resembles Figure 9.12, save the document as 
items and close it. , 

Next, you’ll create the second secondary file—the one holding the 
order information. Again, we’ll keep it simple, so each record will 
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"@ File Edit Search Format Font Special Windows 

Doc 1: packing list 
Packing List 

Invoice no. Quantity Item Description 

“Fi*+ AF2* AY*F1i**V AV*F2°*V 

Figure 9.11: The first step is to create a primary file containing * V codes. 
(Screen captured on a Mac II monitor.) 

. &@ File Edit Search Format Font Special Windows 

[ Doc 3: items 

white pads*R 
ae 
3400°R 
typing paper“R 
pie 

Figure 9.12: The first secondary file, items, holds item information. 
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have only two fields—one for invoice number and the other for quan- 
tity ordered. Open a new document: 

1. For the first field, which holds item numbers, type 4500-3 and 
insert an end of field code. 

2. For the second field, type 50 doz. and insert an end of field 
code. 

3. End the record by inserting an end of record code. 

4. Repeat steps 1-4 for the other two records shown in Figure 9.13. 

When your screen resembles Figure 9.13, save the document as 
invoices and close it. 
Now you’re ready to do the dual merge. First, you’ll use items as 

the secondary document: 

1. Open a new window and select Merge from the Special menu. 

2. Choose packing list as the primary document and items as the 
secondary document. 

When the merge finishes, your screen should resemble Figure 

" € File Edit Search Format Font Special Windows 

Doc 2: invoices 

50 reams*R 

Figure 9.13: The second secondary file, invoices, holds order information. 
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9.14. As you can see, the merge codes that were enclosed in ~ V 

codes have been transferred to the merged documents. 

3. Save the resulting merged document as test and close it so that 
you can merge with it again. 

4. Open a new window and start another merge by choosing 
Merge from the Special menu. 

5. Choose test as the primary document and invoices as the sec- 
ondary document. 

When the merge finishes, you should have the final merged docu- 

ment that was illustrated in Figure 9.10. You’ve used information 
from two separate secondary files in the resulting documents. 

" @ File Edit Search Format Font Special Windows 

Doc 2: Untitled 

Packing List 

Invoice no. Quantity Iten Description 

1299 yellow pads oA SE 2c 

Packing 

Invoice > Quantity Description 

4544 white pads “F2~ 

Packing 

Invoice F Quantity Description 

3400 typing paper i) rte 

Pg3 Col 4 Ln8 

Figure 9.14: When the first merge finishes, save the interim document that 
has been created. (Screen captured on a Mac II monitor.) 

Document Assembly | 
Like the macro library mentioned in Chapter 8, a boilerplate 

library of standard text will let you automate document assembly. 
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If you want each 
item to start on a 

new right-hand page, put 
hard page breaks between 
each item in the primary 
file. 

Maintain a catalog 

of your boilerplate 
files so that you know 

what you’ve got to work 
from. Give them mean- 
ingful names, not just 
letter! and letter2. You 
can open another window 

and display the catalog as 
you construct your pri- 
mary files. 

Once you’ve written a paragraph or a section that you can use 

again—or use with a little revision—you can save it as a separate file 

and build complete documents from these component parts. 

You can use WordPerfect’s mail-merge feature to create a primary 

file, or master document, that will assemble documents from other 

documents. To instruct WordPerfect to assemble the final document, 

you indicate the names of the documents you want to use as the pri- 

mary files and enclose them in a pair of codes in a primary file of their 

own, like this: 

“~PPreface * P * T 

“ PAcknowledgments * P * T 
*~PChapter 1*P*T 

*PChapter 2 *P * T 

*PChapter 3 * P * T 

The * T code sends each chapter or section to the printer and clears it 
from memory, which is useful if you’re assembling a large document. 

Although a book is used in this example, you could as well use sec- 

tions of a contract, parts of a letter, groups of construction specifica- 
tions, or paragraphs of a proposal as building blocks for the master 
document. 

If any of these files contain merge codes, WordPerfect will execute 
those codes as it processes each file. For example, you might want to 

use additional merge codes in files that are to be used with business 
letters to take names and addresses from a secondary file. Figures 
9.15 and 9.16 illustrate how you can use two primary files, the first of 
which is created from information in a secondary file—in this case, the 
address secondary file you created earlier. This first primary file, head- 

ing, holds the codes that generate the date as well as insert the contents 
of the fields for creating the address block and salutation in the letter. 
The second primary file, letter body, contains the body of the letter, 
which also uses information from the secondary file. To assemble a let- 
ter, you’d set up a primary file containing only the lines 

“ Pheading * P 

* Pletter body ~ P 
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Edit 

SE Go chts [first name last name] 
qa [company name] 
F3* [street address] 
“F4° °FS* [city and statel][zipcode] 

Dear F8* F7*: [title] [last name] 

Figure 9.15: The heading file takes information from the secondary file you 
specified at the beginning of the merge. 

@ File Edit Search Format Font Special Windows 

Doc 1: letter body 

For € limited time only, we are offering special corporate customers a 

30% discount on 3 1/4-inch disks. As a representative of *F1*, you are 

entitled to order at this special rate. 

We must receive your order by May 31 to qualify for this discount. 

Sincerely, 

Naomi Lee 

Corporate Sales 

Figure 9.16: The letter body contains the text of the letter. 
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Run the Speller on 
the completed mas- 

ter document. There’s no 
need to perpetuate typing 
errors in all the docu- 
ments you’re going to 
create. 

When the merge executes, it fills out the information in both the 
heading and the letter body files from the records in the secondary file 
that you choose at the beginning of the merge. 

Tips for Setting Up Boilerplate Systems 

If you’re setting up a system of boilerplate for use with merging 
into a master document, you may find it helpful first to enter the 
entire final document, including any variations on the paragraphs or 
sections it contains. You can then scroll through the document, select 
each section that you want to save, and save the selection as a sepa- 
rate file. Then print out the entire ‘“‘master”’ document so that you 
have a hard copy of what it contains. Mark the name under which 

you’ve saved each section. By referring to this hard copy as you 
assemble a document from its component parts, you can easily see 

what each variation contains without having to retrieve the individ- 
ual documents or check their contents by using the Look option of the 
File Management window. If you use much boilerplate in your work, 
you ll probably want to maintain a notebook of these standard docu- 
ments and their variations. 

You should also establish a consistent system for spacing in boiler- 
plate documents. For example, if you save a paragraph as a file, do 
you include the [HRt] code at the end of the paragraph, or will you 
press Return before you insert each merge code into the master file? 
If you want each new section to begin a new page, will you put the 
hard page break at the end of each line in the master document, or 
will you begin each new section with a hard page break? If you aren’t 
consistent, you may get incorrect spacing in the documents you 
assemble, and you’ll have to check their spacing. By setting up a 
spacing system and using it consistently, you can save yourself this 
extra step. 

Instead of assembling a master document from primary files, you 
can use secondary files. For example, you might want to set up a sec- 
ondary file of standard paragraphs, as illustrated in Figure 9.17. As 
you create each primary document, just specify the appropriate field 
number from this file. Keep it open in a separate window so that you 
can see what each field contains. 
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ormat Font Special Windows 

Doc 1: Untitled 

Your recent inquiry has been forwarded to our accounting 

department. The product manager, Wanda Wainwright, will 

be in touch with you as soon as the estimate is Pprepared.°R 

Your recent inquiry is being processed, end you should 

receive 4 written estimate within ten days.’°R 

If you need additional information, our Technical Service 
department number is 555-9000.’R 

If you have further questions, feel free to call us at (800) 

999-1233.R 

If you have further questions, feel free to contact a 

Customer Service representative at 555-4400.°R 

Figure 9.17: Instead of assembling documents from primary files, you can 
store standard paragraphs as fields in secondary files. 

Looking Forward 
This chapter has shown you the various types of merge printing you 

can do with WordPerfect. In addition to what’s normally thought of as 
mail-merge applications that consist of personalized form letters, you’ve 
seen how you can use the program to fill out forms, assemble documents 

from other documents, and create reports from secondary files. 

From this point on in the book, you’ll explore some of WordPer- 

fect’s specialized features for creating reference aids. Chapter 10 dis- 
cusses outlining and automatic paragraph numbering, Chapter 11 
presents techniques for working with reference notes, and Chapter 
12 explains how you can create automatic lists, tables of contents, 

and indexes. 
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70 . Outlining and 
Paragraph Numbering — 

io 



Fast Track 

To turn on outlining, 342 

choose Paragraph from the Format menu; then choose Outline 

(or press Command-Shift-Y). 

To add an outline number to your outline, 342 
press Return when outlining is on. 

To change to a lower outline level, 343 
press Tab. 

To return to the previous outline level, 343 

press Shift-Tab (Margin Release). 

To move text to the next tab stop 343 
without changing the outline number, press Command-Shift-T 
(Indent). 

To indent an outline 343 
between the level number and the text, press Command-Shift-T. 
For a Left-Right Indent, press Command-Shift-L. 

To stop the program from generating outline level numbers 343 
until you press Return again, press the space bar, type text, or 
insert an indent character. 

To change to a different outline numbering style, 349 
select Paragraph from the Format menu; then select Paragraph 
Number Definition (press Command-3 and type 3). You can 
select a predefined style or choose Ser and create your own 
style by clicking on the buttons. é 



341 

To use paragraph numbering, 351 
choose Paragraph from the Format menu and then choose 
Paragraph Numbers (or type Command-3 2). Type a level 

number for fixed numbering or click Auto for automatic num- 

bering. With automatic numbering, the style of the numbering 
changes as you move the number to other tab stops on the line. 

With fixed numbering, the style of the number (Level 1, 2, 3, 

and so on) won’t change when the insertion point moves to 

different tab stops. 
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WORDPERFECT CAN HELP YOU CREATE OUTLINES 
in your documents and can number paragraphs for you automati- 

cally. If you’re working with long documents, you may find these fea- 

tures especially helpful, because they save you from having to keep 

track of each outline level or paragraph number. When you delete an 

item from an outline or add a new numbered paragraph, the pro- 

gram renumbers all the outline entries and paragraphs for you. 

We'll first look at outlining, which to WordPerfect is a special kind 
of paragraph numbering. 

———______._ Working in Outline Mode 
Not only can you use WordPerfect’s outlining feature as a writing 

aid for creating typical outlines and hierarchical lists, but you can 
also use it as a planning tool for the documents you create with the 
program. After you’ve created a basic outline for a document, you 
can add major points to it, indenting sublevels as ideas occur to you. 
You can then write the document by following the outline and be 
assured that all the points you listed will be covered. 
When you turn on the Outline feature (Command-Shift-Y is its 

shortcut), you’ll see the word ‘‘Outline” on the status line. When- 
ever that message is there, the program generates a new outline num- 
ber (like I., A., a., or i.) as you press Return or Tab. To turn off 
Outline mode, press Command-Shift-Y again. It works like a toggle. 
When Outline mode is on, WordPerfect behaves a little differently. 

In particular, pressing certain keys gives different results: 

¢ Pressing Return inserts a Level 1 outline number at the left 
margin. 
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¢ Pressing Tab moves the outline number to the next tab stop 
and changes the outline numbering style to the one associ- 
ated with that tab stop (Level 2 for the second tab stop, Level 
3 for the third tab stop, and so forth). 

e Pressing Shift-Tab (Margin Release) moves text back to the 
previous tab stop and changes the outline number. 

After you press the space bar, type text, or insert an indent 
(Command-Shift-T) or Left-Right indent (Command-Shift-L), the 
program stops generating outline level numbers until you press 
Return again. 

WordPerfect won’t 

automatically renum- 

ber outline levels unless 

Outline mode is on. 

If you don’t want 
the indentation of 

the outline numbers to 
change as the insertion 
point moves from tab 
stop to tab stop, don’t use 
outlining. Use fixed 
paragraph numbering 
(described later in this 
chapter) instead. You can 
create an outline that’s 
aligned flush left, like 
this: 

lL. 
A. 
us 
a. 

Try the next exercise to see how Outline mode works. 

. Open a new document and press Command-Shift-Y to turn on 
Outline mode. 

You’ll see ‘‘Outline”’ on the status line. 

. Press Return. 

A capital Roman numeral I appears at the left margin. 

. Press Tab two or three times. 

Each time you press Tab, a lower-level outline number appears. 

The default numbering style the program uses is the outline style 
you probably used in school—I., A., a., (1), and so on. Word- 

Perfect keeps track of up to seven levels for you. You can change 
the numbering style, as you’ll see later. 

. Press Shift-Tab (Margin Release) to move back to Level 1 at 
the left margin. This time, after the I. appears, press the space 
bar and then type the word Text. Press Tab and see what 

happens. 

After you’ve entered text or pressed the space bar, Tab simply 
moves to the next tab stop instead of taking you down one level. 

Press Return to generate a II. on the next line. 

6. This time, put a second-level entry in your outline: press Tab to 

generate an A. Then press the space bar to get some space 

between the number and the text, and enter the words More text. 
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7. Add a Level 3 entry to your outline. Press Return, press Tab 
twice, then type the words Even more text. 

Your outline should look like this by now, although the spacing 

may be different: 

|. Text 

A. More text 

1. Even more text 

Creating an Outline 

Now that you have a feel for how the keys work in Outline mode, 
you can try entering an actual outline to see how moving items 
around and deleting outline levels work. Open a new document, turn 

on Outline mode, and enter the short outline shown in Figure 10.1. 
What if you make a mistake? If you press Return too many times and 

add a number you don’t want, press Delete to delete it as soon as it 
appears. You'll see a dialog box asking whether you want to delete that 

@ File Edit Search Format Font Special 

tlines 

Doc 3: Outline sample figure 

. Introduction 

A. Financial Estimates for Fiscal 1989 

B. New Product Planning 

. Changes in Operation 

A. Capital Expenditures 

1. Plant and Equipment 

2. International Markets 

B. Personnel Projections 

C. Improvements in Processing 

Figure 10.1: Entering this short outline will give you practice in manipulating 
outline entries. 
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Ph When you delete a 
line with no lower 

utline level under it, the 

utline numbering 

loesn’t change. 
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paragraph number. (To the program, an outline number is just a type 
of paragraph number.) Click OK to delete it. If you press Tab too often 
and go past the level you want, tab backward with Shift-Tab (Margin 
Release) to the correct level. 
When your screen resembles Figure 10.1, you’re ready for the 

next exercises. They’ll show you how to delete and move items and 
give you some additional tips about using Outline mode. 

Moving Outline Text 

In the example outline of Figure 10.1, note that the topic Interna- 

tional Markets seems out of place. By rights, it belongs up in section I 
with the other general topics. To move that text, follow these steps: 

1. Position the insertion point after the level number and period 
(in this case, 2.), select all the text to the right, and cut it. 

If you cut the whole line, including the level number, the level 

number will go with the text when you move it, and you’ll get an 

unwanted level in your outline. (You can try this for yourself, if 
you like.) To avoid having to delete that extra level, be sure to cut 
only text, not its associated number. 

2. Move the insertion point to the end of the line containing topic I. 
B., New Product Planning. Press Return and then Tab to insert a 
new level C. Then press Command-V to paste the cut text. 

3. Go back to the level number whose text you just cut—that 
lonely 2. left there—and delete that line by shift-clicking and 
pressing Delete twice. 

Your screen should now look like Figure 10.2. 

Deleting a Topic 

But what if you want to delete a topic from the outline instead of 

just moving its text? For example, to delete topic II. B., Personnel 

Projections, follow these steps: 

1. Position the cursor anywhere in that line. Press Command-6 

(Select) and type 2 for Sentence. 
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Doc 3: Outline sample figure 

|. Introduction 

A. Financial Estimates for Fiscal 1989 

B. New Product Planning 

C. International Markets 

Il. Changes in Operation 

4. Capital Expenditures 

1. Plant and Equipment 

B. Personnel Projections 

C. Improvements in Processing 
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Figure 10.2: After you’ ve inserted a new level C, your screen should resemble 
this one. 

Alternatively, you can choose Select from the Edit menu and 
then choose Sentence, or you can shift-click. 

2. Press Delete. 

WordPerfect automatically changes the remaining topic C to 
topic B. 

As you can see, when you delete an item along with its level num- 
ber, the program keeps track of the level numbers for you. You’ll 
have to delete the extra space left by the deleted topic yourself, but 
your outline will be renumbered. 

You can also use the shift-click method to select the topic with the 
mouse, which may feel more natural to you. However, if you use this 
method, you may neglect to select the formatting codes at the begin- 
ning of the line (press Command-7 to see them). Using either the 
Command-6 2 sequence or choosing Edit, then Select, and then 

Paragraph ensures that all the appropriate [Tab] and [{#:auto] codes 
go with the line when you cut it. 
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Changing the Level of a Topic 

You can use Shift-Tab (Margin Release) to move a topic back one 
level or Tab to move it down one level. Try this with the remaining 
third-level topic, Plant and Equipment. 

1. With the insertion point on either side of the 7., press Tab. 

The level changes to a. 

2. Press Shift-Tab twice to change it to B. 

The remaining items change to C. and D. 

Outlining Tips 
Now that you’ve seen how to enter and edit text in Outline mode, 

let’s look at a few tips you may find useful if you use a lot of outlining. 
If you use outlining only for brief topics from time to time, you can 
probably skip this section. However, if you prepare outlines for pre- 
sentations or write outlines that contain several lines of text per topic, 
you'll find some tips in the next sections that will help you create bet- 
ter formatted outlines. 

Aligning Outline Numbers and Text 

WordPerfect aligns outline numbers like this: 

iF 
Il. 
III. 

which is rather annoying, instead of like this: 

This occurs because of the way the program inserts formatting codes. 

If you’re preparing an outline for a presentation or writing a paper, 

you’ll probably want to change the alignment. 
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To change the posi- 

tion of outline num- 

bers on the page and the 
amount of space by which 
text is indented, change 
the tab settings. The 

position of Level 1 is 
determined by the posi- 
tion of the first tab, Level 

2 by the second, and so 
forth. 

Another one of WordPerfect’s annoying formatting habits is that 

you don’t automatically get hanging indents in outline text that’s 

longer than one line. You get this: 

|. This is an example of an outline topic that spans 

more than one line 

instead of this: 

|. This is an example of an outline topic that spans 

more than one line 

To make each outline entry align and indent, you need to first use 

Tab Align to align the outline numbers on a period and then insert an 

indent character. 

1. Press Command-Tab (Tab Align) to turn on tab alignment. 

2. Choose Paragraph from the Format menu; then choose Para- 
graph Numbers (or type Command-3 2). 

3. Click Auto to insert an automatic paragraph number. 

4, Choose Paragraph from the Format menu; then choose Indent 
to indent the text you’ll type next. 

This sequence both enters the outline number flush right at the tab 
stop where the insertion point is located and creates an indent. You 
can then start typing the text of the entry. 

These are quite a few steps to take each time you make an outline 
entry, so you can record them as a macro. 

Macro: Aligning Outline Entries 

As you type outlines, you can use the following macro to adjust the 
alignment for you as the program enters each outline level number. 
Remember to have the insertion point at the appropriate tab stop 
before you use the macro. 

1. Press Conimand:-ShifeM and name the macro. 

On the disk that you can order with this book, it’s assigned to 
Command-Option-O so that you can execute it quickly, but you 
can name yours whatever you want. 



= You can also put an 
indent between the 

level number and the text 
(Command-Shift-T) or a 
Left-Right indent 
(Command-Shift-L). Any 
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or inserting an indent 
character—stops the 
program from generating 
level numbers until you 
press Return again. 
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2. Press Command-Tab (Tab Align) to turn on tab alignment. 

3. Press Command-3 2 (or choose Paragraph from the Format 
menu; then choose Paragraph Numbers). 

4. Press Command-A (or click Auto) to insert an automatic para- 
graph number. 

5. Press Command-Shift-T (or choose Indent) to indent the text. 

6. Press Command-Shift-M (or choose Macro) to turn off macro 
definition. 

After you execute the macros, you can immediately begin typing 
the text of the entry, and it will be indented and formatted correctly. 

Changing the Outline Style 

If you don’t want to use the default outline numbering style, you 
can change it either to the Paragraph numbering style or to Legal 

style. Examples of how all three styles appear in your documents are 

ulustrated in Figure 10.3. 

Outline Numbering Style 

Level) I. II. 
Level 2 A. B. 
Level 3 ts 
Level 4 
Level 5 
Level 6 
Level 7 

Paragraph Numbering Style 

Level 1 1: p. 
Level 2 a. b. 
Level 3 
Level 4 
Level 5 
Level 6 
Level 7 

Legal Numbering Style 

Level 1 iin ee, 
Level 2 ja 
Level 3 
Level 4 
Level 5 
Level 6 
Level 7 ps (Ke SoS 

Figure 10.3: WordPerfect provides three outline numbering styles. 
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To change to another style, select Paragraph from the Format 

menu; then select Paragraph Number Definition (or press 

Command-3 and type 3). You’ll see the dialog box shown in Figure 

10.4, which shows the default outline style. You can select one of the 

predefined styles or choose Custom and create your own style by 

clicking on the appropriate buttons. For example, if you wanted 

Level 1 to be uppercase letters enclosed in parentheses, you would 

click Custom, click Level Style 1-(if it’s not already selected), click 
Upper Case Letters, and click the (#) button. 

After you’ve selected a style, click OK to insert the new [Def 4#] code 
in your document. Any time you turn on Outline mode after that code 

appears in your document, the outline will be in the style selected. 
You can change the default outline style permanently by making 

the new paragraph number definition part of your WP Defaults file 
or part of a custom default file. See Chapter 7 for step-by-step 
instructions on setting up default files. 

Several Outlines in One Document 

If you do a lot of outlining, you may want to have several different 
outlines in the same document, each beginning with the number I. 

Paragraph Numbering Definition 

Numbering Numbering Style 

© Paragraph @ Upper Case Roman 

© Outline © Lower Case Roman 

© Legal © Upper Case Letters 

© Custom © Lower Case Letters 

© Numbers 

© Levels with periods Level Style 

Punctuation 

Oy © #) 
@ *. O (*) 

Figure 10.4: The Paragraph Numbering Definition dialog box controls the 
outline numbering style. 
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For example, you might be presenting three alternative outlines for a 
book you propose to write. However, each time you turn on Outline 
mode, the program remembers the last level number in the previous 
outline and automatically provides the next one. To start outline 
numbering over again within the same document, you’ll need to 
define an outline number style again, even if it’s the same style. Just 
click OK in the Paragraph Numbering Definition box. Clicking OK 
inserts a new [Def §#] code in your document and starts numbering 
over again. 

Paragraph Numbering 

WordPerfect lets you assign numbers to paragraphs. When you 
add or delete a numbered paragraph, the program automatically 
renumbers the rest of them for you. 

If you write numbered instructions or test questions, you’ll find 
this feature very useful. It also comes in handy for technical manuals, 
contracts, and legal documents that require section numbers, para- 
graph numbers, or both. 

To assign a number to a paragraph, follow these steps. 

1. Position the insertion point on the line where you want the 
paragraph number to be. 

2. Choose Paragraph from the Format menu; then choose Para- 

graph Numbers (or type Command-3 2). 

You’ll see the Paragraph Level dialog box illustrated in Figure 
10.5. Clicking Auto tells the program to assign the level number 

based on the tab settings that are in effect. For example, if the inser- 

tion point is at the left margin (on the first tab stop), you'll get a Level 

1-style number. If your insertion point is on (or to the right of) the 

third tab setting in your document, you’ll get a Level 3-style number. 

Automatic and Fixed Paragraph Numbering 

If you enter a level number (from 1 to 7) in the Paragraph Level 

dialog box instead of selecting Auto, WordPerfect will consider it to 

be what it calls a fixed paragraph number. This doesn’t mean that the 

! 
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WordPerfect uses 
the same default 

style (Outline number- 
ing); for numbering 
paragraphs and outlines, 
but it also has a built-in 
Paragraph numbering 
style (see Figure 10.3). 
For paragraph number- 
ing in the style 1., a., i., 

(1), and so forth, click on 
the Paragraph button in 
the Paragraph Number- 
ing Definition dialog box 
before you begin number- 
ing paragraphs. 

bie Edit Sear Gh FOR Ol Oe ee ee EL Ie Sk MEP aE LE ae 

Paragraph Level eo * 

Figure 10.5: Clicking Auto inserts an automatic paragraph number that is 
defined by the tab stop the cursor is on. 

number itself is fixed; in fact, as you add or delete numbered para- 
graphs, the numbers will change whether they’ re fixed or automatic. 
It means the style of the number (Level 1, 2, 3, and so on) won’t 
change when the insertion point moves to different tab stops. With 
automatic numbering, the style of the numbering changes as you 
move the number to other tab stops on the line. Let’s try it both ways 
to see what happens. 

Automatic Numbering 

‘To practice using automatic paragraph numbering, you can write 
a multiple-choice question that uses two different levels of paragraph 
numbering. Normally, you probably wouldn’t use automatic para- 
graph numbering on the second-level items in test questions like this, 
but it’s been done here so that you can get some practice in working 
with different numbering levels. 

1. Choose Paragraph from the Format menu; then choose Para- 
graph Number Definition (or type Command-3 3). 



2. Click Paragraph in the Numbering box; then click OK. 

. With the insertion point at the left margin of a blank line, 
choose Paragraph from the Format menu; then choose Para- 
graph Numbering (or type Command-3 2). 

. Click Auto (or press Command-A). 

The number 1. appears in your document. 

. Press the space bar to insert a space. Then enter the text for 
question 1: 

The most reliable source for the events of the period in 
question is 

and press Return twice. 

. Press Tab; then choose Paragraph from the Format menu and 
choose Paragraph Numbering again (or type Command-3 2). 
Click Auto. 

This time when you click Auto, you get a number in the Level 2 
Paragraph style. Your test question should look like this: 

1. The most reliable source for the events of the period in 

question is 

a. 

What happens if you’re at the wrong tab setting when you choose 
paragraph numbering? If you press Delete to remove the paragraph 
number, you have to start all over again by choosing Paragraph from 

the Format menu, and so on. It’s easy to get back to a previous level, 

but it may not be obvious how to do it. Try this exercise. 

1. Press the < key to move the insertion point to the left of the a. 

Then press Shift-Tab (Margin Release). 

Pressing Shift-Tab moves the paragraph numbering code pro- 

gressively to the left. 

2. Press Tab again to get the a. back. 

3. Now press > to move the insertion point back to the right of 

the a. Then enter the following possible answers. Use Tab to 
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move to the second tab stop on each line before you use para- 
graph numbering. 

a. Diaries 
b. Church records 
c. All of the above 

d. Letters 

To see what happens when you move a numbered paragraph, try 
moving item c., All of the above, to-the last position, where it really 

belongs. 

1. Select item c., All of the above. 

A quick way to select a line is to use Command-6 (Select) and 
type 2 for Sentence. That way, you’ll be sure to include all the 
codes needed. 

2. Cut the item (with Command-X) and paste it in the line below 
item d. 

Be sure the insertion point is on the first tab stop when you paste 

it, or the number will appear in a different level style. 

When you paste item c. after item d., the numbering changes to 
reflect the new order. Now your test answers should read as follows: 

a. Diaries 

b. Church records 

c. Letters 

d. All of the above 

‘There’s a gap between items b. and c. now, so you can add a new 
item there. 

3. Click on the space directly below b. and type Command-3 2 
again. Click Auto (or press Command-A). 

This time, you’ve got a new number c., and the following num- 
bers have also changed. 

4. Press the space bar and enter the words Other written records as 
text for item c. to fill out the test question. 
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numbering para- 

graphs with J. again 
anywhere in your docu- 
iment. To do this, insert a 

1mew Paragraph Number- 
ing Definition code [Def 
' §#] where you want the 
| numbering system to 
| begin. Remember to click 
' OK to insert the code 
even if you don’t want to 
change any of the settings 
you’ve been using. 

Outlining and Paragraph Numbering 355 

Now we'll see how you can put this feature to work in some other 
practical ways. First, a short demonstration: 

1. Create another short question. Just press Command-3 2, click 
Auto, and enter the words Second question, which will be num- 
bered 2. 

2. Select the entire first test question (including the answer 
choices) and copy it. 

Be sure to include the [4#] code when you select it. 

3. Move to the end of question 2 and press Return. 

4. Paste the cut question 1. 

What happens? The numbers have changed, as you can see in Fig- 
ure 10.6. When you copy the numbered paragraphs, you also copy 

their paragraph numbering codes, which WordPerfect uses to keep 

track of the numbering system. Because of this, you can save num- 
bered paragraphs in “‘library”’ files and simply copy and paste them 
into documents as you’re writing. The program will make sure 

" € File Edit Search Format Font Special Windows aa 

Doc ?: Untitled 

SSSSFSeSeeeeeSsSEEEE_= Doc B: untitled 

1. The most reliable source for the events of the period in question is 

a. Diaries 

b. Church records 

. Other written records 

. Letters 

_ All of the above 

2. Second question 

3. The most reliable source for the events of the period in question is 

a. Diaries 

b. Church records 

c. Other written records 

. Letters 

_All of the abovd 

Figure 10.6: When you copy or cut numbered paragraphs, WordPerfect auto- 

matically adjusts for the new nuinbering. 
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= If you want Word- 
Perfect to keep track 

of paragraph numbers for 
you, don’t number them 
yourself. It’s easy to type 
a paragraph number 
from the keyboard, but if 
you do, the program has 
no way of remembering 
what that number is. 
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they’re numbered correctly in the document you paste them into. In ~ 

this way, you can create a standard contract from files of numbered ~ 
clauses or build a customized set of exam questions from a test bank 

of numbered questions. 
Inserting paragraph numbering codes is tedious (there’s a macro 

for it coming up soon), but if you mix manual numbering with the 
program’s numbering feature, you may wind up with a bizarre para- 
graph numbering system. If this happens, select Show Codes from 
the Edit menu (Command-7) and see if there are any numbers next 
to any of the [J#] codes. There shouldn’t be; if there are, you must 
have typed them yourself. To repair your numbering system, delete 

the numbers. 

Macro: Automatic Paragraph Numbering 

Even if you use the keyboard shortcuts Command-3 2 Command-A 
to insert automatic paragraph numbers, you still have quite a few key- 
strokes to carry out every time you number a paragraph. The following 
macro speeds up numbering paragraphs for you: 

1. Press Command-Shift-M and name the macro. 

On the disk that you can order with this book, it’s assigned to 
Command-Option-P for speed, but you can name yours what- 
ever you want. 

2. Press Command-3 2 Command-A. 

This selects Paragraph from the Format menu and then selects 
Paragraph Numbers. Command-A selects Auto. 

3. Press the space bar to insert a space between the paragraph 
number and what you type next. 

4. Press Command-Shift-M (or choose Macro) to turn off macro 
definition. 

From now on, to number paragraphs automatically, Just press 
Command-Option-P. You can then start typing the text of your 
paragraph. - 
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Fixed Numbering 

You use fixed paragraph numbering when you want the Algor 
of the numbering to remain the same, no matter what tab stop you’re 
on. For example, you might want all of your paragraphs to be num- 
bered at the first tab stop, but in different style levels, like this: 

1. First-level paragraph 

1.1. Second-level paragraph 

1.1.1. Third-level paragraph 

Just type the level number you want to use in the dialog box instead 
of clicking Auto. 

You can use fixed numbering to set up a different paragraph num- 

bering style. For example, you might want to number all your ques- 
tions as (1), (2), (3), and so forth, instead of 1., 2., 3. If you bring up 
the Paragraph Numbering Definition dialog box and click Para- 

graph, you see that Level 4 produces numbers in that style. You can 

use that style at the left margin (the first tab stop), even though it’s 
normally used at the fourth tab stop, by entering 4 as the level in the 

Paragraph Level dialog box instead of clicking Auto. Then, even 
when you move the paragraph numbers with the Tab key, the num- 
bering style will remain Arabic numerals in parentheses, which is the 
Level-4 style. Try it and see. 

1. With the insertion point at the left margin, choose Paragraph 
from the Format menu and then choose Paragraph Number- 
ing (or type Command-3 2). 

2. This time, enter 4 and press Return (instead of clicking Auto). 

The style of number you get will be Level 4 of the Paragraph 

style—(1), (2), (3), and so on. When you press ‘Tab to move the 

text anywhere on the line, the numbering style stays the same. 

Outlining and Paragraph Numbering Codes 

When you use outlining and paragraph stl oI a paragraph 

number code [4#] is inserted into your text. If you re ae automatic 

paragraph ee) the code is [J#:auto]; if you’re using fixed 
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numbering, the code is [§#:7], where 7 is the level you specified. If 

you’ve defined a style for paragraph numbering, a [Def #] code is 
inserted at the point where you clicked OK in the Paragraph Num- 
bering Definition dialog box. You can use the Search commands to 
search for these codes, but you can’t search for a particular para- 

graph or outline number. 

Looking Forward 

Now that you’ve mastered WordPerfect’s outlining and paragraph 
numbering techniques, you can go on to learn about some of the 
other specialized features. Chapter 11 presents techniques for work- 

ing with footnotes and endnotes, and Chapter 12 discusses working 
with lists, tables of contents, and indexes. 



7 7 - Working with Footnotes 
and Endnotes 



To create footnotes, 

choose Footnotes from the Special menu (or press Command-9); 

then choose Create (or type 1). 

To create endnotes, 

choose Footnotes from the Special menu (or press Command-9); 

then choose Create Endnote (or type 5). Then write the text of 
either type of note and click on the Close box (or press 

Command-K) to close the window. 

To delete a note, 

delete its number. You’ll get a ‘‘Delete Footnote/Endnote?”’ 
prompt; click OK to delete it. 

To edit the text of a note, 

choose Footnotes (Command-9) and Edit (or type 2 for foot- 
notes, or 6 for endnotes). Then type the number of the note you 
want to edit. 

To specify a particular number for a note, 
choose New Note Number after you choose Footnotes from the 
Special menu (Command-9 3 is the keyboard shortcut). 

To change the formatting of footnotes and endnotes, 
choose Options after you choose Footnotes (or press Command-9 
4). The program is preset to give you superscripted Arabic num- 
bers for footnote numbers both in text and in the footnote itself : 
with the footnote indented five spaces from the left margin. 
Endnotes are also superscripted in text, but in the endnote list- 
ing at the end of the document, they have Arabic numbers fol- 
lowed by a period. 
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To change footnotes to endnotes, 374 
move to the beginning of the document, define Newspaper 
Columns, and turn on columns. Then delete the [Col Def] and 
[Gol On] codes or turn off columns to change the document to a 
one-column format. 



CHAPTER 7] 

WORDPERFECT HAS SEVERAL BUILT-IN FEATURES ON 
the Special menu that offer you quite a bit of help if you work with 
documents that require notes, tables of contents, lists, and indexes. 
This chapter is devoted exclusively to footnotes and endnotes, 

because there are so many tips and shortcuts you can use as you work 
with them. Chapter 12 will discuss tables of contents, lists, and 

indexes in detail. If you don’t use any of these specialized elements in 

the documents you write, you can safely skip these chapters. 
Many colleges and universities require a certain style for notes and 

citations, and many companies have their own internal ‘‘house”’ 
style for reports or for articles and bibliographies that are submitted 
to trade journals. Because you can customize the citation style the 
program uses, you can adapt WordPerfect’s note style to meet almost 
any requirements you come across. 

—____. Creatting Notes 

Footnotes, which appear on the same page as the text to which they 
refer, and endnotes, which appear at the end of your document, are 
both available in WordPerfect. (You’ll need to add a blank page at the 
end of the document if you want endnotes on a separate page.) You 
can use footnotes and endnotes together—footnotes to further 
explain material on the page where it is discussed in text, and end- 
notes for bibliographic material or suggested readings. WordPerfect 
maintains your note numbering system, so even if you delete or add 
notes, your notes are always numbered correctly. 

Figure 11.1 illustrates the bottom of a printed page that uses foot- 
notes, and Figure 11.2 shows the default style used for endnotes. As 
you can see, WordPerfect uses superscripted Arabic numerals in the 
references in text for both types of notes but doesn’t use the 



If you’re using 
endnotes, be sure to 

type an extra blank space 
before you type the text of 
your note. 
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superscripted style for the endnotes themselves. It inserts extra space 
between a footnote number and the text that begins the footnote, but 
doesn’t insert space between endnote numbers and text. The font 

used for both types of notes is the same style and size as the text of the 
document unless you change it. 

A business, once beyond the entrepreneurial stage’, next faces the 

challenge of organizing and managing itself as a stable company2. 

Managers who heretofore were rewarded for initiative and ingenuity are 

now penalized for overstepping the bounds of corporate rules; employees 

who in the past were rewarded for their willingness to change established 

theory must now follow corporate canons. In this stage of business 

growth, a radical change in the employee-manager mix may be noted3. 

At the same time the business is facing this challenge, it meets yet 

another challenge for managing for future growth. A dynamic business 

cannot be allowed to stagnate; it must always be planning for the future. 

The future, in such a case, may mean diversification rather than former 

concentration on a narrow set of goals. Yet another type of thinking is 

required: that of long-range planners4. 

These different types of idealists must manage a new set of options 

to provide for current stability while planning for future expansion. Such 

planners must be able to juggle one set of conservative assumptions while 

at the same time exercising a plan of highly imaginative proportions that 

concerns five- and ten-year growth plans and beyond. Such thinkers are 

scarce; when found, they command excellent salaries. 

1 Saul C. Guttman, Strategies for Business Growth, (New York: Hoffman, 

1988), p. 198. 

2 Paul L. Salomon, The Entrepreneurial Mind (Chicago: Row-Martin, 1988). 

3 This is also the time of the most rapid expansion in the number of 

employees, so the change in the mix of personality types may pass 

unnoticed. 

4 Eldon R. Wainwright, Long-Range Planning for Corporate Policy 

(Harrison & Ball: New York, 1988.) 

Figure 11.1: If you accept the default settings for footnotes, they’ll resemble 

the ones in this figure. 
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1.Saul C. Guttman, Strategies for Business Growth, (New York: Hoffman, 

1988), p. 198. 

2.Paul L. Salomon, The Entrepreneurial Mind (Chicago: Row-Martin, 

1988). 

3.This is also the time of the most rapid expansion in the number of 

employees, so the change in the mix of personality types may pass 

unnoticed. 

4.Eldon R. Wainwright, Long-Range Planning for Corporate Policy 

(Harrison & Ball: New York, 1988.) 

Figure 11.2: If you accept the default setting for endnotes, the notes in Figure 
11.1 would appear in this style. 

When you create a note, WordPerfect inserts a [Note#] code in the 
text at the point where you choose Footnotes from the Special menu 
(or press Command-9). The note numbers you see in your text are 
actually generated by these codes so that the program can keep track 
of notes as you delete them or add new ones. You can use the Search 



= You may inadver- 
tently delete the 

note number while you’ re 
writing in the Note win- 
dow. If this happens, 
you'll get a Delete Note 
Number? dialog box; 
press Return so that you 
don’t delete the number. 
If you delete the note 
number, the text of the 

footnote will still print. 
Then, to correct the 

situation, you’ll need to 
delete the whole note (by 
deleting its code) and 
create it again from 
scratch. 

hr The Speller will 
check note text 

when you spell-check 
your document. You can 
also use the Thesaurus 
(Command-T) while 
youre writing a note. 
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commands to search for these codes. For example, you may want to 
review the text of your footnotes before you print the document. 

‘To create a footnote or endnote, follow these steps when the inser- 
tion point is at the location where the note number is to appear. 

1. Choose Footnotes from the Special menu (or press Command-9); 
then choose Create (or type 1). 

If you’d rather have the material appear as an endnote at the end 
of your document, choose Create Endnote (or type 5). 

2. Write the text of the note. 

You'll get a blank full screen in which to write the text of your 
note. The name of your document (if you’ve saved it) and the 

number of the note will appear in the title bar. The note number 
will already be inserted on the screen, so you can just begin to 

type. If you prefer, you can select that number and change its 
style to bold, underline, or any of the other styles. 

You can write as long a note as you like, using any font and style 
available, even inserting graphics. Since footnotes are usually 
printed in a smaller font size than text, you’ll probably want to 
change to a smaller size at the beginning of the note. Also specify the 
font you want the notes to be printed in, if it’s to be different from 
the font that’s being used for text. (Later in this chapter, you’ll find a 
macro that will speed up this task.) 

If you’re writing a footnote, it will be printed on the same page as 
its reference, 0.25 inch below the last line of text. The space the foot- 
note occupies is subtracted from the space allotted to text lines on that 

page. If a note is so long or its note number so low on the page that 

the note has to be broken between pages, the program will keep at 

least three lines of the note on the page before continuing it to the 

next page. If the note number falls so low on the page that three lines 

of the note won’t fit, the text starting with the line with the note num- 

ber is moved to the next page, along with the note itself. 

3. When you’re finished writing the text of the note, click on the 

Close box (or press Command-K) to close the window. 

You’ll be returned to where you were in the text of your docu- 

ment, and a superscripted note number will appear at the inser- 

tion point. 
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You can see the first 

50 characters of a 
note by using the Show 
Codes command 
(Command-7). If you’re 
using short notes, you 
can quickly see what they 
contain this way instead 

of choosing Footnotes and 
then choosing Edit. 

O) If you’re using both 
footnotes and end- 

notes in a document, 

they’ll both start with the 
new number you spe- 

cified! To get around this 
problem, use the “‘Start 
footnote numbers each 

page”’ option for the 
footnotes, and use a 

different system, such as 
symbols instead of num- 
bers, to reference them. 

To see how your 
notes are being 

positioned on the page, 
use Print Preview. 
Choose Print Options 
from the File menu; then 

choose Print Preview (or 
type Command-Shift-P). 
To see the footnote area 
of the page in actual size, 
click on that part of the 
page. 

To delete the note associated with that number, you have to delete 

the number. You’ll get a “Delete Footnote/Endnote?”’ prompt; click 

OK to delete it. When you delete a note, the program automatically 

renumbers the remaining notes for you. 

Editing Notes 

You don’t have to have the-insertion point on a note to edit it. 

When you choose Footnotes (Command-9) and Edit (2, or 6 for end- 
notes), you’ll get a dialog box showing the number of the next note in 
your document. 

If that’s not the note you want to edit, you can enter the number of 
the note you do want to edit, and the program will display its text in a 
note window. When you’ve finished editing the note, close the win- 

dow. You’ll be returned to the place in your document where the note 

number appears. 

Assigning a New Note Number 

WordPerfect automatically numbers footnotes and endnotes; 

when you delete them or add new ones, the numbering system is 
updated. If you do need to specify a number for a note, you can 

choose New Note Number after you choose Footnotes from the Spe- 

cial menu (Command-9 3 is the keyboard shortcut). The program 
inserts a [SetNote#] code in your document. If you’re numbering 
notes consecutively in a book and are beginning a new chapter as a 

new document, you may want to do this. 
If you’re changing a note number that’s already in your docu- 

ment, make sure that the insertion point is to the left of the number 
you want to change. If it’s to the right of the note number, the pro- 
gram will change the number of the next note instead of the one you 
intended. 

Changing Note Options 

You can change several of the ways notes are presented on the 
page. ‘The Footnote Options dialog box (Figure 11.3) lets you change 
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& tile Edit Search Former Font Special Windouss 

Footnote Options 

Text-Footnote Separator Footnote Numbering 

© None © Numbers 

© 2 inch line © Characters 

O Line across page © Letters 

CL] Restart on each page 
Footnote Spacing 

From text ‘3 Endnote Numbering 

— : © Numbers 
Between notes in. O Characters 

© Letters 
Footnote Position 

© After text Note characters [ * 

@ Bottom of page Lines to keep together 

Figure 11.3: The Footnote Options dialog box lets you customize note styles. 

several formatting features for your footnotes and endnotes: 

e You can specify that no line at all, or a line running all the way 
to the right margin, be used to separate footnotes from text on 
the page. WordPerfect is preset to print a two-inch line begin- 
ning at the left margin to separate footnotes from text. 

e You can change the spacing used to separate footnotes from 

text. It’s preset to 0.25 inch. 

e You can change the line spacing between the notes them- 
selves. It’s also preset to 0.25 inch. 

e You can select whether footnotes are to appear all the way at 

the bottom of the page on which their reference falls, whether 
that page is full or not (the default), or right after the last line 
of text on the page. If your page runs short and you’ve 
clicked the After text button, any footnotes on that page will 

be printed immediately after the last line of text instead of at 

the bottom of the page. 

e You can change the numbering system from Arabic numer- 

als to letters or characters (symbols). If you change to charac- 

ters, the program is preset to use asterisks (*)—first one, then 
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O) Your readers may 

get hopelessly con- 
fused if you use the same 
numbering style for both 
footnotes and endnotes 
within one document! 
Change one of them 
(preferably footnotes) to 
either Characters or 
Letters. 

As you create a new 

™ style, you can click 
Bold, Underline, and 

Superscript in the Footnote 
Styles dialog box to get it 
exactly as you need it. 

two, and so forth, up to seven, when the system will start all 
over again. However, you can specify that the program use 
up to five different symbols. For example, if you use two sym- 

bols, the asterisk (*) and the pound sign (#), they’ll alternate 

like this: 

Note 1 * 

Note 2 # 

Note 3 ** 

Note 4 ## 

Note 5 *** 

Note 6 ### 

Note 7 **** 

e You can specify whether the footnote numbering system 
should restart when each new page begins or follow consecu- 
tively through the document (the default). 

e You can select the number of lines of the footnote to keep 
together when the program has to carry the text of a long 
footnote to another page. The default setting is three lines. 

Changing Note Styles 

You also have control over the way your notes are numbered. The 
program is preset to give you superscripted Arabic numerals for foot- 
note numbers both in text and in the footnote itself, with the footnote 
indented five spaces from the left margin. Endnotes are also 
superscripted in text, but in the endnote listing at the end of the docu- 
ment, they’ll be numbered with Arabic numerals followed by a per- 
iod. You may often need to use a different style, such as that 
prescribed by the American Psychological Association (APA) or the 
Modern Language Association (MLA) or by the journal you’re writ- 
ing for. This feature lets you adjust the numbering style accordingly. 
When you click the Styles button in the Footnote Options dialog 

box, you’ll get another dialog box like the one in Figure 11.4 showing 
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é File tdit Seavchk Format Fort Special Windeuss 

Footnote style string 

in text [E=Scind> Choe) rs 

in note ESrScript> Note) SerScript 

Endnote style string 

IN text | BerScipt> Mote) SerScript 

Figure 11.4: The Footnote Styles dialog box lets you customize the note num- 
bering system. 

the default styles for footnotes and endnotes. 
For example, suppose you wanted to change the footnote number- 

ing style to one in which the superscripted number was boldfaced and 
underlined. Figure 11.5 shows an example of how this would appear 

in a printed document. To create this style, fill out the Footnote Styles 

dialog box as shown in Figure 11.6. 

1. Click Styles in the Footnote Options dialog box. Drag across 
the [Note] code to select it. Then click underline. 

2. Select the codes again by dragging across them; then click 

Bold. 

3. Click OK. Then click OK again to accept the changes and 
close the Footnote Options dialog box, inserting a new [Note 
Opt] code in your document. 

From there on, you’ll see footnotes and their references in the new 

style on your screen as well as in your printed documents. 
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A business, once beyond the entrepreneurial stage, next 

faces the challenge of organizing and managing itself as a stable 

company-2. Managers who heretofore were rewarded for initiative and 

ingenuity are now penalized for overstepping the bounds of 

corporate rules; employees who in the past were rewarded for their 

willingness to change established theory must now follow corporate 

canons. In this stage of business growth, a radical change in the 

employee-manager mix may be noted2 

At the same time the business is facing this challenge, it 

meets yet another challenge for managing for future growth. A 

dynamic business cannot be allowed to stagnate; it must always be 

planning for the future. The future, in such a case, may mean 

diversification rather than former concentration on a narrow set 

of goals. Yet another type of thinking is required: that of long- 

range planners-4. 

1 Saul C. Guttman, Strategies for Business Growth, (New York: 
Hoffman, 1988), p. 198. 

2 Paul L. Salomon, The Entrepreneurial Mind (Chicago: Row- 
Martin, 1988). 

3 This is also the time of the most rapid expansion in the 
number of employees, so the change in the mix of personality types 
may pass unnoticed, 

4 : Eldon R. Wainwright, Long-Range Planning for Corporate Policy 
(Harrison & Ball: New York, 1988.) 

To edit a style 
you’ ve already set, 3 

locate its [Note Opt] code Figure 11.5: You can change the way footnote and endnotes are numbered. 
and position the insertion 
point to its right. Then 

choose Note Options Changing the Default Note Style 
from the Footnote sub- 

menu. You'll see the If you change to a note numbering style that you want to use con- 
options you’ve set, and siste : é 
Foe ates (hem ntly, you can save it as your default note style. Fill out the Foot- 
without starting from note Styles dialog box with a blank document on the screen. Then 
scratch. choose WP Defaults from the File menu, choose Save Settings, and 
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Before you change 
any footnote 

options, go to the begin- 
ning of your document 
(press Enter three times, 
then press the f key). 
That way, you’ll be sure 
that the changes apply to 
all the notes in your 

document, not just to 
those that occur after the 
point where you’ve 
changed the style. 

@ file Edit Search Format Fort Special Windouss 

Footnote style string 

in text | Botd>[Undrl> FerScript> Hote) SerScript] Undri] Bord] 

in note [= Ser Script (Note) <r Script] 

Endnote style string 

in text | FerScript> Tote) Ser Script 

Superscript Cancel 

Figure 11.6: Filled out this way, this dialog box produces a completely 
different footnote style. 

save the document as APA Style, or whatever name is appropriate. 
The next time you need to create an APA-style document, you can 

start WordPerfect by clicking on the APA Style icon in the System 

folder. If you’ ve already entered a document and want to convert it to 
the new style, you can use the File menu’s Retrieve command 
to bring the document you’ve already created into an empty docu- 
ment that’s using the custom default file settings. 

Tips for Entering Notes 

If you write notes frequently, you may find the following tips and 
macros helpful. 

Indenting Text in Notes 

WordPerfect will wrap the second line of text in a note back to the 
left margin unless you press Indent (Shift-Command-T) before you 
begin to type the note text. You’ll get a note that looks like this: 

1. Eldon R. Wainwright, Long-Range Planning for Corporate Policy 
(Harrison & Ball: New York, 1987). 
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If you need to 
repeat a note, copy 

it instead of typing it 

again. Put the insertion 
point to the left of the 
note number in your text 
and select it. Just select 
the superscripted num- 
ber, not any text sur- 
rounding it. Then copy it 
and paste it wherever you 

want it. The rest of the 
numbers will adjust. 

If you’ll be using 
several citations 

repeatedly in a docu- 
ment, keep them in a 
separate document win- 
dow and cut and paste 

them as you need them. 

If you’ve changed 
M8 font sizes in notes 
but your notes are still 
printing in the wrong font 
or the wrong size, open 
the Codes window. There 
may be extra [FontSize] 
and [SetFont] codes. 
WordPerfect uses the 
codes that are closest 
before the text. 

Instead of like this: 

1. Eldon R. Wainwright, Long-Range Planning for Corporate Policy 
(Harrison & Ball: New York, 1987). 

Choose Indent (or press Command-Shift-T) first to make your notes 
easier to read. 

Changing Font Size in Notes 

If you want your notes to be in a different size from your text, 
you’ll need to change font size at the beginning of each note. It’s easy 

to forget to do this, so here’s a macro that not only switches you to a 
smaller size but also indents the text as just described. It assumes that 
you want to switch to 10-point for the note from a larger type for the 
text. When you record the macro, you can substitute whatever font 
size you want. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) and name the macro. 

You might want to assign it to Command-Option-F so that you 
can use it quickly. 

2. Choose Footnotes from the Special menu; then choose Create 
(or press Command-9 1). 

3. Choose 10 from the Font menu. 

4. Press Command-Shift-T to indent the note text. 

5. Press Command-Shift-M to end macro definition. 

When you use the macro, WordPerfect will automatically take 
care of the font size change and indenting for you. You can start 
entering the text of your footnote as soon as you execute the macro. If 
you’re using endnotes rather than footnotes, you can change step 2 to 
Command-9 5. 
Why not write the macro so that it would prompt you for your 

footnote text? There’s a good reason: you can’t use italics (for titles) 
in the prompt dialog box. 



Oo) Using Select All 
(Command-Shift-A) 

in a document with notes 

doesn’t select the notes. 

For example, if you 
change the font in text 
with Select All, you’ll still 
need to edit each note 

and change its font, if you 
want the notes to be in 

the same font as the text. 

1) If you’re using 
italics for titles in 

notes, choose Italics from 

the Style submenu 
(Command-Y) or press 
Command-Shift-I to turn 

them on and off. If you 
select the title and click 

the I box in the status 

line, WordPerfect some- 

times has trouble printing 
italics (or any of the other 
styles) in notes or in 
headers and footers. 
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Macro: Multiple Citations 

If you’re citing a work of one author several times, you can write a 
macro that inserts the note for you and then pauses for you to enter a 
specific page reference. The following macro is designed to be used after 
you ve entered the first full reference for the work. The macro is named 
Smith, but you would of course name your macro with the name of the 
author whose works you’ re citing. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) and name the macro 
Smith (or enter your own author’s name). 

so Choose Footnotes from the Special menu; then choose Create 
(or press Command-9 and type 1). 

For an endnote, use Command-9 5. 

3. Choose Indent from the Paragraph submenu (or press Shift- 
Command-T) to indent the text you’re going to enter. 

4. Type Smith, p. (or your author’s name). 

Be sure to type an extra space after the period so that you can 
begin typing immediately when you run the macro. 

5. Choose Macro; then choose Pause (or press Command-M 6) to 
insert a pause for you to enter a page number or delete the p. 
and enter a reference to another of Smith’s works. 

6. Now choose Resume or press Command-M 6. Type a period to 
end the note. 

7. Press Command-K to close the Footnote/Endnote window. 

9. Press Command-Shift-M to end macro definition. 

When you use this macro, position the insertion point where you 

want the note to appear. When WordPerfect pauses, you can enter 

the correct page reference for your author, or you can enter the title of 

another of your author’s works and a page reference for it. If you 

enter the title of a work that needs to be italicized, be sure to turn 

italics on when the macro pauses and turn it off again after you’ve 

entered the title. Then choose Resume Macro (or type Command-M 6) 

when you’ve entered the text for the note. 
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hr You can’t create 
footnotes if you’re 

entering text in columns. 
You can create endnotes, 

though. 

Changing Margins in Notes 

Normally, the note margins will be the same as the text margins in 

your document. However, if you change the margins in your docu- 

ment, the note margins don’t automatically adjust. The WordPerfect 

manual states that to make sure your note margins have been 
updated after you change margins in your document, you can choose 

Count from the Speller menu to perform a word count, in the course 
of which WordPerfect is forced to go through the entire document, 
updating the margins in the process. (I don’t know why this “‘fea- 
ture’’ was left in from the IBM version of the program, but here it is.) 
If you prefer, you can display each note in the Footnote/Endnote 

window (press Command-9 and choose to edit the note) and then 
close the window without changing anything; this also changes the 
note margins. But because the program’s Search feature searches 
through footnotes and endnotes as well as text, the fastest way of all is 

simply to move to the beginning of your document and search for a 

code that you know isn’t in your document. 

Changing Footnotes to Endnotes 

The WordPerfect manual gives a helpful macro for changing foot- 
notes to endnotes and vice versa. ‘The macro calls each footnote into the 
Footnote/Endnote window, cuts it, exits from the window, deletes the 

footnote number, creates an endnote, and pastes the cut footnote text. 

However, because the program automatically converts footnotes to end- 

notes when columns are turned on, the fastest way (still undocumented, 
as far as I can tell) is to move to the beginning of the document, define 
Newspaper Columns, and turn on columns. This automatically con- 
verts all the footnotes in the document to endnotes. To convert your doc- 
ument back to regular text but leave footnotes as endnotes, just delete 
the [Col Def] and [Col on] codes. 

Printing Endnotes 
Endnotes are normally printed at the end of your document, as 

Figure 11.7 illustrates. If you want them to be on a separate page 
from the last text in the document, go to the end of the document and 



If you want end- 
notes to begin on a 

right-hand page in a 
bound document, that 

page must be odd- 
numbered (insert a blank 
page if you need to). 

Stages in Business Growth 

A business, once beyond the 

entrepreneurial stage1, next 

faces the challenge of 

organizing and managing 

itself as a stable company2. 

Managers who heretofore 

were rewarded for initiative 

and ingenuity are now 

penalized for overstepping 

the bounds of corporate 

rules; employees who in the 

past were rewarded for their 

willingness to change 

established theory must now 

follow corporate canons. In 

this stage of business growth, 

a radical change in the 

employee-manager mix may 

be noted3. 

At the same time the 

business is facing this 

challenge, it meets yet 

another challenge for 

managing for future growth. 

A dynamic business cannot be 

allowed to stagnate; it must 

always be planning for the 

future. The future, in such a 

case, may mean 

diversification rather than 

former concentration on a 
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narrow set of goals. Yet 

another type of thinking is 

required: that of long-range 

planners4. 

These different types of 

idealists must manage a new 

set of options to provide for 

current stability while 

planning for future 

expansion. Such planners 

must be able to juggle one set 

of conservative assumptions 

while at the same time 

exercising a plan of highly 

imaginative proportions that 

concerns five- and ten-year 

growth plans and beyond. 

Such thinkers are scarce; 

when found, they command 

excellent salaries. 

1.Saul C. Guttman, 

Strategies for 

Business Growth, (New 

York: Hoffman, 1988), 

p. 198. 

2.Paul L. Salomon, The 

Entrepreneurial Mind 

(Chicago: Row-Martin, 

1988). 

you insert a hard page break. 

3.This is also the time 

of the most rapid 

expansion in the 

number of employees, 

so the change in the 

mix of personality 

types may pass 

uanoticed. 

4.Eldon R. Wainwright, 

Long-Range Planning 

for Corporate Policy 

(Harrison & Ball: New 

York, 1988.) 
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Figure 11.7: Endnotes will be printed starting on the last page of text unless 

insert a hard page break (Command-Return). If you want that page 

to have a heading, such as For Suggested Reading or Bibliography, you can 

enter a heading for the endnote page. 

Endnotes can cause a little trouble if you’re also creating an index 

that must appear as the last element in your document. To get 
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6 Needless to say, 

prepare your index 

in this way only when 

your document is in its 
final form and ready to 

print. If you make any 
changes that affect pagi- 
nation in the original 
document after you print 
the index, the page num- 
bers in the index entries 
won't be accurate. 

around it, follow these steps: 

1. Generate your index first, select it, and save it as a separate file. 

2. Delete the [Index] code from the original document. 

3. Print the original document; then print the index as a separate 

document, paginated as i-1, i-2, and so forth, or paginated begin- 

ning with the number after the last page in the document. 

Remember to use an odd-numbered page if you want the index 
to begin on a right-hand page in a bound document. 

Looking Forward 
You’ve seen many tips and shortcuts in this chapter for working 

with footnotes and endnotes. For advice about general rules to follow 

when writing notes and citations, you may want to consult a style 
guide such as The Chicago Manual of Style, 13th ed. (University of Chi- 
cago Press, 1982). 

Because the types of documents that require footnotes and end- 
notes often require tables of contents and indexes also, you may be 
interested in the material in the next chapter. It shows you how to use 
WordPerfect to automatically keep track of lists, headings for the 
table of contents, and index entries. 
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Fast Track 

To create a list, table of contents, or index, 380 

youuse a similar procedure in each case. First, go through the 
document, selecting the text that’s to be included in the list, table 

of contents, or index. Press Command-J (or choose Mark Text 
from the Special menu). Enter 1 to include the item in List 1, 2 for 

List 2, and so forth. Choose Table of Contents or Index if you’re 
marking text for one of those, then press Return. 

To define the style of a list, 382 
go to where you want the list to appear in your document and 

select Define Lists. A [DefMark] code will be inserted in your 
document. 

To generate the lists in your document, 383 
choose Generate from the Mark Text submenu (or press 
Command-Shift-G). No matter where you are in the document 
when you press Command-Shift-G and click Yes, WordPerfect 
will generate a list, table of contents, or index for each one 

you’ve defined—each located at the place where you inserted 

its [DefMark] code. 

To change the style 383 
of a table of contents, list, or index, search for the [DefMark] 

codes in your document, delete them, and define new ones. 

To delete any of these special lists, 383 

delete its [DefMark] code, the actual text of the list, and the 

[Def] code that ends the list. 



CHAPTER 

If you need more 
than five lists, or if 

you need some items to 

be included in more than 
one list, make a copy of 
your document and 
generate the extra lists 
from it. 

12 

IN ADDITION TO ITS FOOTNOTE FACILITIES, WORD- 
Perfect’s Special menu has several features for creating reference 
tools. For example, if you’ ve just written a long report or chapter in a 

book, you may want to create a table of contents, a list of illustrations 

or tables, or an index of key words. WordPerfect considers each of 
these three types of reference aids a special type of list. Not only does 
the program keep track of the lists’ titles for you, but it also monitors 
the page number on which each item in each list occurs. 

There are three basic steps in creating a list in WordPerfect: 

1. Go through the document, marking the text in your document 
that’s to be included in the list. 

2. Go to where you want the list to appear in your document and 
define the style that’s to be used for the list. 

3. Generate the list. 

We'll look first at the process of creating a simple list of figures or 
tables. Creating the other types of lists—tables of contents and 
indexes—are just variations on this technique. The general process is 
the same for all three types of lists, but there are some additional consid- 
erations you'll need to be aware of for tables of contents and indexes. 

Creating. Lists: sitet) ot jot, 
WordPerfect can keep track of up to five plain-vanilla lists in a doc- 

ument (as opposed to indexes and tables of contents). For example, 
as I write, I’m having the program keep track of all the figure cap- 
tions so that they will be printed on a page of their own and can be 
given to the editor and illustrator separately from the text. I usually 



You can’t mark text 

for a list unless 

you’ve selected something 
first. 

If you’re working 
with several lists, you 

may want to make a note 
of what each one contains 
and keep the note as a 
reminder in a separate 
document window, where 

you can refer to it from 
time to time. List 1 might 
be figures, List 2 program 
listings, List 3 tables, and 
so forth. It’s easy to forget 
which is which. You can’t 
use the same text in more 
than one list, but you can 
include a piece of text in a 
list and also include it in a 
table of contents or index. 
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enter all the text for the chapter and then go back and mark the cap- 
tions to be included in the list, but you can also mark entries for inclu- 
sion in a list as you type them. 

Marking Text for a List 

‘To mark items for a list, follow these steps: 

1. Select the text you want to include in the list. 

2. Press Command-J (or choose Mark Text from the Special 
menu). Press 1 (or select List). 

3. Enter 1 to include the item in List 1, 2 for List 2, and so on; 

then press Return. 

WordPerfect inserts [Mark: List n] codes at the beginning and end of 
the selection (n is the number of the list), as shown in Figure 12.1. 
You can delete either one of these codes to delete the list marking. 

4, Continue through your document until you’ve marked all the 
items to be included in each list. 

J é@ File Edit Search Format Font Special Windows 

Doc 2: Ch 11 final 

Figure 11.1: If you accept the default settings for footnotes, 

they'11 resemble the ones in this figure 

Figure 11.2: The same footnotes as in Figure 11.1 appear in this 

style if you select Endnotes instead 

we 
eameritina4  o FPlejOLo|S| ee 

[Marklist) [Bold>Figureo 1 1.1:@old] olfoyoudaccept othe odefault osettings Ofor Ofootnotes sa) 

they'll Oresemble Othe ones Oinothis Ofigurell Hark list] 

Bold>Figureo11.2:old]O OThe Osame Ofootnotes Oas OinOFigureo11.1 Oappear Oinothi 

|_styleoif oyoudcselect o Endnotes oi nstead 

Figure 12.1: WordPerfect inserts special codes around each list selection to 

indicate which list it belongs to. 



382 Mastering WordPerfect on the Macintosh 

CH e112 

If you want lists to 
appear at the begin- 

ning of a document, be 
sure to begin new page 
numbering for text pages 
as page 1 (use Command- 
2 2 to get the dialog box 
up quickly). Otherwise, 
your list will start at page 
1 and your main text will 
start with a page number 
other than 1. 

Defining the List 

After you’ve marked the items you want to include in a list, the 
next step is to specify the format you want the list to have. Here’s an 
important point: Where you put the list definition determines where 
the list appears in the document. If you want a list of illustrations on a 

separate page at the end of your document, you’ll need to go there 
and insert a hard page break for the list before you define it. Also, if 
you want the list to have a heading, you’ll need to enter it on that 
page above the list definition. 

You’ll probably find it most efficient to mark all the text that’s 
going into each list and then define the styles for the separate lists. 
WordPerfect lets you select five different styles for lists from the dia- 
log box shown in Figure 12.2. 

‘To define the style of a list, follow these steps: 

1. Go to the place in your document where you want the list to 
appear. 

2. Choose Define Lists from the Special menu and choose the list 
you want to define (1-5). 

3. Click on a numbering style; then click OK. 

% file Edit Search Format Font Special Windouss 

Doc 3: Untitled 

Page Number Position 
Type 

@ No Page Numbers 

© Page Numbers Follow Entries 

© (Page Numbers) Follow Entries 

© Flush Right Page Numbers 

© Flush Right Page Numbers With Leaders 

Figure 12.2: You can select from five different page numbering styles in lists. 



If you’re getting 
lists generated at 

odd places in your text, 
it’s probably because 
there are extra 
[DefMark: List] codes 
there. Use Show Codes to 
examine the codes, or 

search for the codes and 
delete any extra ones. 

You can change a 
list’s style after it’s 

been generated. Search for 
the [DefMark] code (it’s 
listed in the Ms in the 
Search dialog box) and, 
when you’ ve found it, 
press Delete to delete it. 
Then define a new style for 
that list again and regener- 
ate your list. Be sure to 
delete the old code before 
you define the list, or 
you’ll get two separate 
lists. 

If you do much 
editing in a docu- 

ment, regenerate your 
lists again. You may have 
changed an item that 
appears in a list, and 
WordPerfect doesn’t 
automatically update the 
corresponding entry in 
the list itself. 
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Clicking OK (or pressing Return) inserts a [DefMark: List] code in 
your text. If you decide you don’t want to use that style, you’ll need 
to delete the code. If you use the second or third styles, page num- 

bers will appear two spaces after the entry. If you use one of the last 

two styles, the page numbers are flush with the right margin. 

Generating the List 

When you’ve marked all the text and defined all the styles for the 
lists you want, the final step is to generate the lists. The keyboard 
shortcut is Command-Shift-G. Of course, you don’t have to wait 

until you’re completely finished with a document; you can generate 
lists at any time. Each time WordPerfect generates lists, it replaces 

the old lists with the items that are currently marked as list items. 
You’ll get a dialog box each time you generate lists asking whether 
you want the old lists deleted. If you don’t want to have the exist- 
ing lists replaced, click No or Cancel, and you’ll be returned to your 
document. 

As each list is generated, you’ll see a counter on the status line to let 
you know the progress of the generation. WordPerfect places a [Def] 
code after each list, indicating the end of the list that’s been defined. 

If you want to delete a list completely from your document, delete 

its [DefMark] code, its text, and its [Def] code. If you erase a 
[DefMark] code but don’t erase its accompanying [Def] code that 
indicates the end of the list, you’ll get a message saying that the 

DefMark for that table is missing, and no list will be generated, but 
the old one will still be there. 

To automate the process of marking text for lists, you can write a 
macro that will mark all the items in a list for you. This can be a great 
timesaver in long documents. The only additional step you’ ll need to 
take is to use some unique symbol or code to indicate the list items. 
For example, I use bold for the first few words in a figure caption, so I 

can search for each [Bold] code, select the sentence or line it’s on, and 

mark it for List 1. If you aren’t using a style code like bold or under- 

lining for the items to be in a list, you can use an unusual pair of sym- 

bols like && to indicate list items as you type them. You can then 

write the macro so that it will delete the symbols from the document 

as it locates and marks them. 
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Macro: Automatically Marking a List 

Here’s a macro that will locate each initial [Bold] code that is fol- 

lowed (in my case) by the word Figure. The macro automatically 

marks the sentence it’s in for inclusion in a list. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M). Name the macro. 

(Mine’s named list3.) 

2. Choose Forward from the Search menu (or press Command-F). 

3. Click on the first [Bold] code; then click Insert to insert it in 
the Find box. Type Figure and press Return. 

If you’re modifying this macro for your own special lists, enter 
whatever you want the macro to search for. 

4, Select the sentence WordPerfect has located (Command-6 2). 

If your list items include more than one sentence, you can have 
the macro select the paragraph instead. 

5. Select Mark Text (Command-]J) and type 1 for List; then sim- 
ply press Return, since List 1 is the default. 

If you want a chance to assign the located items to various lists, 
you can have your macro delay and pause in the dialog box. 

6. Press Command-. to turn off Select. 

7. Choose Macro; then choose Define Macro (or press 
Command-Shift-M) to end macro definition. 

You’ ve now got a macro that marks all the captions (sentences con- 
taining the boldfaced word Figure) to be included in List 1. When 
you use the macro, go to the beginning of your document, before any 

codes (press Enter three times; then press the t key). Then press the 
Esc key and enter a number that’s larger than the number of items in 
the list—say, 100—so that the macro will repeat itself. Choose Exe- 
cute Macro (or press Shift-Command-X) and select the macro’s 
name. It will then execute over and over until all the figure captions 
have been marked for List 1. - 

This macro isn’t appropriate if the text you’re marking is longer 
than one sentence and it isn’t a paragraph you can select automati- 

cally. To make the macro more flexible, have the program pause for 
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you to extend the highlighting to the entire selection and press 
Return. Just change step 4 as follows: 

4. Choose Pause Macro from the Macro submenu. 

Then, when the macro executes, you can highlight as much text as 
you want to have included in each list item. Choose Resume Macro 
to continue the macro. 

Defining the List 

The next step is to define the list. 

1. Choose Macro from the Special menu; then choose Define 
Macro (or press Command-Shift-M) to define the macro. 

Name it define list, or whatever helps you remember it. 

2. Press Enter three times, then press the \ key to go to the end of 
the document. 

This list is defined at the end of the document so that the docu- 
ment itself will start on page 1. You may want lists of tables or 

illustrations to be printed at the beginning of the document. 

3. Create a blank page for List 1 by pressing Command-Return. 

4, Choose Define Lists from the Special menu; then choose List 1 
and press Return. 

If you want page numbers for each item in your list, choose the 
style you want before pressing Return. 

5. Choose Macro; then choose Define Macro (or press 

Command-Shift-M) to end macro definition. 

One fine point you may find useful if you write any of these search- 

and-mark macros: You need to be careful about what you highlight 

for inclusion in the list. For example, if you highlight a line that con- 

tains [Center] codes, that [Center] code will be copied into your list, 

so the list may not be formatted as you’d like when it’s generated. If 

there are a lot of formatting codes in your document, you may want 

to have the macros pause so that you can choose Show Codes 

(Command-7) and check the placement of the insertion point when 

you select the text of the list item. 
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ter You can create 

tables of contents for 
very large documents 
because WordPerfect uses 
virtual memory as it 

generates them. It can 
create a table of contents 

for a 300-page document 
just as easily on a Mac 
Plus as on a Mac II. 

Working with Tables of Contents 

Normally, creating a table of contents is a time-consuming chore. 

You have to search through your document, write down each head- 

ing exactly as it appears, note its page number, and finally enter the 

entire table. WordPerfect will do most.of this work for you: all you 

have to do is mark each heading and indicate its level. 
WordPerfect keeps track of up to five levels of headings that can be 

included in a table of contents. As-this feature is simply a variation on 
the list feature, you’ re already familiar with the basic technique: first, 
mark the headings (you’ll be prompted for the level of each heading), 
then define the format of the table of contents, and, finally, generate it. 

Here’s the basic procedure: 

1. Go through your text and mark each heading you want to 
include in the table of contents. Each time you locate a head- 
ing, select it and then choose Mark Text from the Special menu 
(or press Shift-Command-J). 

You'll see a dialog box with five buttons for Levels 1-5. 

. Click on the appropriate button for the heading you’re marking 
or type the number of the level; then press Return or click OK. 

. After all the headings are marked, go to the place where you 
want the table of contents to be generated and insert a hard 
page break (Command-Return). 

For example, you may want the table of contents to follow a title 
page. First, create the title page at the beginning of the docu- 
ment. Then enter a hard page break and type a heading for your 
contents page. (If you’re printing the document two-sided, you’ll 

want a blank left page between the title page and the table of con- 

tents so that the table of contents will start on a right-hand page.) 

. Move the insertion point to the line where you want the first 
line of the table of contents to appear. 

. Choose Define Lists from the Special menu; then choose Table 
of Contents. 

You’ll see the dialog box in Figure 12.3. 
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hr How the various 
levels in your table 

of contents are indented 
depends on the tab set- 
tings that are in effect. 
The first level appears at 
the first tab stop, the 
second level at the second 
tab stop, and so forth. If 
you don’t want the 
default setting of five- 
space tabs, change the 
tabs before you define the 
style for the table of 
contents. 

r ‘ 3a va ~ 7 z 
@ tile tdit Search Formet Font Special Windouss 

Doc 3: Untitled 

Table of Contents Definition 

Page Numbers 

ONone 

© # Follows Entries 

© (#) Follows Entries 

© # Flush Right 

© # Flush Right with Leaders 

CJ Display last level in wrapped format 

Figure 12.3: The Table of Contents Definition dialog box lets you specify how 
page numbers are to appear. 

6. Click the level whose style you want to define first. You can 
have up to five levels. 

. Select a page numbering style by clicking one of the choices in 
the Page Numbers box. 

The first choice under Page Numbers uses no page numbers. 

With the second and third choices, page numbers are two spaces 
after their heading entries (the third choice encloses the number 
in parentheses). In the last two choices, page numbers are flush 
on the right margin, in the last case preceded by dot leaders (the 
default). As you click on the page number choices, the Style box 

changes to reflect your choice. 

. Repeat steps 6 and 7 for all the levels you have used. Click on 
the level number, the style (if you want to change it), and the 
Page Numbers style. If you want the last level used in the table 
to be wrapped into a paragraph format, rather than printed on 
separate lines, click “‘Display last level in wrapped format.” 

If you choose that style, don’t use flush-right numbers for the last 
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bar You don’t have to 
be on the Contents 

page to generate a table 
of contents—or any other 
type of list, for that mat- 
ter. No matter where you 
are in the document when 

you press Command- 
Shift-G (for Generate) 
and click Yes, WordPer- 

fect will generate a table 

of contents or list at the 
location of the corres- 

ponding [DefMark] code, 
which indicates where 
you were when you defined 
each list. 

To change the style 

of a table of con- 

tents, list, or index, 

search for the [DefMark] 
codes in your document, 
delete them, and define 

new ones. Otherwise, 

you'll get extra tables of 
contents, lists, and 

indexes—one for each 

[DefMark] code Word- 
Perfect finds. 

= It’s possible to get a 
few error messages 

when you generate tables 
of contents. The most 
common is the “‘Not 
Enough Memory”’ mes- 
sage. Close all your docu- 
ments except the one 
you re generating the 
table for and try again. If 
you forget to define the 
table of contents before 
you generate it, you’ll get 
a message to remind you. 
If you get two tables of 
contents, you’ve got two 
[DefMark:TofC] codes, 
so delete one of them. 

10. 

11. 

12. 

be 

level. Use the third style, in which page numbers are in parenthe- 

ses two spaces after each entry, or change it to the second style, 

which doesn’t use the parentheses. 

. Click OK when you’ve selected a style for each level you have 

used. 

When you click OK, WordPerfect inserts a [DefMark:TofC] 

code in your text. The table of contents will be generated at that 

point. 

Press Command-Return to create a page break and begin the 
text of your document on a new page. 

If you’re using any other front-matter pages, such as a list of 

figures or an acknowledgments page, you’ll want them to occur 

before the first text page. Create a page for each of these ele- 
ments. With several pages of front matter, it’s a good idea to use 

Roman numerals to number those pages (press Command-2 2 to 

get the Page Numbering dialog box quickly). In addition, you’ll 
probably want to suppress printing the page number for the title 

page and any blank pages in the front matter. Command-2 3 
brings up that dialog box. 

With the first page of the main text of your document on the 
screen, press Command-2 2 and enter 1 as the new page number. 

Press Command-Shift-G to generate the table of contents. 

A dialog box appears, warning you that the program will replace 
any existing tables of contents, lists, and indexes. 

Click Yes to continue, or click No or Cancel to return to your 
document. 

Figure 12.4 illustrates a table of contents that’s been printed in the 
default style. 

In Chapter 8 we used a table of contents macro as an example of 
chaining macros. You may want to look back at it now to see whether 
it can be of use to you, now that you’ve gone through the steps 
involved in creating tables of contents. 
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Contents 

Exercise: Formatting Existing Text into Newspaper Columns 

Exercise: Retrieving Text into Newspaper Columns 

Exercise: Working with Parallel Columns 
Moving Between Columns 
Editing Parallel Columns 

Macro: Selecting Parallel Columns 
Moving Parallel Columns 

Incorporating Graphics in Your Documents 
Sizing Graphics 
Copying and Moving Graphics 
Types of Graphics 
Graphics Tips 

Avoiding Extra White Space 
Reversing out Text 
The Full-Clipboard Problem 
Creating Duplicate Images 
Special Typographic Effects 
Resizing Images 
Working with Text in Graphics Programs 

Desktop Publishing with WordPerfect 
Using a Grid System 
Design Hints 

Serif or Sans Serif? 
Heading Tips 
Changing the Layout 
Unequal Columns 
Kerning and Letterspacing 
Headers and Footers 
Leading and Vertical Rules 
Subheadings 
Mixing Flush Left and Right Text 
Mixing Leadings 
Switching Column Formats 

Drop Caps 

Using Special Symbols 

Project: Creating a Newsletter 
Specifications for the Examples 

Sources for Clip Art and Graphics 

Nelson, Macintosh WordPerfect Page 5-59 

Figure 12.4: If you use the default style for tables of contents, dot leaders pre- 

cede page numbers. 

Indexing 

Indexing is similar to creating a table of contents or a plain-vanilla list. 

Basically, you mark the words or phrases you want to use as headings 



390 Mastering WordPerfect on the Macintosh 

GH12 

You don’t have to 
highlight what 

you ’re going to index if 

it’s only one word. As 
long as the insertion point 

is somewhere in the 
word, WordPerfect will 

know which word you 

mean and will highlight it 
for the index. 

If the word or 
phrase that’s 

selected and moved to the 
Heading box is the sub- 
heading you want to use, 
Just start typing a new 
heading. The selected 
word or phrase will auto- 
matically move to the 

Subheading box. 

and subheadings in the index, and WordPerfect keeps track of them and 
their page numbers for you. You can have only two levels of alphabetical 
entries in the index: headings and subheadings. The subheadings are 
indented and alphabetized within the headings you specify for them. 

Marking Index Entries 

When you mark an entry to be included in an index, a dialog box 

like the one in Figure 12.5 appears. The text that’s selected is auto- 

matically presented in the Heading box. 
To mark the word as a heading, press Return. If you want to 

include a subheading with the heading, press Tab instead of Return. 

This moves the cursor to the next box, where you can type your sub- 
heading and press Return. 

You can see the heading and subheading displayed following an 

[Index] code in the Codes window. For example, in Figure 12.6 the 
phrase Performance appraisal has been marked as a heading with the 
subheading scheduling. 

You can use more than one index code in the same place in your 

$ file Edit Search Format Fort Special Windouss 

Heading 

SubHeading 

Figure 12.5: The Index dialog box lets you specify a heading and a subhead- 
ing for each index entry. 



WordPerfect follows 
the capitalization 

that appears in your text. 
If you want index entries 
to appear any other way, 
you'll need to make the 
change before accepting 
the suggested entry. 

As you mark text 
Mm for an index, it’s 

easy to forget how you 
phrased earlier entries. 
Did you mark Master 
files as Files, master or 

Master files? Keeping a list 
of the phrases you’ re 
using in another window 
can help you remember 
how you planned to word 
index entries and keep 
them consistent. 
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oc 3: index example, ch 13 

A well-designed m¥¢oyihOLEEsgoebeeel system has as its 

foremost characteristic a regularity of schedule so that ongoing 
communication can be maintained between employee and Manager. The 
schedule itself can be an annual system, or intermittent ap- 
praisals can take place as significant achievements occur. 

schedule Oitself OcanobeOandannual Osystem, Sor Ointermittent oap [oft-)praisals Ocanotake Oplac 

edasOsig nificantOachievements Ooccur.> 

Figure 12.6: When you mark an item for an index, you can see the heading 
and subheading in the Codes window. 

text. In Figure 12.6, the topic has been indexed as the entry value- 
based systems as well as performance appraisals. 

You aren’t confined to using only words and phrases as they 

appear in your text. One common example is proper names, which 
usually appear in text with the first name first and the last name last, 
like Joan Smith. In your index, you want the entry to be Smith, Joan so 

that it can be alphabetized correctly. Just press Delete to delete Word- 

Perfect’s suggested entry and type in your own. You can also create 
See and See also references this way. 

Macro: Marking Text for an Index 

If you do a lot of indexing, you’ll probably want to record a short 

macro that will bring up the Index dialog box quickly when you press 
Command-Option-I. You’ll need to have a word or phrase selected 
on your screen when you record this macro. 

1. Choose Macro from the Special menu; then choose Define 

Macro (or press Command-Shift-M). Assign the macro to 
Command-Option-I. 



392 Mastering WordPerfect on the Macintosh 

CH. 12 

hr If you’re using end- 
notes, they’ll be 

printed after the index. See 
the tip in Chapter 11 for 
how to get around this. 

If you want a 
comma between the 

text and the page num- 
ber, you’ll have to enter it 
as you mark text for the 
index. 

2. Choose Mark Text from the Special menu; then choose Index. 

3. Choose Macro; then choose Pause for Dialog. 

4, Press Command-Shift-M to end macro definition. 

When you run the macro, it will pause for you to edit the word the 
insertion point is on or add a subheading for the index entry. 

Selecting an Index Style 
Once you’ve marked all the words and phrases you want to have in 

the index, the next step—just as with creating lists and tables of 
contents—is to create a style for the index. Again, the place where 

you define the style determines where the index will appear in your 
document. For the page numbers to be accurate, the index should 

begin on the last page of the document after the text. 

1. Move to the end of your document and create a hard page 
break (Command-Return). 

2. Enter a title for the index if you want one; then move to the 
line where you want the first index entry to appear. 

If you want your index in columns, define newspaper columns 
and turn columns on. 

3. Choose Define Lists from the Special menu; then choose Index 
(or type a 7). 

You'll see a dialog box like the one in Figure 12.7. 

4. Click on the numbering style you want to use for your index; 
then click OK or press Return. 

Headings and subheadings will use the same style. 

The most common style for an index is the second choice, in which 
page numbers follow entries, as in the example in Figure 12.8. 

Generating an Index | 

Like the other types of automatic lists WordPerfect provides, 
indexes are generated when you press Command-Shift-G. You’ll be 
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Doc 3: Untitled 

Page Number Position 
Type 

@ No Page Numbers 

© Page Numbers Follow Entries 

© (Page Numbers) Follow Entries 
© Flush Right Page Numbers 

© Flush Right Page Numbers With Leaders 

Figure 12.7: You can also specify how page numbers appear in the index. 

Northernmost provinces 552 
Southern kingdoms 551 
Aethelred the Unready 566 
Anglo-Saxon State 570 
Archaeological evidence 548 

artifacts in graves 548 
place names 548 

Danish invasions 560 
Edward the Confessor 567 
Geographical factors 548 
Norse approach, the 558 
Saxon invasion 

Sources 548 
Traditions 548 

Scandinavian influences 557 
Vitae Duorum Offarum 548 

Figure 12.8: WordPerfect’s default index style produces indexes like this one. 
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If you’re indexing a 

very large docu- 

ment, like a book, and 

run out of memory, 
number its pages by 
chapter (5-1, 5-2, and so 

on) and index each chap- 
ter separately. (Of course, 
the page references won’t 
include the characters 5-.) 
Although it’s tedious, you 
can generate a separate 
index for each chapter 
and combine them by 
cutting and pasting. 

told that the existing tables, lists, and indexes will be replaced. Click 
OK to go ahead with the generation. 

If you get a ‘‘Not Enough Memory”’ message, close all your docu- 

ments except the one you’re generating the index for and try again. 

You can create more than one index for a document. For example, 
you might want to create one index of authors and a separate index of 
topics. Just delete the [Def] code that appears after you generate the 
first index. If WordPerfect can’t find the [Def] code, it considers the 
index it generated to be text and doesn’t automatically delete it when 

it generates a second index. You’ll need to search for and remove all 
the first [Mark'Text: Index] codes before you mark text to be included 
in the second index, though. 

Looking Forward 

At this point you’ve covered all of WordPerfect’s specialized fea- 
tures. You’ve seen how to use the program’s basic commands and 
also how to create a variety of reference aids like footnotes, tables of 

contents, specialized lists, and indexes. 
Chapter 13 will show you how you can get the most from the 

Speller and Thesaurus, and Chapter 14 will explore some of the pos- 
sibilities beyond WordPerfect’s boundaries as you communicate with 
other computers. 
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Fast Track 

To spell-check a document, 

choose Spell from the Special menu (or press Command E). 

Use the shortcut Command-Shift-W for checking the whole 

document. 

To skip a word 
and continue spell-checking the document, click Skip Once. If 

the word appears again in the document, the Speller will query 

you on it. 

To correct a word whose correct spelling is in the list 

of words the Speller presents, double-click on the correct ver- 

sion to replace the word in your text. 

To correct a word whose correct spelling is not in the list, 

Just start typing the correct word. The Speller automatically 

corrects any other misspellings of words you have corrected 

once, as long as they’re misspelled in the same way. 

To tell the Speller to ignore a word 

both now and whenever it occurs again in the document, click 
Ignore. 

To get a word count, 

choose Word Count from the Spell menu (or press Command- 
E 4). 

To look up a single word, 
choose Lookup from the Spell menu (or press Command-E 5). 
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To change dictionaries, 405 
select Change Dictionary from the Spell menu (or press 
Command-E 6). 

To add a word to the User Dictionary, 405 
click Add. 

To use the Thesaurus, 406 

choose Thesaurus from the Special menu (Command-T is the 
keyboard shortcut) when the insertion point is on the word you 

want to look up. Any word the Thesaurus shows with a bullet 

next to it is a headword, and you can look up even more defini- 

tions under that word. 

To look up a word that isn’t being displayed, 406 
start the Thesaurus, click Look Up, then type the word. 

To replace the word 407 
in your document with any of the displayed words, click on the 

word, then click Replace. 

To add to the WP Dictionary or create new dictionaries, 409 

use the Speller Utility, which is a separate program. 

To start the Speller Utility, 410 

double-click on its icon and choose a dictionary, or double-click 

on the WP Dictionary icon. 



CHAPTER FQ 

WORDPERFECT’S SPELLER AND THESAURUS CAN BE OF 
great help to you as you write. The Speller especially is a joy to use, 
because it’s so fast and almost always suggests the right word as a cor- 

rection, which you can then click to select. I never bother to correct 
typos as I type in WordPerfect because I know that the Speller will do 
it faster and more accurately than I can. I can’t say that about any 
other word processor’s spell checker, including WordPerfect’s IBM 
version. 

While the Speller can correct your document, the Thesaurus can 

suggest alternative words to you as you write. If you’re looking for 

Just the right word to use, or if you think you’ve overused a word and 
want to see other words that have similar meanings, use the Thesau- 
rus to see alternative words that might apply in a particular case. The 
Thesaurus also presents a list of antonyms—words that mean the 
opposite of the word you’re looking up. 

—_____._ Specifying the Folder 
for the Speller and Thesaurus 

Before you use the Speller and Thesaurus, you need to tell Word- 
Perfect where you’re keeping your Speller and Thesaurus files. If you 
don’t take this step, the program will list the files on your disk and 
you'll have to locate the WP Dictionary and open it each time you 
use the Speller. If you’re using the Thesaurus, you’ll have to find the 
WP Thesaurus file. 

‘To specify where the dictionaries are, begin with a new blank doc- 
ument on your screen. Then, 

1. Choose WP Defaults front the File menu; then choose Default 
Folders. 

The Default Folders dialog box appears, as shown.in Figure 13.1. 
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Set Default Folders 

Work Folder 

© Undefined 

Temporary Files Folder 
O | home stuff :System Folder : 

Macro Files Folder 

O home stuff:1 wp: | 

Speller/Thesaurus Folder 
O home stuff:1 wp: 

Figure 13.1: The Default Folders dialog box lets you specify where the Speller 
and Thesaurus are kept. 

2. Click on the Speller/Thesaurus Folder button; then click Set. 

A list of files and folders on the current disk appears. Click and 

drag on the folder name at the top of the list to open other folders. 
Click Drive and Eject to see the contents of other folders in a 
different drive. 

3. When the folder you want to use is highlighted, click Open. 
Then click Set. 

When you return to the Default Folders dialog box, you should 
see the name of the folder where you’re keeping the Speller and 
Thesaurus files. This folder should be the last name in the 
Speller/Thesaurus Folder box. For example, I keep mine in a 
folder named 1wp on a disk named home stuff, so the line reads 

home stuff:1wp: 

If you’ve opened too many folders, repeat the process until the 

folder path name is correct. 

4, When the correct folder is listed as the last name in the box, 

click OK. - 
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You don’t have to go 
to the beginning of 

the document to run the 
Speller on the whole docu- 
ment. You can press 
Command-Shift-W from 
anywhere in the docu- 
ment, and WordPerfect 

will check it from the 
beginning for you, includ- 
ing headers, footers, foot- 

notes, and endnotes. 

5. To save this setting so that it will be used each time you start 
WordPerfect, choose WP Defaults again from the File menu. 
This time, choose Save Settings and save the settings in the 
WP Defaults file. 

If you need more information about saving settings as defaults, 

see Chapter 7. 

Using the Speller 

Now that you’ve told WordPerfect where your dictionaries are, 
you can use the Speller efficiently. (If you have two floppy drives and 

no hard disk, you’ll need to insert the Speller/Thesaurus disk into 
one of your floppy drives before you can use the Speller.) 

The Speller itself consists of a WP Dictionary containing over 

100,000 words. WP Dictionary is in turn divided into a list of com- 
mon words (called the Common Dictionary), containing 1500 of the 
most often used words, and a main word list (called the Main Dictio- 
nary), containing about 100,000 more words. As you add words to 

the Speller, they’re put into a supplemental dictionary file called the 
User Dictionary. You can edit this file in WordPerfect just as you 
would any other document. (To edit the WP Dictionary, or create 

another dictionary, you have to use a program called the Speller Util- 
ity, which is discussed at the end of this chapter.) 

The Speller is located on the Special menu. To spell-check a 
document—either a page, the whole document, or a selection you’ve 
highlighted—choose Spell from the Special menu (type Command- 
E) and choose one of the options. If you’re checking an entire docu- 
ment, pressing Command-Shift-W is the fastest way to start the 
Speller. Otherwise, Command-E 2 checks the page, and Command- 
E 3 checks whatever text you’ve selected. 

Once you correct a word that’s been misspelled, the Speller remem- 
bers the correction and automatically corrects any other misspellings of 
that word, as long as they’re misspelled in the same way. 
When the Speller starts, a special Speller window appears, as illus- 

trated in Figure 13.2, As the Speller checks a document (or page, or 
selection), it first looks in the WP Dictionary’s Common dictionary, 
then in the Main Dictionary, and then in the User Dictionary, where 
all the words you’ ve added are stored. If it comes across a word not in 



If you’ve just added 
MS a new paragraph to 

a document you’ve 
already spell-checked, 
select the paragraph and 
spell-check the selection. 
It’s faster than checking 
the page. 
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Doc 2: Speller ch 

Diese to correct typos as I type in WordPerfect because I 

know that the Speller will do it faster and more accurately 

than I can. I can't say that about any other word processor's 

Typo Suggestions: 

Phonetic Suggestions: 
bather batter 

batture bawdier 

beater better 

biter bitter 

bother boudoir 

** Word not found * * Word: footer ah cs 

Figure 13.2: When you use the Speller, any words not found in the Speller dic- 
tionaries are highlighted as potential typos. 

any of these lists, the word is highlighted. In Figure 13.2 the speller 
querying my bad typing of botyer for bother. As you can see, it’s provid- 
ing typo suggestions as well as phonetic suggestions. 

The phonetic suggestions may not seem to make much sense 
sometimes, but their value lies in your ability to type words you don’t 

know how to spell but can approximate the sound of. WordPerfect 
will then make some intelligent guesses about what the word might 
be. Try checking Jeeason, animonee, and dellikatesson. Sure enough, the 
Speller will suggest liaison, anemone, and delicatessen. 

If there are more alternatives than the Speller window can display, 
the scroll bar on the right is grayed. As you can see in Figures 13.3 

and 13.4, scrolling down allows you to see more suggested words. 

Once the Speller arrives at a word not in its dictionaries, you have 

several alternatives: 

e You can correct the word in any of several different ways, as 

you’ll see shortly. 

e You can click Skip Once to skip the word and continue spell- 

checking the document. If the word appears again in the doc- 

ument, the Speller will query you on it. 
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a codes, just as if you were looking at a full-screen Show 
4 Codes window (Figure 0-0). You can't do any editing in_ ote 
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a the file you're looking for. Pressing any key returns you 
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Phonetic Suggestions: 
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Doc 1: File Management Chapter 
odes, just as if you were looking at a full- -screen Show 
odes window (Figure 0-0). You can't do any editing in this 

Hq special window, but you can check to see whether this 
q the file you're looking for. Pressing any key returns you 

to the File Management window. If you've used another 
version of WordPerfect before, you already know how handy 

Phonetic Suggestions: 
adduce adeste 

adios adz 

aides aids 

autos awaits 

eddies educe 

eights eldest 
ides idose 

iotas it's 

*™* Word not found * * Word: 

ce) (Look up) (Phonetic) Gin Ones) (Ignore }(_nda_)(_exit_}| 
Figure 13.4: By scrolling down, you can view additional suggested spellings. 



or You can use most of 

WordPerfect’s 

editing techniques (such 
as shift-click and Delete) 
on the word in the Word 

box, but you can’t use the 
keypad shortcuts like 

Command-1 to delete to 

the end of the line. 

You don’t have to 
wait for the Speller 

to finish presenting alter- 
native spellings. As soon 
as you see the right word, 
go ahead and double-click 
on it. 
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e You can click Ignore to tell the Speller to ignore the word both 
now and whenever it occurs again in the document. 

e You can click Add to add the word to the User Dictionary. 

If you decide that the highlighted word is incorrect, you can cor- 
rect it quickly by using these methods: 

¢ Ifthe correct word is in the list of highlighted words, click on 

it and then click Replace, or just double-click on the word. 
The correct word will replace the word in your text. 

e If the correct word is not in the list, or if the Speller hasn’t 
been able to suggest any word at all, just start typing the cor- 
rect word to replace the word in the Word box. If it’s a minor 
correction, you can just edit the word in the Word box. Press 

Return to put the corrected word in your text. Whenever you 

press Return, what’s in the Word box replaces the word in 
your text. 

e You can also press the Delete key to delete the word in the box 

and then click in the document portion of the screen to cor- 
rect it there, if you prefer. While you’re in the document, you 
can edit words, type new ones, and move with the cursor- 
movement keys, but that’s all you can do. You’re returned to 
the Speller window when you press Return. 

When you replace a word that was capitalized in your text, the first 
letter of the new word will be capitalized also. If it’s a word like Word- 

Perfect in which two letters are capitalized, only the first letter will be 
capitalized. Thus, WordPrefect becomes Wordperfect. 

The Speller doesn’t check numbers (except for words containing 
numbers), and it won’t query you on the following characters if it 

finds them within words: 

(iy es pr ore |G 90" o ee 

For example, if you’ve typed a word like beco,mes, you'll be queried 

only on the beco and the mes parts. The fastest way to correct mistakes 

like this is to delete the word in the Word box and click in the docu- 

ment to correct it. Press Return to accept the changes and return to 

the Speller. 
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The Speller will 
check common 

contractions like can’t 
and won’t. It’s not fool- 
proof, though: if a mis- 
spelled word is also a 
word, it won’t correct it. 

If you’ve typed of where 
you meant to type or, the 

Speller won’t query you. 

How can you tell 

when the Speller is 
done? It gives you a word 
count. 

Oo) Even if you add 
words containing 

numbers to the dictionary, 
the Speller won’t check 
them like regular words. 

If you’ve reset mar- 

gins in a document 
with footnotes, get a word 
count before you print the 
document. This is a way to 
make WordPerfect go 
through the entire docu- 
ment (including notes, 
headers, and footers), 

resetting the margins as it 
goes. This should ensure 
that all the margins are 
consistent. 

Click Exit or press Command-. to exit from the Speller. If you’ve 
added any words, you’ll be asked whether you want to save them in 
your User Dictionary. Press Return to save them. 

As soon as you’re back in your document, press Command-S to 
save the corrected version. WordPerfect doesn’t automatically save it 

for you. It’s also good practice to save your document before you spell- 

check it, too. 

Duplicate Words 

If the Speller comes across a double word, such as the the or an an, it 

selects both words and presents a dialog box. You can click Delete 

2nd to delete the second word, click Continue (or press Return) to 
leave both words in the text, or click Disable Checking to turn off 
double-word checking. 

Alphanumeric Words 

If the Speller locates a word with numbers in it, such as 4WORD or 
Report2, it presents a different dialog box. You can simply press 

Return to continue spell-checking, leaving the word with numbers as 
it appears, or you can click Edit to edit the word. A list of suggested 
words will be displayed. If you prefer, you can turn off checking words 
with numbers by clicking Disable. 

Getting a Word Count 

When the Speller finishes checking a document, it gives you a 
word count. It will also give you a word count without spell-checking 
a document if you choose Word Count from the Spell submenu. 
(Command-E 4 is the keyboard shortcut.) 

Looking Up Words 

You can also use the Speller to look up words whose spelling you 
aren’t sure of. The fastest way to look up a word as you write is to 
start the Speller (Command-Shift-W), type the word you want to 



o Don’t begin a word 
pattern with * 

unless you’re prepared to 
wait awhile. Try to begin 
the word with a letter to 
restrict the search pattern 
to one section of the 
dictionary. 

The WP Dictionary 
is stored on disk, 

while the words you add 
to the dictionary as you 
use the Speller are stored 
in RAM. If you get a 
“Dictionary Full” mes- 
sage as you’re spell- 
checking a document, it 
means that there’s not 
enough memory to hold 
the document and the 
added-word list in mem- 
ory. First, close all the 
documents that are open 
except the one you’re 
working on. If you still 
get the error message, 
exit the speller and add 
the words that are in the 
word list to the User 
Dictionary. 
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look up, and click Look up. If you’re already using the Speller, just 
delete what’s in the word box, enter the word you want to look up, 
and click Look up. If you look up a word that’s already spelled cor- 
rectly, WordPerfect lists the correct spelling in the Speller window. If 
it’s misspelled, you’ll get a ‘‘No words matched with template’’ 
message. 

If you don’t know how a word is spelled, you can either type it the 
way it sounds (like receeve for receive) or enter wildcard characters for 
the letters you’re unsure of. The question mark stands for one char- 
acter, and the asterisk and minus sign represent any number of 
characters. You could enter rec??ve to check whether the word is 
spelled as recieve or receive. You could also enter rec *ve to check for all 
words that begin with zec- and end in -ve. 

To resume spell-checking after you’ ve looked up a word, click Skip 
Once, Ignore, or Add. 

Using Other Dictionaries 

You can create other dictionaries to use with WordPerfect by using 
the Speller Utility. After you create a dictionary, to have WordPerfect 
use it instead of the WP Dictionary, choose Change Dictionary from 
the Spell submenu (Command-E 6 is the shortcut). You’ll be asked to 
choose files for the main dictionary that you want to use as well as the 
user dictionary, or supplemental word list, that you want to use. (To 
avoid ambiguity, I’ll use ‘‘U ser Dictionary”’ to refer to the word list 
WordPerfect creates automatically when you click Yes to the prompt 
‘“‘Save changes to User Dictionary” after a session with the speller, 

and ‘‘user dictionary”’ for word lists you create independently. 
(You’ll see how to create dictionaries and supplemental word lists 
when we discuss using the Speller utility.) 

For example, if you’re working on a document that contains many 

terms that aren’t found in the WP Dictionary—such as new pharma- 

ceutical brand names—you can type these words as a list in a sepa- 

rate file and then select that file as your user dictionary instead of the 

regular User Dictionary. 7. 

You’ll probably find it most convenient to keep the user dictio- 

naries you create in a folder with the WP Dictionary and the regular 
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User Dictionary so that you can easily select which one you want to 

use. You can keep all your dictionaries and word lists in a folder 

called Dictionaries, for example, and specify it as the default folder 

for your dictionaries. 

If you don’t use the WP Dictionary, you won’t get the benefit of 

the 100,000 or so words that are in it. Select the regular WP Dictio- 

nary first and then select a different user dictionary, or create custom 

dictionaries by modifying a copy of the WP Dictionary. 

—_______ Using the Thesaurus 
The Thesaurus helps you determine exactly which word is best in 

any given situation. It consists of about 10,000 headwords, which is 

WordPerfect’s term for words that you can look up in the Thesaurus, 
and about 140,000 other words. 

To look up a word that’s on your screen, move the pointer to it and 
press Command-T. If you want to look up a word that isn’t being dis- 
played, start the Thesaurus, click Look up, and then type the word. 

If you use the The- As many nouns (n), verbs (v), and adjectives (A) as WordPerfect 
saurus frequently on Gnd Henlsued tow th iy 

Mee dak aie yee can find are displayed for the word, as are antonyms (ant)—words 

can avoid having to swap that mean the opposite. If there are more words than can be dis- 

disks by putting the Word- played in the Thesaurus window, the scroll bar will be grayed, and 
Perfect program and the ee ee you can scroll to see additional words. You can also use the arrow 

keys to move through the Thesaurus lists. 

1. To see how the Thesaurus works, open a new document and 
type useful. 

2. Choose Thesaurus from the Special menu (or press Com- 
mand-T). 

The screen illustrated in Figure 13.5 appears. WordPerfect is 
suggesting six synonyms and one antonym for the word, and 
they are all marked with bullets, meaning that they are head- 
words. Headwords can be used to look up even more words. 

3. To look up related words for the headword serviceable, just 

double-click on it. . 

When you look up a headword, its suggested alternatives are dis- 
played in an adjacent column, as shown in Figure 13.6. 



If you look up sev- 
eral headwords, it’s 

easy to get a cluttered 
screen. When the 

columns fill up, select 
Clear to clear a column to 
make room for more 

words. 

You can use the 
arrow keys to move 

either up and down or 
across columns. The 
vertical scroll bar will 

move you up and down 
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Figure 13.5: When you use the Thesaurus, WordPerfect suggests both syno- 

nyms (words that mean something similar) and antonyms 
(words that mean something different). 

4. Double-click on the headword durable. You’ll see another list of 

words, as shown in Figure 13.7. 

WordPerfect only looks up headwords. If the word you’re look- 
ing up isn’t a headword (such as the or and), the program will give 

you a ‘“‘Not a headword!”’ message. 

5. To replace the word useful in your document with word func- 
tional, highlight functional and click Replace (or press 
Command-R). 

You can also return to your document to get a better idea of how a 
word is being used in context and look up other words while running 
the Thesaurus. Just click Document or click in the document portion 
of the screen, and the screen will change to the one shown in Figure 

13.8. The options Search and Goto appear at the bottom of the 
screen, replacing the options Replace and Clear. While you’ re in the 
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Figure 13.7: Looking up durable brought even more suggestions to the screen. 



To quickly return to 
the Thesaurus to 

look up a word that the 
cursor is on in your docu- 
ment, just press Enter or 
Command-T. WordPer- 
fect will return you to the 
Thesaurus and present a 
list of words. You can also 
return to the Thesaurus 
window by clicking any- 
where in it. 

Oo You can’t cycle 

among windows 
while you’re in the The- 
saurus or the Speller. You’ll 
have to exit from them to 
see what’s in another 

document window. 
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Figure 13.8: If you click Document, you’ll be able to move through your doc- 
ument, search for words and phrases, and replace them with 
other words and phrases. 

document, you can search for words in your document and Goto spe- 
cific pages, which makes it easy to locate other occurrences of the 
word whose meaning you’re considering. 

The Speller Utility 
WordPerfect’s Speller Utility lets you work with the WP Dictio- 

nary itself. Although you can’t interact with the WP Dictionary as 
directly as you can with user dictionaries, which are simply supple- 
mental word lists, the Speller Utility lets you determine whether a 

word is in the WP Dictionary’s Main Dictionary or its smaller Com- 

mon Dictionary, and the utility also lets you add words to or delete 

words from either list. 

Why would you want to do any of this? In the first place, it’s often 

useful to delete words from the User Dictionary. It’s easy to add mis- 

spelled words to the User Dictionary by mistake—all you have to do 

is click Add when you mean to click Ignore or Skip Once. Then, if 
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you add the User Dictionary to the WP Dictionary, you ve perpetu- 

ated the error, and the Speller won’t correct you on it. 

Likewise, it can often be useful to delete certain words that you never 

use but that the Speller “knows” are correct. For example, I habitually 

type id for is, but the Speller won’t correct it because 7d is a perfectly good 

word (in psychology, but usually not in word processing). 

Another good reason to add words to the WP Dictionary is that if 

your User Dictionary gets too large, it slows down the Speller. 

You can also increase the speed of the spell-checking process by 

moving words you habitually mistype from the Main Dictionary to 

the Common Dictionary. For example, I seem to be unable to type 

the word document correctly. Judging from the time it takes the Speller 
to suggest the correct alternative, this word is in the Main Dictionary. 

By moving document to the Common Dictionary, any typos that 

closely match its patterns are queried faster. 

You may also want to add words to the WP Dictionary if you get a 

“Dictionary Full’? message, as mentioned earlier. 
That’s five good reasons to use this often-ignored but very useful 

utility. Here’s how to do it. 

Starting the Speller Utility 

The Speller Utility is a separate program from the WordPerfect 
program. It’s on the Speller/Thesaurus disk. If you have a hard disk, 
you'll want to copy it into your WordPerfect folder. 

To start the Speller Utility, just double-click on the WP Dictionary 
icon. You’ll see the screen shown in Figure 13.9. 

Adding the User 
Dictionary to the Main Dictionary 

Since the most frequent task you’ll probably use the Speller Utility 
for is to add your User Dictionary to the WP Dictionary’s Main Dic- 
tionary, we’ll look at how you do that first. 

1. Click on User Dictionary in the Source box. 

If you click Keyboard, you can add words, one at a time, with the 
keyboard. Clicking User Dictionary means that you’re going to 
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Figure 13.9: The Speller Utility lets you add to or delete from the WP Dictio- 

Edit your User a 
Dictionary before 

you add it to the Main 
Dictionary. You’ ll 
undoubtedly find that a 
few misspellings have 
crept in as you added 
words with the Speller. 

Don’t wait until you 
have a huge User 

Dictionary to add it to the 
Main Dictionary. For best 
results, add only about 25 
words at a time. e 

nary, or create new dictionaries. 

use a file containing the words you want to add. Figure 13.10 

shows a typical User Dictionary after a session with the Speller. 

Click Main Dictionary in the Destination box to add the User 
Dictionary to the Main Dictionary. 

Words that you add to the Common Dictionary are automati- 
cally added to the Main Dictionary, but there’s a maximum size 
for the Common Dictionary. 

Click Add. 

Select the dictionary you want to use from the list WordPerfect 
presents. In this case, select User Dictionary. It contains all the 
words you added during your sessions with the Speller. 

Click Open. 

Click Save. 

WordPerfect doesn’t display the words you add until you save the 

revised dictionary. Saving can take quite a while; that WP Dictio- 

nary is big. 
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If you’ve added or 
deleted quite a few 

words, select Optimize on 
the File menu before you 
quit the Speller Utility. 
Optimizing the WP 
Dictionary (or any other 
dictionary you create) 
makes it run more 
efficiently. 

Run the Speller on 
any list of new 

words (user dictionary) 
that you want to add to 
the WP Dictionary. If it 
fails to query you on a 
word, that word is 

already in the dictionary, 
so there’s no point in 
adding it again. You’ll be 
surprised how many 
words are already in the 
WP Dictionary. 

" & File Edit Search Format Font Special Windows 

Doc 1: User Dictionary 

boilerplate 
breaks 

can 

compuserve 

copyediting 
dayna 

dbase 
dialog 

download 

downloading 

enddef 

endmark 

freeware 

helvetica 

Figure 13.10: Your User Dictionary contains all the words you add while 
you’re using the Speller, but any file of words like this one can 
be used as a user dictionary. 

After you’ve added the words in your User Dictionary to the Main 

Dictionary, quit the Speller Utility, open the User Dictionary docu- 
ment in WordPerfect, select its contents (Shift-Command-A selects 
All), and delete the words it contains. From then on, any new words 
you add during a session with the Speller will be added to this now- 
empty document. 

Adding Words to the Dictionary from a File 

To add any file of words to the WP Dictionary, you follow the same 
procedure as adding the User Dictionary. Just select the file that con- 
tains the words you want to add after you ve clicked Add. The words 
in the file should be separated by hard returns or spaces, but they 
don’t have to be in alphabetical order. 

Adding a Word to the Common Dictionary 

As mentioned earlier, if there are some words that you habitually 
mistype that seem to take WordPerfect longer to suggest possible 
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You can also delete 

words from the 

dictionary. Click Delete 
instead of Add; the rest of 

the steps are the same. 

To view the words 
that are already in 

the Common Dictionary, 
click Common. 

spellings for, you can move them from WP Dictionary’s Main Dic- 
tionary to its Common Dictionary to speed up the spell-checking pro- 
cess. ‘Io move a word from one list to the other, follow these steps. 

1. Click Keyboard in the Source box. 

2. Type the word. For example, type Macintosh. If you haven’t 
added it, it’s not in either word list. 

3. Click Common Dictionary in the Destination box. 

4. Click Add. 

After you’ve finished adding words to the Common Dictionary, 
click Save. To check whether the word has been added, you can click 
Find. WordPerfect will report whether the word is in the Common 
Dictionary, the Main Dictionary, or not in either part of the WP 
Dictionary. 

Checking Spelling in the Speller Utility 

The Speller Utility works just like the Speller when you’ re looking 
up a word’s spelling or doing a phonetic lookup. If you’re unsure 
about how a word is spelled and you want to look it up before you add 
it to the dictionary, you can enter the word using a question mark to 
represent any one letter you’re unsure of, or an asterisk or minus sign 
to represent any combination of letters. Figure 13.11 shows some of 
the possible matches that were found for the pattern re*st. 

If you click Phonetic, you’ll get a listing of words that sound like 
the word you’re looking up. Figure 13.12 shows possible phonetic 

matches for the word letter. 

Creating New Dictionaries 

You can also create new dictionaries by using the Speller Utility. 
Then, when you run the Speller, you can choose option 6, Change 

Dictionary, to switch to any new dictionary you ve created. 

You may want to maintain separate dictionaries for legal terms, 

medical terms, or foreign-language words, for example. However, a 
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WP Dictionary 

Main Dictionary: Look up on “re*st" 

readiest readjust realest 

realist rearmost rearrest 

rebroadcast recast receptionist 

recidivist recitalist reconquest 

reconstructionist recontest recordist 

redbreast reddest redigest 

reductionist reediest ~~ reenlist 

F1| reflexologist reforest refractionist 

j| regionalist reincarnationist reinvest 

religionist relist remotest 

ource: 
@ Keyboard 
O User Dictionary 

Destination: 
i © Common Dictionary 

(_betete _} O Main Dictionary 

Figure 13.11: You can look up words in the Speller Utility to check spelling 
without exiting to the Speller. 

<= 

SaaS wr Dictionary 

Main Dictionary: Phonetic match for "letter" 

lather latter 

laughter leader 

letter lewder 

lighter liter 

litre litter 

loader loather 

looter louder 

Source: 

@ Keyboard 

© User Dictionary 

Destination: 

© Common Dictionary 
© Main Dictionary 

Figure 13,12: The Speller Utility-will also find phonetic matches for you. 



If you want to 
create a new dictio- 

nary that has the contents 
of the WP Dictionary plus 
the new words you’re 
adding, save the WP 

Dictionary by using the 
Save As command and 
naming it with a different 
name. Then customize it 
by adding and deleting 
words. That way, you’ll 
still be able to use it as an 
effective spelling checker. 
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word of warning: If you don’t include the contents of the WP Dictio- 

nary in any new dictionary you create, you won’t get the benefit of 
the Speller as an effective spelling checker. 

To create a new dictionary: 

1. Select New from the Speller Utility’s File menu (or press 
Command-N). 

2. Enter a name for the new dictionary, such as Legal Dictionary. 

3. Click Save. 

You can add words to your new, empty dictionary file. 

Using Dictionaries Created on Other Computers 

If you’ve spent a lot of time customizing your WordPerfect dictio- 
nary on another computer, like an IBM or a VAX, don’t despair. If 
you can transfer it by modem, by direct serial cable, or through a net- 

work to your Macintosh, you can still use that dictionary. Choose File 

Management (Command-L), select the dictionary, and click File/ 
Folder Info. Change the Creator to SSIU (all caps) and the Type to 
WPSP (all caps). Click OK; then close the File Management dialog 
box. Your dictionary will then work like any other dictionary for 
WordPerfect on the Macintosh. 

Looking Forward 
In this chapter, we’ve spent a lot of time on an often neglected but 

fascinating subject: WordPerfect’s Speller and Thesaurus. You’ve 
seen how to use both the Speller and the Thesaurus and how to use 
the Speller Utility to customize the way the Speller works and create 
new dictionaries. 

Chapter 14 explores some of the possibilities available if you set up 
your Macintosh to communicate with other machines. 



: "7 - 
tT 

‘ ' re} i ” 7 i 2) AM eet A 
“ } dh Ge Pe eee iw i 4 et y: Ran : i 

“ y id _ ne ie . f , ¢ 

al 

~ 

: ‘ . 
~ 

i mm ’ } ; 
~ _ ? " P replete 

Nes sik x a 5 ¥ si) 

~. " ‘ 
= a. ¢ 4 

‘ 

: : t 
nr at Oe Bed Bk € A 

— 

. 

; y ste” 4 : 7 
ined 

=~ 

t 

; 

ome ee oe “ “he 7} ft 

ce Ute DDteh } ws , va 
. 

& . 
; a) SS? I Ps 

4 tie , h 
r : tj TS Po 

t 7 

8 ur > Sn oe 

vit ; a } Cm Z 

perk Sve eda te) : Aa" Pet nga at Kes daa 

hale rch, | a : 7 ‘ “4 ') ens She ae ie ae Tu rats veg t ey, ° ; 

Br et wetaat be :1 Seubaw tel mye set) hou! Aesth Wii ass Wane 

Pit 4% thoy Yi Wilelis. 6 eon 

i a iv 
‘ 

4 2 
poo} te 

ty i <: 
i 5 it 

X ii 
i 1 

Pa - 

aH) 
! 1 
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To transfer WordPerfect documents 

between a non-networked Macintosh and an IBM computer, 
you need a telecommunications program for each, plus either 
two modems or a special cable. Alternatively, you can use a 
DOS drive with your Macintosh, if you have a SCSI port. 

To convert files 

from other programs on other computers to your Macintosh, 

you can either get a special translation program or convert 
them through IBM WordPerfect. 

To see which files you can import directly, 
choose File Management (Command-L) and click Importable 

Files. 

To change transferred files to WordPerfect Macintosh format, 

use File/Folder Info in the List Management window. Change 

the creator to SSIW and the type to WPPC. 

To exchange files on an AppleShare network, 

first select the Chooser and then the file server you want to 

access. 

To exchange files on a TOPS network, 

you “‘publish”’ a volume by selecting the Publish command. 

To communicate with an information utility 

like CompuServe or an electronic bulletin board, you'll need a 

modem, a phone line, and a telecommunications program. 

421 

422 

422 

425 

427 

428 

431 



CHAPTER 14 

YOU CAN SHARE FILES BY HANDING A COWORKER A 
floppy disk and you can send messages by using a pencil and paper, 

but if you work in an office environment in which many different 
people need to access a central storehouse of information and docu- 

ments, your computer is probably part of a network in which it can 

send information to other computers and receive information from 

them. Networking is becoming so widespread that if you’re working 
for a large or even a medium-size company, chances are you’re either 
running WordPerfect on a machine that can communicate with other 

computers, or you’d like to be. 
WordPerfect is one of the few programs so far that lets you easily 

interchange documents from one type of computer to another. 

Because you now have this capability, you may be more interested in 

using your Macintosh for telecommunications than you were before 

you acquired WordPerfect. This chapter will take a look at a couple of 
the most popular schemes for networking with the Macintosh and 
discuss how you can connect Macs and IBM PCs on a network to 
share your WordPerfect files. Although the examples in this chapter 
use WordPerfect Macintosh to WordPerfect IBM formats and vice 
versa, you can also transfer documents that were created in Word- 
Perfect on a VAX or Data General computer. The basic technique is 
the same. 

Even if you aren’t working in a networked environment, you may 
want to be able to use WordPerfect files that have been created with 
the IBM version of WordPerfect and stored on 51/4-inch diskettes, or 

you may want to work on a Macintosh using WordPerfect and then 
transfer those documents to a PC for others to use. This chapter will 
also show you step hy step how you can use special programs that do 
Just that. In addition, you’ll see how you can use a modem and a tele- 

communications program to get on-line with the WordPerfect Support 
Group on CompuServe, where you can get up-to-date bulletins from 
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WordPerfect Corporation and hints from other WordPerfect users. 
The non-WordPerfect products, programs, and services men- 

tioned in this chapter aren’t the only ones available, but they’re the 
ones that are most widely used at this writing. I’m not endorsing any 
of them over any of the others; they’re simply the ones I’ve had expe- 
rience with. Your situation will dictate your specific needs, but the 
general procedures for using most of the different types of communi- 
cations programs, networks, and services discussed in this chapter 
will probably be similar. 

Transferring WordPerfect 
Documents between Other Computers 

First, we’ll look at the simplest case: you aren’t part of a network 
and you may or may not have a modem. All you want to do is trans- 
fer WordPerfect documents between your Mac and an IBM PC. 
WordPerfect for the Macintosh accepts documents in IBM WordPer- 

fect format, but the problem is how to get them from the IBM, which 
uses 51/4-inch floppies, to the Mac, which uses 31/2-inch floppies. 
(Once you get the files there, it’s simple to convert them to WordPer- 
fect Macintosh format, as you saw in Chapter 7.) 

There are three different things you can do to get the files from one 

computer to another: 

e Purchase a PC-compatible disk drive that will read the 51/4- 
inch floppies into your Mac. 

e Obtain a file translation program and a special cable to con- 

nect the two machines through serial ports. 

e Run communications programs on both computers and con- 

nect them via modem over the phone lines or with a serial 

cable. 

PC Compatible Disk Drives 

The simplest solution is to obtain a PC-compatible drive for your 

Macintosh, but it’s also the most expensive solution. Several manu- 

facturers offer PC-compatible drives that allow you to copy disk files 



422 Mastering WordPerfect on the Macintosh 

CH. 14 

WordPerfect docu- 
ments don’t transfer 

well with Apple File 
Exchange, at least not in 
the early 1.0 releases. 
The Apple PC Drive uses 
Apple File Exchange. If 
you have an Apple PC 
Drive, contact WordPer- 

fect Corporation to see if 
a later release of the 
program is available. 

WordPerfect for the 
IBM has a Convert 

program that converts 
WordStar, MultiMate, 

DisplayWrite, dBASE, 
and spreadsheet files (to 
mention only a few) to 
WordPerfect format, so 

you can convert files from 
these programs into IBM 
WordPerfect and then 
bring them into Macin- 
tosh WordPerfect. 

WordPerfect for the 
Macintosh has quite 

a few built-in file conver- 
sion formats. To see 
which files you can 
import, click Importable 
Files in the File Manage- 
ment window. For 

example, you can import 
MacWrite and Microsoft 
Word files without taking 
any additional steps. 

between the 3!/2-inch and the 51/4-inch disk types. For example, 

Dayna Communications’ DaynaFile is a PC drive that can run on 

any Mac with an SCSI port. The PC disks show up on your Mac 

desktop just like Mac disks. You can drag their icons to copy, move, 

and delete them, so you can easily copy a PC file to the Mac or a Mac 

file to a PC disk. 

File Translation Programs 

If you don’t have a PC-compatible disk drive, you can obtain a 

product named MacLink Plus that allows you to connect a Macin- 

tosh to an IBM PC with a special cable, while converting the docu- 

ment to a format each machine can understand. Its advantage is that 

it has built-in translators to convert documents from other DOS pro- 

grams at the same time that it’s transmitting them to your Macin- 

tosh. It also translates from the Macintosh to the IBM. 
For example, Figure 14.1 shows only a few of the translation 

options available for bringing WordPerfect 4.2 documents over to 

your Macintosh. If you need to be able to convert IBM WordPerfect 
documents to Macintosh formats like Multiplan or Excel, MacLink 
Plus is a good choice until WordPerfect Corporation makes more file 
conversion formats for the Macintosh available. 
When you use MacLink Plus, you first select the appropriate 

transfer mode. You can transfer files from PCs to Macs, from infor- 

mation utilities like CompuServe, or from other Macintoshes that 
are connected via MacLink Plus. You then select file translators 
using a dialog box like the one in Figure 14.1. It resembles Apple’s 
Font/DA mover: on one side of the screen is a list of possible source 
formats, and on the other is a list of possible destination formats. 

After you’ ve selected the translators, you choose the files you want to 
transfer. Figure 14.2 shows how a DOS subdirectory named A appears 
on your Mac’s screen. The contents of A are listed on the right side of 
the screen, and the Macintosh disk named home stuff (on the left of the 
screen) is ready to receive any files that are transferred. 

When you quit Maclink Plus, you’ll see the icon of the file on your 
desktop, just as if you’d created it on your Macintosh. 
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Figure 14.1: MacLink Plus can transfer many different types of files between 
Macs and IBMs while converting them into other formats. 
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Figure 14.2: MacLink Plus represents DOS directories as Macintosh files and 
folders. 
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ie) If you translate files 
from other word 

processing programs to 

MacWrite via MacLink 
Plus and try to open them 
in Macintosh WordPer- 

fect, you may get an 

‘End of file’? message. 

Just retrieve them into an 

open window instead. 

[+] MacLink Plus’ cable 
works fine for trans- 

ferring files this way, too. 

Connecting an IBM PC to Your Macintosh 

If all you want to do is transfer IBM WordPerfect documents to 

your Macintosh, however, you only need a special cable (called a null 
modem cable, available from your dealer; be sure to get the proper 
type for the IBM PC or AT) and two'‘communications programs— 

one that runs on your Mac and another for your PC. The PC pro- 
gram should support the file transfer protocol called XMODEM, 
and it should be capable of transmitting at 9600 or 19,200 baud. (The 
word protocol refers to settings that control how the sending and 
receiving computers interact with each other.) ProComm and PC 
Talk will both do this, and you can get them from most computer bul- 
letin boards, including CompuServe. 

In your Mac, you should be running a communications program 
that will transfer at 9600 or 19,200 baud, support XMODEM, and 

allow you to disable MacBinary. Most communications programs for 
the Macintosh, such as MacTerminal or Microphone, will do this. 

Sending IBM WordPerfect Documents to Your Macintosh 

I used ProComm on the IBM and Microphone on the Macintosh 

to test transferring an IBM WordPerfect file to WordPerfect Macin- 
tosh. It worked flawlessly. Here’s how to do it. 

1. Set both communications programs to 9600 or 19,200 baud, 
no parity, 8 data bits, and 1 stop bit. 

2. On the Macintosh side, disable MacBinary. 

This choice is probably a File Transfer setting on the Settings menu. 

3. On the IBM side, select upload or send file, with XMODEM 
as the protocol, and enter the file name of the DOS file you 
want to send to the Macintosh. 

4. On the Macintosh side, select the Receive XMODEM command. 

5. Press Return on the IBM to send the file from the IBM to the 
Macintosh (or use the appropriate command in your commun- 
ications program). 

The document will appear as an icon on your Macintosh’s 
screen. 



hr If you have a lot of 
secondary mail- 

merge files stored on an 
IBM, transfer them to 

your Macintosh instead 
of inputting them all over 
again. You can transfer 
secondary files created on 
a Mac to your IBM 

WordPerfect, too. 

If you have special 
dictionaries you 

created in WordPerfect 
on another computer, 
transfer them so that you 
don’t have to create them 
from scratch. See 
Chapter 13. 

io) IBM WordPerfect 

documents that 

contain graphics created 
with the Line Draw feature 

translate the graphics as 
ASCII characters. You’ll 

need to delete the ASCII 

characters and recreate the 

graphics on the Macintosh. 
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6. Start WordPerfect. 

7. Press Command-L for File Management. 

8. Select the document’s name and click File/Folder Info. 

If you don’t see the document listed, click All Files; then click on 
it. You may need to click on Drive if the document is on a disk in 
the floppy drive. 

9. Delete what’s in the Creator box and type SSTW. 

Use CAPITAL letters. 

10. Delete what’s in the Type box and type WPPC. 

Use CAPITAL letters. 

11. Click OK. 

You can now use the document that was created on the IBM just as if 

you created it on the Macintosh. You’ll probably want to change fonts, 
since font changes don’t translate from the IBM to the Macintosh. 

Sending Macintosh WordPerfect 
Documents to IBM WordPerfect 

To send a Macintosh WordPerfect document to an IBM using 
WordPerfect, first display it on your Macintosh screen. Then choose 

Save As from the File menu. Click the IBM WordPerfect Format 
button. 

WordPerfect Corporation is constantly making new file formats 
available, so check with the company from time to time to see what 
other direct conversions are possible. 

Next, name the document. Remember, if it’s going to DOS, you 

have an eight-character limit plus a three-character extension. Word- 
Perfect doesn’t require any extension, but you can add one to help 

you identify the source of the document, like chap2.mac. 
Then you can use the same setup—in reverse—that we just dis- 

cussed for transferring Macintosh and IBM files. Just set the com- 
munications program on the IBM to receive an XMODEM file 
(your choice may be called ‘‘downloading’’) and choose Send XMO- 
DEM in your Macintosh communications program. 
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To see which docu- 
ments you’ve saved 

in IBM WordPerfect 
format, view them by 
icon in the Finder. If you 
view by name, they’re all 
simply listed as WordPer- 
fect documents. 

Communicating via Modem 

If your Mac and your IBM aren’t close to each other— maybe 

one’s at home and one’s at work—you can connect them via modem 

to transfer WordPerfect files. You’ll need to connect a modem to both 

computers and have a person at either end when you send. As com- 

munications settings, choose no parity, 8 data bits, and 1 stop bit, just 

as you did in the earlier direct-connect example. However, 1200 or 
2400 baud is a more realistic transfer rate for phone lines, so set up 
for those rates, not 19,200 baud, depending on what your modem 

can handle. 
Give the person at the other end a call and tell them there’s a file 

transfer coming so that they can start their communications program 

running. Have your home communications program dial the other 
computer’s number. 
When you’ve made the connection with the other computer, you 

can then transfer documents just as if both computers were con- 

nected via cable, as described earlier. As each file is transferred, 

you'll see an indication of how much has been transferred and what 
portion is waiting to be transferred. 

After you’ve received a document on your Macintosh, change its 

creator and type as discussed above before you try to use it. 

Networking with WordPerfect 

You can also communicate with IBM PCs by placing Macs and 
IBMs on a network and letting network users share files. In situations 
where several people work on the same document, sharing files on a 

network removes any confusion about which version is the latest. For 
example, say you’re updating the March report, and Jack in the next 
office decides it’s time to add his results to that report. If a network is 
handling file access, both you and Jack can’t have the current version 
of the document, so Jack can’t work on that report until you’ve 
released it, and there can’t be two different versions floating around 
the office. 

In the sections that follow, we’ll take a look at a couple of the most 
popular networking systems for the Macintosh: AppleShare and 



Sharing Documents with Other Computers and Programs 427 

TOPS. We'll review a few tips about getting the most from WordPer- 
fect (or any other program) on a network system. You’ll see the word 
document used interchangeably with file in these sections; most of the 
information here applies to files you create with other programs as 
well as with WordPerfect. 

Working on an AppleShare Network 

For an AppleShare network, one Mac that has at least a megabyte 
of memory and a hard disk has to be dedicated to the network. It’s 

called a ‘‘dedicated”” Mac because you can’t use it as a regular work- 
station; it works only as a file server and runs the AppleShare soft- 

ware. This AppleShare server responds to users’ requests for files and 
can also run electronic mail programs. In an AppleShare net, 

you can have 25 individual Macs connected with AppleTalk cable—50, 
if you’ve dedicated a Mac II with 2 megabytes of memory. You can also 
install AppleTalk network boards in IBM PCs and connect them to the 
network via AppleTalk cables. Among other functions, the AppleTalk 

PC board converts DOS files to PostScript so you can print your 
IBM WordPerfect documents on a shared LaserWriter. 

When you’re in an AppleShare network, you access the files that 
are stored on the file server just as if it were a hard disk attached to 

your workstation, with one important difference. Unlike a local hard 
disk whose contents are accessible only to the user of that disk, the 

files on the AppleShare server (the dedicated Mac with the hard disk) 
are also accessible to other network users. 

To use an AppleShare network, you first select the Chooser and 
choose which file server you want to access, just like you select the 
LaserWriter for printing. It should be the file server that stores the infor- 
mation you want to access. You can usually find out which one that is 
from your AppleShare system administrator or from another user. (In 
many installations, the file servers have whimsical names like OddJob 
or Titanic, so you may not be able to tell what they contain simply from 
reading their names.) If several AppleTalk networks are connected, you 
may also have to specify which zone you’ll be using. 

You’ll then log on with your name and password and select the vol- 

umes you want to use. The file server’s hard disk is divided into areas 
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If you create a 
WordPerfect docu- 

ment on your Macintosh 

that you know someone 
on the network wants to 

use in WordPerfect on the 
PC, save it in WordPer- 

fect IBM format as well 
as in Macintosh format. 
Remember that DOS has 
an eight-character limit 
for file names. Long 
names may be truncated 
beyond recognition. 

called volumes that contain folders, which in turn contain files and pro- 

grams. In fact, you can think of a volume as a collection of folders. 

You'll see a list of the volumes available to you. After you’ve selected 
the server volumes you want to use, they will appear as icons on your 

desktop, and you can open them and use them just as you would use 
files on a hard disk attached next to your computer. The only time 
you’ll notice any difference in the way one of these icons behaves 
from the way an internal hard disk behaves is if you try to open or 

save to a folder you don’t have access to. 
You can assign access rights to the folders you create to protect 

them from being opened or altered by others. Assigning read-only 
rights lets others read documents; read-write rights lets them change 

and save the documents. 
For example, you can grant access rights only to members of your 

work group so that others don’t have access to a document until it’s 
finished and out for review. However, even with access rights, if two 

group members try to work on the same document at the same time, 
the first person who opens the document gets access to it; the others 

are locked out, so there’s no chance of several different versions of the 

same document existing under the same name. This is true on any 
network, whether it’s AppleShare or TOPS. 

If a WordPerfect document you have access rights to is in use by 
someone else, it will appear with a tiny padlock in its title bar on your 
screen when you open it. You can read it, but you can’t edit it and 
save it. You can use the Save As command on it, though, so there’s 
no chance of several versions of the same document existing under 
the same name. 

Working on a TOPS Network 

TOPS is (as of this writing) the most widespread network for inte- 
grating Macs and PCs. It uses distributed file servers instead of a 
dedicated file server like AppleShare does. This means that any Mac- 
intosh with a hard disk on the network can act as a file server, and you 
can choose which information on the hard disk is available to the 
other network users. The advantage of this scheme over the 
AppleShare system is that you don’t have to give up the use of one 
Mac and keep all of your shared information on the same machine. 
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Also, if one Mac goes down, the whole network doesn’t crash; if your 
dedicated Mac on an AppleShare net malfunctions, you’re left with- 
out a file server. The disadvantage of using a distributed network sys- 
tem like TOPS is that as the number of users on-line increases, the 
network’s performance may slow down. 

The TOPS network also allows you to connect IBM PCs. You’ll 
need to take the additional step of installing a TOPS board in an 
empty expansion slot of your IBM and hook it up to an AppleTalk 
cable (or AppleTalk-compatible cable). You’ll need at least 512K of 
RAM in the PC, preferably 640K. You can then access data stored 

on floppy disks in IBM drives, data on IBM hard disks, or data in 
other Macintosh drives. IBM volumes appear on your Macintosh 
screen as disk icons, just as if they were running from a floppy disk on 
your Mac. A file created on a PC looks like a plain document icon. 

On a PC, files from other PCs appear as other volumes and directo- 
ries; Mac files appear as disk drives, such as drive E:. Any Mac 

names that are longer than eight characters will be truncated on the 
IBM, but there’s a menu option for seeing the full names of 
Mac files. 

TOPS resides as a desk accessory on the Apple menu on your Mac. 
When you open it, you’re asked to sign onto the network. On the left is a 
list of the volumes on your Mac, and on the right are listed the network 
file servers and the volumes you can select from them. In the center are 
the command buttons Open, Copy, Mount, Publish, and Help. 

‘“‘Publishing”’ a volume makes it available to other users on the 
network. When you publish a volume, its icon changes to the TOPS 
symbol. To ‘‘unpublish’”’ a volume (remove it from use by others), 
you drag its icon to the Trash. 

Although you can publish a folder of WordPerfect documents or a 
volume of folders, you can’t publish a single document by itself. If 

you want to make only one document available to other users, you’ll 

need to create a folder to hold it. 

Folders can also contain other folders. For example, you may want 

to create a folder for a project you’re writing with your work group; 

you can then place several folders inside that folder, each with a 

different project member’s name. TOPS allows you to assign 

passwords to each folder and designate whether it is read-only or 

read-write. 
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her Be sure to give 
access rights to 

everyone you want to be 
able to use a folder. It’s 
easy to forget to assign 

access rights to your 

whole work group when 
you're sending a docu- 
ment to someone else. If 
you’re seeing a lot of 
locked WordPerfect docu- 
ments, this is probably 
the reason. In a TOPS 
network, each individual 

user has control over 
access rights. 

har If your network 

crashes because of a 
power failure or for some 
other reason, you may 
find the WordPerfect 
document you were 

working with locked 
when the system comes 
up again. WordPerfect 
sometimes interprets an 

improper exit as a request 
from another user. Use 

the Save As command to 
save the document with a 
different name if this 
happens. 

To access a WordPerfect document that’s been published by another 

TOPS workstation, you choose the volume the document is in and click 

Mount. Once you’ve mounted a volume, you can choose from the doc- 
uments and files in it. You can either copy the document to your own 

drive or work with it directly off the other station’s disk drive. 
On the PC side, you’ll find that publishing volumes from the PC is 

slightly more complicated than with the Mac. On the Mac, you can 
click the mouse a couple of times;.on the PC, you’ll have to type in a 

DOS-like command like the following: 

TOPS PUBLISH D:/path AS VOL [/R! RW] [/P [PASSWORD]] 

This tells TOPS to publish the file whose path name you specify as 
a volume under a name you specify, with the options of setting read 

or read/write access with or without a password. (Aren’t you glad 
you have a Macintosh?) 

On the PC side, however, you can’t copy documents directly from 
the mounted volume. You have to exit to DOS and use the COPY 
command, using the volume as if it were a drive. For example, to 

copy a document named AUGRPT in volume D to your hard disk, 
you would type 

COPY D:AUGRPT C: 

The Menu Instructions Help window gives you a list of basic com- 
mands; if you’re familiar with DOS, you’ll have little trouble deci- 
phering them. 

Network Etiquette 

If you’re using either type of network, or even one of the other 
popular networks not mentioned here, you’ll find that observing a 
few conventions can help speed up not only your work, but everyone 
else’s on the net: 

¢ Depending on the size of your network, how it’s configured, 
and how mdny users are actually on-line at a time, you may 
find that network service slows down if you run large pro- 
grams from a file server. You should run large applications— 
such as WordPerfect—locally. This means that you should 
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store the program on the hard disk attached directly to your 
computer, or run it from floppy disks if you haven’t got a 
hard disk. 

¢ When you ’ve finished with WordPerfect documents in a TOPS 
volume, drag it to the Trash so that others can access it. 

¢ Don’t install a new System version on your own. Each machine 
on the net should be running the same version of the Finder, the 
System, and the printer drivers. If you get a new version of 

WordPerfect, copy just the program disk and the Speller/ 
Thesaurus disks onto your hard disk. Don’t copy the System 
disk until everybody else upgrades. 

Telecommunicating with WordPerfect 

No matter whether you’re on a network or not, if you have a 
modem and a telecommunications program like MacTerminal or 

MicroPhone, you can get access through your phone lines to nation- 

wide information services that provide you with a wealth of informa- 

tion both about using WordPerfect on the Macintosh and about 
using the Macintosh itself. Having an account on the CompuServe 
Information Service, the largest consumer information service in the 
country, allows you to access the WordPerfect Support Group, where 

you can read up-to-date bulletins from WordPerfect Corporation and 
get hints and tips from other WordPerfect users. Even if you don’t 
have a CompuServe account, with a modem and communications 
program you can access electronic bulletin boards maintained by 
Macintosh user groups in almost all areas of the country. By 
downloading files from these information services, you can get pro- 
grams for your Macintosh. Often you’ll find helpful programs for 
WordPerfect itself. 

Using CompuServe 

Because the procedure is much the same whether you’re accessing 

a local electronic bulletin board or one of the national information 

services, let’s take CompuServe as an example. It’s also your source 

for logging onto the WordPerfect Support Group. 
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Setting Up Your Equipment 

To get started, you’ll need a modem, a telecommunications pro- 
gram (if you have a choice, get one that supports MacBinary), and a 

CompuServe starter kit, which you can purchase in most computer 

stores. Many times, these starter kits come with a couple of hours of 
“‘free’’ time; you won’t be billed for the hour or so it takes you to get 
familiar with the system, but you will have to pay the local phone 
charges, if any, while you are on-line with the service. 

Once you’ve connected the modem and have your telecommuni- 

cations program running, you’ll need to set the communications 
parameters in the program. You’ll probably see a menu named Set- 
tings. Find it and set the program for 8 bits, no parity, and one stop 

bit. You can probably leave the rest of the settings alone if they’re the 
default settings that came with the program. If someone else has been 
using the program, however, you may want to check to see that it is 
set for full duplex (no local echo) and that XON/XOFF is enabled. 

Depending on your modem, you can set the baud rate for 300, 
1200, or 2400 baud (in some areas of the country, you can send and 
receive at an even higher baud rate). The 300-baud rate is cheapest 
but slowest, and some modems don’t support 2400 baud, so 1200 
baud is a good compromise. 

Next, you'll need a local access number, which is provided in your 
CompuServe starter kit. If your terminal program can do autodialing, 
set it up with the local number and let it do the dialing from now on. If 
you need to enter a dialing sequence manually, you may need to preface 
it with a few letters such as ‘““ATDT” and then the number. See your 
modem manual; ATDT tells the Apple modem “<attention:dial”’, using 
tone dialing, and is immediately followed by the local number in the 
form 555-1212. If you need to get an outside line by dialing 9, pref- 
ace the number with 9, followed by a comma. The comma tells the 
program to pause for two seconds while the outside line is obtained. 
So if you have an Apple modem, your final manual dialing sequence 
would look something like this: 

atdt 9,555-1212 
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Interacting On-Line 

After you’ve dialed the number, on-screen prompts should guide 
you through the rest. You’ll be asked for the host (that’s Compu- 
Serve) and for your ID number and password, which are given in the 
starter kit you purchase. Early in the proceedings you’ll be asked to 
provide information about what kind of terminal you’re using. You 
can get on-line help for determining the size of your screen, and as 
soon as CompuServe knows your screen size, you’ll see full-screen 
lines of text. If there’s any question about what terminal type you’re 
using, you can choose to emulate a DEC VT100, which most Mac 
communications programs provide. 

After you’ve provided the information service with all it needs to 
know about you and your equipment, you can then explore the sys- 

tem on your own or go directly to an area in which you are interested. 
If you get lost, enter HELP or ? and press Return; the system will 

explain the things you can do at that point. 

Visiting the Macintosh User’s Group 

CompuServe is a collection of many electronic bulletin boards, but 
the ones you’ll probably be most interested in are the Macintosh 
User’s Group (enter GO MAUG) and the WordPerfect Support 
Group (enter GO WPSG). MAUG has several subsets. There’s 
MAUG Personal Productivity, which you can reach by typing GO 
MACPRO. You may also find topics of interest in the Macintosh 

Business Users Forum (GO MACBIZ). 
Each of these interest groups is composed of three basic areas: a 

message area, which is the electronic bulletin board where you can 
read and receive messages; data libraries, which contain software 

and text you can download to your own computer; and a conference 

area, usually called a CO, where you can communicate with other 

users who are on-line. 

You should probably go to the MAUG area first, before you go to 

the WordPerfect Support Group area, because it has a built-in guide 

for using the facility. After you type GO MAUG, enter GUIDE at 

the main prompt or select the number corresponding to the menu 

item. 
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= As we go to press, 

CompuServe is in 
the process of streamlin- 
ing these menus. By the 
time you read this, the 
information utility will 

probably be much sim- 

pler to use. 

CompuServe’s menus will undoubtedly get in your way after a 
while—they’ re long and hard to read, and displaying them and read- 
ing them take up valuable connect time. You can easily change to 
command mode to disable the repetitive menus. To do so, select 

OPTIONS (or type OP) and set Use Menus to NO. From then on, 
you can enter short commands that carry out your orders immedi- 
ately, and I’ll assume that you’re doing so in the rest of this chapter, 
which will introduce you to the most often used commands. 

After you’ve taken the tour, you’ll probably want to explore the 
different areas of MAUG. On CompuServe and on large local bulle- 
tin boards, the message area is divided into different subtopics so you 
can read only the messages of interest to you. In MAUG, type OP at 

the Function: prompt; then enter SU at the Option: prompt to get a 
list of subtopics. 

For a complete list of the commands you can use in MAUG, enter 

IN at the main MAUG menu. Press Return when you’re asked for a 

subtopic. When you’re asked for a topic, enter three periods (...) and 
press Return. You’ll get about 20 pages of instructions. 

The QS (Quick Scan) command lets you see a list of message num- 
bers with their Subject: fields so that you can quickly skim through 
the messages to see if any interest you. To read a message, enter its 
number with the command RI (Read Individual) at the Function: 
prompt. For example, to see message number 4455, enter RI 4455. 
To read the replies to that message, enter RR. 

‘To reply to a message, use the command RE (REply) at the Read 
action: prompt. At the Function: prompt, you can leave a new mes- 
sage by using the command L. Be sure to include your user ID num- 
ber so that you can receive replies. (Remember, you can type ? or 
HELP at any prompt.) 

Unless you’ re looking for advice on a specific problem and want to 
post a question to the network by using the message area, you’ll 
probably want to go to the data library area to see what goodies are 
available. For example, in the MAUG data libraries, you’ll find 
MacPaint and MacDraw artwork that you can use in your WordPer- 
fect documents; in the WPSG data libraries, you'll find everything 
from WordPerfect macro files to text-only files describing procedures 
that solve specific problems. 
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Visiting the WordPerfect Support Group 
Let’s assume that you want to leave MAUG now and go over to the 

WordPerfect area to access those data libraries. At the main prompt, 
enter GO WPSG. If it’s your first visit, you’ll be asked to enter your 
name. You’ll then be presented with several screens of information 
about how the area is organized. Messages are grouped into sections: 
general WordPerfect messages are in section 1, printer messages are in 

section 2, and laser printing and desktop publishing messages are 
in section 3. 

Using the Data Libraries 

To access the data libraries, enter DL and the number of the library 
you’re interested in. In the WPSG area, the Macintosh library is 15, for 
example. When you’re there, you can type S/DES to see a list of all the 
files that particular library has. If you want to see files on a particular 
topic, enter S/DES/KEY: followed by a key word, such aa MACROS 
(uppercase and lowercase make no difference). Enter BRO if you want 
to be able to download a file after you read its description. 

Before you begin to download files, though, you’ll need a little ° 
background information. There are two kinds of files in the data 
libraries: text files and coded files. Your telecommunications pro- 
gram undoubtedly has a feature called ASCII text capture, text cap- 
ture, or save screens to disk. You can use it to save unformatted text 

files, such as those that describe procedures, to disk. 

The other type of files is program files such as screen savers, fonts, 
picture files, or desk accessories that must be downloaded by using a 
special protocol like XMODEM. For example, MacBinary files have 
the extension .BIN. Many terminal programs for the Mac will 

decode these files as they download them. 

If your communications program has MacBinary XMODEM, so 
much the better; this means you’ll be able to get the downloaded file 

on your disk in the same form as it appeared on the disk of the person 

who uploaded it, just as if you copied it disk-to-disk by using the 
Finder. If you don’t have MacBinary XMODEM, you’ll have to 

take an additional step to interpret the incoming binary file. How- 

ever, since most communications programs you’ll be using with a 

Macintosh support MacBinary, let’s assume the best case. 
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Even if you don’t : want to download 

files, you may want to 
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fect Support Group 
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Jectionist. Subscription 
information is in Data 

Library 13. 

Assuming you’ve got MacBinary XMODEM, turn it on in your 

terminal program. It’s probably in the Settings menu. After you 
locate a file you want to download, enter a D at the File disposition: 
prompt if you’re browsing, or by typing DOW plus the complete file 
name, including the extension, at the DL prompt. When Compu- 
serve asks what protocol to use, select XMODEM. You’ll then be 

told to type a carriage return when the transfer is complete. Go to the 

File menu and tell your program to get ready to receive a file; you’ll 
probably be asked to give the incoming file a name. After you do so, 
the transfer should begin. 

If by chance your program doesn’t have MacBinary, you’ll find 

additional help in two files named MACBIN.HLP and BINHEX- 
-HLP; to read them, go to data library 0 and enter REA MAC- 
BIN.HLP. If you’re browsing, enter R (for READ) at the file 
disposition prompt. Turn on text capture mode before you press 
Return. 

Teleconferencing 

There’s also a teleconferencing facility in CompuServe—sort of a citi- 
zens band channel in which you can chat with everyone else ‘‘on the 
air.” You get there by typing CO at the Function: prompt. After that, all 
the previous rules no longer apply. In Conference mode, you enter a for- 
ward slash (/) to issue a command. Enter /HELP for help and /EXIT to 
log off. We won’t go further into the workings of this area here, since as a 
WordPerfect user, your main interest areas are primarily represented in 
the data libraries and bulletin board systems. 

If you don’t subscribe to CompuServe, a local Mac user bulletin 
board can no doubt provide sources of other information about using 
WordPerfect on the Mac. To find a user group with an electronic bul- 
letin board near you, call Apple’s User Group Directory. The num- 
ber is (800) 538-9696, extension 500. 

Suppliers of Communications 
Programs and Equipment 

I’ve mentioned several programs, services, and hardware in this 
chapter, so here’s a list of their suppliers. 
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Apple PC Drive 
AppleTalk 

AppleShare 

Apple File Exchange 

Mac Terminal 

Apple Computer, Inc. 

20525 Mariani Avenue 
Cupertino, CA 95014 

CompuServe 
5000 Arlington Centre Boulevard 

Columbus, OH 43220 

(800) 848-8199 

DaynaFile 

Dayna Communications 
50 S. Main Street 
Suite 530 
Salt Lake City, UT 84144 
(801) 531-0600 

MacLink Plus 

DataViz 

16 Winfield Street 

Norwalk, CT 06855 

MicroPhone 
Software Ventures Corporation 
2097 Claremont Avenue 

Suite 220 
Berkeley, CA 94705 

(415) 644-3232 

ProComm 

P.©. Box i441 
DataStorm Technologies, Inc. 
Columbus, MO 65205 

O14) 449-9401 
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TOPS 
TOPS: A Sun Microsystems Company 

950 Marina Village Parkway 

Alameda, CA 94501 
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Formatting Codes 

Code 

I 

[#] 
[F #:n] 

[{ #:auto] 

[Align] [Align] 
[Align Char; n] 

[Bold]| Bold] 

[Bottom Mar:n] 

[Center][Center] 

[Cncl -] 

[CntrPage] 

[Conditional EOP] 

[Col Def] 

[Column][Column] 

[Date:n] 

[Def ] 

[Def {#] 

[Def Mark: Index; 7] 

Effect 

Insertion point (cursor) 

Minus sign 

Hard space 

Note number 

Paragraph number (n = level number) 

Outline or automatic paragraph number 

Flush right or Tab Align on/off 

Tab align (n = character) 

Bold on/off 

Bottom margin (n = space) 

Center text on/off 

Cancel hyphenation 

Center page top to bottom 

Conditional end of page 

Column definition 

Column on/off 

Date (n = format) 

End_of index, list, table of contents 

Paragraph numbering definition 

Index definition (n = format) 
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[Def Mark: List; 7] 

[Def Mark: TofC; n] 

[Endnote:n] 

[Font Size:7] 

[Footer A:n] 

[Footer B:n] 

[Footnote:n] 

[Header A:n] 

[Header B:n] 

[HPg] 
[HRt] 

[Hyph][Hyph] 
[HZone Set] 

| > Indent] 

[ >Indent<] 

[ Index: heading; 
subheading| 

[Ital][Ital] 
[Justify: Center, Full, 

Left, Right] 

[Kern:7] 
[“#, °#, ®¥ Pos] 

[Leading:7] 

[Margin Set] 

[ Mark: List;7] 

[Mark: List;7] 

{[Mark:TofC;n] 

{[Mark:TofC;n] 

[< Mar Rel] 

List definition (n = list number) 

Endnote (n = number) 

Font size (n = points) 

Footer A definition (n = occurrence) 

Footer B definition (n = occurrence) 

Footnote (n = number) 

Header A definition (n = occurrence) 

Header B definition (n = occurrence) 

Hard page break 

Hard return 

Hyphenation on/off 

Set H-zone 

Indent 

Left-right indent 

Index entry 

Italics on/off 

Justification on/off 

Kerning (n = points) 

Page number position 

Leading (n = points) 

Margin set 

Table of contents definition (n = format) 

Mark for list number (n = list number) 

Mark for table of contents (n = TofC 
level) 

Margin release 
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Note Opt] 

Outln][Outln] 

Overstk] 

Page *] 

Pg#:Pos | 

Pg#:n] 

[Picture] 

[ 

[ 

[ 

[ 
[ 

[ 

[PostScript] 

[ Protect][ Protect] 

[Redline][Redline] 

[Req -] 
[ReqSpce] 

[Select][Select] 

[SetFont:7] 

[SetNote#:7] 

[Shad][Shad] 

[Soft -] 

[Space:7] 

[Spacing Set:7] 

[SPg] 
[SRt] 

[Strkout][Strkout] 

[SubScript][SubScript] 

[Suppress:n] 

[SupScript][SupScript] 

[Tab] 

Note options 

Outline style on/off 

Overstrike 

Insert page number 

Page number position 

New page number (n = starting number) 

Graphic image 

PostScript command 

Block protection on/off 

Redline on/off 

Required hyphen 

Required space (keep words together) 

Select on/off 

Set font (n = font) 

New note number (n = starting number) 

Shadow on/off 

Soft hyphen 

Letter spacing between characters 
(n = points) 

Line spacing set (n = number of lines) 

Soft page 

Soft return 

Strikeout on/off 

Subscript on/off 

Suppress for current page (n = format or 
formats) 

Superscript on/off 

Tab 
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[Tab Set] Tab setting(s) 

[Top Mar:n] ‘Top margin (n = space) 

[Undrln][Undrln] Underline on/off 

[Undln Style] Underline style 

[W/O][W/O] Widow-orphan protection on/off 
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Keyboard Charts 

IF YOU’RE USING A KEYBOARD WITH A NUMERIC KEY- 
pad, there are many shortcuts you can take by using the keypad 
instead of the mouse. WordPerfect Corporation provides a set of 

“‘keycals’’—key-cap decals—that you can stick on your key caps to 

remind you of a key’s function. However, if you’ve misplaced your 
keycals or if they’ ve become worn and dropped off from use, you can 

refer to the numeric keypad template shown here. 
If you’re using the Apple Extended Keyboard—the one with the 

function keys—you can refer to the larger template to remind your- 
self of the function keys’ optional uses. All the keys from F1 to F15 
are fully functional in WordPerfect. Each key operates in four 
different modes: pressed by itself, the key carries out one function; 

pressed with the Command, Shift, or Option keys, it carries out 
other functions. They’re listed on the template. 

Numeric Keypad ENTER i 
a 

: : 
= 

1 2 

TYPE 
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Extended Keyboard 

Command 
Shift 
Option 
Plain 

Command 
Shift 
Option 
Plain 

Command 
Shift 
Option 
Plain 

Command 
Shift 
Option 
plain 

Transfer 

Char Format 
Thesaurus 
Undo 

Open 
Date 
Mark Text 

List Files 

Merge 

Merge E 
Merge Codes 
Merge R 

Clipboard 
Append 
Undelete 
Cut 

Spell 
4Search 
Change 
»Search 

Tab Align 
Center 
Flush Right 
Bold 

Macro Def 

Retrieve 

Macro 

Save 

Print Options 
Macro Options 
Page Preview 

Copy 

Screen 
Switch 
Show Codes 
Help 

Feotnote 

Print 

Columns 

Quit 

Close 
Save As 

Defaults 

New 

Goto 
Define lists 
Insert Literal 

Paste 

Move 
oIndent¢ 

Select 
oIndent 

Print 
Line 

Page 
Underline 

Columns On 
Paragraph 

Outline 
Ruler 
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Since you can assign 
features to the Enter 

key with all the characters 
on your keyboard and 
assign even more features 
to a double-Enter 
sequence, you’ll probably 
run out of ideas before 
you run out of possible 
key assignments. 

Customizing WordPerfect 
to Suit the Way You Work 

THERE HAVE BEEN MANY COMMENTS THROUGHOUT 
this book about ways you can tailor WordPerfect for your own work 

habits, but nowhere, other than here, will you find them all in one 

place. 

Because the Macintosh and WordPerfect were designed so that 
you could interact with them in ways that suit you best, there are usu- 
ally several different methods that will accomplish any given task. At 
the basic level, you usually have a choice of using the keyboard or the 
mouse to choose from a menu, for example. You can even execute a 

command from the Help dialog box, for that matter. And you can 
record macros that automate repetitive or complex tasks. 

Here are a few reminders about how you can customize the pro- 
gram in other ways. 

Mapping Features to the Enter Key 

You can use Help (it’s on the Apple menu, or press Command-?) 
to map most of WordPerfect’s features to an Enter key and a key- 
board character (or to an Enter-Enter-key sequence, in which you 
press Enter twice, followed by the character, to carry out that func- 
tion). After you’ ve mapped a feature to the Enter key, pressing Enter 
and the character to which you’ve assigned the feature executes the 
command. For example, if you change fonts frequently, you can 

define Enter F as Fonts; from then on, the key sequence Enter F will 
bring up the Characters dialog box, where you can change fonts, 



hr You don’t have to 
press the assigned 

key while you are still 
holding the Enter key 
down. Just be sure you 
press the Enter key first. 
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sizes, and styles. If you use macros frequently, you can map some of 
the submenu options that don’t have keyboard shortcuts—like Chain 
Macro or Macro Input—to an Enter-key sequence so that you don’t 
have to select from two menus when you use them. Likewise, if you 
use footnotes often in your work, you can map their commands, 
which don’t have shortcuts, to Enter-key sequences. In fact, any- 
thing on the menu system that doesn’t have a keyboard shortcut is a 
good candidate for mapping to an Enter-key sequence. (If you can’t 
map a feature to the Enter key, WordPerfect will let you know.) 

Whatever system of key assignments you choose, make it consist- 
ent so that it’s easy to remember. Table C.1 presents some suggested 
Enter-key assignments. For example, in Table C.1, commands that 

delete text or move the cursor are assigned to number keys, and other 

program functions have letter key assignments. I assigned the arrow- 
key functions to ;, ’, ., and / simply because those keys are closest to 
the Enter key on a basic Macintosh keyboard that lacks arrow keys, 
but the I, J, M, and L keys are also often used as arrow keys. You can 

choose whatever key assignments suit the way vou tvpe. 

Table C.1: Suggestions for Enter-Key Mapping 

Enter-Key 
Combination Function 

Enter C Chain macro 

Enter D Macro delay 

Enter E Escape key 

Enter F Font change 

Enter I Macro input 

Enter K Kerning 

Enter L Define lists 

Enter N Page numbering 

Enter P Block protect 

Enter U Case convert (U for uppercase) 

Enter T Tabs 
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Table C.1: Suggestions for Enter-Key Mapping (continued) 

Enter-Key 

Combination Function 

Enter 1 Delete to end of line 

Enter 2 Delete to end of page 

Enter 3 Delete right 

Enter 4 Delete left 

Enter 5 Page down 

Enter 6 Page up 

Enter 7 Screen down 

Enter 8 Screen up 

Enter ; t key 

Enter , \ key 

Enter . aa Key, 

Enter / > key 

Enter [ Move to beginning of line before codes 

Enter ] Move to end of line 

To map a feature to the Enter key, follow these steps: 

1. Choose WP Help from the Apple menu (or type Command ?). 

2. Choose the feature you want to assign to an Enter-key sequence. 

3. Click Define. 

4. Press the key you want to use with Enter. 

The key you choose can be a letter, a number, or a symbol. 

5. Click Topics to return to the help topics. 

6. Click Quit to exit Help. 
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Setting Default Formats 
You can use the WP Defaults command to change WordPerfect’s 

default formats (such as font, line spacing, hyphenation on/off, justifica- 
tion on/off, and so forth) to the settings you use regularly in your work. 

You can also set up custom default formats for specialized docu- 
ments like newsletters or reports that use a slightly different format 
from your everyday documents. When you start WordPerfect from 
the System folder by clicking on one of these custom default file icons, 
the settings in that file will be used until you quit WordPerfect. 

Chapter 7 has step-by-step instructions for setting up default formats. 

——____._ Starting WordPerfect Automatically 
If you want to begin each work session with your Macintosh in Word- 

Perfect, you can set up your system to start WordPerfect automatically. 

Click on the WordPerfect program icon in the Finder; then choose Set 
Startup. If you’re running MultiFinder, open WordPerfect; then go to 
the Finder and choose Set Startup. From then on, whenever you turn 
on your Macintosh, you’ll come up in WordPerfect. 

—_. Creating a Startup Macro 
You can record a startup macro that will execute each time you 

start WordPerfect. For example, you may want to insert today’s 
date, or you may want to open a certain document automatically 

each time you start WordPerfect. Any macro you name Startup 
Macro and save in your macros folder will automatically execute 
when you start the program. 

Chapter 8 has step-by-step instructions for recording macros. 

eens, Setting Automatic Backups 

WordPerfect’s timed buckup option automatically makes a backup 

copy of the document you’re working on every so many minutes— 

you specify the interval. The program’s orginal backup option is 

designed to maintain a copy of the previously saved version of the 
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= Be sure to use the 

Control Panel to set 

your colors at 256 before 
you try to set colors in 
WordPerfect. 

document you’re working on so that you have a version one genera- 

tion older than the current one. If you’ve specified original backups, 
the program saves the original document (the one you previously 

saved) each time you save the document you’re working on. 
Chapter 7 has step-by-step instructions for specifying automatic 

backups. 

Adjusting the Screen Display 
The Special menu’s Screen command has several options that let 

you specify how your screen will appear. 

e If you prefer to have a completely full screen to work in, you 
can suppress the menu bar at the top of the screen by choos- 
ing Full Window (or pressing Command-Shift-Z). 

e You can choose Show Position to have the program indicate 
the horizontal and vertical coordinates of the insertion point 
on the screen. 

e You can choose Display Justification to see justified text dis- 
played on the screen. 

Setting Screen Colors 
If you have a color monitor, you can select a background color as 

well as a color for text and a highlight color. (If you don’t have a color 
monitor, highlighted text is dimmed.) 
When you choose Colors from the Screen submenu, you’ll see a 

color wheel. It will initially appear to be black, because black is the 
default text color, and most people like to leave it that way for ease of 
reading. Just click OK to leave the text color black, or change the text 
color by following the instructions given in the next paragraph for 
changing the background color. 

You'll then see a color wheel for the background color. Click any- 
where in the color wheel until the background color you want to use is 
displayed in the box. Keep it light for greater contrast between the 
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text and the background. (I have mine set as a very light green, but 
you may prefer an amber shade or a light blue.) You can drag on the 
scroll bar to adjust the brightness; dragging down darkens the colors. 
When you’ve selected a background color, click OK. 

You can then set a color for the highlight by clicking in the color 
wheel and dragging the scroll bar for brightness. 

After you’ve set colors, choose WP Defaults from the File menu; 
then choose Save Settings. If you want the colors you’ve selected to 
become your default colors, save them into the WP Defaults file. You 
can save different colors into your custom default files if your prefer, 
so that you have a visual reminder of which default settings you’re 
using when you work with custom default files. For example, you 

might want to set the background color to be amber for your newslet- 
ter default settings and the background color to be blue for special 
reports, while keeping green as the default background color for reg- 
ular documents. 

Changing Control Panel Settings 
By using the Control Panel on the Apple menu, you can change 

certain settings that affect how WordPerfect and all your other pro- 
grams operate. When you select the Control Panel, you’ll see a 
device-selection panel on the left displaying an icon for each device, 
like the keyboard and the monitor. (You can scroll to see devices that 
aren’t visible.) Click on the icon of the device to change its settings. 

For example, the General icon lets you adjust the background pat- 
tern of the desktop. Click on the right and left arrows in the desktop’s 
icon, and you'll see the pattern change. Its image will be displayed on 
the left in FatBits, and you can edit the pattern there. When you’ve 

got a pattern that you like, click on the desktop icon, and the pattern 

will appear on the desktop. If you have a color monitor, you can spec- 

ify a color for the desktop pattern. 

You can also set the rate at which the insertion point and the 

menus blink, and adjust the speaker volume. 

Click the keyboard icon to adjust the key repeat and delay rate so 

that a character will be repeated faster or slower. (If you’re getting a 

lot of unintentionally repeated characters, set a longer delay.) 
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If you get a new 

device that can be 

controlled from the Con- 

trol Panel, it will have a 

file called CDEV (Con- 

trol DEVice). Put this file 
in your System folder. 
The next time you use 
the Control Panel, you’ll 
see the device there. 

Click the mouse icon to change the double-clicking rate so that the 

mouse operates at the speed you’re comfortable with. If you change the 

mouse tracking speed to Fast, you won’t have to move the mouse very 

far to take the insertion point across the screen. With the mouse tracking 

speed set to Very Slow, the insertion point tracks the mouse exactly. If 

you move it two inches, the insertion point moves two inches on your 

screen. 
Use the startup device icon to change the device your Macintosh 

boots from. The Macintosh will start from the internal drive unless 

you change the startup device. For example, you may be using a 

Macintosh SE with a built-in hard disk and have a second, faster 

hard disk drive that you want to use as the startup device. 



Index 

A 

A4 Letter (paper size), 201 
Access rights, in networks, 428-431 

Acronyms, searching for, 63 

Addressing envelopes and mailing labels, 326 
Adobe Illustrator, 167 

Adobe Systems, Inc., 213, 221 

Alarm Clock, 20 

Aligning numbers in outlines, 347-349 
Aligning text. See Centering, Flush left, Flush 

right, Justification 

Alignment character, 104, 108-110, 308 

Alleys, between columns, 147, 150-151 

ALSoft, Inc. 222 

Altsys Corp, 220-221 
Antonyms, 406 
Appending 

to Clipboard, 56 
to file, 166 

Apple Computer, 193, 437 
Apple File Exchange, 422 
Apple fonts, 84 
Apple menu, 16, 20, 39, 91, 199, 218-219, 451 
Apple PC Drive, 422, 437 
AppleShare, 419, 426-429, 437 

AppleTalk, 419, 427-429, 437 
Arabic numbers, 120, 127, 129 

Arrow key equivalents, 6 
Ascenders, 83 

ASCII characters, 425 

ASCII files, 224, 228, 237 
Assembling documents, 333-337 
Assigning passwords, 238-239 
Automatic downloading, 215 
Automatic hyphenation, 110 
Automatic page number referencing, 130 
Automatic paragraph numbering, 351-357. See 

also Paragraph numbering 
Avant Garde typeface, 180-181, 214 

B5 Letter (paper size), 201 
Backtab, 125. See also Margin release 
Backup files, 225, 244-248, 449-450 

Bad breaks, avoiding, 137-140, 183, 205 

Balancing columns, 179-180 

Banner, creating a, 98-99, 186 

Baseline, 114 

Beep, changing the, 242 
Binding width, 120, 122-123, 125-127 

Index 453 i nex 493 

Bit-mapped graphics, 166-167, 171, 204, 218 
Bitmap, 212 

Block protection, 103, 121-122, 138-139, 157 

Boilerplate text, 333-337 
Bold character style, 88-89 

Bookman typeface, 188, 214 
Borders, creating, 171 

Bundled attribute, 234 

Busy attribute, 233 

Cc 

Cached attribute, 233 

Cairo typeface, 211 
Cancel command (Command-.), 10 
Capitalization 

in headings, 176, 178 

in index entries, 391 

Caps Lock key, 200, 217 
Casady Company, 220 
Case conversion, 31, 59-60, 276-278. See also 

Capitalization 
Case, in searching and replacing, 63, 67 
Center command (Command-Shift-C), 28-29. 

See also Centering 
Center page top to bottom, 120, 122-123, 125 

Center tabs, 26, 99 

Centering, 18-19, 28, 93-96, 98-99, 104, 125, 
133-135, 154, 315 

Century Software, Inc., 221 

Character pairs, 115 
Character styles, changing, 15, 19, 29, 66 

Characters dialog box, 85, 88 
Chicago typeface, 212 
Chooser, 39, 147, 199, 201, 219, 269, 274 

ClickArt Special Effects, 170-171, 175, 192, 427 

Clip art, sources for, 165, 192-193 

Clipboard, 31, 56, 59, 74, 165, 168-169, 
237-238 

Close (Command-k), 236 
Close box, 365 

Codes. See Format codes 
Codes window, 9, 60-61, 102, 135, 157-158, 

160, 166, 170, 207, 230, 232, 372, 390 

Colon, used as tab align character, 108-110 

Color monitors, 171, 450-451 

Colors, setting, 450-451 

Column Definition icon, 147-148 

Column Options, 146-147, 149-151, 158, 161 

Columns, 144-165 

adding or deleting, 155 

balancing, 179-180 
breaking, 147, 149, 157, 183-184 
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calculating width of, 151-152 D 

centering text in, 96 
changing the number of, 154 

converting to one-column, 153 
cutting, 160-165 Data fork, 232 

defining, 146, 149-152, 158, 161 Data General, 237, 420 

defining with Ruler line, 93, 147, 154-155 Database programs, 323-324 

deleting, 153, 163 Date format, 77 

editing parallel, 160-165 Date function, 76 

evenly spaced, 149-151, 158 Date, inserting the, 20, 76-78, 135 

in foldouts, 189 DaynafFile, 422, 437 

footnotes/endnotes in, 376 dBASE IBM, 324, 422 

formatting text into newspaper, 154-155 dBASE Mac, 323 
hyphenation in, 157 DEC VT-100, 433 
in grid design system, 173-175 Decimal point, 104 
keeping together, 157 Decimal tabs, 26, 99, 107 
macro for, 284-285 Default files and folders, 16, 240-247, 296 
moving between, 153, 159-160 Default formats, 189, 225, 449 

newspaper, 102, 146, 147-149, 154-158, Default settings, 82-83 

186-188 Delays, in macros, 264-265, 274, 295, 299-300 

number of, 145, 150 Delete buffer, 22 

margins, calculating, 151-152 Delete EOP, in columns, 153 

parallel, 102, 104, 146, 149-152, 158-165 Delete key, 403 
selecting, 162-165 Delete Right, 161, 163 
status line in, 158 Deleting 
switching column formats, 183-184 columns, 163 

tabbed, 102-104 files and folders, 231 

transposing, 162-165 format codes, 89 
tuning on and off (Command-Shift-K), 149, graphic images, 165-166, 169 

152, 183-184 aline, 102 
unequal, 151-152 locked documents, 240 
used as pages, 189 tabs, 100, 107 
using footnotes in, 154 text, 21-22, 56-59 

using with mailing labels, 327 Delimited files, 323-324 
Command key, 49 Demonstration macro, 293-296 

Command key, in MacPaint, 169-170 Descenders, 83 

Common dictionary, 400, 409-415 Designing publications, 172-192 

Communications programs, 421, 424 Desk accessories, 168, 170, 222, 235 

Complete word searches, 63 Desktop, 171, 233. See also Finder 

CompuServe, 213-214, 419-420, 422, 431-437 Desktop Graphics, 193 

Computer paper, 201 Desktop pattern, 451 
Conditional chains, 270-273 Desktop publishing, 144-193 
Conditional EOP, 121-122, 138, 157 Diacritical marks, 185 

Contents page. See Tables of contents Dialog boxes, 13, 33 

Continuous-form paper, 201 Dictionaries 
Control key, 6, 31, 74 adding words to, 397 

Control Panel, 16, 20, 450-452 changing, 396 

Convert program (WordPerfect IBM), 324 creating, 397, 405-406, 413-415 

Coordinates, of insertion point, 15, 151, 325.See deleting words from, 413 

also Show Position optimizing, 412 
Copies, number of to print, 200 transferring, 415, 425 
Copy command, 166 Dictionary Full error message, 405 
Copying files and folders, 231 DigitArt Laser Graphics, 181, 192 
Correcting misspelled words. See Spell-checking; Disk backups, 247 

Speller Disk drives, 421-422 
Courier typeface, 84, 86, 214, 324 Disk First Aid, 238 

Cover sheet, 126, 129, 136, 201 Disk space, checking, 229 

Creation date, of file, 232 Disk-full error messages, 249 

Creator, of file, 233 DisplayWrite, 422 3 
CricketDraw, 167 Document assembly, 333-337 

Cursor, 16 Documents 

Custom default files, 189, 241-242 merging, 236 
Cut command (Command-X) 22, 30-31, 45, 166 naming, 25 



retrieving, 229 

working with several, 72-74 
DOS, commands, in TOPS, 430 

DOS directories, 422, 429 

Dot-leader tabs, 100 

Dot-matrix printers, 211 

Double spacing, 113 
Double-clicking, 21, 53, 452 

Downloading files, 425 

Downloading fonts, 204, 214-215 
Draft-quality printing, 199-200 
Dragging, 18, 55, 166 
Draw-type graphics, 167 
DrawArt, 174, 193 

Drop caps, 144 

Dual merges, 329-333 
Dummy record, creating, 311 
Duplicate images, creating, 169-179 
Duplicate words, checking for, 404 

E 

Editing screen, 11, 60 

Ellipsis, 13, 218 
Em and en dashes, 113, 219 

End key, 51, 57-58, 160, 163-164 
Endnotes, 144, 362, 375-376, 392. See also 

Footnotes/Endnotes 
Enlarging printing, 204 
Enter key, 10, 12, 32, 49-54, 104, 124, 153, 

160-161, 171, 266, 272, 371 
Enter key, mapping features to, 446-448 
Entering text, 17, 20-24, 146 

Envelopes, printing, 124, 200-202, 216-217, 326 
Equations 

alignment characters in, 109-110 

typing, 89-91 
Equipment requirements, 5-6 
Error messages, 58, 151, 249, 388, 394, 405 

Esc key, 6, 48, 265, 267-268, 295, 384 
Excel, 165, 422 

Exporting documents, 425-426 
Extended keyboard, 6, 445 

F 

Fast Saves, in Microsoft Word, 235 

Faster Bitmap Printing, 204 

FatBits, 169, 186 
Fields, 306, 310-311, 314, 319, 323, 330 

File creator, 233 
File Management command (Command-L), 

196, 227-235 

File Management window, 228-229, 235, 240, 

324, 336, 415 
File menu, 224, 229, 238 
File menu, in Finder, 240 

File names, 236 
File servers, 427-431 

Index 455 I a Se ee 

File translation programs, 421 
File type, 233, 415 
File/Folder information, 232-234, 324 

Files 
copying, 231 
deleting, 231 
renaming, 231 

types of, 228-229 
Find File, 235 
Finder, 224, 226, 229, 233-234, 238-240, 426. 

See also Desktop 
Fixed paragraph numbering, 343, 351-352, 357 
Floppy disks, 212, 421-422 

Fluent Fonts, 220 

Flush left, 180, 183 

Flush right, 97-98, 132-135, 180, 183, 188, 315 
Folders 

creating new, 231, 234 
in TOPS networks, 429-430 

organizing, 226-227 
Foldouts, creating, 189 
Font change codes, 85-86 
Font menu, best sizes on, 88 

Font styles, for laser fonts, 213 

Font substitution, 202, 204, 217 

Font/DA Juggler, 222 
Font/DA Mover, 208, 210-211 

FONTastic, 220 
Fontographer, 221 
Fonts, 83-91 

changing, 18-19 
changing in MacPaint, 171 
copying and removing, 210-211 
design considerations for, 172 
downloading, 214-215 
editing ImageWriter, 220 
editing laser, 221 

ImageWriter, 211-212, 222 

laser, 219, 221-222 

sizes, 114, 212-213, 217 
sources for, 220-221. See also individual font 

names 
Footers. See Headers/footers 
Footnote Options dialog box, 369 
Footnotes/Endnotes, 361-362 

assigning a new number, 366 
breaking between pages, 365 

changing the style of, 366-371 
copying, 372 
creating, 360, 365-366 
deleting, 365-366 
editing, 366 
font size of, 372 

indenting text in, 371-373 

macro for, 373 

margins in, 374 
numbering, 366 
printing, 374-376 
searching for, 364-365 
style of, 362-364 

Foreign-language fonts, 220-221 
Form letters, 306-307 

Format codes, 440-443 
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for block protection, 139 
for canceling hyphenation, 110 
for centering, 92-96, 98-99, 385 

for columns, 146-149, 153, 157-165, 285, 361, 

374 
for conditional EOP, 138 

for date, 77 

deleting, 56, 68, 71-72, 89 
for flush right, 97-99 
for font changes, 85-88, 372 
for footnotes/endnotes, 364, 366, 369-370 

for graphics, 165 
for hard return, 24, 65, 284 

for header/footers, 132-133, 135 

for hyphens, 110-111 
for indexes, 376, 379, 391, 394 

for italics, 25, 68 

for justification, 92-99 
for leading, 114 
for line height, 114 
for line spacing, 113 
list of, 440-443 
for lists, 379, 381, 383 
for outline character style, 90 

for outline definition, 350-351, 357-358 

for outlining, 90, 346 

for paragraph numbering, 355-358 
for required hyphens, 63, 112 
searching and replacing, 62-72 
for suppressing page formats, 137 
for tab align, 108 
for tables of contents, 379, 388 

for tabs, 100-104, 107, 283, 346 

for widow/orphan protection, 139-140 
viewing, 8-9, 24-25, 60-61 

Format menu, 105, 111, 114, 116, 285-292 

Formats 

macros for, 285-292 

saving documents in other, 237 
Formatting 

pages, 122-140 
text, 17, 82-117, 146 

Forms, filling out,324-325 

Forums, CompuServe, 433 
Fractional widths, displaying, 214 
Frames, for graphics, 171 
Full justification, 91 

Full Windows command (Commans-Shift-Z), 
450 

FullPaint, 168 

Function keys, 445 

G 

Geneva typeface, 176, 186, 212 

Glue, 167, 193 

Goto command (Command-G), 21-22, 48-49, 
52-53, 55, 153, 159-160, 163-164 

Goto, in Thesaurus, 407-408 

Graphics 
deleting, 166 

incorporating, 165-171, 183-184, 294 

printing, 199, 204 

resizing, 166 
rotating, 202 
smoothing, 202, 204 
sources for, 192-193 

Grid, setting up a, 325 
Grid system, for design, 173-175 

H 

H-zone, 153 

Hand-feeding paper, 200 
Handles, in graphics, 166 
Hanging indents, 104 
Hard disk 
backing up, 247-248 
as file server, 427 

Hard hyphen, 111-112 
Hard page break (Command-Return), 122-123, 

147, 153, 159, 163 
Hard return, 98, 104, 323-324 

Hard space (Enter-space bar), 89 
Hardware requirements, 5-6 
Headers/Footersoo 

creating (Command-Shift-H), 120, 122, 

130-133 
deleting, 135-136 
discontinuing, 136 

formatting, 133-135 
page numbers in, 133 

Headings 

design tips for, 172, 176, 178, 180 
in indexes, 390-391 

Headwords, 406-409. See also Thesaurus 

Help, 7 
Helvetica typeface, 86, 176, 180-181, 186, 188, 

214-215 
Helvetica Narrow typeface, 214 
Hiding the ruler, 26 
High-quality printing, 199 
Home key (IBM keyboard), 10, 51 
Horizontal rules, creating, 186 
HyperCard, 168, 175, 179, 187-188, 193, 219 
Hyphenated words, searching for, 63 
Hyphenation, 92-93, 110-113, 157, 219 

I-beam, 16 

IBM WordPerfect, 10, 55, 224, 227, 233, 237, 

327, 374 
Icons, 100, 147-148, 155, 205, 209-210, 215, 

250-251, 415, 419-427 
Image Club Graphics, Inc. 192 
ImageWriters, 84, 116, 199-200, 202-204, 

211-213, 216-217, 327-328 
Importable files, displaying, 229 
Importing 



dictionaries, 415 

files, 233-235, 419, 422, 425 
IBM WordPerfect documents, 233 

Indents (Command-Shift-T), 104, 125, 371, 373 
in outlining, 343, 348-349 

Indexes, 379-380, 389-394 

Information utilities, 422. Sze also CompuServe 
Inited attribute, 234 

Insert Literal command (Command-]), 31, 
74-75, 91, 185, 188 

Insert mode, 16 

Insert Page Number command, 130 
Insertion point, 11, 15-16, 101, 155 

displaying position of, 151, 325 
Installer, 208-210 

Insufficient Memory error message, 249 
Invisible attribute, 243 

Italics, 88-89, 176 

J 

Justification, 91-93, 218, 450 

K 

Kerning, 115-117, 180 

Key Caps, 91, 218 
Key repeat rate, 451 

Keyboard input, in macros, 261-264 

Keyboards, 6, 444-445 

Keyboard shortcuts, 12-14, 20, 44-46 

Labels, 326-329 

Laser fonts, 213-214 

Laser printing, 116, 213-222 
LaserPrep, 210 
LaserWriter, 84, 124, 144, 199, 202-204, 

210-213, 216-222 
Lasso, in MacPaint, 168-169, 171 

Leading, 114-115, 180-181, 183 

Left justification, 91 
Left margin, 93, 151. See also Margins 

Left-justified tabs, 26, 99 
Left-Right indent (Command-Shift-L), 104 

in outlining, 343, 348 
Legal numbering style, 349, 357 

Legal-sized paper, 173, 189 
Letter-quality printing, 211-212 
Letterspacing, 115-117, 180 
Line command, 183 

Line Draw, in IBM WordPerfect, 425 

Line Format submenu, 104 

Line height, 114 
Line spacing, 113 
Line submenu, 109 

Index 457 eee IOX FO 

Linotronic typesetters, 211 
List Files. See File Management command 
List Management window. See File Management 

window 

Lists, automated, 379-385 

Locking files, 239-240 
Look at contents of files, 224, 230-231, 235, 336 

Lowercase, converting to, 31, 59-60. See also 

Capitalization 

M 

Mac Art Department, 192 
Mac the Knife, 220 

MacBinary, 242, 432, 435-436 

MacDraw, 168, 171, 193, 238 

Macintosh II, 217, 386, 427 
Macintosh User’s Group (MAUG), 433-434 
MacLink Plus, 422-424, 437 

MacPaint, 167-171, 186, 193, 218 

Macros, by name 

abc (automatic writing), 264-265 
automatic paragraph, 258 
banner (creates a banner), 291-292 

begin para (moves to beginning of paragraph), 
283-284 

boiler (contract boilerplate), 263-264 
cap (capitalizes first letter of a word), 277 
Command-Option-1 (first-level headings), 

286-287 
Command-Option-2 (second-level headings), 

287 
Command-Option-3 (third-level headings), 

287 
Command-Option-B (bullet), 280-281 
Command-Option-D (subscripts), 281-282 
Command-Option-I (indexing), 391-392 

Command-Option-O (aligns outlines), 
348-349 

Command-Option-P (paragraph numbering), 
356 

Command-Option-P (prints a document), 

268-269 
Command-Option-Q (quotes), 288 
Command-Option-R (return to baseline), 282 
Command-Option-U (superscripts), 281 
cover sheet (creates title page), 297-298 
cp (copies paragraph), 282-283 
cut parallel (cuts parallel columns), 284-285 
decimal tabs (sets decimal tabs), 288-289 
define list (defines list style), 385 
define toc (styles table of contents), 298-299 
delete bol (deletes to the beginning of a line), 

276 
demo (on-screen demonstration), 295-296 
display (cycles among windows), 295 
do glossary (search macro), 271-272 
end para (moves to end of paragraph), 294 
front matter (master macro), 300-301 
glossary (word list), 266-267 
hanging (hanging indent), 260 
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header (creates header), 261-262 

ital (italicizes words), 267 
letterspacing (automatic letterspacing), 291 

line delete (deletes a line), 275 
line up (converts to uppercase), 276 
list3 (marks items for list), 384 
lower (converts to lowercase), 277 
lowercase (lowercase a word), 278 
mark toc (marks text for table of contents), 

299-300 
memo (memo format), 290-291 
page number (automatic page numbering), 

292-293 
page numbers (master macro), 269-270 
print list (saves and prints a list), 271 
print merge (saves and prints merged 

document), 322 
second notice, 258 

Smith (multiple citations), 373 

third notice, 258 

tr (transposes letters), 279 
tr sentence (transposes sentences), 259-260 

upper (uppercase a word), 278-279 
word (transposes words), 279-280 
word left (transposes words), 275 

Macros 
building a library of, 273-274 
Command-Option, 35, 268 
conditional chains, 270-273 

debugging, 274 
delay in, 264-265, 274, 295, 299-300 
editing, 273 

executing, 257, 259 

files, 228, 243-244 

for front matter, 296-301 

in merges, 305, 321-323 
naming, 257, 266 
nesting, 268-270, 301 

pauses in, 261-262, 292-293, 300, 363, 373 
prompts in, 262-263 

recording, 257 

renaming, 274 
repeating, 265-268, 295, 384 

repeating chains, 265-267 
resuming, 262 

search-and-repeat, 301 
signature block, 34-36 
startup, 265, 296 

system of notation for, 273-274 
using Select in, 267 

MacTerminal, 424, 431 

MacWrite, 111, 237, 324 

Mail-merge files from other programs, 323-324, 
425 

Mailing labels, 124, 326 

Main Dictionary (WP Dictionary), 400, 
405-406, 409-415 

Manual downloading, 215 

Manual paper feeding, 200 

Mapping features to the Enter key, 12 
Margin release (Shift-Tab), 125 

in outlining, 104, 182, 343, 345, 347, 353 

Margins, 26, 93, 146 

changing, 120, 122-125 
in columns, 151-152 

with headers and footers, 131-133 

with laser printers, 217 

related to printer, 201 

right and left, 151 
Mark Text (Shift-Command-J), 381, 386 
Master documents, 336 
Masthead, creating a, 186 
Mathematical typing, 89-91. See also eae 

Memo format, macros for, 289-290 
Memory, 72. See also RAM 

Menu bar, removing the, 73 

Menus, 8, 11 

Merge codes, 319-320 
*C (Console), 304, 307, 309 
*D (Date), 304, 312-313, 319 
« E (End of Record), 312, 319, 323-324 
~ F (Retrieve Field), 304, 311, 319, 325 

* G (Go to macro), 305, 319, 322-323 
“N (Next Record), 304, 311, 319-320, 
326-327 

* P (New Primary), 305, 320-322, 326-327, 
334 

~Q (Quit), 305, 320-321 
“R (End of Field), 304, 320, 323 
“S$ (Secondary), 305, 317-318, 320 

*T (To Printer), 305, 320-321, 334 
“~U (Update), 305, 320 
*V (Transfer), 305, 320, 329-333 

Merging 
addressing envelopes and mailing labels in, 
326-329 

assembling documents in, 333-337 
creating reports in, 325-329 
dual merges, 329-333 
end of field, 310-311 

end of record, 312 

fields in, 314 

with forms, 324-325 
inserting the date, 307, 313 

from keyboard, 304, 307-311 
with macros, 305, 321-323 

to next record, 311 

page breaks in, 334 
primary files in, 304, 306, 313-318, 329-333 
to printer, 305, 319-323 

with records from other programs, 323-324 
retrieving a field, 311, 314 

secondary files in, 304, 306, 311-313, 329-333 

setting up fields and records for, 319 
simple, 315 

splitting secondary files in, 320 
starting, 304, 309, 323, 332 

stopping, 305, 317 

suppressing blank lines in, 315-316 
switching secondary files in, 317-318 
using RAM, 318-319 

Messages, 15 * x 

MicroPhone, 424, 431, 437 
Microsoft Word, 111, 235 

Miles Computing, 220 

Minus sign, 113 



Modems, communicating via, 426 

Monaco typeface, 84, 200, 212, 324 

Monospaced fonts, 84, 199-200, 214, 324 

Mouse tracking speed, 452 
Mouse, using the, 46-47 
MPNT (MacPaint), 233 
MultiFinder, 236, 238 
MultiMate, 422 

Multiplan, 422 
Multiple citations, 373 
Multiple images, creating, 169-170 

N 

Naming files and folders, 25, 226-227, 229, 231, 
234, 236 

Near-letter-quality printing, 211-212 
NeoScribe International, 221 

Nesting macros, 268-270 
Networks, 419-420, 426-431 

New Century Schoolbook typeface, 176, 214 
New document command (Command-N), 17 
New folder, creating, 234 

New Helvetica Narrow typeface, 180-181, 

185-186 
Newsletter, creating a, 186-189 
Newspaper columns, 93, 102, 146-149, 

154-158. See also Columns 
Nonproportional fonts, 84, 199-200, 212, 214 

Not Enough Memory error message, 388, 394 
Notes. See Footnotes/Endnotes 
Num Lock, 6 

Number of copies to print, 200 
Numbering paragraphs. See Paragraph 

numbering 
Numeric keypad, 6, 16, 21, 32, 47-53, 57-58, 

153, 159, 161, 444 

Oo 

Open command (Command-O), 10, 25-26, 235, 

243 
Opening a document in File Management, 229 

Opening protected documents, 239 
Optima typeface, 214 
Option key, 169, 200, 211, 218-219 

Orientation, print, 201-202 
Original backups, 245-246 
Orphans, 137, 183. See also Widow/orphan 

protection 
Outdenting, 104, 182 
Outline character style, 88-89, 168-169 
Outline mode, 342-343, 351 
Outline numbering, 342-343, 349 
Outlines, several in one document, 350-351 

Outlining 
aligning entries, 347-349 
changing the style of, 340 
deleting a number, 344-345 

Index 459 eee CX FS 

deleting a topic, 345-346 
editing, 345-347 
entering entries, 340 

macro for, 348-349 

selecting text in, 346 
style of, 349-350 

turning on (Command-Shift-Y), 340 
Overflow files, 249 

Overstrike, 91 

P 

Page breaks, 122-123, 388 

in merges, 334, 336 
Page formatting, 121-140 

Page, in WordPerfect, 55 

Page Layout command, 120, 123, 327 
Page layouts, designing, 177-187 
Page length, 120, 122 
Page number, position of, 93, 128-129, 137 

Page numbering, 120, 122, 125-130, 382 

in headers and footers, 129, 188 

stopping, 128-129 

suppressing, 136-137 

Page Setup, 20, 151, 196, 201-204, 209, 217 
Page size 

with columns, 151 

for mailing labels, 327 
Page submenu, 120 
Page width, 120, 122 

Pages 
centering top to bottom, 36 
printing selected, 200 

Paint can, in MacPaint, 186 

Paint-type Graphics, 167, 171 
printing, 204 

Palatino typeface, 214 

Paper sizes, 201 
Paragraph numbering, 340, 343, 349-357 
Parallel columns, 102, 104, 146, 149. See also 

Columns 
Partial word searches, 33, 63 

Passwords, 224, 238-239 

Paste command (Command-V), 12, 16, 22 

Pauses, in macros, 261-262 

PC Talk, 424 
PC-compatible disk drives, 421-422 
Pencil tool, in MacPaint, 169 

Perspective, changing in graphics, 170-171 
Pg indicator, 15 
Pg Up, Pg Dn keys, 49, 52 

PICT files, 166-167 
Pixel, 212 
Plain character style, 88-89 

Pointer, 16 

Points, 83, 114 

PostScript, 166-167, 205-208, 213, 217, 427 
Precision Bitmap Alignment, 204 

Preprinted forms, 324-325 
Previewing a document, 204-205 
Primary file, 304, 306, 309, 320, 322, 324, 

326-327, 329-337 
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Print (Command-P), 196, 199-200 
Print areas, 201-202, 204 

Print dialog box, 151, 199-200 

Print Options, 20, 151, 167, 199, 210-204, 327 
Print Preview (Command-Shift-P), 11, 36-37, 

92, 103, 128, 131, 188, 196, 199-200, 
204-205, 211, 366 

Print quality, 196, 199-200, 211 

Print Selection, 199-200 

Printer Command dialog box, 207-208 
Printer fonts, 210, 213-215 

Printer, selecting a, 147 
Printing, 39 
bit-mapped graphics, 218 

envelopes, 327 

from File Management, 230 

graphics, 199 
mailing labels, 327 
orientation, 151 

selected pages, 200 
sideways, 151 

speed of, 204 

two-sided, 176, 189, 386 

Printing resources, installing, 208-210 
ProComm, 424, 437 

Prompts, in macros, 262-263 

Proportional fonts, 84, 100, 116, 212, 214 

Protect attribute, 234, 238-240 

Protocol, 424 

PTNG (MacPaint), 233 
Publications, designing, 172-192 

Q 

QuickDraw, 167, 212-213 

Quit command (Command-Q), 25, 327 
Quotes 

design tips for, 176 

typesetter’s, 280 

R 

RAM, 72, 248-249, 295, 318 
RAM cache, 238 

Record, 306, 319, 323 

Redlining, 75-76, 180-181 
Reducing printing, 204 

Renaming files and folders, 231 

Repeating a command, 48 

Repeating macros, 265-268 
Repeating tabs, 106 

Reports, creating by merging, 325-329 
Required hyphen, 111-112 

Required (non-breaking) space, 89 
Resizing graphics, 166, 169-170 
Resolution, 211, 218 

Resource fork, 232-233 

Restoring distorted graphics, 166 

Retrieving documents, 10, 26, 229, 234-236 

Return key, 10, 21 

Reversing out text, 168-169 
Revert icon, 93, 148, 166 

Right justification, 91, 108, 113 

Right-justified tabs, 26, 99 
Right margin, 93, 113, 151. See also Margins 

Roman (plain) type, 176 
Roman numbers, 120, 127, 129, 300, 388 

Ruler line, 15, 26, 91-93, 95, 97, 99-103, » 
105-107, 112-113, 146-147, 149, 151, 
154-155 

Rules 
horizontal, 186 

vertical, 180-181 

Running feet. See Headers/ footers 
Running heads. See Headers/footers 

Ss 

Sans serif type, 176-177, 214-215 
Save As command, 10, 224, 236-239, 425, 428, 

430 

Save command (Command-S), 10, 25, 236 

Save Copy As Command, 10, 237 

Saving default formats, 241 

Scrapbook, 165, 167, 186-189, 238 

Screen colors, setting, 450 

Screen display, 450 
ImageWriter vs. LaserWriter, 20 

Screen fonts, 204, 210, 212-213 

Screen, printing the, 171, 218 

Screen submenu, 92, 151, 450, 214 

Scrn Up, Scrn Dn keys, 49, 52 

Scroll bars, 15, 52 
Scrolling, 112, 160 

Searching 
for codes, 160-161, 358 
for column definitions, 184 

for margin changes, 124 
in Thesaurus, 407-408 

through files for a word, 234-235 
Searching and replacing, 32-34, 61-72 

fonts, 86 

Select with, 64 

in uppercase/lowercase, 33 
Seattle typeface, 212 

Secondary file, 304, 306, 309, 311-313, 
315-318, 320, 325, 329-333 

selecting different, 317 
transferring, 425 

Section referencing, 144 
Select, 160 

with searching and replacing, 64 
turning off, 25 
turning on quickly, 279 
using in macros, 267 

Select All, 373 » K 

Select Column command, 162-165 

Select On command (Command-Shift-N), 55 
Select submenu, 162 

Selecting, 11-12. Sve also Select 



an entire document, 58 

keyboard shortcuts for, 54-55 
in outlining, 346 
a paragraph, 30 

text, 18-19, 21, 53-56 

Selection box 

in MacDraw, 171 

in MacPaint, 168-171 

Selection, printing a, 199-200 
Sentence, in WordPerfect, 55 

Sentences, converting to uppercase/lowercase, 
276-277 

Serif type, 176-177, 214-215 
Shadow style, 88-89 
Sharing printers, 215 

Shift key, 169-170 
Shift-clicking, 10, 53 
Show Codes, 60, 133, 383, 385 

Show Position, 151, 325, 450 

Showpage command, 186, 208 

Sidebars, 187 

Single sheets, printing, 200 
Single spacing, 113 

Sizing a window, 14 
Smart quotes. See Typesetter’s quotes 

SmartScrap, 167, 193 

Snaking columns, 146 

Soft hyphen, 110-112 
Soft page breaks, 122, 147 
Software Supply, 222 
Solutions International, 193 

Space bar, 95 
in outlining, 343, 349 

Space character, special, 89 
Spaces, between sentences, 283 
Speaker volume, 451 
Special characters 

inserting, 31-32, 74-75 

printing, 218-219 
Special effects, in graphics, 170 
Special menu, 304, 309, 326, 360, 383, 386, 400 
Special symbols, 185. See also Symbols 
Specifications, for documents shown in text, 

189-192 
Speed, of printing, 199-200 
Spell command (Command-Shift-W), 12-13 
Spell-checking, 396-397, 400-406, 413 
Speller, 37-39, 396-406 

default folder for, 243-244, 398-400 
organization of, 400 
using before merging, 336 
using on notes, 365 
using to standardize margins, 374 
using with two disk drives, 38 

window, 400-402 

Speller Utility, 397, 405-406, 409-415. See also 
Dictionaries 

Speller window, 400-402 
Spreadsheet programs, 165, 211. See also Excel; 

Multiplan 
Starting Wordperfect automatically, 449 
Startup device, changing the, 452 

Startup disk, 219, 296 

461 

Startup macros, 265, 296, 449 

Status line, 15, 151, 158, 205, 342 
Strikeout, 75-76 

Stuttgart typeface, 170 

Style sheets, macros for, 285-288 
Subheadings 

as design elements, 181-182, 188 

in indexes, 390-391 

Submenus, 8, 11-13 
Subscripts, 89-91 

macros for, 281-282 

Suitcase, 222 

Superscripts, 89-91 

macros for, 281-282 

Suppress formats, 121-122 
Suppressing page formats, 136-137 
Symbol font, 214 

Symbols 

em and en dashes, 218-219 

in file names, 227 

inserting, 91 

as note numbers, 367-368 

spell-checking, 403. See also Diacritical marks 
Synonyms, 406 

System attributes, 233-234 
System clock, 20 
System disk, 209 

System file, 85, 208-213, 216, 247, 249, 371 
System folder, 189, 199, 215, 240-241 

System version, 8, 208, 431 

T/Maker, 192 

Tab Align (Command-Tab), 104, 107-110, 308, 
348-349 

Tab alignment character, 108-110 
Tab Format box, 105-107 

Tab key, 95-96, 100-102, 107-110, 151, 340 
in outlining, 340, 343, 345, 347, 353 

Tables, breaking, 205 

creating with tabs, 102-104. See also Columns; 
Parallel columns; Tabs. 

Tables of contents 

creating, 379-380, 386-389 

generating, 301, 388 
Tabs, 21, 26-29, 93, 99-110 

deleting, 107 
macros for, 288-289 

in tables of contents, 387 

Tall Adjusted type, 20 
Telecommunication, 431-436 

Templates, creating, 241-242 

Temporary files, default folder for, 243-244 
Test bank, creating a, 356 

Text boxes, 13 

Text files, 224, 228, 237 
Text, in graphics programs, 171 
Text tool, in MacDraw, 171 

TEXT type, 233 

The WordPerfectionist, 436 
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Thesaurus, 397, 406-409 

default folder for, 243-244, 398-400 

TIFF files, 167 
Time, inserting the, 76-78 
Timed backups, 244-246 
Times typeface, 86, 206, 214-215 

Title bar, 14, 242 

Title page, 126, 129, 136, 386 

TOPS, 419, 428-431, 437 
Transfer command, 224, 238 

Transferring 
dictionaries, 415 

documents between computers, 419, 421-431 

Trash, 240-241 
TV1, BV1 (virtual files), 249 

Two-drive system, 249 
Two-sided printing, 125, 176, 189, 386 

Type, of file, 233 
Type sizes, 87-88 

Type styles, 88-91. See also individual styles 
Typeover mode, 16, 21 
Typesetter’s quotes, 280 

Typesetting, 211 

Typography, special effects in, 170-171 

U 

Uncentering text, 96 

Undelete command (Command-U), 10, 22-23, 

31, 58-59 
Undelete files, 249 

Underline, 88-89, 91 

Undo command (Command-Z), 23, 55-56 
Univers typeface, 214 

Uppercase, converting to, 31, 59-60 
US Legal (paper size), 201 
US Letter (paper size), 201 
User Dictionary, 400, 404-406, 409-415 

V 

Variables, in PostScript, 207 

VAX, 233, 237, 415, 420 
Vertical rules, 180-181 

Viewing 

format codes, 24-25, 60-61 

insertion point coordinates, 15 
by name, 240 

Virtual memory, 72, 248-249, 386 

Volume 

in AppleShare networks, 427-428 
in TOPS, 429-430 

Ww 

White space 

avoiding with graphics, 168 
designing for, 180 

Widow/Orphan protection, 121-122, 137-140, 

183. See also Widow/orphan protection 
Wildcards, 64, 67 

in Speller, 405 

Winding columns, 146. See also Newspaper 
columns 

Windows, manipulating, 14, 72-73- 
Windows menu, 73-74 : 

Word count, 396, 404 

Word Left, 50, 52 

Word lists, in Speller, 400, 409-413 

Word Right, 50, 52 

Word search, 224, 234-235 

Word wrap, in MacDraw, 171 

WordPerfect program 

comparisons with IBM PC version, 10 
features, 4-5 

installing, 7-8 
starting, 26, 226-227 
types of files in, 248-251 
using with two disk drives, 38 

WordPerfect Support Group, 420, 431, 433, 
435-436 

WordStar, 422 

Work folder, default folder for, 243-244 

WP Defaults, 225, 240, 249, 370-371, 398-400, 
451 

WP Dictionary, 400, 405-406, 409-415 
WP Disk Is Full error message, 249 
WP File Formats, 249 

WP Help file, 249 

X 

XMODEM, 424-425, 435-436 

Zapf Chancery typeface, 214 

Zapf Dingbats, 186, 188, 214, 218 

Zones, in AppleShare networks, 427 
Zoom box, 14 
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Mastering ProDOS 
Timothy Rice/Karen Rice 
260pp. Ref. 315-5 

An in-depth look at the inner workings of 
ProDOS, for advanced users and pro- 
grammers—with discussion of system 
programming techniques, sample pro- 
grams in BASIC and assembler, and scores 
of ready-made ProDOS utility routines. 

Programming the Apple II 
in Assembly Language 

Rodnay Zaks 

519pp. Ref. 290-6 

This tutorial on 6502 programming is for 
newcomers to assembly language, as well 
as programmers interested in an Apple Ilc/ 
lle-specific presentation. Topics include 
the 65C02, the Apple mouse, the ProDOS 
interface, graphics and animation. 

Mastering Adobe Illustrator 

David A. Holzgang 
AO0Opp. Ref. 463-1 
This text provides a complete introduction 
to Adobe Illustrator, bringing new sophisti- 
cation to artists using computer-aided 
graphics and page design technology. 
Includes a look at PostScript, the page 
composition language used by Illustrator. 

Understanding HyperCard 

Greg Harvey 
550pp. Ref. 506-9 
The enormous potential of this major soft- 
ware development is clarified and 
explained in this extensive hands-on tuto- 
rial which covers all aspects of the Hyper- 
Card and Hypertext world, using 
step-by-step discussions, examples, and 
insights. The best way to construct, fill, 

and use stacks efficiently is covered in 
detail. 

Mastering AppleWorks 
(Second Edition) 
Eina Tymes 

479pp. Ref. 398-8 

New chapters on business applications, 
data sharing DIF and Applesoft BASIC 
make this practical, in-depth tutorial even 
better. Full details on AppleWorks 
desktop, word processing, spreadsheet 
and database functions. 

AppleWorks Tips and 
Techniques 
(Second Edition) 
Robert Ericson 
462pp. Ref. 480-1 

An indispensible collection of timesaving 
techniques, practical solutions, and tips 
on undocumented problems for every 
AppleWorks user. This expanded new 
edition covers all versions through 2.0, 
and includes in-depth treatment of 
macros. 

Inside the Apple lIGS 

Gary Bond 
449pp. Ref. 365-1 

An inside look at the hardware and sys- 
tem organization, with numerous pro- 
gramming examples showing how to 
access the system’s ROM calls, soft 
switches, and tooi calls using 65816 
assembly language. Includes sound and 
graphics programming. The author, Gary 
Bond, was a member of the Apple IIGS 
development team. 

Mastering Excel on the 
Macintosh 
(Second Edition) 

Carl Townsend 

607pp. Ref. 439-9 

A new edition of our popular hands-on 



guide to using Excel’s extensive work- 
sheet, database, and graphics capabil- 
ities. With in-depth coverage of special 
features and techniques, sample applica- 
tions, and detailed treatment of macros. 

Advanced Excel Solutions 
David K. Simerly 

253pp. Ref. 389-9 
High-level business applications using 
linked spreadsheets serve to demonstrate 
Excel's most advanced database, report, 
chart, table, and macro capabilities. Also: 
data interchange, optimizing disk storage, 
and the Switcher. 

Programming the Macintosh 
in Assembly Language 
Steve Williams 

779pp. Ref. 263-9 

A comprehensive tutorial and reference 
covering assembly-language basics, the 
68000 architecture and instruction set, 
the Macintosh Toolbox, linking with high- 
level languages and more; plus an exten- 
sive macro library and sample programs. 

Programming the Macintosh 
inc 

Bryan J. Cummings/Lawrence J. 
Pollack 

294pp. Ref. 328-7 

A comprehensive introduction to C pro- 
gramming, especially for Macintosh 
users. Covers the design philosophy and 
special advantages of C, as well as every 
feature of the language. With extensive 
reference material. 

WORD PROCESSING 

The ABC's of WordPerfect 
(Second Edition) 
Alan R. Neibauer 

300pp. Ref. 504-2 

This introduction explains the basics of 
desktop publishing with WordPerfect 5: 
editing, layout, formatting, printing, sort- 
ing, merging, and more. Readers are 
shown how to use WordPerfect 5’s new 
features to produce great-looking reports. 

The ABC's of WordPerfect 
Alan R. Neibauer 

239pp. Ref. 425-9 

This basic introduction to WordPefect 
consists of short, step-by-step lessons— 
for new users who want to get going fast. 
Topics range from simple editing and for- 
matting, to merging, sorting, macros, and 
more. Includes version 4.2 

Mastering WordPerfect 5 

Susan Baake Kelly 
475pp. Ref. 500-X 

The revised and expanded version of this 
definitive guide is now on WordPerfect 5 
and covers wordprocessing and basic 
desktop publishing. As more than 
100,000 readers of the original edition 
can attest, no tutorial approaches it for 
clarity and depth of treatment. Sorting, 
line drawing, and laser printing included. 

Mastering WordPerfect 

Susan Baake Kelly 

435pp. Ref. 332-5 

Step-by-step training from startup to mas- 
tery, featuring practical uses (form letters, 
newsletters and more), plus advanced 
topics such as document security and 
macro creation, sorting and columnar 
math. Includes Version 4.2. 

Advanced Techniques in 
WordPerfect 5 

Kay Yarborough Nelson 
500pp. Ref. 511-5 

Now updated for Version 5, this invaluable 
guide to the advanced features of WordPer- 
fect provides step-by-step instructions and 
practical examples covering those spe- 
cialized techniques which have most per- 
plexed users—indexing, outlining, 
foreign-language typing, mathematical 
functions, and more. 

Advanced Techniques in 
WordPerfect 

Kay Yarborough Nelson 
400pp. Ref. 431-3 

Exact details’ are presented on how to 
accomplish complex tasks including spe- 
cial sorts, layered indexing, and statistical 
typing. Includes details on laser printing 
operations. 



Mastering WordPerfect 
on the Macintosh 

Macros and Sample Files 
Available on Disk 

If you’d like to use the examples in this book without typing them your- 

self, you can send for a disk containing the sample files, the desktop pub- 

lishing documents, and approximately 50 macro files. To obtain this 

disk, complete the order form below and return it with a check or money 
order for $20.00 per copy, made out to Kay Nelson. 

Kay Nelson 

5751 Pescadero Rd., 

Pescadero, CA 94060 

Name 

Address 

City 

State 

Quantity 

WordPerfect on the Macintosh 

SYBEX is not affiliated with Kay Nelson and assumes no responsibility for any defect in the disk or 

programs. 
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SYBEX Computer Books 
are different. 

Here is why... 

At SYBEX, each book is designed with you in mind. Every manuscript is 
carefully selected and supervised by our editors, who are themselves 

computer experts. We publish the best authors, whose technical expertise 

is matched by an ability to write clearly and to communicate effectively. 

Programs are thoroughly tested for accuracy by our technical staff. Our 
computerized production department goes to great lengths to make 
sure that each book is well-designed. 

In the pursuit of timeliness, SYBEX has achieved many publishing firsts. 

SYBEX was among the first to integrate personal computers used by 
authors and staff into the publishing process. SYBEX was the first to 

publish books on the CP/M operating system, microprocessor interfacing 

techniques, word processing, and many more topics. 

Expertise in computers and dedication to the highest quality product 
have made SYBEX a world leader in computer book publishing. Trans- 

lated into fourteen languages, SYBEX books have helped millions of 

people around the world to get the most from their computers. We hope 

we have helped you, too. 

For a complete catalog of our publications: 

SYBEX, Inc. 2021 Challenger Drive, #100, Alameda, CA 94501 

Tel: (415) 523-8233/(800) 227-2346 Telex: 336311 
Fax: (415) 523-2373 



Command Shortcut 

Merge date code 

Merge EOF code 

Merge EOR code 

Merge new 
primary code 

Merge new 
secondary code 

Merge next 
record code 

Merge to 
printer code 

Merge retrieve field 
code 

Merge transfer code 

Merge update 
screen code 

Move to 
beginning/end 
of document 

Move to EOL 

Move between 

columns 

Move to edge 
of window 

Move to beginning 
of line (before codes) 

Move up or down 
by pages 

Move up or down 
by screens 

New document 

New starting 
note number 

New starting 
page number 

New primary file 
(merge code) 

New secondary file 
(merge code) 

Next record 
(merge code) 

Number of copies 
to pnt 

Open a document 

Command-8 D 

Command-Shift-R 

Command-Shift-E 

Command-8 P 

Command-8 S 

Command-8 N 

Command-8 T 

Command-8 F 

Command-8 V 

Command-8 U 

Enter Enter ¢ or ¥ 

1 (numeric keypad) 

Command-G <arrow keys > 
and Command-G Enter 
<arrow keys > 

Enter <arrow keys > 

Enter Enter Enter <— 

9 or 3 (numeric keypad) 

— or + (numeric keypad) 

Command-N 

Command-9 3 

Command-2 2 

Command-8 P 

Command-8 S 

Command-8 N 

Command-P 

Command-O 

(continued from inside front cover) 

307 

319 

319 

327 

321 

311 

320 

SA 

329 

320 

Command 

Outline 

Outline style 

Overstrike 

Page formats 

Page layout 

Page numbers 

Page setup 

Paper feeding 

Paper size 

Paste 

Paragraph 
numbering 

Paragraph 
number definition 

Parallel columns 

Password protection 

Pause a macro 

Plain text 

Point size 

Postscript command 

Preview a 
document 

Print 

Print a saved Word- 
Perfect document 

Printing 
orientation 

Print preview 

Print selection 

Print Options 

Quit 

Redline 

Reduce printing 

Rename a file 

or folder 

Shortcut 

Command-Shift-Y 

Command-3 3 

Command-Shift-V 

Command-2 

Command-?2 1 

Command-2 2 

Choose Print Options 1 
from File menu 

Command-P 

Choose Print Options 1 
from File menu 

Command-V 

Command-3 2 

Command 3 3 

Command-1 2 

Choose Save As from 
File menu 

Command-M 6 

Command-Y 1 

Command-5 

Choose Print Options 4 
from File menu 

Command-Shift-P 

Command-P 

Command-L <select > 
Command-2 

Choose Print Options 1 
from File menu 

Command-Shift-P 

<select > Choose Print 
Options 3 from File menu 

Choose Print Options 
from File menu 

Command-Q. 

Command-Y B 

Choose Print Options 1 
from File menu 

Command-L <select > 

Command-5 <rename> 

See 

342 



‘| and strikeout 

| Search 

| Select all 

| Set beep options 

| Set margins 

| Shadow 

| Replace 

| Retrieve field 

| Select column 

Select on/off 

| Select page 

Remove redline 

| Repeat a command 

Required (non- 
breaking) space 

Retrieve 
a document 

(merge code) 

Reveal codes 

Reverse search 

Ruler 

Save 

Save copy 

Save default 
settings 

Save in other 
| formats 

Save selection 

Screen colors 

Select 

of a document 

| Select paragraph 

Select sentence 

| Set backup options 

} Set default folder 

Esc n (n = number of times 
to repeat) 
Command-H 

Enter space bar 

Command-L <select > 
Command-1 

Command-8 F 

Command-7 

Command-B 

Command-R 

Command-S 

Choose Save Copy As 
from File menu 

Choose WP Defaults 1 
from File menu 

Choose Save As 
from File menu 

Choose Save Selection As 
from File menu 

Choose Screen 4 
from Special menu 

Command-F or Command-B 

Command-6 

Command-Shift-A 

Command-6 5 

Command-Shift-N 

Command-6 4 

Command-6 3 

Command-6 2 

Choose WP Defaults 2 
from File menu 

Choose WP Defaults 3 
from File menu 

Choose WP Defaults 4 

from File menu 

Command-R or 
Command-2 1 

Command-Shift-S 

229 

237 

241 

237 

3, 

55 

243 

Show Codes 

Show position 

Show ruler 

Soft hyphen 

Speller 

Strikeout 

Style 

Stop merge code 

Subscript 

Superscript 

Suppress format 
for current page 

Tabs 

Tab Align 

Transfer to 
another program 

Thesaurus 

Typeover 

Undelete 

Underline 

Underline style 

Undo 

Update screen 
(merge code) 

Uppercase 
conversion 

View different 
types of files 

Widow/orphan 
protection 

Windows (switch) 

Word count 

Word left 

Word right 

Word search 

WP Defaults 

Command-7 (toggle) 

Choose Screen 2 
from Special menu 

Command-R 

Command-(hyphen) 

Command-E 

<select > Command-Y A 

Command-Y 

Command-Shift-Q_ 

Command-Y 8 

Command-Y 7 

Command-2 3 

Command-4 3 or 
Command-R 

Command-Tab 

Choose Transfer from File 
menu 

Command-T 

0 (numeric keypad) 

Command-U 

Command-Shift-U 

Command-5 

Command-Z 

Command-8 U 

<select > Choose Case 
Convert 1 from Edit menu 

Command-L 

Command-?2 7 

Command-W 

Command-E 4 

Command-<- 

Command-~ 

Command-L Command-9 

Choose WP Defaults 
from File menu 

320 

139 

von 

241 



MASTERING 

WORDPERFECT 
ON THE MACINTOSH 
Here’s the only book you’ll need to go from startup to mastery 

with the Macintosh version of WordPerfect version 1.0—offering: 

e Shortcuts and pointers for new Macintosh users 

¢ Undocumented tips on getting more from WordPerfect 

e Hints for former IBM WordPerfect users 

e Details on transferring files between the PC and the Mac 

¢ More than 50 ready-made macros, for timesaving and 
efficiency in all your word-processing tasks 

Whether you’re new to WordPerfect, new to the Mac—or looking 
to master WordPerfect’s most sophisticated features—Mastering 
WordPerfect on the Macintosh gives you all the skills you need. 

Get started without intimidation—with easy-to-follow, 
step-by-step tutorials. 

Produce letter-perfect, smoothly edited text using the full 
potential of WordPerfect’s on-line editing features. 

Create visually striking printouts using varied typefaces, styles 
and sizes, unusual formats, and special characters. 

Merge and assemble form letters, memos, and “boilerplate” 
text—all at the touch of a key. 

Put finishing touches on major reports with footnotes, 
headers, footers, section numbering, automatic indexing, 

tables of contents, and many other specialized techniques. 

Learn to be a desktop publishing pro: Detailed examples 
show practical design techniques for your newsletters, 
reports, advertisements, and professional publications. 

Let graphics do the talking: You’\l find dozens of tips on 
using WordPerfect with popular graphics programs. 

And there’s plenty of handy reference information, including 
customization notes and a quick-reference guide to WordPerfect 
codes and commands. : 

o ISBN 

With 77St7@CKk Speed Notes 
| —— 

Fast Track speed notes summarize 
chapters, list the steps or keystrokes 
needed to complete specific tasks, and 
point you to pages on which more 
detailed explanations appear. Watch for 
new releases with the Fast Track logo on 
the book cover. The Fast Track parallels 
the main text on clearly marked pages at 
the front of each chapter. 

About the Author 

Kay Yarborough Nelson is a 
recognized expert on WordPerfect and 
a Macintosh enthusiast—having 
owned and operated a Mac for word 
processing since it was first introduced 
in 1984. She has authored and 
coauthored many popular SYBEX 
books on word processing, including 
Advanced Techniques in WordPerfect, 
WordPerfect Desktop Companion, 
and WordPerfect Instant Reference. 

0-89588-515-a4 U.S. $21.95 
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